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1 SimBiology Apps

Keyboard Shortcuts for SimBiology App

1-2

On Macintosh platforms, use the command key instead of Ctrl.

Shortcuts for the Diagram View

Action Shortcut
Select all blocks Ctrl + A
Highlight block in the Table view on |Ctrl + B
page 1-26 or in the Browser on

page 1-10 if open

Copy block Ctrl + C
Duplicate block Ctrl + D
Paste block Ctrl +V
Print the diagram on page 1-5 Ctrl + P
Delete block Delete
Move block up by 5 pixels Up arrow

Move block down by 5 pixels

Down arrow

Move block left by 5 pixels

Left arrow

Move block right by 5 pixels

Right arrow

Move block by 1 pixel

Ctrl + any arrow key

Move block by 10 pixels

Ctrl + Shift + any arrow key

Pan the diagram

Shift + any arrow key

Zoom in Ctrl + +
Zoom out Ctrl + -
Toggle selection Ctrl +1
Select the next cloned block N

Select the previous cloned block P

Move one or more blocks in a Shift + U

clockwise fashion




See Also

Action

Shortcut

Move one or more blocks in an anti-
clockwise fashion

Ctrl + Shift + U

Expand one or more blocks by Shift + E
increasing the distance between

them

Collapse one or more blocks by Ctrl + E

decreasing the distance between
them

Show usages of a quantity

Ctrl + Shift + F

Show search bar

Ctrl + F

See Also

More About
. “Diagram View” on page 1-4
. “Table View” on page 1-26

1-3



1 SimBiology Apps

Model Views in SimBiology App

1-4

The SimBiology app provides three different views of a model on page 2-2: the Diagram
view, Table view, and Equations view. The Diagram view shows a graphical representation
of a model. It describes the model using a set of connected blocks. Blocks represent
different modeling elements such as quantities and expressions, and the view shows the
relationships between model elements graphically. The Table view displays modeling
elements and their properties in a tabular form. You can use either view to build a model.
The Equations view shows the differential equations and other expressions such as
assignment rules of a model. This view does not let you edit the model. If you make a
change to the model using the Diagram or Table view, the change is reflected in all views.
To open any view, select Open from the Model tab.

Diagram View

The Diagram view shows the structure of a model graphically. It provides information
about how model elements, such as species, interact with one another using a block
diagram. To supplement the diagram on page 1-5, this view also contains the browser

on page 1-10 that shows the relationships between quantities and expressions. You can
build a model by dragging and dropping blocks on page 1-22 from the block library

panel to the browser or diagram. The browser and diagram are synchronized, and any
update or change is reflected in both. The next figure shows a model open in the Diagram
view.



Model Views in SimBiology App

Remove unused | Display the browser and diagram. ‘ ‘ Customize the browser. ‘
model elements.

4
HEEES DIAGRAM BLOCK VIEW 2%~ @'@I h Model P~
=2 f{‘! Eﬂ FED S&' I“"—; =1 “@ ‘:"'—g % Show Usages 2] Show Programs
Open different - — S < h h
15 Open  Rename Remove Export Verfy Convert |Browser [|Diagmm| View Tools Select - CnangeScope i Searc SimBiclogy
views of a model. ~ Unused = Units * v Varients Model Analyzer
VIEW MODEL LAYO! EROWSER ANALYSIS =
——— agram |
[E] Content | @ » Project » TwoComp g -
Each open panel has ‘
: Disgram Equations
its own tab. - — -
L =]
[camparment 1 Model: TwoComp
i 2 B3 Central = 10 liter
Block Library Panel @ spacies \_J_
@ reaction 3 e = 100 milligram
@ initial assignment 4 © Drg = 00 milligram/liter
@ repeated s B [ Periphenl = 07 liter
) 6 © Dose = 00 milligram & &
0= algebraic rule 7 © Dyg = 00 milligramy/liter ¢ —0 ¢ )
ose o0se
# event 8 E Model Scoped Parameters ]
@rrepeatdose 5 © €I Central = 03 liter/hour &
5 - —1C
) schepule caxg 10 2O k2 = o7 1/hour e B
I variant 1 (2) Central -> Peripheral Transport Rate Initialization = Q12 / Central
A 12 2o -0 Thhour
=] - i = !
13 [ @ Peripheral > Central Transport Rate Initialization Q12/ Periphera ey S
14 © ka_Peripheral = 04 1fhour
15 = © ke_Central = 03 1/hour )
16 (&) Central Elimination Rate Initialization = ClCentral/Ce..
17 < aQnr = 02 liter/hour
18 E Reaction Scoped Parameters
19 = @ Central.Dose -> Central.Drug
20 S ka_Central = 06 1/hour
P
| ]
Diagram

The diagram section contains a set of connected blocks that shows the structure of a
model and the relationships between model quantities and expressions graphically.

You can add new quantities and expressions by dragging and dropping blocks from the
block library panel to the block diagram. To connect two blocks, Ctrl + click (Option +
click for a Mac) the first block and drag to the second block. Double-click a block to edit
its properties. Right-click a block to see the context menu with more options, such as
hiding the block to avoid clutter. Double-click the name of a block to rename.

The app uses contextual icons to provide more information about a block. The icons
appear above each block. For instance, if a species is being dosed, a dose icon appears
above the species block. Hover the mouse over the icon for more information.

Adding and configuring reactions

Suppose you want to model the pharmacokinetics of antibacterial drugs in a time-kill
curve experiment [1]. Such an experiment involves exposing an in vitro bacterial
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1-6

inoculum to a fixed antibiotic dose and monitoring bacterial activity over time. You can
model the in vitro drug kinetics using a one-compartment model with linear elimination to
account for drug degradation due to compound instability. This is represented by the first
reaction Drug Central -> null. Include a second compartment (Biophase) to
incorporate potential pharmacologic delay, which correspond to the second and third
reactions: Drug Central -> Drug Central + Drug Biophase, Drug Biophase -
> null.

= =
Central Biophase
Drrug_Central Drug_Biophase
reaction3
reaction reaction2

Drag and drop two compartment blocks onto the diagram. Then drop a species block
inside each compartment. To build the first reaction, reactionl, drag and drop a reaction
block onto the diagram. Then draw a line (Ctrl+Click or Options+Click on a Mac) from
the Drug Central species to reactionl. Double-click the reaction block and the Block
Property Editor opens. In the Quantities Used by Reaction table, enter kdeg in the
Name column as the Forward Rate Parameter. This automatically adds a parameter
named kdeg, which is used as the forward rate constant for the reaction rate, that is,
kdeg*Drug Central. Similarly, configure the second reaction reaction2. Enter ke as the
forward rate parameter for the reaction. To build the third reaction, reaction3, draw a line
from Drug Central to Drug Biophase. A reaction block is automatically added between
two species blocks. The input and output of the Biophase compartment are modeled as
first-order kinetic processes. Drug Central is both a reactant and product in the input
process, assuming that the presence of the Biophase compartment does not affect the
mass balance. SimBiology indicates such species using a dashed line. The dashed line can
be achieved by drawing another line from reaction2 to Drug Central. You can also update
a reaction by dragging a reaction line or arrow (Ctrl+Click or Option+Click in a Mac) to
another species.



Model Views in SimBiology App

Defining or updating a quantity value using mathematical equations

The equations can take the form of initial assignments, assignments during the course of
a simulation (repeated assignments), algebraic relationships, or differential equations
(rate rules). Each equation is represented by a unique block. For details about rule
blocks, see the block library on page 1-22. For more information about rules, see
“Definitions and Evaluations of Rules in SimBiology Models” on page 2-17.

Suppose, in the above example, you want to set the initial concentration of Drug Central
to a factor of minimal inhibitory concentration (MIC). You can do so by using an
assignment rule that initializes the concentration of Drug Central at simulation time = 0,
thatis, Drug Central, = 0.25*MIC, where MIC is a parameter. The following figure
shows the graphical representation of the assignment rule.

= bt
Central : Biophase
&
Drug_~Central Drug_Biophase
_________ O—t
r4 reaction3
Vi
/ reaction i
@ 0.25*"MIC
S
H\.::' I
\m.

Drag and drop the initial assignment rule block from the block library onto the diagram.
To define the left-hand-side (LHS) of the equation, draw a line from the rule block to
Drug Central. An arrow appears pointing at Drug Central. To display the right-hand-side
(RHS) of the equation, right-click the rule block and select Show Only Expressions. By
default, the RHS is set to 1. Double-click it and enter the equation: Drug Central =
0.25*MIC. Drag and drop a parameter block and rename it as MIC. A dash-dot line
automatically appears connecting MIC to the rule block indicating MIC is referenced by
the RHS. You can also change the LHS by dragging the arrow (Ctrl+Click or Option
+Click in a Mac) to another quantity.

1-7
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Incorporating sudden changes in model behavior

You can model sudden changes in model behavior based on a specified condition. For
example, you can reset a parameter value at a certain time point or when a certain
concentration threshold is crossed. In SimBiology, you can model such changes using a
modeling element called event. An event lets you specify discrete transitions in quantity
values that occur when a custom condition becomes true. Such condition is called an
event trigger. Once the condition becomes true, one or more event functions are
executed. For details, see events on page 2-30.

Suppose you want to set the concentration of Drug Central at time = 5 to another factor
of MIC as well as the parameter value of the elimination rate constant ke. Specifically,

if (time >= 5)
Drug Central = 0.35*MIC;
ke = pl*Drug Biophase;
where pl is another parameter.

The next figure shows the graphical representation of the event.

= =
Central Biophase
[l
Crrug_Central Drug_Biophase
f reaction e
/,»’ Va
/ reaction fdi*mc reaction?
3 0.25*MIC A4 iy
- *
\n - \\:1‘1 Drug_Biophase
5 T n 7
R g e
MIC p ke

By default, parameter blocks are hidden from the diagram. To see hidden parameter
blocks such as ke, right-click the diagram, and select Show All Hidden Blocks and
Lines. Drag and drop an event block onto the diagram. To define the quantities that are
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being updated by the event, draw a line from the event block to Drug Central and another
line to ke. Two arrows appear pointing at Drug Central and ke, which are the LHS of
event functions. To show the RHS of event functions, right-click the event block and select
Show Only Expressions. Double-click the expressions to edit the event functions as
shown. To see the dash-dot lines indicating quantities referenced in the RHS of an event
function, right-click the event block and select Show Expressions and Lines (Alt
+Click). In this example, MIC, p1, and Drug Biophase are the referenced quantities as
indicated by dash-dot lines. You can also change the LHS by dragging the arrow (Ctrl
+Click or Option+Click in a Mac) to another species.

Interpreting a model from its diagram

The next figure shows an example of a block diagram of another model and
interpretations from looking at the graphical semantics.

fuan]

---0-- - —0--C—0—

k) ¥1 yZ r

o

=)

compartment

There are three reactions in this model. Species x, y1, and y2 are catalysts, that is, both
reactants and products, and z is a product. The amount of species yI is being modified by
an event. Different contextual icons above some blocks indicate:

» The amount of species z is being increased by a dose.

* There is an error with an initial assignment rule.

* The compartment has constant volume.
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Making the diagram clearer

When there are multiple references to the same quantity, multiple lines are connected to
the quantity block. This can cause the diagram to look cluttered. To make the diagram
clearer, you can split the block, that is, create copies of the same block, so that each
reference is connected to a different copy of the block. You can also clone a block to add
another use for it. For instance, you can first clone a species block that you know will be
referenced in multiple expressions. Then use each clone in each expression as you build
the model.

SimBiology lets you clone or split a species block. For event blocks, you can only split
them if there are multiple event functions, but you cannot clone an event. To clone or split
a species block, first select the block. Then select Split or Clone from the drop-down
menu of the Split button on the Block tab. The next figure shows an example where a
species (s2) is referenced by a repeated assignment rule and event, and splitting the
block creates a copy for each reference. Copied blocks are then marked by a contextual
icon to indicate that they have been cloned.

Before splittingthe species s2 After splittingthe species 52
I
1]
S i ——-—# s2*3

s2 o~ 52

"‘-\_\ ! b . -

Er g% Er 24
51 51
compartment compartment

You can also hide blocks to avoid clutter. To hide a block, right-click it, and select Hide
Block from the context menu. By default, blocks that represent constant parameters are
hidden. Hidden blocks can be shown by selecting Hidden Blocks on the Block tab.

Browser

The browser supplements the diagram by providing a table of model elements that shows
the relationships between quantities and expressions. You can edit these elements in the
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browser or add new quantities or expressions by dragging and dropping blocks from the
block library panel onto the browser. If you make a change in the browser, the diagram is
automatically updated.

You can view the model elements shown in the browser by quantities or expressions. In
the quantities view, the browser shows all quantities of the model. If a quantity is being
modified by any expressions and doses, the view also lists them. Alternatively, the
expressions view lists all expressions of the model. It also shows quantities that are
referenced by each expression. To switch between the two views, select View > By
Quantities or View > By Expressions on the Model tab.

View By Quantities

The quantities view shows a table of quantities and expressions that are modifying them.
Use this view to check the values of quantities and if they are being modified by
expressions such as events or assignment rules. You can also see the right-hand-side, of
each modifying expression. To display quantity units, select Tools > Show Quantity
Units on the Model tab. The check box next to each expression indicates whether the
expression is active and used during simulation.

You can model biological variability using a modeling element called variant. A variant is
a collection of quantities with alternative values. For instance, in the above example, you
can have one set of parameter values such as the elimination rate (ke) and degradation
rate (kdeg) for each antibacterial drug.

The browser shows a variant column for each variant of a model. For instance, a variant
named Vancomycin is shown in the next figure. You can edit each quantity value by
double-clicking it. When there are multiple variants, you can display a subset by clicking
Select Variants on the Model tab. To add a variant, drag and drop a variant block from
the block panel onto the browser.

If there are expressions for which the left-hand-sides are not defined, these expressions
are listed under the section named Undefined. For example, in the next figure, the initial
assignment rule 2 is modifying a quantity p2 that is not defined yet in the model. You can
right-click the undefined quantity and define it as a species, parameter, or compartment.

Before running any analysis program, SimBiology prepares a model for simulation and
updates the quantity values according to the variant values, assignment rules, and doses.
For details, see “Model Simulation” on page 4-2. You can check if the quantity values

are initialized as you expect by checking the initial conditions of the program.

To see the initial conditions, first, select Show Programs on the Model tab. Then select a
program in the program toolbar. For instance, in the following figure, the initial
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conditions of a simulation program is shown. In this program, a variant called Vancomycin
and a dose called dose 1 have been selected to apply to the model during simulation. The
concentration of Drug Central at the beginning of the simulation is 0.25, compared to the
model value 0.0. The value is updated because, at simulation time = 0, SimBiology
evaluates the initial assignment rule 1 that initializes Drug Central to 0.25*MIC. Since
the variant Vancomycin has been selected, the alternate values stored in it, namely 0.5
and 0.86 for kdeg and ke, are used instead of model values.

Since a dose is applied to species Drug Biophase at time = 0, the browser displays the
total amount of the species, that is, the initial condition value of the species plus the dose
amount. For instance, in the next figure, the total amount of species Drug Biophase after
applying the dose is 0.1. Alternatively, you can view the initial value and dose amount
separately by selecting Tools > Program Initial Conditions Options > Show the dose
amount separate from the initial condition value from the Model tab.
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Click to show a program in the program toolbar.

HOME DIAGRAM VIEW earch Model Fe B
&l E’d & & E@ L% E &l E E E Show Usages |3 Show Programs
Open Remame Remove Export Verify Convert Brows.ef; Diagram View Tools Select Shanige icupe: 1 emch SimBiology
- Unused - > Units | > w  Variants Model Analyzer
VIEW MODEL LAYOUT BROWSER ANALYSIS x
[l Content | @ ¥ Project ¥ Antibactenal l Program toolbar | Variantcolumn | ‘ Initial conditions | -
q'\_ —® | Simulation = [ Open program Hide Initial Conditions (& Refresh + + X
[ |compartment =5 - T r TV o = s_'" i 1@l
O parameter ‘ancomycin \=| Simulation
O species 1 Modell_: Antibactenal
Q) reaction z B [ Biophase = 10 1.0
@ initial assignment 3 = © Drug Biophase = 00 0.1
E repeated assignment | 4 @ dose_ = =
4 rate rule s B3 Central = 10 1.0
0= algebraic rule 6 5 © Drug_Central = 00 0.25
o avant 7 M & el = 025MIC
(3 repeat dose . &  Lmes=h
@ schedule dose 8 QD event 1 - ——
I variant
A text g = Model Scoped Parameters
10 O kdeg = 10 0.5 0.5
11 O ke = 1000 0.86 0.86
12 @ MmIC = 10 1.0
13 Q p1 = 035 0.5
14 Reaction Scoped Parameters
15 = Undefined
16 2 [& p2
17 M & ez = 035 =

Defining or updating a quantity value using mathematical equations. The

equations can take the form of initial assignments, assignments during the course of a
simulation (repeated assignments), algebraic relationships, or differential equations (rate
rules). For details, see rules on page 2-17. In the following example, the concentration of
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Drug Central at time = 0 is defined by an initial assignment equation, that is,
Drug Central, = 0.25*MIC. The next figure shows how the browser displays the
assignment rule in relation to the species Drug Central.

LHS of rule_1 RHS of rule_1

1 Model: Antibacterial

o EJ Bicphase = 1.0

3 = EJ Central = 1.0

4 E|' S Drug_Central = 00 V¥

5 (= rulel = | 0.25*MIC
if  timex=5

g B eventd s

7 Model Scoped Parameters
) Reaction Scoped Parameters

0 Undefined

Drag and drop the initial assignment rule block onto the species Drug Central. The rule
block appears as a separate row below the species. Double-click the RHS of the equation
to edit it.

Incorporating sudden changes in model behavior. You can model sudden changes in
model behavior based on a specified condition by using a modeling element called event.
In the following example, you want to set the concentration of Drug Central at time = 5
to another factor of MIC as well as the parameter value of the elimination rate constant
ke. Specifically,

if (time >= 5)
Drug Central = 0.35*MIC;
ke = pl*Drug Biophase;

where pl is another parameter.

The next figure shows how the browser displays the event.
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Event trigger

LHS of the first
event function 1 | Model: Antibacterial
z [:J Biophase = 10
3 = EJ Central = 1.0
ﬂ|'§3 Drug_CentraI| = 00
- 5 (=) rulel = 0.25MIC
RHS of the _'|r5t ”
event function G Bt event 1 )
7 E  Model Scoped Parameters
LHS of the second g D kdeg = 10
event function g E - 1000
" B event 1 if  time»=5
RHS of the second = [pl*Drug_Biophase
event function 11 O MIC :F 1.0
12 O pl = 05
13 Reaction Scoped Parameters

14 Undefined

Drag and drop the event block onto the species Drug Central. An event appears as a
separate row below the species. To add the second event function, right-click the event
and select Add EventFcn. Double-click the event trigger or RHS of an event function to
edit.

Increasing a species amount using doses. You can model the increase in the amount
of a species due to a stimulus such as an oral or intravenous administration of a drug. To
model such an increase in a species amount, use the modeling element called dose on
page 2-42. In the following example, the concentration of species Drug Biophase is
being increased by a dose.
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1 Model: &ntibacterial

2 = [:J Bicphase = 1.0

3 = & Drug_Biophase = 00
Dose icon 4 p'j':'se—l =

5 [%| Central =

& Model Scoped Parameters
Tableicon -

7 Reaction Scoped Parameters

g

Undefined

Drag and drop a dose block onto the target species. A dose appears as a separate row
below the species. To edit the dose amount, double-click the table icon. In this example,
the concentration of species Drug Biophase is being increased by a schedule dose dose 1.
For more details about dose objects, see “Doses in SimBiology Models” on page 2-42.

View by Expressions

In the expressions view, you can see all expressions of a model grouped by their types
such as reactions, assignment rules, and events. It shows how each expression is defined
and the relationship between each expression and quantities. The check box next to each
expression indicates whether the expression is active and used during simulation.

You can expand each reaction in the browser to configure its properties, such as reaction
rate, kinetic law, quantities referenced by the reactions, and quantity values. You can
define your own reaction rate or use a predefined rate that follows some particular
reaction kinetics such as mass action.

A built-in kinetic law in SimBiology specifies a rate law that defines the reaction rate.
Specifically each law has a predefined reaction rate containing parameters and species
that need to be mapped to the corresponding model quantities to determine the final
reaction rate. The browser displays the mapping information in parentheses next to a
quantity. For instance, if a parameter kf is used as the forward rate parameter in the
reaction rate, the browser displays kf (Forward). In case you map incorrectly, you can
reset the mapping by right-clicking the quantity and selecting Remove Kinetic Law
Mapping.

The kinetic law for a newly added reaction is configured to MassAction by default, and
the app automatically creates and maps the species and parameters needed by the
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reaction rate. For other kinetic laws, only parameters are created and mapped. You need
to create and map the species manually. To change the default kinetic law and reaction
building settings, select Tools > Reaction Building Preferences on the Model tab.

This view also displays the assignment rules grouped according to their types such as
initial assignment, repeated assignment, rate rule, and algebraic rule. For each rule, you
can see its left-hand-side (LHS) and right-hand-side (RHS). The LHS is the quantity that is
being modified by a rule, except for the algebraic rule. The algebraic rule takes the form
0 = Expression, and the rule is specified as the Expression. For details, see
“Definitions and Evaluations of Rules in SimBiology Models” on page 2-17.

This view also shows events. For each event, its trigger and event functions are grouped
together. Each trigger is started with the word if followed by an expression such as if
time>=3. You can also configure the LHS and RHS of each event function.

In addition to all the expressions, you can also see doses on page 2-42 that are grouped
into either schedule doses or repeat doses. For each dose, the corresponding dosed
species, that is, dose target, is shown right next to it. You can double-click the dose icon
to edit all dose properties or the table icon to edit just the dose schedule.

The following figure shows a model open in the expressions view of the browser.
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=

Adding and configuring reactions. There are three reactions in this example. Suppose
the first and second reaction follow the mass action kinetics and the third reaction follows
the Michaelis-Menten kinetics. For illustration purposes, the configuration of reactionl
and reaction3 is described below.

The following figure shows the details of reactionl. It follows the mass action kinetics
with the reaction rate kdeg*Central.Drug Central.
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1 E Reactions

2
3

1 E Reactions
¥ Central.Drug_Central -» null
kdeg*Central.Dirug_Central
2 O reactionl Masshction
O kdeg (Forward)
D Central.Drug_Central

1.0
0.0

To add a reaction, drag and drop a reaction block onto the browser. You can then enter
the reaction string by double-clicking the default null -> null string. Since there are
species in two compartments, qualify the species name with the compartment name. For
example, Central.Drug Central indicates that the Drug Central species is inside the
Central compartment. By default, the reaction’s kinetic law is configured to MassAction.
The parameter kf is automatically created and mapped to the forward rate constant of the
reaction rate. If you want to use a different parameter, you can change it by double-
clicking kf and entering the name of another parameter such as kdeg. You can then delete
the parameter kf which is no longer used in the reaction rate.

The following figure shows the details of reaction3 that is configured to follow Michaelis-
Menten enzyme kinetics with the reaction rate Vm*S/ (Km+S).

CJ reactionl ¥ Central.Drug_Central -> null
O reaction2 b Central.Drug_Central -» Bicphase.Drug_Biophase + Central.Drug_Central

¥ Biophase.Orug_Biophase -» null
Y * S/ (Km + 5)

Henri-Michaelis-Menten

O reaction3

=] vm [Vm) = 10

3] km (Km) 1.0

: 5

Drag and drop a reaction block onto the browser. By default, it uses the mass action
kinetic law. The parameter kf is automatically created and mapped to the forward rate
constant. To specify the reaction to follow Michaelis-Menten kinetics, double-click the row
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labeled MassAction and select Henri-Michaelis-Menten. SimBiology automatically
updates the reaction rate to Vm*S/ (Km+S). The parameters vm and km are also
automatically added and mapped to Vm and Km, which are the parameters referenced in
the reaction rate. However, the S species referenced in the reaction rate is not mapped
yet as indicated by a dotted species block. Double-click the (S) row to enter a model
species that corresponds to the species S. The reaction rate is then automatically updated
using the selected species. To avoid confusion, you may delete the parameter kf, which is
no longer used in the reaction rate.

Adding and configuring assignment rules. In this example, there are two initial
assignment rules on page 2-17. The first initial assignment rule 1 initializes the
concentration of species Drug Central. The second initial assignment rule 2 initializes an
undefined quantity p2.

The next figure shows how the expressions view displays such assignment rules.

LHS of rule_1 RHS of rule_1
5 [ Initial Assignments i l
& o LE'J rule_1 | D Central.Drug_Central = | 0.25*"MIC

. B O ez

Undefined quantity

1.0

Drag and drop the initial assignment rule block onto the browser. Define the LHS of the
rule by double-clicking the string null and entering the name of a quantity that the rule
is modifying. Double-click the RHS of the equation to edit it. If the LHS of the rule is
referring to a quantity that is not yet defined in the model, such as pZ2 in this example,
right-click the undefined quantity and select Define Quantities to define it as a species,
parameter, or compartment.

Adding and configuring events. In this example, there is one event event 1 with two
event functions changing the concentration of species Drug Central and parameter ke
respectively. Specifically,



Model Views in SimBiology App

if (time >= 5)
Drug Central = 0.35*MIC;
ke = pl*Drug Biophase;
where pl is a parameter.

The next figure shows how the expressions view displays the event.

1t event
function Event trigger
g [ Events ¢
q 7| B4 event 1 2 Drug_Central = 035*MIC
|—> = |pl*Drug_Biophase
2™ event ?
function LHS of the 2™ event function

RHS of the 2™ event function

Drag and drop the event block onto the browser. Double-click the default trigger if
time>=1 to edit it. The default event function, null = 0.0, is listed below the trigger.
Double-click its LHS and RHS to edit. To add more event functions, right-click the event
and select Add EventFcn.

Adding and configuring doses. You can increase the amount or concentration of a
species using a dose during simulation. In this example, the concentration of species
Drug Biophase is being increased by a schedule dose dose 1. The next figure shows how
the expressions view displays the dose.
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Dosed species

10 B Schedule Doses

11 dl:lse_l = BiDphase.Dr*g_Binphase = ‘

! i

Dose icon Tableicon

Drag and drop a dose block onto the browser. Define the dosed species by double-clicking
the LHS of the table icon. Double-click the dose icon to edit all dose properties or the
table icon to edit just the dose schedule.

Block Library Panel

The block library panel contains blocks from one or more block libraries. SimBiology
provides a default block library which contains blocks that represent all modeling
elements that you can use to build models. You can also create a library of custom blocks
with different block appearance settings. For instance, you can customize a receptor
protein to have a different block shape or color than other species whenever you use it in
the diagram. For details on the SimBiology libraries, see “SimBiology Model Component
Libraries” on page 1-35.

You can drag and drop most blocks from the panel to both the browser and diagram, and
there are some blocks that can be dropped only in the browser, not in the diagram. Some
blocks do not appear as blocks in the diagram but as contextual icons. For instance, a
dose block appears as a contextual icon above a species block that is being dosed. The
following table summarizes the behaviors of different built-in block types.

Block Blo|Drag |Drag |Block Description
Name ck [and [and |appe
Gr [Drop [Drop |ars
ap onto |onto |as

hic |the the
s |Brows (Diagr
er am

Species  |Yes Yes Block |Quantity that participates in expressions, such as
reactions and represents an amount or
concentration.
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Block Blo|Drag |Drag |Block |Description
Name ck [and |and |appe
Gr |Drop |Drop |ars
ap |onto |onto |as
hic |the the
s |Brows |Diagr
er am
Compartm & Yes Yes Block |Physically bounded region that contains species
ent in a model. All species in a model must belong to
a compartment. A compartment can also belong
to another compartment. For instance, a
compartment that represents a cell can contain
other cellular components such as mitochondria
and nucleus as separate compartments within
the cell compartment.
Parameter | |Yes Yes Block |Quantity that is referenced by expressions. For

instance, you can use it to define a rate constant
of a reaction.

By default, if you drop a parameter block onto
the browser or diagram, it is available to all
expressions including reactions. This type of
parameter is called a model-scoped parameter
and listed under the Model Scoped Parameters
section in the quantities view of the browser.

Another type is called a reaction-scoped
parameter, where the parameter is only available
to one particular reaction. These parameters are
listed under the Reaction Scoped Parameters
section. To add a reaction-scoped parameter,
switch to the expressions view of the browser
and then drop a parameter block onto a
particular reaction.

To switch between the two types, right-click a
parameter block and select Change Scope.
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Block Blo|Drag |Drag |Block |Description
Name ck [and |and |appe
Gr |Drop |Drop |ars
ap |onto |onto |as
hic [the the
s |Brows |Diagr
er am
Reaction Q@ Yes Yes Block |Process such as a transformation, transport, or
(only the binding and unbinding of reactants and
in the products.
expres
sions
view of
the
brows
er)

Initial S |Yes Yes Block |Expression to assign the initial value of a

assignmen quantity. For example, an initial assignment rule

t s4 = 0.75 means that the amount of species s4
is initialized to 0.75 at simulation time = 0.

Repeated |@= |Yes Yes Block |Expression to assign a quantity value repeatedly

assignmen during simulation. For example, a repeated

t assignment rule x = y1 + y2 means that the
amount of species x is repeatedly assigned the
total amount of species yI and y2 throughout the
simulation.

Rate rule |ar |Yes Yes Block |Differential equation to specify the time
derivative of a model quantity. For example, a
differential equation x = kK * (y + z2)
specifies that the time derivative of species x
(dx/dt) is evaluated continuously during the
simulation according to the equation.
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Block Blo|Drag |Drag |Block |Description
Name ck [and |and |appe
Gr |Drop |Drop |ars
ap |onto |onto |as
hic [the the
s |Brows |Diagr
er am

Algebraic | o= |Yes Yes Block |Expression to specify a mathematical constraint

rule (for example, a nonlinear equation) on one or
more quantities that must hold during
simulation. For example, if you have an equation
such as x = log(x+time), write the
corresponding algebraic rule as log (x+time) -
X.

Tip Use algebraic rules only for nonlinear
equations that cannot be solved analytically to
get closed-form solutions. For details, see
“Algebraic Rules” on page 2-18.

Event 4 |Yes Yes Block |Discrete transition in a quantity value. This
discrete transition occurs when a specified
condition becomes true.

Repeat @ |Yes No Conte [Modeling element that increases the value of a

dose xtual [species by a certain amount at predefined time

icon |intervals. To add a dose to a species, drag and
above |drop the dose block onto the species in the

a quantities view of the browser. Double-click the
speci |dose icon to edit the dose value.

es

block

that

is

being

dosed
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Block Blo|Drag |Drag |Block |Description
Name ck [and |and |appe
Gr |Drop |Drop |ars
ap |onto |onto |as
hic [the the
s |Brows |Diagr
er am
Schedule | |Yes No Conte |[Modeling element that increases the value of a
dose xtual |species by certain amount at specific time points.
icon |To add a dose to a species, drag and drop the
above |dose block onto the species in the quantities view
a of the browser. Double-click the dose icon to edit
speci |the dose value.
es
block
that
is
being
dosed
Variant 5 |Yes No Colu |Modeling element that is a collection of
(only mn in |quantities with alternate values from the original
in the the |model values.
quanti Brow
ties ser
view of
the
brows
er)
Text A |No Yes Block |Text block to annotate the model in the diagram.

Table View

This view presents a model in a tabular format, and there are many tables that organize
the model information differently. For instance, the Table Overview gives an overview of
the entire model by showing the complete list of model quantities, expressions, and some
of their properties. There are also tables dedicated to each type of quantity or expression,
doses, and variants, and these individual tables provide more information specific for
each type.
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You can open different tables from the Open drop-down list to edit and add elements to
each table. For instance, you can enter a reaction string such as y2 -> z in the Table
Overview or Reactions table.

The context menu, which you can open using a right-click, provides options to customize
the table and open other modeling tools. For instance, to check which expressions are
referencing a quantity, right-click the quantity and select Show Usages from the context

menu.
4\ simBiclogy - Antibacterial * - [m] x
MODEL g e .%:v-;@:v@ls.am Model P~
Q] & cu =) Q gl @ [ [l Show Columns @) Build Reaction  (J, Search
: b H 8 @& @ % :
Open different tables H3 Copy % Show Usages (@4 Edit Reaction
i £ del Open Rename Remove Export Verify Convert  SimBiology Component
ANENIEWS Ol 2 e - Paste Unused  ~ = Units  Model Analyzer  Palette Change Scope  [] Set Event Order
VIEW  CLIPBOARD MODEL TOOLS =
[Ell content | ® b Project b Antibacterial -
Each open panel has - -
r Table Overview Diagram Species Reactions Parameters Variants Doses
its own tab. L
@ Add Expression: | reaction ~ | Reaction: Add Delete
Type Name Active Expression :LJ
Reaction: | Central.Drug_Central -> null
= = : ReactionRate: kdeg*Central.Drug_Central
1 [ reaction reactionl
KineticLaw: | MassAction A
- - Forward Rate Parameter: kdeg
Click the plus sign to
. — 7™ reaction reaction? Central.Drug_Central -> Biophase.Orug_Biophase + Central.Drug_Central, ke*Central.Drug_Central
. 3 @ reaction reaction3 %] Biophase.Drug_Biophase -> null, ke*Biophase.Drug_Biophase
4 [ initial assignment rule_1 Central.Drug_Central = 0.25"MIC
5 @ initial assignment rule_ 2 p2=05 -
6 [Eevent event_1 time>=35, {Drug_Central = 0.35* MIC, ke = p1*Drug_Biophase} T
Message indicators -
@ Add Quantity: | species in Central ~ Name: Add Defete ‘g
Type Scope Name Value Units Constant i
1 compartment Antibacterial Central 1.0 liter ~ %]
2 compartment Antibacterial Biophase 1.0 liter ~ %]
Contextual icon 3 @ species Central Drug_Central 0.0 molarity v O
indicating the species | 1 species Biophase Drug_Biophase 0.0 molarity v m]
7 is being dosed. S parameter Antibacterial ke 100.0 1/second ~ O
6  parameter Antibacterial kdeg 1.0 1/second ~ O
7 parameter Antibacterial MIC 1.0 molarity v %]
8  parameter Antibacterial pl 0.5 1/(molarity*secont »- (m}
r

Equations View

This view describes a model in the form of mathematical equations. It shows a system of
ordinary differential equations (ODESs) that represent a model. Specifically, the ODEs are
derived from model reactions and define what quantities are being integrated during
model simulation. For details about the simulation process and how SimBiology
constructs ODEs, see “Model Simulation” on page 4-2.
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You can use this view to help debug a model. For instance, you can check the initial
conditions of ODEs to see if the quantity values are initialized as you expect. You can also
see how SimBiology corrects the dimensions of ODEs by dividing the right-hand-sides of
equations with compartment volumes. The volume-correction information can help debug
unexpected simulation results, especially when you have a multi-compartment model with
different compartment volumes. You can also compare the ODEs to the ones from a
publication to reproduce the reported results.

The initial conditions of ODEs are used as starting points to simulate the dynamics of a
model. The initial conditions are the quantity values at simulation time = 0. The Value at
Time Zero column of the view shows these values. You can check this column to see if
the quantity values are initialized as you expect based on initial assignment and repeated
assignment rules, and debug the rules as necessary. For details about how SimBiology
evaluates the assignment rules, see “Model Simulation” on page 4-2.

The next figure shows a model open in the equations view, which has the Equations and
Initial Conditions sections. The Equations section contains the expressions and ODEs
that SimBiology evaluates during model simulation. The Initial Conditions section
contains the quantity values at simulation time = 0. Since initial assignments are
evaluated just once at time = 0, they are only accessible in the Initial Conditions section
via a contextual icon. Repeated assignments are evaluated both at time = 0 and during
simulation. Hence they are shown in the Equations section and also indicated by
contextual icons.
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In this model, the concentration of drug in the central compartment Drug Central is
initialized to 0.25*MIC, resulting in the amount of 0.25 as shown in the Value at Time
Zero column. To see the initial assignment equation, click the contextual icon next to
Drug Central. In addition, a repeated assignment equation sets the value of parameter
kdeg to p1*1.5, resulting in the value of 0.75. You can see the equation listed under the
Repeated Assignments section. The desktop also shows a contextual icon next to the
parameter kdeg to indicate the application of the assignment rule.

To perform an analysis on a model such as simulation or sensitivity calculation, you need
to run a program. You can specify which doses and variants to use for the analysis in the
program configuration. When you select a program, the app applies the doses and
variants specified in the program, hence updating the corresponding quantity values in
the Value at Time Zero column. The dose is also added to the Equations section. The
next figure shows the equations view of the same model with a program selected. In this
example, the program is a simulation program that uses a dose dose 1 to increase the
concentration of drug in the Biophase compartment Drug Biophase at simulation time =
0.
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The grayed-out numbers in the Model Value column indicates the quantity values that
have been changed due to the program configuration. The model value and the value at
time zero are considered different if the relative tolerance between the values is greater
than 1012, that is, |x-y| > le-12*min(|x]|,|y|) where x is the model value and y is
the value at time zero.

The Fluxes section of the equations view contains reaction fluxes for all reactions in the
order they appear in the model. Reaction fluxes are equivalent to reaction rates except
that the dimensions of fluxes are always amount/time. Hence, if the dimension of a
reaction rate is concentration/time, the expression for the reaction flux is equal to
the reaction rate multiplied by a compartment volume. SimBiology uses the name of a
compartment to represent its volume in reaction fluxes and ordinary differential
equations (ODEs). For details, see “Deriving ODEs from Reactions” on page 4-4. The
next figure illustrates an example where reaction! is volume-corrected.
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While preparing a model for simulation and other analyses, SimBiology performs
dimensional analysis to make sure the dimensions of the left-hand-side (LHS) and right-
hand-side (RHS) of each ODE are consistent. The LHS of each ODE is the time-derivative
of the amount or concentration of a species, and the RHS is defined using reaction fluxes.
If you specify no units, the default dimension for a species is concentration, and the
default dimension for a flux is amount/time. For such cases, SimBiology divides the RHS
by a compartment volume to make the dimensions of LHS and RHS consistent. For
details, see “Deriving ODEs from Reactions” on page 4-4. You can see all the ODEs in

the ODESs section of the view as shown in the next figure. In this example, SimBiology
uses the default dimensions for species and fluxes. Hence each RHS of ODE is divided by
the corresponding compartment volume Central or Biophase for volume-correction. By
default, the flux names are used in ODEs. To use the expressions explicitly instead of
using the flux names, select Tools > Embed fluxes on the Model tab. The following
figure shows ODEs after fluxes have been embedded.

Volumecorrection

!

7 [ ODEs |
f 1
g d{Drug_Central}/dt = 1/Central®(- ((kdeg*Drug_Central}*Central])

g d(Drug_Bicphase)/dt = 1/Biophase*({(ke*Drug_Central}*Central} - ((ke*Drug_Biophase]*Biophase])
| ]
[

1

Embedded reaction fluxes
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Copy SimBiology Blocks

When building models interactively in the “Diagram” on page 1-5 view of the SimBiology
app, you can copy and paste blocks using Ctrl + C and Ctrl + V. You can also use the
context (right-click) menu.

» Using Ctrl + V works only if there is enough space near the original blocks. The app
does not automatically increase the compartment size if there is not enough space.

» Using the context menu gives you a better control of where you want the copied
blocks to appear. The app uses the current location of the mouse pointer to place the
new blocks. You must still make sure that there is enough space at the new location.

Generally, only selected blocks are copied and blocks connected to the selected blocks are
not copied. However, there are a few different behaviors depending on the block type as
explained next.

Compartment Blocks

If you select a compartment and copy it, the desktop copies the compartment block and
any blocks that are inside the compartment, even if they are not visible or selected
explicitly. You can display all hidden blocks within a compartment by right-clicking inside
the compartment and selecting Show Hidden Blocks and Lines in Compartment. The
app does not copy any blocks that lie outside the compartment, even if they are connected
to the blocks within it.

Species Blocks
If you copy a species block that is dosed, the associated dose is not copied. You can add a

dose to the copied species manually using the “Browser” on page 1-10 or create a
duplicate dose from the dose table on page 1-26 and update its target name.

Reaction Blocks

If you select a reaction block, the app copies only the reaction block and does not copy
the associated species participating in the reaction. The reaction string is null -> null
and its reaction rate is set to empty.
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Parameter Blocks

Parameters can be model-scoped or reaction-scoped.

» If you select and copy an entire reaction (that is, the reaction block, the reactant
species, and product species), the reaction-scoped parameter (such as a forward rate
parameter) is also copied even though the parameter is not visible or selected
explicitly.

* However, if the parameter is model-scoped, the newly copied reaction uses the original
parameter (that is, both the original reaction and copied reaction share the
parameter). If you paste the entire reaction to a different model, then the app does not
copy the parameter, and you must create one for the reaction rate in that model.

Rule and Events Blocks

If you copy a rule or event block, the app uses the original rule or event string for the
copied block. In other words, the copied rule or event has the connections to the same
blocks as the original block.

If you copy a rule (or event) block and its right-hand-side (RHS) species block, the app
does not update the rule (or event) string to include the newly copied species block. The
copied rule continues pointing to the original RHS species block.

As an example, suppose that you have a rule (rule 1) definedas s1I = 10 * s2.You
select rule 1 and its RHS species block s2 and copy them. After pasting, rule 2 and s3 are
created, but rule 2 continues pointing to the original s2 block. The newly copied species
s3 is unused.

Co Paste
PY -
o]
— e
51 reaction_1 T 82 s reaction_1 7 s2 s3
. - ~ _-— -~
E ey Oz @02
rule_1 rule_1 rule_2
compartment compartment
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SimBiology Model Component Libraries

The SimBiology libraries are collections of built-in components that you can use to build
and analyze models. For instance, you can use built-in units such as mole or molecule as
amount units for species. As you perform model analyses, you can use built-in plots such
as box plot or residuals plot to display the analysis results. You can also add custom
components to any library. For instance, you can define a custom unit or block and use it
as you build models. Similar to preferences, libraries are saved across sessions of
MATLAB® and the SimBiology desktop. Libraries are available for all projects and are not
part of any one project. You can also export libraries and share with others by selecting
Export All Libraries from the action menu.

To open a library in the SimBiology desktop, select Content > Libraries and double-click
a library. For instance, the following figure shows the kinetic laws library with all the
available built-in kinetic laws.

Content panel
showing the
available libraries

HOME [ A =0s @lsaer-:m-.wccle\ p ~|
=) = Q e
o = e T & a4 &H @
Open Save Close AddModel  SimBiology Layout Preferences Search Community Help
- - Model Analyzer = -
s Add custom
PROJECT MODELS ENVIRONMENT RESOURCES
components to
[El| Content | @ ||| v Libraries » Kinetic Laws - alibrary
X
Enter Name: Add Delete
l_il E‘ = Name Expression Library -
X X § 1 Unknown Unknown Built-in
Project | Libraries |Recent Files ; ;
2 MassAction MassAction Built-in
i\ Kinetic Laws 3 Henri-Michaelis-Menten VS/(Km + 5) Built-in
i\, Units 4 Henri-Michaelis-Menten-Reve... (Vmf*S/Ks - Vmr"P/Kp)/(1 + S/Ks + P/Kp) Built-in
iy, Unit Prefixes 5 Hill-Kinetics VmS#n/(Kp + 5*n) Built-in
iy Brocks 6 Iso-Uni-Uni Vmf*(S - P/Keq)/(Kms*(1 + P/Kmp) + S*(1 + P/Kiip)) Built-in
7 Ordered-Bi-Bi Vm/((Ksa"Kmb/(A"B)) + (Kma/A) + (Kmb/B) + 1) Built-in
3 Ping-Pong-Bi-Bi Ven/((Kma/A) + (Kmb/B) + 1) Built-in
9 Competitive-Inhibition VS/KmA(1 + /KD) + 5) Built-in
10 NonCompetitive-Inhibition  Vm*S/((Ks + S)*(1 + I/Ki)) Built-in
11 UnCompetitive-Inhibition Vm?S/(Km + S°(1 + Vi) Built-in
Seftings Description
Name (Built-in:
Unknown
Clexpression:
Unknown Editor...
Expression Variables:
Para.. Speci.. Variable Name
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Kinetic Laws Library

As you configure model reactions, you can use predefined reaction rates that follow
particular kinetics such as mass action or Michaelis-Menten. SimBiology provides a list of
such predefined rates in the Kinetic Laws library.

The kinetic law for a newly added reaction is configured to MassAction by default, and
SimBiology automatically creates and maps the species and parameters needed by the
reaction rate. For other kinetic laws, only parameters are created and mapped. You need
to create and map the species manually. For details about configuring reaction rates in
the SimBiology desktop, see “View by Expressions” on page 1-16. Use the Unknown
kinetic law to define a custom reaction rate with its own parameters. You must define and
add the species and parameters needed by the custom rate.

Note The MassAction and Unknown kinetic laws can have different simulation results
even when the reaction rate is the same. This can happen when you have a reversible
reaction with species in different compartments. The difference in simulation results is
because of the volume-scaling performed by SimBiology during the dimensional analysis.
For details, see “Deriving ODEs from Reactions” on page 4-4. Specifically, for
MassAction, SimBiology uses corresponding compartment volumes to multiply the
forward and reverse rates. However, for Unknown and other built-in kinetic laws,
SimBiology multiplies the entire rate by only one compartment which contains the
reactants. To see exactly what compartment volumes are used for scaling, open the
“Equations View” on page 1-27 and check the ODEs section.

Units Library

It provides a collection of units that you can use. The library displays the unit composition
for each unit. The Menu Display column controls how each unit is displayed when
selecting quantity units in the Table on page 1-26 or Diagram on page 1-4 views. For
instance, suppose you have a custom unit with the unit composition mole/
(liter*second). Depending on what you select in the Menu Display, SimBiology
displays it differently in the Units column of Table Overview.



See Also

A custom unit in the Units library

MName

1 custom_unit

Unit Composition Menu Display Library Narme Unit Composition Menu Display Library

mole / (liter*second) unit name = | User-defined 1 custom_unit  mole/ (liter*second) unit composition ¥ | User-defined

Table Overview

® Add Quanti e + | Name: Add Delete D Add Quantity: | parameter * | Name: Add Delete

Type Scope Name Value Unit Constant - Type Scope Mame Value Unit Constant

1 compartment untitled unnamed 1.0 liter] - 1 compartment untitled unnamed 1.0 liter| -

2 species unnamed sl 0.0 molf/liter - = 2 species unnamed sl 0.0 molf/liter - =

3 species unnamed s2 00 molf/liter - = 3 species unnamed s2 00 molf/liter - [}

4 | parameter ] -» 52 Kf 10 - 4 parameter sl-> 52 kf 10 -
custom unit____JiY
1/second = 1/second 3
acre acre L
mole/(liter*second) mole/(liter*second)
liter/ (mole*second) liter/(mole*second)
liter/mole*second liter/mole*second
mole/liter role/liter ]

,_mI”IgI'EmF'htEI' - ’_milligrama’liter e

Unit Prefixes Library

It provides a list of all the available unit prefixes.

Blocks Library

It contains blocks that you can use to build models interactively. SimBiology provides a
default block library called ModelBuilding that contains built-in blocks representing all
modeling elements. In addition to built-in blocks, you can create custom blocks with
different appearances. For instance, you can customize a receptor protein to have a
different block shape or color than other species. You can use these blocks to build a
model graphically in the diagram view on page 1-4. For details about different built-in
block types, see Built-in Blocks on page 1-22.

See Also
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Find Important Parameters with Sensitivity Analysis
Using SimBiology Model Analyzer App

1-38

This example shows how to identify important model parameters for a tumor growth
model [1]. In this example, you compute local time-dependent sensitivities of tumor
growth with respect to model parameters for an anticancer drug.

Tumor Growth Model

The model used in this example is a SimBiology implementation of the pharmacokinetic/
pharmacodynamic (PK/PD) model by Simeoni et al. It quantifies the effect of anticancer
drugs on tumor growth kinetics from in vivo animal studies. The drug pharmacokinetics
are described by a two-compartment model with IV bolus dosing and linear elimination
(ke) from the Central compartment. Tumor growth is described as a biphasic process with
an initial exponential growth followed by linear growth. The growth rate of the
proliferating tumor cells is described by

Lo*xq

e fton)]”

Here, Ly, L;, and W are tumor growth parameters, x; is the weight of the proliferating
tumor cells, and w is the total tumor weight. In the absence of any drugs, tumor is
comprised only of proliferating cells, that is, w = x;. In the presence of an anticancer
agent, it is assumed that a fraction of the proliferating cells is transformed into non-
proliferating cells. The rate of this transformation is assumed to be a function of the drug
concentration in the plasma and an efficacy factor k,. The nonproliferating cells, x2, go
through a series of transit stages (x3 and x4) and are eventually cleared from the system.
The flow through of the transit compartments is modeled as a first-order process with the
rate constant k;.

Some adjustments were made to the pharmacodynamics of tumor growth.

* Instead of defining the tumor weight as the sum of x1, x2, x3, and x4, the tumor
weight is determined by the reaction named Increase, null - tumor weight, with

the reaction rate (2 *L1*Lo *X12/L1 +2%Lo* Xl) *tumor weight.
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tumor weight is the total tumor weight, x; is the weight of the proliferating tumor
cells, and L, and L; are tumor growth parameters.

o Similarly, the decrease in tumor weight is defined by the reaction named Decay,
tumor weight - null, with the reaction rate k;*x,. k; is the forward rate
parameter and x, is the last species in the series of transit reductions in tumor weight.

* ke is defined as a function of the clearance and the volume of the central
compartment: ke = Cl Central/Central.

]
Central Peripheral
& . :
| Drug — K120k _,_,-| Drug |
% &
k12 k21
O
ke
= wo
Growth l_ JR— — —
O—{(a —0—(e }—0—(8 +—0O— )
. — k2*Central.Drug k1_1 ) k1_2 . k1.3

.

Increase 1umdr__weight Decay

Tumaor Growth Model
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Sensitivity Analysis

Sensitivity analysis on page 4-28 lets you determine which rate constants and
concentrations in a model have significant influence on the overall behavior of the model.
This example shows how to investigate which model parameters are sensitive to the
tumor growth using the built-in sensitivity analysis program. Specifically, this example
shows you how to calculate the sensitivity of tumor weight species with respect to the
model parameters as follows:

d(tumor weight) d(tumor weight) o(tumor weight)
d(Lo) ’ (L) ’ a(ky)

Calculate Sensitivities

Suppose that you have already calibrated tumor growth model parameters on page 1-79
to experimental PK/PD data and saved parameter estimates and initial conditions as a
variant called parameterEstimates in your model. As a follow-up analysis, you want to find
out which model parameters are sensitive to tumor growth. The following steps show how
to do so using the built-in sensitivity analysis program.

Load Tumor Growth Model

1 Open the SimBiology Model Analyzer app by typing simBiologyModelAnalyzer
at the MATLAB command line or by clicking SimBiology Model Analyzer on the
Apps tab.

2 On the Home tab, click Open. Navigate to the folder matlabroot\examples
\simbio, where matlabroot is the folder where MATLAB is installed. Open the
SimBiology project file named tumor _growth vpop sa.sbproj.

If you are using a Mac, press Command+Shift+G in the File Browser dialog box,
and enter the full path to the folder.

Configure Calculate Sensitivities Program

1 On the Home tab, select Program > Calculate Sensitivities. A new program
opens.

2 In the Variants section in the Model step of the program, click the option to view the
variants to be applied. Then select parameterEstimates. This variant contains
previously estimated parameter values and initial conditions for the drug.
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In the Doses section, select interval_dose. This repeat dose applies 30 mg of the
drug every 4 days starting at day 7 for a total of five times.

In the States To Log section, select [Tumor Growth Model].tumor_weight only.

Tip The context menu of the table contains options to add species, parameters, or
compartments, and lets you make selections. Access the context menu by right-
clicking the table.
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MODEL
MODEL

[S Tumor Growth Model

[ ] Prepare the model for accelerated simulation
VARIANTS

Use Name

2_[:.,5‘1 parameterEstimates]

DOSES
Use Name Description
single_dose Target Name: Central. Drug
3[,{ interval_dose Target Name: Central Drug

STATES TO LOG
[ 1Log all states

Use MName

Central.Drug

Peripheral Drug

4_[5{2 [Tumor Growth Model].tumor weig__h_t_]

5 In the Simulation step (an execution step), by default, the normalization method is
set to Full (full dedimensionalization), meaning that the app fully normalize the
sensitivities so that they can be compared to each other. For details, see
Normalization.
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Tip Every program execution step can be run separately. An execution step is
marked by the run icon at the top of the step. Running an individual step is helpful
especially if the program contains multiple steps and you want to see the
intermediate results from a particular step. By doing so, you can make adjustments
as needed before running the next program step or the whole program. To run the
whole program, click the Run button on the Home tab.

In the Sensitivities to Compute section, right-click anywhere in the table and select
Add All Constant Parameters. Clear ke because it is defined as a function of the
Central volume and CI Central, which is already an input. Click the last empty row
and type tumor. Then select [Tumor Growth Model].tumor weight from the
list. The tumor weight species is then added as the output.
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= 4 SIMULATION

DESCRIFTION
Click to edit the description

STOP TIME
40 day

ED SEMSITIVITIES
5. Full {full dedimensionalization)

SENSITIVITIES TO COMPUTE

Output  Input Name

/@’ k12 \
L] k21
L] LO
L] L1
L] wi

B. (] k2

L] k1
L] L] ke
L] Cl_Central

L] [Tumor Growth Mod el].tumnr_weiW

|3, Disable sensitivity calculation
7 On the Home tab, click Run.

Visualize Sensitivity Results

1  After the sensitivity analysis, the program automatically generates two plots. Click
the Plot1 tab to view a plot of the time course of the tumor weight and other
sensitivity values d[tumor weight]/d[parameter]. The time plots for

1-44



Find Important Parameters with Sensitivity Analysis Using SimBiology Model Analyzer App

d[tumor weight]/d[k21] and d[tumor weight]/d[k12] stay relatively flat
compared to other sensitivities, indicating that the tumor growth is not sensitive to
k21 and k12 parameters. The Property Editor lets you select which plots to display.

Program1 Plot Plot2

25

20

0 5 10 15 20

time (day)

25

PROPERTY EDITOR
Slice Data | Plot Settings

Slice Style

Responses Color

RESPOMSES - Color

Color Program1
tumor_weight (gram)
dltumor_weight]/d[k12] (dimensionless)
d[tumor_weight)/d[k21] (dimensionless)

d[tumor_weight)/d[L0] (dimensionless)

0] (dimensionless)

dftumor_weight]/d]
dltumor_w ] (dimensionless)

d[tumor_weight)/d[k1] (dimensionless)

LS A S S AN AN AN AN

I
C
N
B d[tumor_weight)/d[L1] (dimensionless)
[l
I
[

tl/d[Cl_Central]

Tip Plots are backed by data that are currently present in the app workspace. Plots
are not snapshots. When the data (either experimental data or simulation results) is
removed or changed, the plots are also updated according to the changes in the

underlying data.

2 You can also examine the same sensitivity data by checking the magnitude of the
computed sensitivities integrated over time. The second generated plot (Plot2) shows
a bar plot containing such information. The plot shows that the tumor weight is
sensitive to L0, L1, w0, k2, k1, and CI Central, but not to k12 and k21.
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Program1 Plot1 Flot2 = - o
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20
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k12 k21 LD L1 wi k2 k1 CI_Central

3  Save the sensitivity analysis results in a separate folder.

a  Right-click the LastRun folder of the program in the Browser pane.
b  Select Save Data.
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C

In the Save Data dialog, enter sa_data as the data name.

Investigate Variability of k12 and k21

The sensitivity analysis results indicate that tumor weight is not sensitive to the model
values of k12 and k21. Explore whether varying these parameter values results in
different sensitivity results.

Vary k12

First, vary values for the k12 parameter.

1 (Click the Program1 tab. Click the (+) plus at the top of the program and select
Generate Samples.

Program1 Plot1 Plot2
gA ~ Simulation
DOSES Generate Samples {}J
Use Steady State
«  Simulation
] Postprocessing

Calculate Statistics

2 The Generate Samples step appears. In the Parameter Set section of the step,
double-click the empty cell in the Component Name, and enter k12. Set the
following options:

Type — Range Of Values
Spacing — linear

Min — le-3

Max — 1

# Of Steps — 25
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PE| b GENERATE SAMPLES
DESCRIFTION

Click to edit the description
PARAMETER SET . Cluantity

MName = P31

Type = user defined values

Farameter Combination = elementwise (25)

Use Component Name

= ki2
Type Hange Of Values
Spacing 2. linear
Min 1.0000e-3
Max 1
# Of Steps 25

| Add parameter set to scan

Current Value
0.0108

3 Disable default plot generation by clicking the plot button at the top of the step.

={ (3 JSEENERATE SAMPLES

DESCRIPTION
Click to edit the description

4 In the Simulation step, under Sensitivities to Compute, clear all the inputs except
k12. Keep tumor weight as the output. Also, disable the default plot generation by

clicking the plot button at the top of the step.

1-48



Find Important Parameters with Sensitivity Analysis Using SimBiology Model Analyzer App

P= D@ SIMULATION
DESCRIPTION
Click to edit the description
STOP TIME
40 day
MORMALIZATION FOR COMPUTED SENSITIVITIES
Full (full dedimensionalization)
SENSITIVITIES TO COMPUTE
Output Input Name
v k12
k21
LD
L1
wi
k2
k1
ke
_ Cl_Central
v [Tumor Growth Model] tumor_weight

|= Disable sensitivity calculation

On the Home tab, click the Run button to run the whole program.

Once the simulation finishes, the sensitivity results are stored in the LastRun folder.
Expand the LastRun folder. Click results. Then select time from the Plot section on
the Home tab.

The Responses in the plot correspond to the tumor weight and the sensitivity of the
tumor weight with respect to k12. Each response is plotted using a different line
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style. The Scenarios correspond to each parameter scan (simulation scenario). Each
scenario is plotted using a different color.

ODH® B8 &8 = Ef'z"@\/\] @ () |Bner [$ @ & o
Open Save C(Close Model Data Program New New ot ~ | Run rgf Bonaad cmarce Simulation = SimBiclogy Preferences Community Help
x: e s ¥ > Datasheet Plot time |2 Advance Settings -
PROJECT PLOT RUN STEP TOOLS ENVIRONMENT RESOQURCES =
Program1 Plot1 Plot2 Plot3 + o PROPERTY EDITOR (]
Workspace | Documents | Model ® 3 . . i . . . . Slice Data | Plot Settings
= = ° Slice Style
Neme Stee e R Line Style
« [™] Models 1 251 - Cobor
|B] Tumor Growth Model 1x1 SimBioclogy.Model
- (5 Program1 scan 51 RESPONSES - Line Style
[ LastRun Style Marker Width Program1
g1 samples 1x1 SimBiology. Scenarios J,."‘ none 05 S
] results 25x1 SimData 15} .‘; none 05
+ [ sa_data .’;
Fi SCENARIOS - Color
4 _ Color
v EXPLORER Q 7 .
OVERLAY RESULTS " |
05| v
¥] Drop quantily, dose or vanant to explore v‘ .
71 R
7 .
7/ B
. 7
05F 7 m
4
= : - : - - - - 7
0 5 10 15 20 25 30 35 40 v -

time (day)

7 Customize the plot so that the plot uses a different color for each response instead. In
the Slice Data table, clear the Style of Scenarios by selecting empty. Set
Responses to Color.

8 In the Responses table, clear tumor weight and keep only the sensitivity results.
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Program1 Plot3 PROPERTY EDITOR
Slice Data | Plot Settings
08 T T T T T T T | g
Slice Style
Responses Calor
06 Scenarios 7.
RESPOMNSES - Color
Color Programi
04 8. 9
I ] tumor_weight (gram)
d[tumor_weight]/d[k12] (dimensionless)
02
0
02+
041
_06 1 1 1 1 1 1 1
0 5 10 15 20 25 30 35 40

time (day)

4l

The plot suggests that the tumor weight is sensitive to some k12 parameter values
when model variants different than the estimated parameter values are explored.

9 Plot the k12 sensitivities together with the previous sensitivity results to see how
sensitive the tumor growth is to k12 relative to other model parameters. In the
Browser pane, expand the folder sa_data that you saved previously. Then expand
results.

10 Multiselect (Ctrl + Click) the sensitivity data entries for L0, L1, w0, k2, k1, and
Cl Central. Then drag them on to the k12 sensitivity plot Plot3.
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BROWSER

Workspace | Documents | Model

“ @
Name Size Type
=1 Models 1x1
[ Program1 scan
[ LastRun
results 1x1 SimData
time 587x1 double
tumor_weight 587x1 double
d[tumor_weight)/d[k12] 587x1 double
d[tumor_weight}id[k21] 587x1 double
10, d[tumor_weight}/d[LO] 587x1 double
d[tumor_weight}/d[L1] 587x1 double
d[tumor_weight}/d[w0] 587x1 double
d[tumor_weight}/d[k2] 587x1 double
dftumor_weight}/d[k1] 587x1 double
d[tumer_weight)/d[CI_Central] 587x1 double
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EXPLORER

Program1

"Pio3

25

20 -

20}

25

15 20 25
time (day)

30

35

40

Slice Data | Plot Settings

Slice Style
S Calor

RESPONSES - Color

Color Name

M

The plot suggests that the tumor growth is still more sensitive to most of the other
parameters than k12.
11 Save the results in a separate folder. Right-click LastRun and select Save Data.
Enter k12 data as the data name.

Vary k21

You can perform a similar analysis by varying k21 and comparing its results with other
parameter sensitivities.

1 Return to Programl. At the bottom of the Generate Samples step, click Add
parameter set to scan. A new Parameter Set section appears.

2 Double-click the empty cell in the Component Name, and enter k21. Set the same
options as k12:

+ Type — Range of Values

* Spacing — linear
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* Min — le-3
e Max—1
* # Of Steps — 25

Disable the first parameter set (PS1). Point to the top corner of Parameter Set
section of PS1 and click the action button. Then select Disable Parameter Set.

PARAMETER SET . Cluantity v
Add Parameter Set @

Mame = P31

Type - user defined values Dizable Parameter Set
Parameter Combination = elementwise (25) Delete Parameter Set

Use Component Name Current Value
= k12 0.0115
Type = Range Of Values

The Parameter Set is then grayed out to indicate you have successfully disabled it.

[ Quantity
Name = P51
Type = user defined values
Parameter Combination = elementwise (2%)
Use Component Name Current Value
V] B k12 0.0108
Type = Range Of Values
Spacing = linear
Min = 1.0000e-3
Max =1
# Of Steps =25
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4 In the Simulation step, select k21 as the only input and tumor weight as the output.
Hit Run from the Home tab to run the program again.

6 Once the simulation finishes, the sensitivity results are stored in the LastRun folder.
Expand the LastRun folder. Click results. Then select time from the Plot section on
the Home tab.

HOME

ODOHEHK @B &

W @ @|Fnnew 09 @ & @

- Ea Run and Advance

Open Save Close Model Data Program New New Run zi Simulation = SimBiclogy Preferences Community Help
x ¥ A = ¥ Datasheet Plot time |2 Advance Settings v
PROJECT PLOT RUN STEP T ENVIRONMENT RESOURCES =
Plot1 Plot2 Plot3 Plot4 v PROPERTY EDITOR (v
Workspace | Documents | Model ® 3 Slice Data | Plot Settings
T T T T T T T
“ 8|7 5
Slice Style
Name Size Type
yp / R ses Line Style
[ Models 1x1 ~| a5t / i S e
{Zf Tumor Growth Model 1x1  SimBiology.Model
(5 Program1 scan RESPONSES - Line Style
™ LastRun 2 i Style Marker Width Program1
i T
& samples 1x1  SimBiology.Scenarios f v - none 05 tu
¢ results 25x1 SimData / V| - none 05
+ [C]sa_data 150 .': |
- / SCEMNARIOS - Color
v [ k12_data )i
/ Color k21
/ N | 1.0000e
1F s 7 B
.'I. L4
Nl =2m
05 4 mZl B 5
/ 7
/
7 |
7 W
Y H
L4
o I I B N B S 7 |
0 5 10 15 20 25 30 35 40 v -
» EXPLORER o time (day)
4 ki

7 In the Slice Data table, clear the Style of Scenarios by selecting empty. Set
Responses to Color.

8 In the Responses table, clear tumor weight and keep only the sensitivity results.
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10

Program1 Plot4 PROPERTY EDITOR
0.1 Slice Data | Plot Settings
Slice Style
//\\ Responses Color
0.05 / \' Scenarios 7.
/
RESPONSES - Color
0 Color Program1
B tumor_weight (gram)
Fill | d[tumor_weight]/d[k21] (dimensionless)
-0.05 1
/
| /
\ /
\ /
01 | —
| I|l|l
|I /
|I I.l
| /
/
015 - L J
-.._rf"
02 . . . .
0 5 10 15 20 25 30 35 40
time (day) ,
bl
The plot suggests that the tumor weight is sensitive to some k21 parameter values
when model variants different than the estimated parameter values are explored.

Plot k21 sensitivities together with the previous sensitivity results to compare. Click
Plot3. In the Browser pane, expand the LastRun folder. Then expand results.

Drag the k21 sensitivity data d[tumor_weight]/d[k21] on to Plot3.
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o2 | = o I~ A n B RunStep X o
ER B R 2 =2 =2 nhn) (SROR: -
< - Y3 Run and Advance | _
Open | Save Close Model Data Progam  New  New Run Sim
- - - - - Datsshest Plot e [ Advance i
FILE PROJECT mor R STER TOOLS ENVIRONMENT =
Workspace | Documents | Mods @ 25 Slice Data | Plot Settings
Q @7
Slice Style
Name Size Type » e
0 Response Color
[ Models 1t 208 1
[ Program1 scan =
(< i ] LastRun sk | K21
samples =1 SimBiology. Scenarios
= W Match groups between data sources il applicable
] results 25x1 SimData | \
time nxd double 10}k | RESPONSES- Color
tumor_weight nx1 double f Y Color Name
ditumor_weightjd[k21) | nx1 double | \ 71
[~ N
1sa_data X 2 7T B &
e ) 2 17| ™
[ k12_data L/[ . —\— I/ =4 "
& A
I —— — I . - —
0 —_— e — ol |
] i ~ 7 W o
st - 7
7 |
10 4 Zl |
71
151 o
EXPLORER
OVERLAY RESULTS
20 |- 4
© Drop quantity, dose or variant to explare
.25 L I I L 1 L L
0 5 10 15 20 25 30 35 40
time (day)
4 bl

The plot suggests that the tumor growth is relatively more sensitive to most other
parameters than k21 and k12.

This example shows how to perform sensitivity analysis to find important model
parameters to which tumor growth is sensitive. The initial analysis concludes that the
tumor weight is not sensitive to some of the parameters. The example then explores the
parameter space of these less sensitive parameters and compares the sensitivity results
with those of other model parameters. You can use such sensitivity information for other
analyses, such as to perform Monte Carlo simulations on page 1-58 by varying sensitive
parameters to explore the model dynamics and biological variability.

References
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Model Biological Variability with Virtual Patients Using
SimBiology Model Analyzer App

1-58

This example shows how to generate and simulate virtual patients using the SimBiology
Model Analyzer app. In this example, a virtual patient is represented as a single
realization of model parameters. The example uses a tumor growth model [1] to explore
the variability of some model parameters that influence the tumor growth and investigate
various dosing regimens to control it.

This example requires Statistics and Machine Learning Toolbox™.

Tumor Growth Model

The model used in this example is a SimBiology implementation of the pharmacokinetic/
pharmacodynamic (PK/PD) model by Simeoni et al. It quantifies the effect of anticancer
drugs on tumor growth kinetics from in vivo animal studies. The drug pharmacokinetics
are described by a two-compartment model with IV bolus dosing and linear elimination
(ke) from the Central compartment. Tumor growth is described as a biphasic process with
an initial exponential growth followed by linear growth. The growth rate of the
proliferating tumor cells is described by

Lo*X1

1y, w17
T

Here, Ly, L;, and W are tumor growth parameters, x; is the weight of the proliferating
tumor cells, and w is the total tumor weight. In the absence of any drugs, tumor is
comprised only of proliferating cells, that is, w = x;. In the presence of an anticancer
agent, it is assumed that a fraction of the proliferating cells is transformed into non-
proliferating cells. The rate of this transformation is assumed to be a function of the drug
concentration in the plasma and an efficacy factor k,. The nonproliferating cells, x2, go
through a series of transit stages (x3 and x4) and are eventually cleared from the system.
The flow through of the transit compartments is modeled as a first-order process with the
rate constant k;.

Some adjustments were made to the pharmacodynamics of tumor growth.
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* Instead of defining the tumor weight as the sum of x1, x2, x3, and x4, the tumor
weight is determined by the reaction named Increase, null - tumor weight, with

the reaction rate (2 *Li*Lo* X12/L1 +2%Lo* Xl) *tumor weight.

tumor weight is the total tumor weight, x; is the weight of the proliferating tumor
cells, and L,, and L; are tumor growth parameters.

* Similarly, the decrease in tumor weight is defined by the reaction named Decay,
tumor_weight - null, with the reaction rate k;*x,. k; is the forward rate
parameter and x, is the last species in the series of transit reductions in tumor weight.

¢ ke is defined as a function of the clearance and the volume of the central
compartment: ke = Cl_Central/Central.

]
Central Peripheral
£
| Drug — K122 _._~—| Drug |
o &
k12 k21
ke
& wo
Growth 1_ S N —
QO—x —O—2H——0—8—0—«;
h — kZ*Central.Drug k1_1 k1_2 _ k1_3

5 L

Increase tumor__weight Decay

Tumuor Growth Model
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Description of Virtual Population

The virtual population in this example is represented by virtual patients, specified as
distinct sets of patient-specific parameter values. Suppose that, based on prior knowledge
or sensitivity analysis on page 1-38 of the model, the tumor growth is sensitive to these
model parameters: L0, L1, w0, k1, k2, and CI Central. Assuming that these biological
parameters follow the lognormal distribution (and must always be positive), you can
generate virtual patients that represent different parameter values drawn from the joint

lognormal distribution.

The lognormal distribution uses these parameters:

* mu - Mean of logarithmic values
* sigma - Standard deviation of logarithmic values

For details, see “Lognormal Distribution” (Statistics and Machine Learning Toolbox).

In this example, mu for each parameter is the log of the model value, and sigma is
assumed to be 0.01 for all the parameters.

Dosing Strategies

In this example, an anticancer drug is used to control the tumor growth. Each virtual
patient receives the same amount of the drug on the same schedule. The tumor growth
response is simulated for each patient. Dose amounts are then varied to find the range of
dose amounts that can suppress the tumor growth of many virtual patients in the
population.

Generate Samples to Represent Virtual Patients

The following steps show how to draw sample values from the joint probability
distribution for model parameters that are sensitive to tumor growth, to represent a
group of virtual patients.

Load Tumor Growth Model

1 Open the SimBiology Model Analyzer app by typing simBiologyModelAnalyzer
in the command line or clicking the app icon on the Apps tab.

2 On the Home tab of the app, select Open.
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Navigate to the folder matlabroot\examples\simbio\. matlabroot is the folder
where you have installed MATLAB. Select the project file named
tumor growth vpop sa.sbproj.

Define Joint Probability Distribution

Create a program to draw sample values from the joint lognormal distribution for tumor
growth sensitive parameters: L0, L1, w0, k1, k2, and CI Central.

1
2

N o »u b~

On the Home tab, select Program > Generate Samples. A new program opens.

In the Variants section in the Model step of the program, click the option to view the
variants to be applied. Then select parameterEstimates, which contains the
estimated parameter values.

In the Generate Samples step, click the plot button to disable default plot
generation. You will plot the samples later on.

¢=([@JSENERATE SAVPLES

DESCRIPTION
Click to edit the description

In the Parameter Set section, set Type to values from a distribution.
Set Number Of Samples to 25.
Double-click the empty cell in the Component Name column, and enter LO.

Change Distribution for L0 to Lognormal. By definition, mu is the mean of
logarithmic values. So, change mu to -0.5644, which is Log(Current Value) or
1og(0.5687). Change sigma to 0.01.

Double-click the empty cell in the Component Name column, and add L1. Repeat
the same process to change the distribution to lognormal and set the mu and sigma
values. Similarly, add w0, k1, k2, and ke. This table lists the corresponding mu values
of these parameters that you can copy and paste in the software. Change sigma to
0.01 for each parameter.

Parameter Current Value mu or Log(Current
Value)

LO 0.5687 -0.5644

L1 0.2690 -1.3130
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Parameter Current Value mu or Log(Current
Value)

w0 1 0

kil 0.4643 -0.7672

k2 8.4200e-4 -7.0797

Cl Central 0.6672 -0.4047

9 For Sampling, use the default option: random sampling with rank
correlation matrix, where the matrix is an identity matrix.

The following figure shows the Parameter Set section with all parameters
configured. The red numbers correspond to the preceding steps.
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PARAMETER SET . Cuantity
Mame = P31

Type 4. =[ values from a distribution

MNumber Of Samples > :[ 25

Parameter Combination =

Use Component Name

veELl )
Distribution
mu
sigma

= L1
Distribution
mu
sigma

2 wi
Distribution
mu

sigma

— — 1

-~
i

Lognormal
-0.5644
0.0100
Lognormal
-1.3130

0.0100

Lognormal
0

0.0100

B{Sampling = random sampling with rank correlation matri>;]

LO L1
LO 1 0
L1 0 1
wi 0 0
k1 0 0
k2 0 0
Cl_Central 0 0

wi
0

== R == TR = ]

Current Value

0.5687

0.2690

Cl_Central

[ ac R - N - B = )

10 (Optional) Save the project under a new name by selecting Save > Save Project As

on the Home tab.
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Define Dosing Strategies

Add the dosing information as another parameter set by specifying different dose amount
—specifically, six dose amounts that are equally spaced from 5 to 35 mg. Then combine
the doses with the first parameter set (virtual patients) using the Cartesian combination
method. This method combines every virtual patient with every dose amount to generate
a total of 150 iterations (or simulation scenarios). For details, see “Combine Simulation
Scenarios in SimBiology” on page 3-29.

1 At the bottom of the Generate Samples step, click Add parameter set to scan.
Another parameter set (PS2) appears.

2 Double-click the empty cell in the Component Name column, and type interval. A
list of choices appears. Select interval dose.Amount.

3 Set Type to Individual Values and set Values to [5:6:35].

PARAMETER SET: CQuantity
MName = PS52

Type user defined values

Parameter Combination = elementwise (6)

Use Component Name Current Value

+| Bl interval_dose Amount 30

=]
3¢}
I

Individual Valuas

Values [5:6:35]

4 Near the top of the Generate Samples step, under Parameter Set Combinations,
ensure that the Combination type is set to cartesian to combine PS1 and PS2.
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FPARAMETER SET COMBINATIONS
Mumber of lterations: 150

Sampling Data Combination
SD1 (150) = P51 (25) (E52) P52 (6)

[ ca rtesian
PARAMETER SET : Cuantity

P51
values from a distribution

228 elementwise
Mame LEEd

Type

Generate and Visualize Parameter and Dose Combinations

Once you have defined the joint lognormal distribution for model parameters, range of
dose amounts, and the combination method, you can run the step to generate the
different parameters and dose combinations.

1

Click the Run this program step button to generate samples.

= E GENERATE SAMPLES

CESCRIPTICN
Click to edit the description

Tip Every program execution step can be run separately. An execution step is
marked by the run icon at the top of the step. Running an individual step is helpful
especially if the program contains multiple steps and you want to see the
intermediate results from a particular step. By doing so, you can make adjustments
as needed before running the next program step or the whole program. To run the
whole program, click the Run button on the Home tab.

By default, the app stores the generated samples in the LastRun folder of the
program.

Visualize the generated samples. In the Browser pane on the left, expand the
Program1 folder. Expand the LastRun folder, and then click samples. In the Plot
section on the Home tab, click Plot Matrix. The plot shows the distribution of each
parameter varied around its model value, except the dose amounts, which appear in a
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uniform range. Note that your plot might vary from the plot shown here due to

randomness.
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OE 8 2 B =

- ocovsen o IR

Note You can enable default plot generation to display the plot automatically every
time you run the step. To do so, click the plot button at the top of the Generate
Samples step. Keep in mind that when the program step has a lot of samples,
plotting all the samples can be time consuming.

3 Display the generated virtual patients and dose combinations numerically in a tabular
format. On the Home tab, click New Datasheet. From the LastRun folder of the
program, drag samples into the new datasheet. Each row of the table represents a
simulation scenario with different model parameter values and dose amounts.

B

-~
pen | Save Close Model Data Program Run

Workspace | Documents | Modal @
«@ BII7]  programt: LastRun: samples
Name Six Ty [?
; = L Lo L1 wd K K2 Ci_Central Intpeval tioss
[ Models x1 L
= 1 0.5591 0.2666 10043 83 0673 5
3.2 [~ [ Program scan
2 05709 02663 10018 8442604 06725 5
[ LastRun
714 02680 1006 462004 06636
P51 1x1 SimBiology. Scanarios & L) o) Lt £8000 L =
3 026! 1.0059 28e-4 [
pos - T 4 0.5691 02683 10059 832288 06710 5
0.5695 0.2691 0.9840 8419164 067 5
o e o 5 0.5695 02691 09840 84191 6721 5
6 05656 0.2664 10002 8464764 06675 5
S 7 05727 0.2690 0,987 8387204 06792 5
05638 02672 0.9759 06543 5
9 0.5641 02678 0.9868 06641 5
10 05727 02671 0.9%8 06677 5
n 05783 02680 8455064 06588 5
S— 12 0.5664 02786 84511e4 06680 5
v EXPLORER
0.5657 781 8421504 0666 5
T 1 5657 02 84215 6669 5
T 05709 02719 8416504 06655 5
N 15 05747 02709 8341704 06695 5
O Drop quantity, dose or vanant fo expiore
16 05741 0.2654 851294 06799 5
7 0.5701 02672 8.3202e-4 06726 5
18 0.5650 02671 8.625%-4 06647 5
19 05722 02702 10175 8447304 06677 5
b3 05681 02701 0.993 06692 5
2 05765 02692 10120 06591 5
2 05606 02679 1.0096 0.6603 5
3 0.5694 02663 0.9859 06643 5
2 05760 02688 09897 06677 5
% 0.5658 02719 1.0026 06742 5
% 0.5591 02666 1.0043 0673 1
ri 0.5709 02663 1.0018 06725 1
. Aeraa naeen Thaas AaeTs neeae

Perform Monte Carlo Simulations

Once you have the samples ready, you can simulate the model to explore the tumor
growth of virtual patients receiving different dose amounts.
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1  Go back to the program by clicking the Program1 tab.
2 Click the (+) icon at the upper left and click Simulation.

FProgram1 Plat1 Datasheet

gA * Generate Samples
¥ (Generate Samples
PROGR/ Steady State

DESCRIF
Click to

Simulation h

MODEL

KA

3 Inthe Model setup step, in the States To Log section, click the option for viewing
the states, and then clear all check boxes except [Tumor Growth
Model].tumor_weight.
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MODEL
MODEL
@ Tumor Growth Model
Prepare the mode! for accelerated simulation
VARIANTS

Use Mame

[ v parameterEslimatEﬁ]

DOSES
Click to view doses that will be applied

STATES TO LOG
Log all states
Use Name
Central Drug
Peripheral Drug

[ «|  [Tumor Growth Model] tumor_weight

At the top of the Simulation step (scroll down to see this step), click the plot button
to disable default plot generation.

Click the Run this program step button to simulate the model.

The app simulates the generated scenarios from the Generate Samples step that
you ran previously. You do not need to rerun the step.

Once the simulation finishes, the app saves the simulation results in the LastRun
folder.

In the LastRun folder in the Browser pane, click results. In the Plot section on the
Home tab, click time. Each line in the plot represents the tumor weight profile of
each simulation scenario.
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Program1 ><|| Plot1 ><| Flot2 x | Datasheet1 x| +
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7

The plot shows that the tumor weight profiles appear in groups, corresponding to
different dose amounts. To better visualize this observation, you can slice the data by
dose amounts. To do so, you can use the Slice Data table, which contains a summary
of slicing variables that are currently being used in the plot and their corresponding
plot styles.

Tip Plots are backed by data that are currently present in the app workspace. Plots
are not snapshots. When the data (either experimental data or simulation results) is
removed or changed, the plots are also updated according to the changes in the
underlying data.

In the Slice Data table, double-click L0 and select interval dose Amount.

PROPERTY EDITOR

Slice Data | Plot Settings

Slice Style
Responses Line Style
Scenarios Colar
J o

L0

L1

wil

k1

k2

RE Cl_Central

interval_dose Amount idth Program1

S - none @ tumor_weight

Tip You can slice your data by using different slicing variables. Each slicing variable
is shown in the plot using a different visual style (or channel) such as color, line style,
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and axes position. Slicing variables can represent attributes of data, such as
responses or scenarios (that is, groups or simulation runs). Slicing variables can also
be covariates or parameter values associated with a scenario or group. By default,
the slicing variables are provided for different response variables and different
scenarios in the plotted data. Additional visual styles (or channels) can be added for
sets of responses and associated parameter or covariate variables.

8 Double-click the empty cell in the Style column and select Grid.

PROPERTY EDITOR

Slice Data | Plot Settings

Slice Style
lesponses Line Style
Scenarios Color
I interval_dose Amount
L1 Grid @
wi Horizontal
k1 Vertical
k2 Color
Line Style

RESPONSES - Line Style
Style Marker Wi

n ol

Transparency

The app updates Plot2 to show each dose amount on its own axes.
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The plot shows that different dose amounts play critical roles in the tumor growth of
virtual patients. From this plot, you can obtain some initial insights into the optimal
dose amounts and dose scheduling. For instance, suppose that the target tumor
weight to reach is 0.5 grams. The simulation results indicates that a dose amount of
23 milligrams or larger can achieve that goal (you can fine-tune the range of dose
amounts further by tweaking it in the Generate Samples step of the program). You
can use this information in combination with existing drug toxicity information (not
discussed in this example) to get a dosing regimen that satisfies both efficacy and
safety requirements, for instance.

Postprocess Simulation Data

You can also postprocess the simulation results to look at the correlation between dose
amounts and the tumor weight in another way.

1

Go back to the program by clicking the Program1 tab. Click the (+) icon near the top
of the program and select Calculate Statistics under Postprocessing.

Program1 Plot1 Plot2 Datasheet

Parallel | g0 v Generate Samples — Simulation
+  (Generate Samples
PROGRA  steagy State

DESCRIF Simulation
Click to

Fostprocessing
MODEL Calculate SiafiEfiCEi
MODEL

A Postprocessing: Calculate Statistics step appears below the Simulation step.

Double-click the first cell in the Expression column next to statl and enter the
following expression: min(tumor weight(time>=7)). The expression returns the
minimum tumor weight after the first dose applied at day 7 from each simulation.

Click the run button at the top of the step. The app runs the postprocessing step for
each simulation scenario or iteration, and generates the following plot. The x-axis
represents the parameters and the y-axis represents the minimum tumor weight.
Each dot represents a simulation scenario. The plot also shows that there is no
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correlation between the tumor size and the values of various model parameters,
except for the dose amounts (the rightmost subplot).
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Show only the dose amount subplot. In the Plot Settings, clear all check boxes in the

Plot Settings

SOURCE: Program1:LastRun:samples stats

4
Parameters table, except interval dose Amount.
In the Grid section, select both to show the grids for both the x- and y-axis.
Frogram1 Flot1 Plot2 Plot3 = || Dalasheell
3k
|

251

stat1

05

5 10 15 20 25
interval_dose Amount

30

35

PARAMETERS
Use Sampled Parameter
wl
ki
k2
Cl_Central

[ interval_dose Am oum]

Use Statistic
stat1

LABELS
Piot Titte =
Flot XLabel =
Plot YLabel =

MARGIN
Top:10 Left:10 Bottom:10 Right: 10

CONFIGURE AXES

LABELS
Title =
XLabel = interval_dose Amount
YLabel = stat1
GRID i :
==
none xgrid ygrid both ‘
Style = solid
.v Color

The plot confirms that higher dose amounts control the tumor growth better. These
initial simulation results indicate that the dose amounts of 23 mg or larger could
reach the hypothetical tumor weight threshold of 0.5 grams or lower. You can further
adjust the range of dose amounts in the Generate Samples step.
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Tip To interactively explore the plotted data, export the plot to a separate figure
window by selecting Export Plot from the context (right-click) menu of the plot.

This example shows you how to generate samples to represent virtual patients and
perform Monte Carlo simulations to explore the model response on tumor growth under
different dose amounts. The simulation results indicate a range for dose amounts and
dose schedules that controls the tumor growth for various virtual patients. You could
further adjust the dosing regimens so that the doses stay within some known efficacy and
toxicity thresholds. For a similar analysis, see the example “Scan Dosing Regimens Using
SimBiology Model Analyzer App” on page 1-117.
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See Also
SimBiology Model Analyzer

More About

. “Calculate NCA Parameters and Fit Model to PK/PD Data Using SimBiology Model
Analyzer App” on page 1-79

. “Find Important Parameters with Sensitivity Analysis Using SimBiology Model
Analyzer App” on page 1-38

. “Scan Dosing Regimens Using SimBiology Model Analyzer App” on page 1-117
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Calculate NCA Parameters and Fit Model to PK/PD Data
Using SimBiology Model Analyzer App

This example shows how to perform noncompartmental analysis to calculate NCA
parameters and estimate the tumor growth model [1] parameters from experimental data
using nonlinear regression in the SimBiology Model Analyzer app.

Tumor Growth Model

The model used in this example is a SimBiology implementation of the pharmacokinetic/
pharmacodynamic (PK/PD) model by Simeoni et al. It quantifies the effect of anticancer
drugs on tumor growth kinetics from in vivo animal studies. The drug pharmacokinetics
are described by a two-compartment model with IV bolus dosing and linear elimination
(ke) from the Central compartment. Tumor growth is described as a biphasic process with
an initial exponential growth followed by linear growth. The growth rate of the
proliferating tumor cells is described by

Lo*xq

e fton)]”

Here, Ly, L;, and W are tumor growth parameters, x; is the weight of the proliferating
tumor cells, and w is the total tumor weight. In the absence of any drugs, tumor is
comprised only of proliferating cells, that is, w = x;. In the presence of an anticancer
agent, it is assumed that a fraction of the proliferating cells is transformed into non-
proliferating cells. The rate of this transformation is assumed to be a function of the drug
concentration in the plasma and an efficacy factor k,. The nonproliferating cells, x2, go
through a series of transit stages (x3 and x4) and are eventually cleared from the system.
The flow through of the transit compartments is modeled as a first-order process with the
rate constant k;.

Some adjustments were made to the pharmacodynamics of tumor growth.

* Instead of defining the tumor weight as the sum of x1, x2, x3, and x4, the tumor
weight is determined by the reaction named Increase, null - tumor weight, with

the reaction rate (2 *L1*Lo *X12/L1 +2%Lo* Xl) *tumor weight.
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tumor weight is the total tumor weight, x; is the weight of the proliferating tumor
cells, and L, and L; are tumor growth parameters.

o Similarly, the decrease in tumor weight is defined by the reaction named Decay,
tumor weight - null, with the reaction rate k;*x,. k; is the forward rate
parameter and x, is the last species in the series of transit reductions in tumor weight.

* ke is defined as a function of the clearance and the volume of the central
compartment: ke = Cl Central/Central.

o= =
Central Peripheral
# ) :
|. T I“—'— k12121 _'_.___l Drug |
% &
kK12 k21
O
ke
i)
= wo
Growth l_ JR— — —
O—{(x—O0—(e —0—(no}—0—m]
. — k2*Central.Drug ' k1_1 ) ) k1_2 I k1_3

.

Increase 1umdr__w-eight Decay

Tumaor Growth Model
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PK/PD Data Description

The experimental (synthetic) data contains measurements from eight patients for three
responses: measured drug concentrations in the central compartment, in the peripheral
compartment, and measured tumor weight. The data also contains the dosing
information, and each patient receives an IV dose at day 7.

The data set contains the following columns.

ID — Patient IDs

Time — Times when measurements are taken

CentralConc — Drug concentration in the central compartment
PeripheralConc — Drug concentration in the peripheral compartment
Dose — Dosing information for each patient

NaN values are used whenever there is no measurement or no dose is given.

Load Tumor Growth Model and Data

1

Open the SimBiology Model Analyzer app by typing simBiologyModelAnalyzer
at the command line or by clicking the app icon on the Apps tab.

On the Home tab of the app, select Open.

Navigate to the folder matlabroot\examples\simbio\. matlabroot is the folder
where you have installed MATLAB. Select the project file named

tumor _growth fitPKPD.sbproj. In the Browser pane, the Models folder
contains the Tumor Growth Model and the Datal folder contains the experimental
data.

Classify the measured responses of the data as the dependent variables. In the
Browser pane, click Documents and double-click Datasheet].

In the Datal table, double-click Classification under CentralConc. Select
dependent. Repeat the same process for PeripheralConc and TumorWeight. Now all
the data columns have proper classifications and the data is ready for use.
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SH® R B B & N[O @8, N @ & ©
Open Save Close Model Data Program  New  New t X VS 7 Run Ef'?s"""m’:m"“ Simulation ~ SimBiology Preferences  Community Help
s - = 5 - Datasheet Plot time Sens |33 Advance Settings =
PROJECT PLOT RUN STEP TOOLS ENVIRONMENT RESOURCES =
" BROWSE © |3 Datashestl x|
Workspace \'\ Model ®
“ 9 v Data1
Name Type D Time CentralConc PeripheralConc TumorWeight Dose
(3 Project project group independent ) [ L ] dosel
4.2 | Datasheet1 datasheet day milligram/liter milligram/liter gram milligram
48 8 1 0 NaN NaN 0.9810 NaN
2 1 1 NaN NaN 1.0120 NaN
3 1 3 NaN NaN 1.5840 NaN
4 1 & NaN NaN 1.7820 NaN
5 1 6 NaN NaN 3.2260 NaN
EXPLORER 6 1 T 135510 NaN 3.1500 30
7 1 7.2500 1.9650 06970 3.0860 NaN
8 1 7.5000 0.2840 0.7680 2.8690 NaN
8 1

77500 0.0680 0.4010 29910 NaN

)
)

Visualize Experimental Data

After you load the data, you can visualize the measured responses.

In the Browser pane, click Workspace.
Click Datal.

On the Home tab, in the Plot section, click the time plot. The app generates a time
plot of all three responses, namely: CentralConc, PeripheralConc, and TumorWeight.
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HOME

o]E %
Open | Save Close Model Data Program

BROWSER

1. [Workspace || Documents | Model ®
S} @Y
Name Size Type
v [ Models 1x1
2. 152x6 table
v EXPLORER

I4

gl ] ( _ P Runstep | \
&3 N\ N\ @ B @@ ©® & @
VoA - PZ Run and Advance
New New Run = Simulation = SimBiology Preferences Community Help
Datasheet Plot time |38 Advance Settings -
PLOT STEP TOOLS ENVIRONMENT RE! CES a
Datasheeti Piot1
a0 i Slice Data | Plot Setlings
Slice Style
[e]
80 | : Line Style
O Color
1 Dose
70 F 4
RESPONSES - Line Style
60l . Style Marker Width Datat
1 7 0 05 ent
50 v + 05
v ' 05
40 SCENARIOS - Color
p Color ID
30t v
7 1l
20 =
v B
¥ B
10 5 v
] . 4 v 1l
¥ -
0 5 10 15 20 25 30 35
Time (day)

In the default time plot, Responses correspond to the measured responses and are
plotted using different line styles. Scenarios refers to different groups (eight
patients) in the data and are plotted using different colors.

Tip Plots are backed by data that are currently present in the app workspace. Plots
are not snapshots. When the data (either experimental data or simulation results) is
removed or changed, the plots are also updated according to the changes in the

underlying data.

Customize Data Visualization

You can customize the plot to make it clearer. For example, you can plot the PD data
(TumorWeight) on a different axis than the PK data (CentralConc and PeripheralConc). To
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do so, create two diffferent groups (sets) of responses, where the first set contains only
TumorWeight and the second set contains CentralConc and PeripheralConc.

Right-click TumorWeight (gram) in the Responses table (the middle table in the
Property Editor) and select Create New Set. The app creates Set 1 and Set 2. Set
1 contains only TumorWeight, which is now plotted on a different axis than Set 2,
which contains CentralConc and PeripheralConc.

Note You can create a set only if there are two or more responses.
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Set 2 (milligram/liter)

Datasheet1 Plot1 FROFERTY EDITOR
6 Slice Data | Plot Settings
F
i Slice Style
57 ] Sets Vertical
N " Responses Line Style
= . Scenarios Color
g * g Dose
g . SETS - Vertical RESFOMSE- Line 5... Create Set
S | Style Marker Width Datal
’ i Set1
N : * 05 TumoriWeight
T = Set 2
100 - ’ 0 05 CentralConc
+ 05 PeripheralConc
a0 | @ SCENARIOS - Caolor
@r Color ID
60 | i 1
| m
| ;
“f ' m
i .
20t | 6
m
. | I m ¢
0 5 10 15 20 25 30 35

Time (day)

The Slice table (the top table in the Property Editor) now contains Sets. This table is
a summary table of all slicing variables that are currently present in the plot and their
corresponding plot styles. In this current plot, the slicing variables are Sets,
Responses, Scenarios, and Dose.

Tip You can slice your data by using different slicing variables. Each slicing variable is
shown in the plot using a different visual style (or channel) such as color, line style,
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and axes position. Slicing variables can represent attributes of data, such as responses
or scenarios (that is, groups or simulation runs). Slicing variables can also be
covariates or parameter values associated with a scenario or group. By default, the
slicing variables are provided for different response variables and different scenarios
in the plotted data. Additional visual styles (or channels) can be added for sets of
responses and associated parameter or covariate variables.

You can also group the responses based on different dose amounts that the patients
receive. There are three different dose groups: 30, 75, and 150 mg.

1

In the Slice table, at the Dose row, double-click the empty cell and select Color. A
red indicator appears because another slicing variable (Scenarios) has the same plot
style. Clear the style (visual channel) for Scenarios by selecting empty.

In the Dose table (the bottom table), the app has automatically binned the dose
amounts. Set Number of Bins to 3. You can now see that the dose amount has an
impact on the tumor size. The higher the dose is, the smaller the tumor becomes.

You can also query the corresponding dose group from each line by showing its data
tip. Press Ctrl and click a blue line to display its data tip. To remove it, Ctrl + Click
again anywhere on the same line.
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Perform Noncompartmental Analysis (NCA)

. Dose < 6

Datal

TumorWeight

CentralConc

haralCane
enpneran.ond

»l

Using the drug pharmacokinetic data, you can estimate NCA parameters. NCA is model
agnostic and can give insights into the drug pharmacokinetics without any underlying

assumptions. You can use some of the NCA results as initial estimates when calibrating
the model to the data, as discussed later in this example. For details on the list of

available NCA parameters and their formulas, see “Noncompartmental Analysis” on page

4-116.
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NCA Program Setup

1

On the Home tab, select Program > Non-Compartmental Analysis. A new
program (Programl) appears.

The Data setup step of the program defines the data set to use for the NCA analysis.
In this example, the program automatically selects Datal.

The NCA execution step defines the data column associations and algorithm details.
In the Definition table, set Concentration to CentralConc. Leave the other
settings unchanged.

On the Home tab, click Run.
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%ﬂ. = @ s {\/\/ _ =] Run Step

E Run and Adwvance

Data |Program Mew Mew | Do Simulation
- - Datashest Plot time (3} Advance Settings
FROUECT PLOT RUN 5TEP TOOLS
(7] Datasheet1 Plot1 Program1 =
® ~ NCA

@/(7]| [PROGRAM DESCRIPTION

Siz DESCRIFTION
- Click to edit the description

1x1
DATA

152
7. [ DATA

5] NCA

DESCRIPTION
Click to edit the description

- DEFINITION

Classification Column
Group ID

ID

Time Time

3. [Con centration CentralConc ]

I IV Bolus Dose Dose

Extravascular Dose

Display NCA Results

Once the NCA analysis is complete, the app saves the results in the LastRun folder of the
program by default.
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1 On the Home tab, select New Datasheet. A new datasheet (Datasheet2) opens on a
new tab.

2 In the Browser pane, expand the Program1 folder. Then expand LastRun folder.
The NCA results are stored in the table named results.

3 Drag results onto Datasheet2. The calculated NCA parameter values are now
shown in the datasheet. Use the scroll bar at the bottom of the table to scroll and
view the NCA data columns. For details about calculated NCA parameters, see
“Noncompartmental Analysis” on page 4-116.

HOME 5w e

S H R & E‘bl & | ;Fqﬂ"\,-’/\'\xit/ ”1| ] ® = =) Run Step LB & b @

§ Run and Advanc
Open Save Close Model Data Program P28 Ruriand Advares
S = <

Run Simulation ~ SimBiol
Sens |23 Advance Settings

New
Datasheet| Plot time

y Preferences Community Help
-

RESOURCES Y

PROJECT PLOT RUN STEP

FILE ROJE PLO RUN STEP

BROWSER o Datasheet1 Datasheet2 Flot1 1 Program 1
Workspace | Documents | Model ®
b Q¥ Program1: LastRun: results
Name Size Type ini i
L D doseSchedule adm'“'*‘:“"“"““" Lambda_Z R2 adjusted_R2 Nu
[=] Models 1x1 2
1 1 Singl IVBol 1.4589 0.9934 0.9868
(1 Datat 1526 table e =
O T —— 2 2 Single IVBolus 1.5102 0.9978 0.9955
5[~ U Program1 nca
= : 3 b Single IVBolus 1.5937 0.9906 0.9859
[ LastRun
4 4 Single IVBolus 1.4979 0.9982 0.9963
3.( [ results ) 8x25 table
K‘J 5 Single IVBolus 14775 0.9997 0.9995
e 6 Single IVBolus 1.2423 0.9845 0.9767
EXPLORER T 7 Single IVBolus 1.2391 0.9962 0.9925
8 8 Single IVBolus 1.5340 0.9983 0.9967

Export Results to MATLAB Workspace

You can export the NCA results to the MATLAB workspace and perform further data
analyses at the command line.

1 Right-click results. Select Export Data to MATLAB Workspace.
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[ =
O H & E

Cpen Save Close B

- -

FILE

Export Data to MATLAE Workspace... g

EROWSER -

Workspace | Docume ¥
7

Name Expand Ctirl+Right

v [ Models Collapse Cirl+Left

» [3 Datat Expand All Ctrl+Shift+Right

) [E Program1 Collapse All Cirl+Shift+Left

- [ LastRun
+ B results Bx25 table

2 The SimBiology Data Export dialog box opens. Change the name of the variable to
ncatable. Click OK.

SimBiology Data Export b

Specify a variable name for the data:
| ncatable
Cwverwrite variable if it already exists

After you export the data to the MATLAB workspace, you can analyze the data at the
command-line. For instance, you can calculate the average drug clearance from the NCA
data and use it as the model parameter value.

1-91



1 SimBiology Apps

1-92

Estimate Model Parameters Using Nonlinear Regression

SimBiology provides different regression techniques to estimate model parameters based
on experimental data. This example details the steps for using the nonlinear regression
method Lsgnonlin (requires Optimization Toolbox™) to fit the model to the data. If you
do not have Optimization Toolbox, the app uses fminsearch instead. For the purposes of
the example, only some of the PK/PD model parameters are estimated, namely: k1, L0, L1,
Cl Central, k12, and k21.

Fit Program Setup

1

From the Home tab, select Program > Fit Data. A new program (Program?2)
appears on a new tab. The Data and Model steps have been prepopulated with
Datal and Tumor Growth Model, respectively.

By default, the Fit step autogenerates plots after the fitting is complete. Disable the
plot generation by clicking the plot icon at the top of the Fit program step for now.
The plots will be explored later in the example.

=™y

DESCRIPTION
Click to edit the description

STATISTICAL MODELING
non-linear regressions

Define the mapping between the model components and the data columns from the
experimental data. Specifically, map CentralConc to the model species Drug in the
central compartment (Central.Drug). Similarly, map PeripheralConc to
Peripheral.Drug.

Map TumorWeight to [Tumor Growth Model].tumor weight.

Map the Dose column to Central.Drug to indicate that the Drug species in the Central
compartment is being dosed.
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Ei E FIT
DESCRIPTION
Click to edit the description

STATISTICAL MODELING
non-linear regrassions

DEFINITION
Use Classification Value
group 1]
independent Time
[+/] B response 3. CentralConc -~ Central.Drug
[+] B response {F‘eripherai{:nnc - Peripheral Drug]
Column = PeripheralConc
Component = Peripheral Drug
[+] B response f-l.[ TumorWeight ~ [Tumor Growth Model] tumor_weight ]
Column = TumorWeight
Component = [Tumeor Growth Model].tumor_weight
] dose from data 5.[[}05& -> Central Drug ] Bolus Dose

Add to Definition Add Response A Dose «

6 Define the model parameters to estimate in the Estimated Parameters table.
Double-click the empty cell in the Estimated Parameters column and type k1. The
app shows model components with matching names. Select k1 from the list.

ESTIMATED PARAMETERS
Use Estimated Parameters

k| I

[ |Poal k1

ERRCR I ’
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By default, the parameter is log-transformed as indicated by the expression exp(k1).
You can change the expression to no transformation, probit, or logit
transformation. For this example, keep the default log transform because it often
improves the convergence. The Initial Untransformed Value is automatically set to
the model value which is 0.5.

7 Enforce the biological parameters to stay positive by specifying the Untransformed
Lower Bound and Untransformed Upper Bound as 1le-5 and 10, respectively.

8 Similarly, add the following parameters: Cl Central, L0, L1, k12, and k21.

ESTIMATED PARAMETERS

Use Estimated Parameters Category Variable
Y| B ki = expikl)

nitial Untransformed Value = 0.5000

Untransformed Lower Bound = 1.0000e-5

Untransformed Upper Bound 10

| & Cl_Central

exp(Cl_Central)

nitial Untransformed Value = 0.7000
Untransformed Lower Bound = 1.0000e-5
Untransformed Upper Bound = 10

s 2 L0 = exp(L0)
nitial Untransformed Value = 0.4000
Untransformed Lower Bound = 1.0000e-5
Untransformed Upper Bound = 10

— Pn_a

[ ]Pooled fit
9 Select Pooled fit to estimate one set of parameters for all patients (population fit). If

you do not select Pooled fit, the app estimates one set of parameters for each patient
(individual fit).

1-94



Calculate NCA Parameters and Fit Model to PK/PD Data Using SimBiology Model Analyzer App

Untransformed Lower Bound = 1.0000¢
Untransformed Upper Bound =10
Pooled fit
ERROR MODEL
Use the same error model for each response o constant

10 The default error model is the constant error model. SimBiology supports constant,
proportional, exponential, and combined error models. For details, see “Error
Models” on page 4-56. For now, use the constant error model.

11 Keep the rest of the fitting settings unchanged. These settings are

* Estimation Method — The default method is Lsqnonlin if you have Optimization
Toolbox. If you do not, the app uses fminsearch.

ESTIMATION METHCD
[ ] Use a global solver

() Isgnonlin () fminunc () Isgeurvefit
()yfminsearch () fmincon

For more information, see “Supported Methods for Parameter Estimation” on
page 4-53.

* Algorithm Settings — Most common options for the estimation method. Click to
expand the section and see the options. To see the description of each option, click
the info icon to the right of the header.

ALGORITHM SETTINGS[ @ |

ProgressPlot = true Show the Fit Data program progress

StepTolerance = 1.0000e-3 Termination tolerance on the estimated parameters
FunctionTolerance = 1.0000e-8 Termination tolerance on the objective function value
OptimalityTolerance = 1.0000e-6 Termination tolerance on the first-order optimality
Maxlterations = 400 Maximum number of iterations
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* Advanced Algorithm Settings — Advanced settings for the estimation method. The
table is empty by default.

Run Fit Program

After you set the fitting options, you can run the Fit step.

1

At the top of the Fit step, click the Run this program step button.

[Es Fir
DESCRIFTION
Click to edit the description

STATISTICAL MODELING
non-linear regressions

By default, the Fit step shows the progress of parameter estimation in a separate
figure. The progress plot shows the live status of parameter estimation and fitting
quality measures such as log likelihood. For details, see “Progress Plot” on page 4-
57.

The progress plot shows that the fit converged. You can close the progress plot.

If you are using fminsearch, the fit can fail to converge due to reaching the
maximum number of iterations. You can increase MaxIter in the Algorithm
Settings, but for the purposes of this example, you can continue completing the
steps without doing so.

Visualize Fit Results

Once the parameter estimation is complete, the fit results are stored in the LastRun
folder of the program.

1
2

On the Home tab, select New Datasheet. A new datasheet opens in a new tab.

In the Browser pane, expand the Program?2 folder. Then expand LastRun folder,
which contains results and simdatal. results contains estimated parameter values
and fit statistics. simdatal contains the simulated model responses for each
individual (patient or group) using the estimated parameter values.

Drag results onto the new datasheet.
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HOME =1 7]

1 (B P=| Run Step "
JH X B E & = |= ® & & @
- E Run and Advance
Cpen Save Close Mude\ Data Program New Run . Simulation = SimBiology Preferences = Community Help
- Datashest | Plot time Xy Advance Settings -
FILE PROJECT PLOT RUN STEP TOOLS ENVIRONMENT RESOURCES
BROWSER Program2 Datasheetd
Workspace | Documents | Model ®
- l@”i‘ Pooled Parameter Estimates (Program2: LastRun)
Name Size Type Name Estimate StandardError
[ Models 1x1 1 k1 0.4635 0.0334
[ Data1 152x6 table 2 Cl_Central 06747 0.0112
[ Pregram1 nca 3 L0 0.5453 0.2000
; [ Program2 fit 4 L1 0.2697 0.0204
|- [T LasiRun 5 k12 0.0116 9.2577e-4
3.[ results 1x1 SimBiology fit OptimResults ] 6 k21 0.0645 0.0060
[ simdatal 8x1 SimData 1%,__ _‘__‘=J—//}/§

T Staustcs [Program2: LastRun)

Name Value
1 AlC 534.7027
2 BIC 556.2036
3 LogLikelihood -261.3513
EXPLORER < DFE 260
© Drop quantity, dose or vaniant to explore 5 MSE 0.4274
6 SSE 111.1262

Pooled Beta (Program2: LastRun)

The Statistics table contains fit quality measures such as AIC, BIC, and log
likelihood. These measures can be useful, for example, to compare the performance
of different error models.

In addition to quality statistics, you can also view various fit plots, such as actual
versus predicted plots and residual distribution plots. First, select results in the
Browser pane. Available fit plots are automatically listed in the Plot section on the
Home tab. Then select Act vs Pred from the list.
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HER T E B = =

@ =
|Dpen Save (Close Model Data Program New New T Run
s - . > Datasheet Plot

PROJECT RUM
Frogram2 Datasheet? x| +
Workspace | Documents | Model =
A @Y Ppooled Parameter Estimates (Progri
Name Size Type Name
v [] Models 1x1 = 1 k1
v [5] Data1 152x6 table 2 Cl_Central
+ [=] Program1 nca 3 LO
- [ Program2 fit 4 L1
- =] LastRun 5 k12
4-1-[ results 1x1  SimBiology.fit OptimResults ] 6 k21

+ [ simdatal 8x1  SimData

The actual versus predicted plot appears on a separate tab. The predicted responses
are plotted on the x-axis and the observed (experimental) responses are plotted on
the y-axis.
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oo i E:] Run Step @ . o
AL~ @@= == @ ® &4 ©
e ] - i
o Run T i VAN | Simulation SimBiology Preferences | Community Help
Fit Act vs Pred Residual D... |34 Advance Settings -
PLOT RUN STEP TOOLS ENVIRONMENT RESOURCES
Program2 Datasheet3 Plot2 x| + Q PROPERTY EDITOR
= Plot Settings
= 100 . . : . . g
E
4 _@-*‘ SOURCE: Program2-LastRun-results
5 L
E sof s STYLE
o S b it ]
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= e hat | | ety
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= Central Drug (milligram/liter) e
5 g
i 0
o © 3 Box
3 & e
g £ T
- = O .= LABELS
® B &y Piot Tile =
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s 24 o i Piot XLabel = Predicied Value
0 — Q—O _
O % 5 &% . | Piot YLabel = Observed Value
o 0 05 1 15 2 25 3 35 AXES LIMITS
& Peripheral.Drug (milligram/iter) M Link X-Axis
E " (] Link Y-Asxis
Za} =T MARGIN
% ,.a*@" 0 Top:10 Left: 10 Bottom: 10 Right:10
=
‘é %l % GAP
2 &@@r’ % Horzontal: 4 Vertical 4
3 i 2 ; : 5 6
[Tumor Growth Model] tumor_weight (gram) CONFIGURE AXES
Predicted Value SCALE

=3 T -|='I.—'\ ot

You can change the plot to other supported plots by selecting one of the plots from
the Style section in the Property Editor. If you want the new plot on its own
separate tab and you do not want to reuse the existing plot tab, select the plot from

the Plot section on the Home tab.
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5 Change the plot to a residual distribution plot by selecting Res Dist in the Style
section.

—

||, | @ @ Em= g @ & ©

sl ; i Ri d Ad
o b Run G5t E R Bars Simulation | SimBiology Preferences = Community Help
Fit Act vs Pred Residual D... |34 Advance Settings -

PLOT RUN STEP TOOLS ENVIRONMENT RESOURCES a

Program2 Datasheet3 Plot2 J- (v ]

Plot Settings
Indwmual Resnjuals

g T T T T _#'— T T + -
O + SOURCE: Program2:LastRun:results
w
E + + 4'!- STYLE : 5. = 5
o | (| e | —
Aoy | SN
Fit Act Pred Res Dist || Residuals |
8 &
o T
8 Box
2 :
E M
= + + LABELS
sle . s . Piot Tile =
o o 02 2
cics e 02 02 4 Plot XLabel =
Fiot YLabel =
MARGIN
: R e - Top: 10 Left:10 Bottom: 10 Right:10
4 3 2 A 0 1 2 3 4
E T T T T T T | T T
= L FF GAP |
= M Horizontal:4 Vertical:4
(=]
E -+
1 2 : N " : : . CONFIGURE AXES
08 06 04 02 0 02 04 06 08
. . ‘ g . a SCALE . ]
f\/ E\"" ‘-'I‘ P\J{r\u/‘:. "J(\
. e m T — . plot semilogx || semilogy || loglog
4 3 2 - 0 1 2 3 4 . :

¥l

The plot shows whether the residuals for each response are normally distributed. In
an ideal normal probability plot of residuals, the residuals line up along the diagonal
line across the plot and the histograms indicate a normal fit. However, from the plot,

1-100



Calculate NCA Parameters and Fit Model to PK/PD Data Using SimBiology Model Analyzer App

the residuals for all three responses, especially CentralConc and PeripheralConc, do
not seem to be normally distributed. It could be an indication that the constant error
model assumption is incorrect.

Compare Different Error Models

The following steps show how to change the error model to an exponential error model to
fit the data again and compare the fit statistics of two different error models.

Save Fit Results

Before fitting the data again using the exponential error model, save the constant error
model result in a separate folder. Otherwise, the program, by default, overwrites results
from the LastRun folder every time you run the fit.

1 Right-click the LastRun folder of the fit program in the Browser pane.
2 Select Save Data.
3 Inthe Save Data dialog, enter fit constant as the data name.

Rerun Fit With Exponential Error Model
After you save the data, you can rerun the fit program with a different error model.

1 Return to the fit program by clicking the Program?2 tab. In the Error Model section,
select exponential.

ERROR MODEL

IIse the same error model for each response . constant
constant
ESTIMATION METHOD
Jse a global solver proportional
exponential
&) Isgnanlin fminunc Isqcurvef -
frminsearch frmincon combined

2 At the top of the Fit step, click the Run this program step button.
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[Ems Fir

DESCRIFTION
Click to edit the description

STATISTICAL MODELING
non-linear regressions

3 Close the progress plot after the fit completes.

If you closed the datasheet (Datasheet3) that contains the fit statistics from the
previous fit, reopen the datasheet. In the Browser pane, click Documents. Then
double-click Datasheet3.

Workspacé '|| Model @

Q @V
Name Type
(=] Project project
|g] Program1 nca
lEl Program?2 fit
|1 Flot1 time
|| Plot2 residual dist
|g] Datashest1 datasheet
|g| Datashesat2 datasheet
4-2-[ |g| Datasheeat3 datasheet ]

5 Click Workspace to go back to the fit program results. Expand LastRun folder of the
fit program. Then drag results onto Datasheet3. New columns

(Program?2_LastRun) containing the latest fit results are added next to the previous
fit results (Program?2_fit_constant).
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UH®R B E B = & @ (@ Simse 0 & & @
Open| Save Close Model Data Program  New  New boos i+ 2 B2 Run and Advance
5% = &

Run = Simulation = SimBiology Preferences Community Help
- - Datasheet Piot Act vs Pred Residual D... |33 Advance Settings g
FILE PROJECT PLOT RUN STEP TOOLS ENVIRONMENT Iy
v BROWSER o Program2 Datasheet3
Workspace | Documents | Model @
e @7 Pooled Parameter Estimates

Name Size Type Program2_fit_constant Program2_LastRun
+ [ Models 1x1 < Name Estimate StandardError Estimate StandardError
» [J Datal 152x6 table 1 k1 0.4635 0.0334 0.4643 0.0036
+ [ Program1 nca 2 Cl_Central 0.6747 0.0112 0.6672 0.0085
v Ll;‘ Program2 fit 3 Lo 0.5453 0.2000 05687 0.0656

~ [31 LastRun 4 L1 0.2697 0.0204 0.2650 0.0063
5: [ results 11 SimBiology. fit OptimResults 5 k12 0.0116 9.2577e-4 0.0108 36076e-4

+ [H simdatal  8x1 SimData 6 k21 //A 0.0645 0.0060 0.0588 0.0017
+ [ fit_constant
Statistics
Source AlC BIC LogLikelihood DFE MSE SSE
1 Program2_fit_consta 5347027 556.2036 -261.3513 260 0.4274 111.1262
2 Program2_LastRun -36.2272 -14.7262 241136 260 0.0500 12.9917
EXPLORER 1 »
© Drop quantity, dose or vaniant to explore
Pooled Beta
Program2_fit_constant Program2_LastRun
Name Estimate StandardError Estimate StandardError

The Statistics table compares the fit quality measures. From the comparison, both
the AIC and BIC of the fit using the exponential error model are smaller than those of
the previous fit. This indicates that the exponential error model fits the data better
than the constant error model. The larger log likelihood of the exponential error
model also indicates it is a better fit.

6 Next, look at the residual distribution plot. Click results from the LastRun folder.
Then click Residual Dist from the Plot section on the Home tab.
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HOME
DEHR BE B = @ @ @B
{ - { Run and Ad ]
Open | Save Close Model Data Program New New Run E’? ok ANCE Simulation SimBioloc
A - » - > Datasheet Plot Fit Act vs Pred | S} Advance Settings
FILE PROJECT L PLOT RUN STEP TOOLS ENV
v BROWSER o Program2 Datasheetd Plot2 Plot3 »
Workspace | Documents | Model ®
poce | 1 . Individual Residuals
= 2 T T T T T T T T —T——%7F
e 8y § - R ¥
Name Size Type -E _P_HW
[ Model 1%1 e 814.* T L L L i 1 L 1 i
+ L1 Models X 05 04 03 02 01 0 0.1 02 03 04 05
[ Data1 152x6 table T T T T T T
+ [ Program1 nca
- (5l Program2 ft L : —i — :
4 -3 -2 -1 0 1 2 3 4
= [ LastRun § ; : : 1 e " . -
6.1.[ results 1x1 SimBiology.fit. OptimResults| | & H’wr #+
- 2
+ [ simdatal 8x1 SimData =S 2 ittt
= . . . H . . .
» [ fit_constant o 0.8 0.6 0.4 02 0 02 0.4
-4 3 2 -1 0 1 2 3 4
EC» T T T T T T _'__l_-- + + T
| 2 e U
r EXPLORER o | £ M
p E +4 _
& Drop quantity, dose or vanant to explore Al = +1 eI . L . L . .
5 B -0.8 -0.6 -0.4 02 0 02 04 06 08
T T T “ T T T
4 -3 2 -1 0 1 2 3 4

I4

Compared to the residual distributions of the constant error model, the residual
distributions from the exponential error model look more normal, indicating that the
exponential error model indeed fits the data better.

Calculate Confidence Intervals

Another way to assess the quality of fit results is to compute 95% confidence intervals for
the estimated parameters and model predictions — that is, model simulation results using
the estimated parameters. This step requires Statistics and Machine Learning Toolbox.

1  Return to the fit program. Click the (+) icon at the upper left and select Confidence
Interval. A Confidence Interval step appears following the Fit step.
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Program2 Datasheetl Plot2 Plot3

Parallel | g = Fit
Confidence Interval

PROGRAM DESCRIPTION

DESCRIPTION
Click to edit the description

At the top of the Confidence Interval step, disable the autogeneration of plots by
clicking the plot icon. For both Parameter Confidence Intervals and Prediction
Confidence Intervals, use the default method gaussian and 95% confidence level.
Click the Run this program step button to compute confidence intervals.

[EI]EDNFIDENCE INTERVAL

CESCRIPTICMN
Click to edit the description

FARAMETER COMFIDENCE INTERVALS

Calculate = frue
Confidence Level (%) = 95
Method = gaussian

FREDICTICN CONFIDENCE INTERVALS

Calculate = frue
Confidence Level (%) = 95
Method = gaussian

For parameter confidence intervals, the supported methods are gaussian,
profileLikelihood, and bootstrap.

For prediction confidence intervals, the supported methods are gaussian and
bootstrap.

Once completed, the results are stored as parameterCI and predictionCI in the
LastRun folder of the program. parameterCI contains 95% confidence intervals for
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the estimated parameters. predictionCI contains 95% confidence intervals for the
model predictions.

4 Plot 95% confidence intervals for the estimated parameters. Click parameterCI in the
Browser pane and select Confidence in the Plot section.

JH%@ 2B E & = &

| Open Sa'v'e Close Model Data Program New MNew

= = - ot - Datasheet Plot
PROJECT PLOT
Program2 x| ||
Project | Model @ | ([l Paraliel| g5 -
Q @7 ® Isgnonlin
- | fminsearc
Name Size Type
L s 5 E
(=] Project project 5 ALGORITHM
Click to view
v 2] Models 1x1
. A
+ [ Datat 152x6 table AOVENEED 1
Click to view
v [ Program1 nca
+ [[3] Program2 fit P=] Big CONFI
= [=] LastRun DESCRIPTION
results 1x1 SimBiology fit OptimResults Click to edit {
C simdatal 8x1 SimData PARAMETER ¢
4.1[ parameterCl 1x1 SimBiology fit ParameterConfidencelnterval ] Calculate
— ; = Confidence L
predictionCl 1x1 SimBiology fit PredictionConfidencelnterval Method
|&] Plot3 1x1 residual dist
PREDICTION ¢
|| Datasheet3 1x1 datasheet Calculate
+ [ fit_constant Confidence L
. Method
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The confidence interval for each estimated parameter is shown in a new plot. The
plot indicates the successful computation of the confidence intervals for all estimated
parameters.

Program2 Datasheet3 Plot2 Plot3 Plot4 PROPERTY EDITOR

) _ Plot Settings
95% Gaussian Parameter Confidence Interval Plot

Z 076 SOURCE: Program2:LastRun:parameterCl
= &
E 078 PARAMETER COMFIDENCE INTERVAL
- - Layout = split
poo
_ LABELS
g -0.33 Flot Title =
& 04 ® Plot XLabel =
O -0.42 Plot ¥Label =
[=3
= pooled MARGIN
Top:10 Left: 10 Bottom: 10 Right-10
0.4
= Py GAP
i e Horizontal:4 Vertical 4
03
pooled CONFIGURE AXES
e SCALE
il avar s
T . \/\ VIV
2134 . -
1.36 plot semilogx semilogy loglog
pooled
LABELS
= Title = mixed
T 45 py ¥Label =
5455 YLabel = mixed
-46
pooled GRID
o 28
%_2_85 hd none xgrid yarid both
T o9 Style = solid
pooled
M- coo M

Depending on the outcome (status) of the confidence interval estimation, the app
plots the results differently.
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+ Ifthe status of confidence interval estimation is a success (as in the above plot),
the app uses the first default color (blue) to plot a line and a centered dot for
every parameter estimate. The app also plots a box to indicate the confidence
intervals.

» If the status is constrained or estimable, the app uses the second default color
(red) and plots a line, centered dot, and box to indicate the confidence intervals.

« If the status is not estimable, the app plots only a line and a centered cross in red.

» If there are any transformed parameters with estimated values that are 0 (for the
log transform) and 0 or 1 (for the probit or logit transform), no confidence
intervals are plotted for those parameter estimates.

For more details on the definitions of different statuses, see “Parameter Confidence
Interval Estimation Status”.

You can also change the Layout of the plot in Plot Settings.

* The 'split' layout displays the confidence interval for each parameter estimate
on a separate axis.

* The 'grouped' layout displays all confidence intervals on one axis, grouped by
parameter estimates. Each estimated parameter is separated by a vertical black
line.

In both cases, the parameter bounds defined in the original fit are marked by square
brackets. The app uses vertical dotted lines to group confidence intervals of
parameter estimates that have been computed in a common fit.

Similarly, plot 95% confidence intervals for the model predictions. Click predictionCI
in the Browser pane and select Confidence in the Plot section.
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Program2 Datasheet3 Plot2 Plot3 Plot4 Plots
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In this plot, the confidence interval for each group is plotted in a separate column,

and each response is plotted in a separate row. The plot indicates the successful

computation of the confidence intervals.

The plotting behavior differs depending on the outcome (status) of the confidence

interval calculation.

+ If the status is constrained or not estimable, the app uses the second default color

(red) to plot the confidence intervals.

* Otherwise, the app uses the first default color (blue) and plots the confidence
intervals as shaded areas (as in the above plot).

For details, see “Gaussian Confidence Interval Calculation for Model Predictions” and
“Bootstrap Confidence Interval Calculation”.

Show Overlay of Fitted Results Over Experimental Data

Once the parameter estimation is complete, you can plot the simulation results on top of

the experimental data. There are generally two ways to get the plot.
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The first approach is to use the default Fit plot that shows the fitted results over
experimental data for each group.

1 C(Click results from the LastRun folder of the fit program.

2  Select Fit in the Plot section on the Home tab.

HOME

- =Y 2, ;
= 2 B ! 2 = =
H ; = o
Open | Save Close Model Data Program  New  New - 7 Run
- - - Fit

Datasheet Plot

PROJECT

Workspace | Documents | Model ®
“Q @7

Name Size Type
+ [ Models 1x1

[ Data1 152x6 table

[ Program1 nca
- [3 Program2 fit

[ LastRun
1-[ results 1x1 SimBiology.fit DplimResulis]

+ [H simdatal 8x1  SimData

parameterC| 1x1 SimBiology.fit ParameterConfidencelnterval

predictionCl 1x1  SimBiology.fit PredictionConfidencelnterval

[ fit_constant

v EXPLORER

© Drop quantity, dose or variant fo explore

= Run st ~ ] -
u | | B Runstep
@ @ =— ) @ & @
Flun and AGVANCE gimul Biclogy Preferences  Communit Help
Act vs Pred Residual D.. |54 Advance Settings -
PLOT RUN STEP TOOLS RONMENT
Program2 Ploté o
1 2 =]
100
50
o
™ 9
ostamen=—o—0 | Ladages—o—o | Loe o |
4 5
100
o]
# " = PROPERTY EDITOR
L Plot Settings
e = —et2 S - — SOURCE: Program2 LastRun fesults
100 Le ) STNE
i }/\ F ’..-# ‘ E -“’.—d.. t" Nr:: ‘
- Fit ActPred || ResDist || Residuals
Ba
D ] o
o ses6—o—o— oo Box
(] 20 400 20 w00 a0 =
time (day) S

The second approach is more customized and involved, but you have more control over
how the plot looks like. The following steps show how to plot the tumor growth profiles of
all groups on the same axes but use different line styles for experimental data and

simulation data.

1 (Click simdatal in the LastRun folder of the fit program.

2 Click time from the Plot section on the Home tab.

1-110



Calculate NCA Parameters and Fit Model to PK/PD Data Using SimBiology Model Analyzer App

| Open Sav: Close = Model Dam Program New New
=) ¥ 7 Datasheet Plot
E PROJECT
v BROV R -]
Workspace | Documents | Model
@ €]
Name Size Type
» [ Madels 1x1
+ 7] Datat 152x6 table
+ [ Programi nca
(3 Program2 fit
= [ LastRun
results x1 SimBiology.fit OptimResults
1. [_@ simdatal 8x1  SimData
parameterC| 1x1  SimBiclogy fit ParameterConfidencelnterval
predictionCl 1x1  SimBiology fit PredictionConfidencelnterval

+ [ fit_constant

¥ EXPLORER

o

© Drop quantity, dose or vanant to explore

3

Program2

80

B} Run Step
- B Runand Advance

@

S

(3 Advance Settings
TOOLS

o

Plot7 x

Ploté

T

60

50

40

30

20

5 10 15 20 25 30 35
time (day)

Drag Datal (experimental data) on to the plot.

Slice Data | Plot Settings

Help

Slice Style

R Line Style

Scenarios Color
RESPONSES - Line Style

Style Marker Width Programz simdatal

vl - none 0.5

v - none 05

¥ none 05

SCENARIOS - Color
Color Run

Run 1

Run 2

Run 3

"". &: .\‘ "'.

Run 4
Run 5
Run 6

Run 7

.ﬁ & .\‘
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v BROWSER (v]
Workspace | Documents | Model ® .
Q CIlN
Name Size Type
v [ Models 1x1 2
[. [=] Datal 152x6 table ]
+ [31 Program1 nca
- [[3l Program2 fit
- [ LastRun
results x1 SimBiology.fit. OptimResults
+ [ simdatal 8x1  SimData
parameterCl 1x1 SimBiology. fit ParameterConfidencelnterval
predictionCl 1x1 SimBiology.fit PredictionConfidencelnterval

+ [ fit_constant

‘v EXPLORER

© Drop quantity, dose or variant fo explore -

Program2

90

Plot6

Plot7

+

80
o
50
40
30
20 |
10

Ul

i

-10 '
0 5

day

35

4 In the Property Editor of the plot, multiselect (Ctrl + Click) the first three rows
(simulation data) of the Responses table and click Create Set.
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RESPONSES - Line Style 4.2.1  Create Set

Style Marker Width Name
- none 05 Program2:simdatal Central Drug (milligram/liter)
3 none | 05 If:’rl?lgramE:ngm!dataI.PenpheraI.Drug
{milligramy/liter)
ProgramZ2:simdatal. Tumor Growth
none 05 o .
Model tumor_weight (gram)
o 05 Data1.CentralConc (milligram/liter)
- 05 Data1.PeripheralConc (milligram/liter)
* 05 Data1. TumorWeight {gram)

5 In the Slice table, use no style for Scenarios by selecting empty.

6 Clear the first two rows from each set. Keep only the tumor growth data from each
set.
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FPROPERTY EDITOR
Slice Data | Plot Settings

Slice
Sets

Responses

Style
Vertical
Line Style

5. [Scenarins

Dose

Match groups between data sources if applicable

SETS - Vertical RESFOMSE- Line S...
Style Marker Width
= Set 1
L] none 05
¢- L] none 05
none 05
= Set2
L] 0 0.5
L] + 05
- 05

Name

Program2:simdatal. Central. Drug
(milligram/liter)

Program:simdatal. Peripheral Drug
(milligram/liter)
Program2:simdatal. Tumor Growth
Model tumor_weight (gram)

Data1.CentralConc (milligram/liter)
Data1 PeripheralConc (milligram/liter)

Datal TumorWeight (gram)

7 Use Line Style for Sets and Color for Response. Also set the Marker of the
simulation data (Program?2) to none. Set the Style of the experimental data (Datal)

to none. Select 0 as the Marker.
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Program2 Ploté Plof7? PROPERTY EDITOR
Slice Data | Plot Settings
6 T T T T
Slice Style
Sets Line Style
5r T Responses Calor
Scenarios
Dose
4r +| Match groups between data sources if applicable
7.1.{ SETS- Lines }7-2-IRESPOI\SE- Color} Create Set
Style Marker Width Color Name
3r 1 -
Program?2:simdatal Central Drug
o (milligra )
ProgramZ2:simdatal. Peripheral. Drug
2F 1 O (milligra )
Program2:simdatal. Tumor Growth
s M ode
Model tumor_w :
R O
O
v Data1. TumorWWeight {gram)
0 I I I | . i
0 5 10 15 20 25 30 35

After fitting to data, you can set the model values to the parameter estimates and perform
other analyses. For instance, you can find out important model parameters using
sensitivity analysis on page 1-38 and vary the sensitive parameters to investigate model
variability by using virtual patients on page 1-58.
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See Also
SimBiology Model Analyzer
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More About

. “Find Important Parameters with Sensitivity Analysis Using SimBiology Model
Analyzer App” on page 1-38

. “Model Biological Variability with Virtual Patients Using SimBiology Model Analyzer
App” on page 1-58

. “Scan Dosing Regimens Using SimBiology Model Analyzer App” on page 1-117
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Scan Dosing Regimens Using SimBiology Model Analyzer

App

This example shows how to assess the efficacy and toxicity of various dose amounts in the
SimBiology Model Analyzer app by using the target (receptor) occupancy as a
biomarker. The example uses the target-mediated drug disposition (TMDD) model [1] with
slight modifications.

Target-Mediated Drug Disposition (TMDD) Model

Target-mediated drug disposition (TMDD) is a phenomenon in which a drug binds with
high affinity to its pharmacologic target site, such as a receptor or enzyme, in an
interaction that is reflected in the pharmacokinetic characteristics of the drug.

This example uses a modified TMDD model based on the model used by Mager and Jusko
[1] with a minor adjustment. The authors proposed a generic TMDD model that accounted
for saturable drug-target binding and target (or receptor) mediated elimination. Drug in
the Plasma reversibly binds with the unbound Target to form the drug-target Complex.
kon and koff are the association and dissociation rate constants, respectively. Clearance
of free Drug and Complex from the Plasma is described by first-order processes with
rate constants — kel and km, respectively. Free target turnover is described by the zero-
order synthesis rate ksyn and a first-order elimination (the rate constant, kdeg). Variants
of the TMDD model have been since used to characterize the pharmacokinetics of
numerous drugs.

The adjustment made to the model presented by Mager and Jusko, is as follows.

» Target occupancy (TO) is modeled as TO0 = Complex/(Target + Complex), where
TO is a parameter and Complex and Target are species.
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Explore Model Response Using Different Dose Amounts

Investigate the model response on the target occupancy (TO) using different dose

amounts.

Load TMDD Model

1 Open the SimBiology Model Analyzer app by typing simBiologyModelAnalyzer
at the command line or clicking the app icon on the Apps tab.

On the Home tab of the app, select Open.

Navigate to the folder matlabroot\examples\simbio\. matlabroot is the folder
where you have installed MATLAB. Select the project file named
tmdd with TO.sbproj.

Generate Array of Doses and Simulate Model

First, create a program to generate an array of doses with different dose amounts ranging
from 0 to 300 nanomoles.



Scan Dosing Regimens Using SimBiology Model Analyzer App

5

Select Program > Generate Samples.

In the Generate Samples step, double-click the empty cell under Component
Name and enter Daily Dose.Amount.

Under Daily Dose.Amount, set Type to MATLAB Code, and set Code to
linspace(0,300,31). This code specifies the generation of 31 doses with amounts
ranging from 0 to 300 nanomoles.

Disable the plotting of dose samples by clicking the plot button, as shown in the
figure.

4.
@@GENERATE SAMPLES
DESCRIPTION

Click to edit the description
PARAMETER SET : Cuantity

Name = P31
Type = user defined values

Farameter Combination = elementwise (31)

Use Component Name Current Value
| B Daily Dose Amount 150

Type = [MATLAB Code

Code = Lins.pace[ﬂﬂﬂﬂﬁﬂ

|34 Add parameter set to scan
Add a simulation step to simulate the model using the defined doses. Click the (+)

icon at the upper left of the program and select Simulation. A Simulation step
appears following the Generate Samples step.
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Program Plot1 Datasheetd

oA v Generate Samples
¥ Generate Samples

PROGR/ Steady State

CESCRIP
Click to

Simulation h

MODEL

RAMMIT L

6 In the Model step, click States to Log. Select TO as the only state to log by clearing
all other check boxes.

7 On the Home tab, click Run.

Once the simulation is complete, the program plots the results in Plot1, which shows
the time course of the model response (TO) given different dose amounts.
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Program1 Plot1 x| + Q PROPERTY EDITOR [+]

1 Slice Data | Plot Settings
T T T T T T T

Slice Style
Responses Line Style
Scenarios Color

RESPOMNSES - Line Style
Style Marker Width Program1
- nene 0.5 TO

SCENARIOS - Color

=
=

Color Daily Dose Amount

0 a
10

20

30

40

50

60

70

80

90

100

110 -

TO (dimensionless)
(=]
w

0.4

ENHESHENHENHENHENHENHENHENTESHENIIEN
B EEENEETYEN

time (day)

4]

Tip Plots are backed by data that are currently present in the app workspace. Plots
are not snapshots. When the data (either experimental data or simulation results) is
removed or changed, the plots are also updated according to the changes in the
underlying data.

Define Maximum and Minimum Target Occupancy Thresholds

Investigate which dose amounts correspond to the TO responses that lie within the safety
(TO = 0.85) and efficacy (TO = 0.15) thresholds. One approach is to add two
(horizontal) threshold lines to the TO response plot.
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On the Home tab, in the Project section, click New Datasheet.
In the Browser pane, expand the Program1 folder, then expand the LastRun folder.

Drag results into the new datasheet. The datasheet now shows time and TO
columns with their corresponding values.

HOME S we
}%ﬁ R BEE =B % NN @ @ |Brmsee @ 4 @
Open| Save Close Model Data Program New 7| Run B Runand Advance | L SimBiology Preferences  Community Help
- - - - - Datasheet| Plot time [Z] Advance Settings -
FILE PROJECT PLOT RUN STEP TOOLS ENVIRONMENT RESOURCES
BROWSER Program1 Datasheet1
Workspace | Documents | Model K
A l@”:\ﬂ Program1: LastRun: results
Name Size Type time TO
[ Models 1x1 independent dependent
[ Program1 scan day dimensionless
| @ 1B 1 0.3333
samples 1x1  SimBiology Scenarios 2 1 0 0.3333
3. 31 SimData 3 1 48149 5 0.3334
w 1 9.62599e-5 0.3334
- 5 1 22248¢-4 0.3336
6 1 3.4867e-4 0.3338
T 1 47485e-4 0.3339
8 1 6.0104e-4 0.3341
9 1 8.7413e4 0.3344
EXPLORER 10 1 0.0015 0.3351
QVERLAY RESULTS 1 1 0.0021 0.3358
12 1 0.0028 0.3365
© Drop quantity, dose or variant to explore 13 1 0.0034 03372

4 Point to the table and add an expression by clicking the (+) icon that appears at the
top right.
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TO o -
@ . Add an expression column

dependent
dimensionless
0.3333
0.3333

5 Double-click Namel and rename it EfficacyThreshold.

Double-click the Expression cell and enter 0.15*ones (size(time)). The
expression fills the column with the same constant value (0.15) for every time point.

7 Similarly, add another expression column named SafetyThreshold with the
expression 0.85*ones (size(time) ). Expand results in the LastRun folder. The
values from these two expression columns are now stored in the table named
observables.

BROWSER Program1 Datasheet1

Workspace | Documents | Model @ Program1: LastRun: results
Q (@[T time T0 EfficacyThreshold | SafetyThreshold
Name Size Type independent dependent dependent dependent
5 Models 1x1 day dimensionless
[} Program1 scan 0.15*ones(size(time)) 0.85%ones(size(time))
[ LastRun 1 =1 0 0.3333 0.1500 0.8500
samples 1x1  SimBiology Scenarios 2 1 0 0.3333 0.1500 0.8500
[ results 31x1  SimData 3 1 4.8149e-5 0.3334 0.1500 0.8500
time nx1  double 4 1 9.6299s5 03334 0.1500 0.8500
TO nx1 double 5 1 22248e-4 0.3336 0.1500 0.8500
[ observables 1x1  table 6 1 3.4867e-4 03338 0.1500 0.8500
EfficacyThreshold | nx1 double 7 1 4.7485e-4 0.3339 0.1500 0.8500
SafetyThreshold nx1  double 8 1 6.0104e-4 0.3341 0.1500 0.8500
9 1 8.7413e4 0.3344 0.1500 0.8500
10 1 0.0015 0.3351 0.1500 0.8500
11 1 0.0021 0.3358 0.1500 0.8500
12 1 0.0028 0.3365 0.1500 0.8500
EAFLORER 13 1 0.0034 03372 0.1500 0.8500

14

8  You can now plot the maximum and minimum thresholds along with the simulation
data. On the Home tab, click New Plot.
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9 Press Ctrl and select the TO, EfficacyThreshold, and SafetyThreshold variables
from the Browser pane. Drag them into the plot. The plot now shows TO profiles
along with the efficacy and safety threshold lines.

HOME

HER BE B =

Open | Save Close Model Data Program New
> | - - - - Datashee
__FILE PROJECT
v BROWSER Q
Workspace | Documents | Model ®
Q 8|7
Name Size Type
v =] Models 1x1 -
- ({3 Program1 scan
- [ LastRun
samples 1x1  SimBiology.Scenarios
- [ results 31x1  SimData
time nx1  double
g, TO nx1  double
[ observables ix1  table
EfficacyThreshold | nx1  double
SafetyThreshold | nx1  double

p EXFLORER [¥]

Visualize Target Occupancy Responses on Separate Axes

. i @ Run Step
Q@ = 0
@ Run and Advance .
| Run : Simul
time @ Advance Sett
PLOT RUN STEP TOC
Program1 Datasheet1 Plot2 x| + o
1
09 E

dimensionless

=] = =]
o w =2

=]
]

time (day)

The plot shows that certain TO responses either exceed the safety threshold or dip below
the efficacy threshold. To better visualize this observation, you can customize the plot to
see each dose amount and the corresponding TO response on separate axes.
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1 In the Property Editor of the plot, in the Slice Data table, set Responses to Color
and Scenarios to Grid.
PROPERTY EDITOR
Slice Data | Plot Settings

Style
Colar

(Grid

RESPOMSES - Color

Color Program1

v W
7] [ EfiicacyThreshold
¥ ety T

2 C(Click Plot Settings. For Plot YLabel, enter TO as the value.

3 In the Axes Limits section, select Link Y-Axis to show the same set of labels on the
y-axis for all subplots.
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Programi Plot2 + o

0.5]

o
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. 2 2 - Slice Da%élﬁ Plot Settings
Daily Dose Amount=0 Daily Dose Amount=10  Daily Dose Amount=20  Daily Dose Amount=30  Daily Dose Amount=40  Daily Dose Amount=50

UNIT CONVERSION
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Postprocess Simulation Results

In addition to visually inspecting each response plot on separate axes, you can add a
postprocessing step to query exactly which dose amounts stay within the thresholds.

1 Click the Program1 tab. Click the (+) icon at the upper left and select Calculate
Statistics under Postprocessing. A Postprocessing: Calculate Statistics step
appears following the Simulation step.

2 Double-click the first cell in the Expression column for statl and enter
double(max(T0) < 0.85 & min(T0) > 0.15).

3 Run only this step by clicking the run button at the top of the Calculate Statistics
step.

E. Run this program step 5: CALCULATE STATISTICS

TISTICS

Use Name Expression

stat1 = double(max(TO) < 0.85 & min(TO) = 0.15)
stat2 =

PROPERTY EDITOR o



Scan Dosing Regimens Using SimBiology Model Analyzer App

Running the program step generates the following figure. Display both the x-grid and y-
grid by clicking both in the Grid section. The x-axis represents the dose amounts and the
y-axis represents whether the dose amount generates a TO response that stays within the
safety and efficacy thresholds (with a value of 1) or not (with a value of 0).

Program1 Plot1 Plot2 Plot3 PROPERTY EDITOR
Plot Settings

SOURCE: Programi-LastRun samples stats

PARAMETERS
Use Sampled Parameter

1F LA S S 2 5 S SRR RN R -

Daily Dose Amount

Use Statistic
08} 8

stat1

LABELS
Flot Title =
Flot XLabel =
Plot YLabel =

D& -

stat1

MARGIN

Top:10 Left:10 Bottom:10 Right:10
04 R

CONFIGURE AXES

LABELS
Titte =
¥Label = Daily Dose Amount
Ylabel = stat

GRID

0F LA B & 2 LA R A R R B S S S 55 -

none xgrid ygrid both
Siyle = solid

i i i i i i i
« Col
0 50 100 150 200 250 300 - coor
Daily Dose Amount

ki

The plot shows that dose amounts ranging from 50 to 180 nanomoles provide TO
responses that lie within the desired efficacy and safety thresholds.
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See Also
SimBiology Model Analyzer | simbiology

More About

. “Calculate NCA Parameters and Fit Model to PK/PD Data Using SimBiology Model
Analyzer App” on page 1-79

. “Find Important Parameters with Sensitivity Analysis Using SimBiology Model
Analyzer App” on page 1-38

. “Model Biological Variability with Virtual Patients Using SimBiology Model Analyzer
App” on page 1-58

References

[1] Marger, D., and W. Jusko. 2001. General pharmacokinetic model for drugs exhibiting
target-mediated drug disposition. Journal of Pharmacokinetics and
Pharmacodynamics. 28: 507-532.
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What is a SimBiology Model?

2-2

In this section...

“Model Definition” on page 2-2
“Expressions” on page 2-2
“Quantities” on page 2-3
“Model Hierarchy” on page 2-4

“Representing a Model” on page 2-4

Model Definition

A SimBiology model is composed of a set of expressions (reactions, differential equations,
discrete events), which together describe the dynamics of a biological system. You write
expressions in terms of quantities (compartments, species, parameters), which are also
enumerated in the model.

Expressions

There are three distinct types of expressions in SimBiology:

* Reactions
* Rules
* Events

Reactions

A reaction describes a process such as a transformation, transport, or binding/unbinding
process between reactants and products.

Example reactions include:

Creatine + ATP <-> ADP + phosphocreatine
cytoplasm.speciesA -> nucleus.speciesA

Rules

A rule is a class of mathematical expressions that include differential equations, initial
assignments, repeated assignments, and algebraic constraints.




What is a SimBiology Model?

For example, you can use a rule to:
* Specify values for model components that are required for comparison with
experimental data. For example, specify the active fraction of total protein.

* Assign values to model components based on the values of other components in the
model. For example, define a parameter's value as being proportional to a species or
another parameter.

» Define mass balance equations.

» For species, use rate rules as an alternative to the differential rate expression
generated from reactions.

Events

An event describes an instantaneous change in the value of a quantity (compartment,
species, parameter). The discrete transition occurs when a user-specified condition
becomes true. The condition can be a specific time or a specific time-independent
condition.

For example, you can use an event to:

» Activate or deactivate a specific species (activator or inhibitor species).
* Change a parameter value based on external signals.
* Change reaction rates in response to addition or removal of a species.

* Replicate an experimental condition, such as the addition or removal of an activating
agent (such as a drug) to or from a sample.

Quantities

SimBiology uses three types of quantities in models:

¢ Compartments
* Species
* Parameters

Compartments

A compartment defines a physically bounded region that contains species. A compartment
is characterized by a capacity expressed as volume, area, or length. A compartment can
also contain other compartments, which adds hierarchy to a model. For example, a
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compartment named cytoplasm might contain a compartment named nucleus, thereby
partitioning species based on their location.

Species

A species characterizes the state of the biological system by representing the amount (or
concentration) present in the system for that entity. Examples of species are DNA, ATP,
and creatine. Species' amounts (or concentrations) vary during a simulation as a result
of their participation in reactions, differential equations, and events. Therefore, species
represent the dynamical state of a biological system.

Parameters

A parameter is a quantity that is referred to by expressions. It typically remains constant
during a simulation. For example, parameters are used as rate constants in reactions.

You can configure a parameter to vary during a simulation. This is useful, for example, to
model the change in a reaction rate given the concentration of a catalyst or a change in
temperature.

Model Hierarchy

Note the following conditions imposed on quantities in the model hierarchy:

* Models must contain at least one compartment.
* A compartment can contain one or more compartments.

* Species are always contained within a compartment.

Representing a Model

In SimBiology, models and their components are implemented as objects. These objects
have properties and methods that you can use to access and configure them. Use the get
method to list the property values of an object. Use the dot notation to change the
property values of an object.

SimBiology objects are handle objects, which has implications for how they behave during
copy operations. Handle objects are referenced by their handle variable, and copies of the
handle variable refer to the same object. To learn how handle objects affect copy
operations, see Copying Objects (MATLAB).



See Also

See Also
Model
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Species Object

A species object represents a species, which is the amount of a chemical or entity
that participates in reactions. A species is always scoped to a compartment.

When adding species to a model with multiple compartments, you must specify qualified
names, using compartmentName.speciesName. For example, nucleus.DNA denotes the
species DNA in the compartment nucleus.

For information about... See...

Creating and adding a species to a model |addspecies
Methods and properties of a species species object

How Species Amounts Change During Simulations

The amount of a species can remain constant or vary during the simulation of a model.
Use the following properties of a species object to specify how the amount of a
species changes during a simulation:

* ConstantAmount property — When set to true, the species amount does not change
during a simulation. The species can be part of a reaction or rule, but the reaction or
rule cannot change its amount. When set to false, the species amount is determined
by a reaction or a rule, but not both.

* BoundaryCondition property — When set to true, the species amount is either
constant or determined by a rule, but not determined by a chemical reaction. In other
words, the simulation does not create a differential rate term from the reactions for
this species, even if it is in a reaction, but it can have a differential rate term created
from a rule.

Keeping a Species Amount Unchanged

Set ConstantAmount to true and BoundaryCondition to false for a constant
species, whose amount is not changed by a reaction or rule. In this case, the species acts
like a parameter. It cannot be in a reaction, and it cannot be varied by a rule.

ConstantAmount BoundaryCondition Reaction Rule Changed By

True

False No No Never
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Example — Species E is not part of the reaction, but it is part of the reaction rate
equation. E is constant and could be replaced with the constant Vm = k2*E.

reaction: S -> P
reaction rate: kcat*E*S/(Km + S)

Changing a Species Amount with a Reaction or Rule

Set ConstantAmount to false and BoundaryCondition to false for a species whose
amount is changed by a reaction or rule, but not both.

ConstantAmount BoundaryCondition Reaction Rule Changed By
False False Yes No Reaction
False False No Yes Rule

Example 1 — Species A is part of a reaction, and it is in the reaction rate equation. The
species amount or concentration is determined by the reaction. This is the most common
category of a species. A differential rate equation for the species is created from the
reactions.

reaction: A -> B
reaction rate: k*A

Example 2 — Species E is not part of the reaction, but it is in the reaction rate equation.
E varies with another reaction or rule.

reaction: S -> P
reaction rate: kcat*E*S/(Km + S)

Example 3 — Species G is not part of a reaction, and it is not in a rate equation. G varies
with an algebraic rule or rate rule.

rate rule: dG/dt = k

Changing a Species Amount with a Rule When Species is Part
of a Reaction

Set ConstantAmount to false and BoundaryCondition to true for a species whose
amount is changed by a rule, but the species is also part of a reaction, and a differential

rate term from the reaction is not created. The amount of the species changes with the
rule, and a differential rate term is created from the rule.
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ConstantAmount BoundaryCondition Reaction Rule Changed By

False

True Yes Yes Rule

Example 1 — Species A is not changed by the rate equation, but changes according to a
rate rule. However, A could be in the rate equation that changes other species in the
reaction.

reaction: A -> B
reaction rate: k1l or k1*A
rate rule: dA/dt = k2*A (solution is A = k2*t)
(enter in SimBiology as A = k2*A)

Example 2 — Species A is not in the rate equation, but changes according to an
algebraic rule.

reaction: A -> B + C
reaction rate: k or k*A
algebraic rule: A = 2*C
(enter in SimBiology as 2*C - A)

Keeping a Species Amount Unchanged When Species is Part of
a Reaction that Adds or Removes Mass

Set ConstantAmount to false and BoundaryCondition to true for a constant species
that is part of a reaction, but a differential rate term is not created from the reaction. The
differential rate term is created from a rule.

ConstantAmount BoundaryCondition Reaction Rule Changed By

True

True Yes No Never
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During simulation, a differential rate equation is not created for the species.
dSpecies/dt does not exist.

Example 1 — Aisa infinite source and its amount does not change. B increases
with a zero order rate (k and k*A are both constants). A source refers to a species where
mass is added to the system.

reaction: A -> B
reaction rate: k or k*A



Species Object

Example 2 — B decreases with a first-order rate, but Aisan infinite sink and its
amount does not change. A sink refers to a species where mass is subtracted from the
system.

reaction: B -> A
reaction rate: k*B

Example 3 — The null species is a reserved species name that can act as a source or a
sink.

reaction: null -> B
reaction rate: k

reaction: B -> null
reaction rate: k*B

Example 4 — ATP and ADP are in the reaction and have constant values, but they are
not in the reaction rate equation.

reaction: S + ATP -> P + ADP
reaction rate: Vm*S/(Km + S)
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Definitions and Evaluations of Reactions in SimBiology
Models

A reaction is a mathematical expression that describe a transformation, transport, or
binding process that changes one or more species. Typically, an amount of a species is

2-10

changed through a reaction.

In SimBiology, a reaction is represented by a reaction object, which has the following

properties.

* Reaction property — Mathematical expression that describes the reaction

* ReactionRate property — Mathematical expression that defines the rate at which the
reactants combine to form products. You can provide this information explicitly or use
the KineticlLaw property to populate this information.

* KineticLaw property — Object that specifies a rate law that defines the type of
reaction rate. Examples include Henri-Michaelis-Menten and Mass Action. The object
also specifies species objects, or parameter objects. This property is optional.
It serves as a template for a reaction rate and provides a convenient way of applying a
specific rate law to multiple reactions. If you use this property, it automatically

populates the ReactionRate property.

A reaction is scoped to a model.

For information about...

See...

Creating and adding a reaction to a model

addreaction

Methods and properties of a reaction

reaction object

Creating and adding a kinetic law to a
reaction

addkineticlaw

Methods and properties of a kinetic law

KineticlLaw object

Writing Reaction Expressions

Use standard chemistry reaction notation to create the mathematical expression for a
reaction (Reaction property of a reaction object).

Following are rules for writing reaction expressions:




Definitions and Evaluations of Reactions in SimBiology Models

» Use spaces before and after species names and stoichiometric values.
» Stoichiometry values must be positive.
+ If a stoichiometry value is not specified, it is assumed to be 1.

* In a model with a single compartment, specify species using speciesName. In a model
with multiple compartments, specify species using qualified names:
compartmentName.speciesName. For example, nucleus .DNA denotes the species
DNA in the compartment nucleus.

* Enclose names with non-alphanumeric characters (including spaces) in brackets.
* Reactions can be reversible (<->) or irreversible (->).

Examples of reaction expressions include:

Creatine + ATP <-> ADP + phosphocreatine

glucose + 2 ADP + 2 Pi -> 2 lactic acid + 2 ATP + 2 H20
cytoplasm.A -> nucleus.A

[compartment 1].[species A] -> [compartment 2].[species A]

Note Same species can be used multiple times in the list of reactions or products. The
expression '2 A' is equivalentto 'A + A'.

Writing Reaction Rate Expressions Explicitly

Use any valid MATLAB code to create the mathematical expression for a reaction rate
(ReactionRate property of a reaction object). The reaction rate can specify
compartments, species, or parameters.

Following are rules for writing reaction rate expressions:

* The expression must be a single MATLAB statement that returns a scalar.

* In a model with a single compartment, specify species using speciesName. In a model
with multiple compartments, specify species using qualified names:
compartmentName.speciesName. For example, nucleus .DNA denotes the species
DNA in the compartment nucleus.

* Enclose names with non-alphanumeric characters (including spaces) in brackets.
* Do not end the reaction rate expression with any of the following:

e Semicolon
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* Comma
* Comment text preceded by %
* Line continuations indicated by . . .

For example, if you have the following reaction expression:
Creatine + ATP <-> ADP + phosphocreatine

and the reaction follows Mass Action kinetics, then the reaction rate expression would be:

K*Creatine*ATP - Krev*ADP*phosphocreatine

Tip If your reaction rate expression is not continuous and differentiable, see “Using
Events to Address Discontinuities in Rule and Reaction Rate Expressions” on page 2-38
before simulating your model.

Creating Reaction Rate Expressions Using Kinetic Law Objects

AKineticLaw object is scoped to a reaction and specifies:

* Arate law that defines the type of reaction rate. Examples include Henri-Michaelis-
Menten and Mass Action.

* species and parameters

AKineticlLaw object serves as a template for a reaction rate and provides a
convenient way of applying a specific rate law to multiple reactions. You can use this
object to create a reaction rate, which populates the ReactionRate property of the
reaction object.

For example, if you create a KineticLaw object that specifies Henri-Michaelis-Menten
for the KineticLawName, species S, and parameters Vm and Km, the reaction rate law is:

Vi *SI(Kpm + S)

Then if you create a reaction object that specifies the previous KineticLaw object
and species the following reaction expression:

A ->B

with Vm = Va and Km = Ka and S = A, then the reaction rate equation is:
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Va*A/(Ka + A)

Examples of Creating Reaction Rates
Example of Creating a Zero-Order Reaction

With a zero-order reaction, the reaction rate does not depend on the concentration of
reactants. Examples of zero-order reactions are synthesis from a null species, and
modeling a source species that is added to the system at a specified rate.

reaction: null -> P
reaction rate: k mole/second
species: P = 0 mole
parameters: k = 1 mole/second

Note When specifying a null species, the reaction rate must be defined in units of
amount per unit time not concentration per unit time.

Entering the reaction above into the software and simulating produces the following
result:
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Zero-Order Mass Action Kinetics

Note If the amount of a reactant with zero-order kinetics reaches zero before the end of
a simulation, then the amount of reactant can go below zero regardless of the solver or
tolerances you set.

Examples of Creating Other Reactions

For examples of creating other reaction rates, see “Define Reaction Rates with Mass
Action Kinetics” on page A-2 and “Define Reaction Rates with Enzyme Kinetics” on
page A-8.

How Reaction Rates Are Evaluated

Reaction Rate Dimensions

When calculating species fluxes, SimBiology must determine whether you specified
reaction rates in dimensions of amount/time or concentration/time. When all
compartments in a model have a capacity of one unit, amount and concentration are
numerically equivalent.
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For all other models, the numerical results of the simulation depend on which
interpretation SimBiology selects. SimBiology determines whether a reaction rate is in
dimensions of amount/time or concentration/time via dimensional analysis of
ReactionRate expressions. This minimum level of dimensional analysis always occurs,
even when DimensionalAnalysis and UnitConversion are off.

The DefaultSpeciesDimension property defines the dimensions of species appearing
in a reaction rate. SimBiology infers the dimensions of parameters appearing in a reaction
rate from their ValueUnits property. If any parameters appearing in a reaction rate
expression do not have units, SimBiology interprets the reaction rate in dimensions of
amount/time. Therefore, the only way to specify that a reaction rate has dimensions of
concentration/time is to assign appropriate units to all parameters.

Reactions Spanning Multiple Compartments

Specify reactions that span compartments using the syntax
compartmentlName.specieslName -> compartment2Name.species2Name. The
reaction rate dimensions must resolve to amount/time if either of the following conditions
are true:

* Reactant species are in different compartments.
* The reaction is reversible mass action and the products are in multiple compartments.

Examples

Consider a reactiona + b —> c. Using mass action kinetics, the reaction rate is k*a*b,
where k is the rate constant of the reaction. If you specify that initial amounts of a and b
are 0.01 molarity and 0.005 molarity respectively, then the reaction rate is in
concentration/time (and units of molarity/second) if the units of k are 1/
(molarity*second). If you specify k with another equivalent unit definition, for
example, 1/ ((moles/liter)*second), SimBiology checks whether the physical
quantities match. If the physical quantities do not match, you see an error and the model
is not simulated.

If, in the previous example, you specify that initial amounts of a and b are 0.01 and

0. 005 respectively, without specifying units, SimBiology checks whether
DefaultSpeciesDimension is substance or concentration. If
DefaultSpeciesDimension is concentration, and you set units on the rate constant
such that the reaction rate dimensions resolve to concentration/time, SimBiology scales
the species amounts for compartment capacity, and returns the species values in
concentration.
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If you specify initial amounts of a and b as .01 molarity and 0.005 mole
respectively, include the volume scaling for b in the reaction rate expression. Include
volume scaling in the rate constant, and set the units of the rate constant accordingly (1/
(mole*second) for concentration/time, or 1/ (molarity*second) for amount/time).

Viewing Equations for Reactions

You can view the system of equations that SimBiology creates when you build a model
using reaction expressions. For details, see “View Model Equations” on page 2-57.

See Also

More About

. “Create and Simulate a Model with a Custom Function” on page 2-49

. “Model Simulation” on page 4-2

. “Deriving ODEs from Reactions” on page 4-4

. “What is a SimBiology Model?” on page 2-2

. “Definitions and Evaluations of Rules in SimBiology Models” on page 2-17
. “Events in SimBiology Models” on page 2-30

. “Component Usage” on page 2-58

. “Evaluation of Model Component Names in Expressions” on page 2-61
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Definitions and Evaluations of Rules in SimBiology
Models

In this section...

“Overview” on page 2-17

“Initial Assignment” on page 2-17

“Repeated Assignment” on page 2-18

“Algebraic Rules” on page 2-18

“Repeated Assignment vs. Algebraic Rules” on page 2-19
“Rate Rules” on page 2-19

“Evaluation Order of Rules” on page 2-19

“Conservation of Amounts During Simulation” on page 2-20
“Writing Rule Expressions” on page 2-21

“Considerations When Imposing Constraints” on page 2-21

“Rate Rule Examples” on page 2-22

Overview

Rules are mathematical expressions that allow you to define or modify model quantities,
namely compartment capacity, species amount, or parameter value.

Rules can take the form of initial assignments, assignments during the course of a
simulation (repeated assignments), algebraic relationships, or differential equations (rate
rules). Details of each type of rule are described next.

Initial Assignment

An initial assignment rule lets you specify the initial value of a model quantity as a
numeric value or as a function of other model quantities. It is evaluated once at the
beginning of a simulation.

An initial assignment rule is expressed as Variable = Expression, and the rule is
specified as the Expression. For example, you could write an initial assignment rule to
set the initial amount of species?2 to be proportional to speciesl as species2 = k *
speciesl where Kk is a constant parameter.
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Repeated Assignment

A repeated assignment rule lets you specify the value of a quantity as a numeric value or
as a function of other quantities repeatedly during the simulation. It is evaluated at every
time step, which is determined by the solver during the simulation process.

A repeated assignment rule is expressed as Variable = Expression, and the rule is
specified as the Expression. For example, to repeatedly evaluate the total species
amount by summing up the species in different compartments, you could enter: xTotal
= cl.X + c2.X, where xTotal is a nonconstant parameter, c1 and c2 are the name of
compartments where species x resides.

Algebraic Rules

An algebraic rule lets you specify mathematical constraints on one or more model
quantities that must hold during a simulation. It is evaluated continuously during a
simulation.

An algebraic rule takes the form © = Expression, and the rule is specified as the
Expression. For example, if you have a mass conservation equation such as

species total = speciesl + species2, write the corresponding algebraic rule as
speciesl + species2 - species total.

However, repeated assignment rules are mathematically equivalent to algebraic rules, but
result in exact solutions instead of approximated solutions. Therefore, it is recommended

that you use repeated assignment rules instead of algebraic rules whenever possible. Use
algebraic rules only when:

* You cannot analytically solve the equations to get a closed-form solution. For example,
there is no closed-form solution for x*4 + ax”3 + bx"2 + cx + k = 0 whereas
the closed-form solution for kx — ¢ = Qisx = c/k.

*  You have multiple equations with multiple unknowns, and they could be inconvenient
to solve.

If you use an algebraic rule, rate rule, or repeated assignment to vary the value of a
parameter or compartment during the simulation, make sure the ConstantValue
property of the parameter or ConstantCapacity of the compartment is set to false.
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Repeated Assignment vs. Algebraic Rules

Repeated assignment rules are mathematically equivalent to algebraic rules, but result in
exact solutions. However, algebraic rules are solved numerically, and the accuracy
depends on the error tolerances specified in the simulation settings. In addition, there are
several advantages to repeated assignment rules such as better computational
performance, more accurate results since no rules have to be solved numerically (hence
no approximations), and sensitivity analysis support.

Tip

» If you can analytically solve for a variable, use a repeated assignment rule instead of
an algebraic rule.

* Inrepeated assignment rules, the constrained variable is explicitly defined as the left-
hand side, whereas in algebraic rules it is inferred from the degrees of freedom in the
system of equations. See also “Considerations When Imposing Constraints” on page 2-
21.

Rate Rules

A rate rule represents a differential equation and lets you specify the time derivative of a
model quantity. It is evaluated continuously during a simulation.

A rate rule is represented as % = Expression, which is expressed in SimBiology
as Variable = Expression. For example, if you have a differential equation for species

dx

x,%=k(y+z), write the rate ruleas: x = k * (y + z).

For more examples, see “Rate Rule Examples” on page 2-22.

Evaluation Order of Rules

At the start of the simulation (that is, at simulation time = 0), SimBiology evaluates the
initial assignment and repeated assignment rules as a set of simultaneous constraints.
SimBiology treats the rules as a unified system of constraints and automatically reorders
and evaluates them. The order in which the rules appear in the model has no effect on the
simulation results.
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If a quantity is being modified by an assignment rule, the rule replaces initial value
properties, such as InitialAmount, Capacity, or Value. Similarly, a variant altering
such quantities has no effect because the value is superseded by the assignment rules.

SimBiology throws an error if the model has circular dependencies in the initial
assignment and repeated assignment rules. In other words, initial assignments and
repeated assignments cannot have a variable that is explicitly or implicitly referenced on
both the left- and right-hand sides of the equation.

For instance, you cannot create circular sets of assignments suchasa = b + landb =
a + 1, where a and b are explicitly referenced on both sides of the equation. An example
of an implicit reference is when an assignment rule references a species in concentration.
In this case, the compartment that contains the species is implicitly referenced.

Compatibility Considerations

You might observe different simulation results with respect to initial assignments for
previous releases of SimBiology (R2017a or earlier). To recover the same simulation
results at time = 0, as in R2017a or earlier, use the updateInitialAssignments
function in the command line. If you are using the SimBiology app, right-click the model
from the Project Workspace and select Remove Order Dependencies.

Conservation of Amounts During Simulation

During a simulation (that is, at simulation time > 0), SimBiology conserves species
amounts rather than concentrations if there are any changes to the volume of a
compartment where the species reside. In other words, if you have a repeated assignment
rule or an event that changes the volume, then you see the effect of conservation of
species amounts at time > 0.

However, at the beginning of a simulation (that is, at simulation time = 0), the concept of
amount conservation does not apply because there are no changes before time = 0. Only
one set of initial conditions exists and SimBiology uses the conditions at the start of the
simulation. Specifically, at time = 0, SimBiology:

1 Initializes variables for species, compartments, and parameters using the
corresponding InitialAmount, Capacity, and Value properties.

2 Updates the values by replacing them with the corresponding alternate values from
variants, if any.
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3 Updates the values by evaluating initial assignment and repeated assignment rules as
a set of simultaneous constraints. Therefore, the assignment rules replace initial
values if model quantities are being modified by such rules or variants.

Compatibility Considerations

In previous releases (R2017a or earlier), if a repeated assignment changed a
compartment volume, SimBiology used the compartment capacity to determine the initial
amount and conserved it when the compartment volume changed at time = 0. In R2017b
or later, SimBiology uses the InitialAmount property of the species as the initial
condition at time = 0. Consider the following model.

sbiomodel('ml")

addcompartment(m, 'v',10, 'ConstantCapacity',0, 'CapacityUnit', 'liter")
addparameter(m, 'p', 'ValueUnit', 'liter")

addrule(m,'v = 100 * p', 'repeatedAssignment')

addspecies(v, 's',50, 'InitialAmountUnit', 'milligram/liter")

nw 5T <3
| | | | I |

In R2017a or earlier, SimBiology first calculated the initial amount of s as 50
milligram/liter * 10 liter = 500 milligram, and then applied the repeated
assignment rule v = 100 liter. So, the concentration of s was then calculated and
reported as 500 milligram/100 liter = 5 milligram/liter attime = 0.

In R2017b or later, SimBiology uses the InitialAmount property of species s, and
reports the initial amount of s as 50 milligram/liter instead.

Writing Rule Expressions

Use MATLAB syntax to write a mathematical expression for a rule. Note that no
semicolon or comma is needed at the end of a rule expression. If your algebraic, repeated
assignment, or rate rule expression is not continuous or differentiable, see “Using Events
to Address Discontinuities in Rule and Reaction Rate Expressions” on page 2-38 before
simulating your model.

Considerations When Imposing Constraints

Suppose that you have a species y whose amount is determined by the equationy = m *
X - c¢.In SimBiology, the algebraic rule to describe this constraint is writtenasm * x -
Cc - y.Ifyou want to use this rule to determine the value of y, then m, x, and ¢ must be
variables or constants whose values are known or determined by other equations.

2-21



2 Modeling

Therefore, you must ensure that the system of equations is not overconstrained or
underconstrained. For instance, if you have more equations than unknowns, then the
system is overconstrained. Conversely, if you have more unknowns than the equations,
then the system is underconstrained.

Tip The behavior of an underconstrained system could be fixed by adding additional rules
or by setting the ConstantValue or ConstantCapacity or ConstantAmount property
of some of the components in the model.

Rate Rule Examples
The following examples show how to create rate rules for different applications.
Create a Rate Rule for a Constant Rate of Change

This example shows how to increase the amount or concentration of a species by a
constant value using the zero-order rate rule. For example, suppose species x increases
by a constant rate k. The rate of change is:

dx/dt =k

Set the initial amount of species x to 2, and the value of parameter k to 1. Use the
following commands to set up a SimBiology model accordingly and simulate it.

sbiomodel('m"');

addcompartment(m, 'comp');
addspecies(m, 'x', 'InitialAmount',2);
addparameter(m, 'k', '"Value',1);
addrule(m, 'x = k', 'RuleType', 'rate');
[t,sd,species] = sbiosimulate(m);
plot(t,sd);

legend(species)

xlabel('Time");

ylabel('Species Amount');

ST wnw o 3
muuuu
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Alternatively, you could model a constant increase in a species using the Mass Action
reaction null -> x with the forward rate constant k.

clear

m = sbiomodel('m');

c = addcompartment(m, 'comp');

s = addspecies(m, 'x','InitialAmount',2);
r = addreaction(m, 'null -> x');

kl = addkineticlaw(r, 'MassAction');
p addparameter(kl, 'k', 'Value',1);
kl.ParameterVariableNames = 'k';
[t,sd,species] = sbiosimulate(m);
plot(t,sd);

legend(species)
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Create a Rate Rule for an Exponential Rate of Change

This example shows how to change the amount of a species similar to a first-order
reaction using the first-order rate rule. For example, suppose the species x decays
exponentially. The rate of change of species X is:

dx/dt = — k*x

The analytical solution is:
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Cr = Co*e Kt

where C; is the amount of species at time t, and Cy is the initial amount. Use the following
commands to set up a SimBiology model accordingly and simulate it.

sbiomodel('m"');

addcompartment(m, 'comp');
addspecies(m, 'x', 'InitialAmount',2);
addparameter(m, 'k', 'Value',1);
addrule(m, 'x = -k * x','RuleType', 'rate');
[t,sd,species] = sbiosimulate(m);

plot(t,sd);

legend(species);

xlabel('Time");

ylabel('Species Amount');

ST n o 3
o nn
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If the amount of a species x is determined by a rate rule and x is also in a reaction, x
must have its BoundaryCondition property set to true. For example, with a reaction a

-> x and a rate rule % = k*x, set the BoundaryCondition property of species x to

true so that a differential rate term is not created from the reaction. The amount of x is
determined solely by a differential rate term from the rate rule. If the

BoundaryCondition property is set to false, you will get the following error message
such as Invalid rule variable 'x' in rate rule or reaction.
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Create a Rate Rule to Define a Differential Rate Equation

Many mathematical models in the literature are described with differential rate equations
for the species. You could manually convert the equations to reactions, or you could enter
the equations as rate rules. For example, you could enter the following differential rate
equation for a species C:

ac _

i vi - vdX kdC

_C
Kc+C
as a rate rule in SimBiology: C = vi - (vd*X*C)/(Kc + C) - kd*C

Create a Rate Rule for the Rate of Change That Is Determined by Another
Species

This example shows how to create a rate rule where a species from one reaction can
determine the rate of another reaction if it is in the second reaction rate equation.
Similarly, a species from a reaction can determine the rate of another species if it is in the
rate rule that defines that other species. Suppose you have a SimBiology model with three
species (a, b, and ¢), one reaction (a -> b), and two parameters (k1 and k2). The rate
equation is defined as b = — kq *a, and rate rule is dc/dt = k) *a. The solution for the
species in the reaction are:

a=age 1 bh=a,(l-e XY,

Since the rate rule dc/dt = ky *a is dependent on the reaction, dc/dt = kg(aoe_klt). The
solution is:

¢ = ¢y + koay/ky(1 — e~ K1)

Enter the following commands to set up a SimBiology model accordingly and simulate it.

m = sbiomodel('m');
¢ = addcompartment(m, 'comp');
sl addspecies(m, 'a', 'InitialAmount',10, 'InitialAmountUnits', 'mole');

s2 = addspecies(m,'b','InitialAmount',0, 'InitialAmountUnits', 'mole"');
= addspecies(m,'c', 'InitialAmount',5, 'InitialAmountUnits"', 'mole"');
rxn = addreaction(m,'a -> b');

kl = addkineticlaw(rxn, 'MassAction');
pl = addparameter(kl, 'kl1', 'Value',1, 'ValueUnits', '1l/second"');
rule = addrule(m,'c = k2 * a','RuleType', 'rate');
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kl.ParameterVariableNames = 'kl1';

p2 = addparameter(m, 'k2','Value',1, 'ValueUnits','1l/second');
[t,sd,species] = sbiosimulate(m);

plot(t,sd);

legend(species);

xlabel('Time");

ylabel('Species Amount');
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See Also

More About

. “What is a SimBiology Model?” on page 2-2

. “Definitions and Evaluations of Reactions in SimBiology Models” on page 2-10
. “Events in SimBiology Models” on page 2-30

. “Component Usage” on page 2-58

. “Evaluation of Model Component Names in Expressions” on page 2-61
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Events in SimBiology Models

2-30

In this section...

“Overview” on page 2-30

“Event Triggers” on page 2-30

“Event Functions” on page 2-31

“Specifying Event Triggers” on page 2-31

“Specifying Event Functions” on page 2-33

“Simulation Solvers for Models Containing Events” on page 2-34
“How Events Are Evaluated” on page 2-34

“Evaluation of Simultaneous Events” on page 2-36
“Evaluation of Multiple Event Functions” on page 2-37
“When One Event Triggers Another Event” on page 2-37
“Cyclical Events” on page 2-38

“Using Events to Address Discontinuities in Rule and Reaction Rate Expressions” on
page 2-38

Overview

In SimBiology, an event is a discrete transition in value of a quantity or expression in a
model. This discrete transition occurs when a customized condition becomes true. The
condition can be a specific time and/or a time-independent condition. Such conditions are
defined in an Event object.

Event Triggers

An event object has a Trigger property that specifies a condition that must be true to
trigger the event to execute.

Typical event triggers are:

* A specific simulation time — Specify that the event must change the amounts or values
of species or parameters. For example, at time = 5 s, increase the amount of an
inhibitor species above the threshold to inhibit a given reaction.
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* Inresponse to state or changes in the system — Change amounts/values of certain
species/parameters in response to events that are not tied to any specific time. For
example, when species A reaches an amount of 30 molecules, double the value of
reaction rate constant k. Or when temperature reaches 42 °C, inhibit a particular
reaction by setting its reaction rate to zero.

Note Currently, events cannot be triggered at time = 0. However, you can get the event
to happen just after time = 0 by using time > timeSmall as the event trigger where
timeSmall can be a tiny fraction of a second such as 1.0 picosecond.

Event Functions

An event has an EventFcns property that specifies what occurs when the event is
triggered. Event functions can range from simple to complex. For example, an event
function might:

* Change the values of compartments, species, or parameters.
* Double the value of a reaction rate constant.

Specifying Event Triggers

The Trigger property of an event specifies a condition that must become true for an
event to execute. Typically, the condition uses a combination of relational and logical
operators to build a trigger expression.

A trigger can contain the keyword time and relational operators to trigger an event that
occurs at a specific time during the simulation. For example, time >= X. For more
information see the Trigger property.

Use MATLAB syntax to write expressions for event triggers. Note that the expression
must be a single MATLAB statement that returns a logical. No semicolon or comma is
needed at the end of an expression. MATLAB uses specific operator precedence to
evaluate trigger expressions. Precedence levels determine the order in which MATLAB
evaluates an expression. Within each precedence level, operators have equal precedence
and are evaluated from left to right. To find more information on how relational and
logical operators are evaluated see “Relational Operations” (MATLAB) and “Logical
Operations” (MATLAB).

Some examples of triggers are:
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Trigger

Explanation

(time >= 5) && (speciesA <
1000)

Execute the event when the following condition
becomes true:

Time is greater than or equal to 5, and
speciesA is less than 1000.

Tip Using a && (instead of &) evaluates the
first part of the expression for whether the
statement is true or false, and skips evaluating
the second statement if this statement is false.

(time >= 5) || (speciesA <
1000)

Execute the event when the following condition
becomes true:

Time is greater than or equal to 5, or if
speciesA is less than 1000.

(sl >= 10.0) || (time >= 250)
&& (s2 < 5.0E17)

Execute the event when the following condition
becomes true:

Species, sl is greater than or equal to 10.0 or,
time is greater than or equal to 250 and
species s2 is less than 5.0E17.

Because of operator precedence, the
expression is treated as if it were (sl
>=10.0) || ((time>= 250) &&
(s2<5.0E17)).

Thus, it is always a good idea to use
parenthesis to explicitly specify the intended
precedence of the statements.

((sl >= 10.0) ||
&& (s2 < 5.0E17)

(time >= 250))

Execute the event when the following condition
becomes true:

Species s1 is greater than or equal to 10 or
time is greater than or equal to 250, and
species s2 is less than 5.0E17.
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Trigger Explanation
((sl >= 5000.0) && (time >= Execute the event when the following condition
250)) || (s2 < 5.0E17) becomes true:

Species s1 is greater than or equal to 5000
and time is greater than or equal to 250, or
species s2 is less than 5.0E17.

Tip If UnitConversion is on and your model has any event, follow the recommendation
below.

Non-dimensionalize any parameters used in the event Trigger if they are not already
dimensionless. For example, suppose you have a trigger x > 1, where x is the species
concentration in mole/liter. Non-dimensionalize x by scaling (dividing) it with a constant
such as x/x0 > 1, where x0 is a parameter defined as 1.0 mole/liter. Note that x does not
have to have the same unit as the constant x0, but must be dimensionally consistent with
it. For example, the unit of x can be picomole/liter instead of mole/liter.

Specifying Event Functions

The EventFcns property of an event specifies what occurs when the event is triggered.
You can use an event function to change the value of a compartment, species, or
parameter, or you can specify complex tasks by calling a custom function or script.

Use MATLAB syntax to define expressions for event functions. The expression must be a
single MATLAB assignment statement that includes =, or a cell array of such statements.
No semicolon or comma is needed at the end of the expression.

Following are rules for writing expressions for event functions:

EventFcn Explanation

speciesA = speciesB When the event is executed, set the amount of
speciesA equal to that of speciesB.

k = k/2 When the event is executed, halve the value of the
rate constant k.
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EventFcn Explanation

{'speciesA = speciesB', 'k = |When the event is executed, set the amount of
k/2'} speciesA equal to that of speciesB, and halve the
value of the rate constant k.

kC = my func(A,B,kC) When the event is executed, call the custom
function my_func (). This function takes three
arguments: The first two arguments are the current
amounts of two species (A and B) during simulation
and the third argument is the current value of a
parameter, kC. The function returns the modified
value of kC as its output.

Simulation Solvers for Models Containing Events
To simulate models containing events, use a deterministic (ODE or SUNDIALS) solver or

the stochastic ssa solver. Other stochastic solvers do not support events. For more
information, see “Choosing a Simulation Solver” on page 4-7.

How Events Are Evaluated

Consider the example of a simple event where you specify that at 4s, you want to assign a
value of 10 to species A.
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At time = 4 s the trigger becomes true and the event executes. In the previous figure
assuming that 0 is false and 1 is true, when the trigger becomes true, the amount of
species A is set to 10. In theory, with a perfect solver, the event would be executed exactly
at time = 4.00 s. In practice there is a very minute delay (for example you might
notice that the event is executed at time = 4.00001 s). Thus, you must specify that the
trigger can become true at or after 4s, which is time >= 4 s.

Trigger EventFcn
time >= 4 A =10

The point at which the trigger becomes true is called a rising edge. SimBiology events
execute the EventFcn only at rising edges.

The trigger is evaluated at every time step to check whether the condition specified in the
trigger transitions from false to true. The solver detects and tracks falling edges, which is
when the trigger becomes false, so if another rising edge is encountered, the event is

reexecuted. If a trigger is already true before a simulation starts, then the event does not
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execute at the start of the simulation. The event is not executed until the solver
encounters a rising edge. Very rarely, the solver might miss a rising edge. An example of
this is when a rising edge follows very quickly after a falling edge, and the step size
results in the solver skipping the transition point.

If the trigger becomes true exactly at the stop time of the simulation, the event might or
might not execute. If you want the event to execute, increase the stop time.

Note Since the rising edge is instantaneous and changes the system state, there are two
values for the state at the same time. The simulation data thus contains the state before
and after the event, but both points are at the same time value. This leads to multiple
values of the system state at a single instant in time.

Evaluation of Simultaneous Events

When two or more trigger conditions simultaneously become true, the solver executes the
events sequentially in the order in which they are listed in the model. You can reorder
events using the reorder method. For example, consider this case.

Event Trigger EventFcn
Number

1 SpeciesA >= 4 SpeciesB = 10
2 SpeciesC >= 15 SpeciesB = 25

The solver tries to find the rising edge for these events within a certain level of tolerance.
If this results in both events occurring simultaneously, then the value of SpeciesB after
the time step in which these two events occur, will be 25. If you reorder the events to
reverse the event order, then the value of SpeciesB after the time step in which these
two events occur, will be 10.

Consider an example in which you include event functions that change model components
in a dependent fashion. For example, the event function in Event 2, stipulates that
SpeciesB takes the value of SpeciesC.

Event Trigger EventFcn
Number
1 SpeciesA >= 4 SpeciesC = 10
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Event Trigger EventFcn
Number
2 time >= 15 SpeciesB = SpeciesC

Event 1 and Event 2 might or might not occur simultaneously.

+ IfEvent 1 and Event 2 do not occur simultaneously, when Event 2 is triggered,
SpeciesB is assigned the value that SpeciesC has at the time of the event trigger.

+ IfEvent 1 and Event 2 occur simultaneously, the solver executes Event 1 first, then
executes Event 2. In this example, if SpeciesC = 15 when the events are triggered,
after the events are executed, SpeciesC = 10 and SpeciesB = 10.

Evaluation of Multiple Event Functions

Consider an event function in which you specify that the value of a model component
(SpeciesB) depends on the value of model component (SpeciesA), but SpeciesA also is
changed by the event function.

Trigger EventFcn

time >= 4 {'SpeciesA = 10, SpeciesB = SpeciesA'}

The solver stores the value of SpeciesA at the rising edge and before any event functions
are executed and uses this stored value to assign SpeciesB its value. So in this example
if SpeciesA = 15 at the time the event is triggered, after the event is executed,
SpeciesA = 10 and SpeciesB = 15.

When One Event Triggers Another Event

In the next example, Event 1 includes an expression in the event function that causes
Event 2 to be triggered (assuming that SpeciesA has amount less than 5 when Event 1 is
executed).

Event Trigger EventFcn

Number

1 time >= 5 {'SpeciesA = 10, SpeciesB = 5'}
2 SpeciesA >= 5 SpeciesC = SpeciesB

When Event 1 is triggered, the solver evaluates and executes Event 1 with the result that
SpeciesA = 10 and SpeciesB = 5. Now, the trigger for Event 2 becomes true and the
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solver executes the event function for Event 2. Thus, SpeciesC = 5 at the end of this
event execution.

You can thus have event cascades of arbitrary length, for example, Event 1 triggers Event
2, which in turn triggers Event 3, and so on.

Cyclical Events

In some situations, a series of events can trigger a cascade that becomes cyclical. Once
you trigger a cyclical set of events, the only way to stop the simulation is by pressing Ctrl
+C. You lose any data acquired in the current simulation. Here is an example of cyclical
events. This example assumes that Species B <= 4 at the start of the cycle.

Event Trigger EventFcn

Number

1 SpeciesA > 10 {'SpeciesB = 5', 'SpeciesC = 1'}
2 SpeciesB > 4 {'SpeciesC = 10', 'SpeciesA = 1'}
3 SpeciesC > 9 {'SpeciesA = 15', 'SpeciesB = 1'}

Using Events to Address Discontinuities in Rule and Reaction
Rate Expressions

The solvers provided with SimBiology gives inaccurate results when the following
expressions are not continuous and differentiable:

* Repeated assignment rule

* Algebraic rule

* Raterule

* Reaction rate

Either ensure that the previous expressions are continuous and differentiable or use

events to reset the solver at the discontinuity, as described in “Deterministic Simulation of
a Model Containing a Discontinuity”.



See Also

See Also

More About

. “What is a SimBiology Model?” on page 2-2

. “Definitions and Evaluations of Reactions in SimBiology Models” on page 2-10
. “Definitions and Evaluations of Rules in SimBiology Models” on page 2-17

. “Component Usage” on page 2-58

. “Evaluation of Model Component Names in Expressions” on page 2-61
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A variant stores alternate values of model parameters and initial conditions. You can use
variants to evaluate model behavior under different experimental or initial conditions,
without having to change the existing values or create additional models with the new
values.

A variant lets you store an alternate value for any of the following model elements:

* Compartment Capacity property
* Species InitialAmount property
» Parameter Value property

Simulating using a variant does not alter the model original values. The values specified
in the variant are temporarily applied to the model during simulation. You can
permanently replace the values in your model with the values stored in the variant object
by committing it to the model. When you use multiple variants during a simulation, and
there are duplicate specifications for a property value, the last occurrence for the
property value in the array of variants is used during simulation.

Creating Variants Programmatically

There are two ways to create variants or add variants to a model. To create a standalone
variant that is not attached to any model, use sbiovariant. To add a variant to an
existing model, use addvariant. Use the commit function to replace the values in your
model with the variant values permanently.

For illustrated examples of using variants, see the following.

* “Simulate Biological Variability of the Yeast G Protein Cycle Using the Wild-Type and
Mutant Strains” on page 2-47

* “Simulate Model of Glucose-Insulin Response with Different Initial Conditions” on
page 3-22

Creating Variants Graphically

You can interactively create and add variants using the SimBiology app. For details, see
“Diagram View” on page 1-4.



See Also

See Also

Variant object | addcontent | addvariant | commit | sbiovariant

More About
. “SimBiology Apps”
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Doses let you increase the amount of a species in a SimBiology model during simulation,
either at specific time points or regular intervals. For example, you can use a dose object
to model an instantaneous supply of a drug regimen during the simulation of a model. The
increase in the amount of a species occurs only during simulation and does not alter the
species value permanently (that is, the value in the model is not changed).

Representing Doses

There are two types of dose objects.

* ScheduleDose object — Applies a dose to a single species at a predefined list of
time points

* RepeatDose object — Applies a dose to a single species at regular intervals

SimBiology dose objects support the following dosing types.

Dosing |Description Dose Object Properties
Strate Configuration
gy
Bolus |Instantaneous increase in the amount of |To create a bolus dose, set the
drug in the compartment Amount and TargetName properties

of a dose object. You might also
need to configure other properties
such as RepeatCount, Interval, or
scheduled dose times (Time) if you
are applying a series of doses. For
details on these properties, see
ScheduleDose object and
RepeatDose object.

Infusio |Increase of the drug at a fixed rate over a |Unlike a bolus dose, you also need
n period of time, which is calculated from to specify the infusion rate (Rate

the dose amount property) of the dose object.
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Dosing |Description Dose Object Properties

Strate Configuration

gy

Zero- |Increase of the drug at a fixed rate Unlike a bolus dose, you also need

order |calculated from the dose amount and dose |to create a zero-order duration
duration parameter and specify the duration

parameter name
(DurationParameterNamepropert
y) of the dose object.

First- |Increase of the drug via first-order Unlike bolus, infusion, or zero-

order |absorption kinetics order, you need to create an
additional reaction for the drug
absorption.

Creating Doses Programmatically

There are two common ways to create dose objects using the command-line interface.
One way is to create a dose object using the sbiodose or adddose function. Another is
to create dose objects automatically from data containing dosing information. This first
approach is useful when you want to explore different dosing strategies through
simulation. The second approach is useful if you already have a data set with dosing
information and plan to use this dosing information in your simulation or parameter
estimation.

Create a Dose Object Using shiodose or adddose

sbiodose creates a standalone dose object that is not attached to any model. You can
apply a standalone dose to different models during simulation by specifying it as a dosing
argument for sbiosimulate, or attach it to any model using adddose. You can also use
it during parameter estimation using sbiofit or shiofitmixed.

adddose creates a dose object and adds it to a model. You must set its Active property
to true to apply the dose to the model during simulation.

The following examples show how to add a dose object to a one-compartment PK model
using sbiodose and set up the dose properties manually. Alternatively, you can use the
built-in PK models with different dosing types. For details, see “Create Pharmacokinetic
Models” on page 5-14.
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Dosing Strategy Example

Bolus “Add a Series of Bolus Doses to a One-Compartment Model”
Infusion “Add an Infusion Dose to a One-Compartment Model”
Zero-order “Increase Drug Concentration in a One-Compartment Model

via Zero-order Dosing”

First-order “Increase Drug Concentration in a One-Compartment Model

via First-order Dosing”

Create Dose Objects from Dosing Data

If you already have dosing data for one or more subjects or patients that you would like to
use in your parameter estimation, first create a groupedData object from your data
set. Use createDoses function to automatically generate an array of dose objects. You
can then use the dose array during parameter estimation using sbiofit or
sbiofitmixed. For a complete workflow, see “Modeling the Population
Pharmacokinetics of Phenobarbital in Neonates”.

Creating Doses Graphically

You can interactively create and add doses using the SimBiology app. For details, see
“Diagram View” on page 1-4.

Parameterized and Adaptive Doses

You can specify some of the properties of RepeatDose and ScheduleDose objects by
using model parameters. This parameterization of dose properties gives you more
flexibility in modeling different dosing applications, such as scaling the dose amount by
body weight.

RepeatDose properties that you can parameterize are: Amount, Rate, Interval,
StartTime, RepeatCount, LagParameterName, and DurationParameterName.
ScheduleDose properties that can be parameterized are LagParameterName and
DurationParameterName. You can set these RepeatDose properties, except
LagParameterName and DurationParameterName, to either a numeric value or the
name of a model-scoped parameter (as a character vector or string).

You can make doses adaptive to events, such as increasing the dose amount when the
drug concentration drops below some threshold. This adaptive feature of doses is useful
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for doses that are not instantaneous. Consider an IV infusion for a drug being added at a
fixed rate over a fixed duration. If an event modifies a dose parameter while this dose is in
progress, you have two options:

* Stop the ongoing dose if any relevant parameter values change by setting the
EventMode property of the dose object to 'stop"'.

* Continue the ongoing dose to completion, and updated parameter values affect only
subsequent doses by setting EventMode to 'continue’.

For details, see the EventMode property. For illustrated examples, see “Scale Dose
Amount by Body Weight” and “Change Dose Behavior In Response to Changes in Model
Parameters”.

Units Validation on Parameterized Dose Properties

If you parameterize a dose property and enable dimensional analysis, the unit of the dose
property (dose unit) is validated. The dose unit is valid either if it is empty or if it exactly
matches the unit of the parameter. If the dose unit is invalid, SimBiology issues a warning
in the command line and uses the unit of the parameter instead. To remove the warning,
set the dose unit to empty (' ') or to the same unit as the parameter unit.

In the SimBiology app, the text (unused) appears next to the corresponding unit field in
the Block Property Editor or Doses tab, meaning that SimBiology is using the
parameter unit instead of the dose unit during simulation. For example, this figure shows
the details of the repeat dose object param _dose in the Block Property Editor. The
TimeUnits option is designated as unused. Instead, SimBiology uses the unit of the
parameter StartTimeParam during simulation. The Amount and Rate properties are not
parameterized, and hence the selected AmountUnits and RateUnits options are used.
To see the units of referenced parameters, click the indicator next to the corresponding
property. The TimeUnits option corresponds to both the StartTime and Interval
properties.
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Block Property Editor

Mame: Type:

param_dose repeat
[ TargetName:

z

[0 DuraticnParameterMame:
TDur

[ LagParameterName:
TLag

Event Mode:

stop

[ StartTimes TimelUnits: (unused)
StartTimeParam second w o] o] e} (o] s}

[ Amount: AmountUnits:

10.0 milligram ~

[ Rate: Ratellnits:

0.0 milligram/second

[ Interval: 3

IntervalParam
0 1 . 1 1 . 1

[ RepeatCount:

RepeatCountParam

Amoaunt

Simulation Solvers for Models Containing Doses

To simulate models containing doses, use a deterministic (ODE or SUNDIALS) solver.

Stochastic solvers do not support doses. For details, see “Choosing a Simulation Solver”
on page 4-7.

See Also

RepeatDose object | ScheduleDose object | adddose | sbiodose

More About
. “SimBiology Apps”
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Simulate Biological Variability of the Yeast G Protein
Cycle Using the Wild-Type and Mutant Strains

This example shows how to create and apply a variant to the G protein model of a wild-
type strain. The variant represents a parameter value for the G protein model of a mutant
strain. Thus, when you simulate the model without applying the variant, you see results
for the wild type strain, and when you simulate the model with the variant, you see results
for the mutant strain. This example uses the model described in Model of the Yeast
Heterotrimeric G Protein Cycle on page B-17.

The value of the parameter kGd is 0. 11 for the wild-type strain and 0. 004 for the mutant
strain. To represent the mutant strain, you will store an alternate value of 0.004 for the
kGd parameter in a variant object, and apply this variant when simulating the model.

For information on variants, see “Variants in SimBiology Models” on page 2-40.

Load the gprotein.sbproj project, which includes the variable m1, a SimBiology model
object.

sbioloadproject gprotein

You can create a variant of the original model by specifying a different parameter value
for the kGd parameter of the model. First, add a variant to the m1 model object.

vl = addvariant(ml, 'mutant strain');

Next, add a parameter kGd with a value of 0.004 to the variant object v1.
addcontent(vl,{'parameter', 'kGd', 'Value',0.004});

Simulate the wild type model.

[t,x,names] = sbiosimulate(ml);

Simulate the mutant strain model by applying the variant.

[tV,xV,names] = sbiosimulate(ml,vl);

Plot and compare the simulated results.

subplot(1,2,1)

plot(t,x);
legend(names) ;
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xLlabel('Time");
ylabel('Amount');
title('Wild Type');

subplot(1,2,2)
plot(tV,xV);
legend(names) ;
xLlabel('Time");
ylabel('Amount');
title('Mutant Strain');
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Create and Simulate a Model with a Custom Function

This example shows how to create a custom function and incorporate it in model
simulation.

Overview
Prerequisites for the Example

This example assumes you have a working knowledge of:
* MATLAB app

* Creating and saving MATLAB programs

About the Example Model

This example uses the model described in Model of the Yeast Heterotrimeric G Protein
Cycle on page B-17.

This table shows the reactions used to model the G protein cycle and the corresponding
rate parameters (rate constants) for each reaction. For reversible reactions, the forward
rate parameter is listed first.

No. [Name Reaction? Rate
Parameters

Receptor-ligand interaction L + R <->RL kRL, KRLm

2 Heterotrimeric G protein Gd + Gbg -> G kG1
formation

3 G protein activation RL + G -> Ga + Gbg + RL kGa
Receptor synthesis and R <-> null kRdo, kRs
degradation

5 Receptor-ligand degradation |RL -> null kRD1

6 G protein inactivation Ga -> Gd kGd

! Legend of species: L = ligand (alpha factor), R = alpha-factor receptor, Gd = inactive

G-alpha-GDP, Gbg = free levels of G-beta:G-gamma complex, G = inactive Gbg:Gd

complex, Ga = active G-alpha-GTP
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Assumptions of the Example

This example assumes that:
* An inhibitor (Inhib species) slows the inactivation of the active G protein (reaction 6
above, Ga — Gd).

* The variation in the amount of inhibitor (Inhib species) is defined in a custom
function, inhibvalex.

* The inhibitor (Inhib species) affects the reaction by changing the amount of rate
parameter kGd.

About the Example

This example shows how to create and call a custom function in a SimBiology expression.
Specifically, it shows how to use a custom function in a rule expression.

About Using Custom Functions in SimBiology Expressions

You can use custom functions in:

* Reaction rate expressions (ReactionRate property)
* Rule expressions (Rule property)
* Event expressions (EventFcns property or Trigger property)

The requirements for using custom functions in SimBiology expressions are:

* Create a custom function. For more information, see function.

* Change the current folder to the folder containing your custom MATLAB file. Do this
by using the cd command or by using the Current Folder field in the MATLAB desktop
toolbar. Alternatively, add the folder containing your file to the search path. Do this by
using the addpath command or see “Change Folders on the Search Path” (MATLAB).

* Call the custom function in a SimBiology reaction, rule, or event expression.

Tip If your rule or reaction rate expression is not continuous and differentiable, see
“Using Events to Address Discontinuities in Rule and Reaction Rate Expressions” on page
2-38 before simulating your model.
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Create a Custom Function

The following procedure creates a custom function, inhibvalex, which lets you specify
how the inhibitor amount changes over time. The inputs are time, the initial amount of
inhibitor, and a parameter that governs the amount of inhibitor. The output of the function
is the amount of inhibitor.

1
2

In the MATLAB desktop, select File > New > Script, to open the MATLAB Editor.
Copy and paste the following function declaration:

% inhibvalex.m
function Cp = inhibvalex(t, Cpo, kel)

This function takes the input arguments t, Cpo, and kel

and returns the value of the inhibitor Cp.

You can later specify the input arguments in a

SimBiology rule expression.

For example in the rule expression, specify:

t as time (a keyword recognized as simulation time),

Cpo as a parameter that represents the initial amount of inhibitor,
and kel as a parameter that governs the amount of inhibitor.

o o o° o° o° o° o° o°

if t < 400
Cp = Cpo*exp(-kel*(t));
else
Cp = Cpo*exp(-kel*(t-400));
end
Save the file (name the file inhibvalex.m) in a directory that is on the MATLAB
search path, or to a directory that you can access.

If the location of the file is not on the MATLAB search path, change the working
directory to the file location.

Load the Example Model

Load the gprotein example project, which includes the variable m1, a model object:

sbioloadproject gprotein

The m1 model object appears in the MATLAB Workspace.
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Add the Custom Function to the Example Model

The following procedure creates a rule expression that calls the custom function,
inhibvalex, and specifies the three input values to this function.

1 Add a repeated assignment rule to the model that specifies the three input values to
the custom function, inhibvalex:

rulel = addrule(ml, 'Inhib = inhibvalex(time, Cpo, Kel)',...
'repeatedAssignment');
The time input is a SimBiology keyword recognized as simulation time
2 Create the two parameters used by the rulel rule and assign values to them:
pl addparameter(ml, 'Cpo', 250);
p2 addparameter(ml, 'Kel', 0.01);
3 Create the species used by the rulel rule:

sl = addspecies(ml.Compartments, 'Inhib');

Define a Rule to Change Parameter Value

The value of rate parameter kGd is affected by the amount of inhibitor present in the
system. Add a rule to the model to describe this action, but first change the
ConstantValue property of the parameter kGd so that it can be varied by a rule.

1 Change the ConstantValue property of the kGd parameter to false.

p3 = sbioselect(ml, 'Type', 'parameter', 'Name', 'kGd');
p3.ConstantValue = false;

2 Add a repeated assignment rule to the model to define how the kGd parameter is
affected by the Inhib species.

rule2 = addrule(ml, 'kGd = 1/Inhib', 'repeatedAssignment');

Add an Event to Reset the Solver at a Discontinuity

The custom function, inhibvalex, introduces a discontinuity in the model when time =
400. To ensure accurate simulation results, add an event to the model to reset the solver
at the time of the discontinuity. Set the event to trigger at the time of the discontinuity
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(time = 400). The event does not need to modify the model, so create an event function
that multiplies a species value by 1.

addevent(ml, 'time>=400', 'G=1*G');

Simulate the Modified Model

1 Configure the simulation settings (configset object) for the m1 model object to
log all states during the simulation.

cs = getconfigset(ml);
cs.RuntimeOptions.StatesToLog = 'all’;
2 Simulate the model.

simDataObj = sbiosimulate(ml);
3 Plot the results.

sbioplot(simDataObj);
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o!7 States versus Time = [¥] All Runs
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The plot does not show the species of interest due to the wide range in species
amounts/concentrations.
4 Plot only the species of interest. Ga.

GaSimDataObj = selectbyname(simDataObj, 'Ga');
sbioplot(GaSimDataObj);
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time). This is the time when the inhibitor amount is changed to reflect the re-addition

of inhibitor to the model.
Plot only the inhibitor (Inhib species).

InhibSimDataObj = selectbyname(simDataObj, 'Inhib');

sbioplot(InhibSimDataObj)
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More About
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View Model Equations

View Model Equations

You can view the system of equations that SimBiology creates when you build a model
using reactions, rules, events, variants, and doses. Viewing model equations is useful for:

* Publishing purposes
* Model debugging

For details, see the getequations method of a Model object or the “Equations View” on
page 1-27 from the SimBiology app.
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SimBiology lets you find species, parameters, and compartments that are not used in a
model. You can also query how a particular quantity is used by other expressions such as
a parameter being used as a reaction rate constant or species being used in an event.

From the command line, use the findUnusedComponents function to look for unused
model components and the findUsages function to see how a component is used in
expressions. From the SimBiology app on page 1-4, select Remove Unused on the
Model tab to delete unused quantities. To look for usages of a quantity, select Show
Usages.

Species Usage

A species is used when it is referenced in any of the following properties of other
components:
* The Reaction or ReactionRate property of a Reaction object,

* The ParameterVariableNames or SpeciesVariableNames property of a KineticLaw
object,

* The Rule property of a Rule object,
* The Trigger or EventFcns property of an Event object, and
» The TargetName property of a ScheduleDose object or RepeatDose object.

Parameter Usage

A parameter is used when it is referenced in any of the following properties of other
components:

* The ReactionRate property of a Reaction object,

* The ParameterVariableNames property of a KineticLaw object,

* The Rule property of a Rule object,

* The Trigger or EventFcns property of an Event object,

* The Content property of a Variant object, and

* The DurationParameterName or LagParameterName property of a ScheduleDose
object or RepeatDose object.
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* The Amount, Rate, Interval, StartTime, or RepeatCount property of a RepeatDose
object.

Compartment Usage

A compartment is used when it is referenced in any of the following properties of other
components:

* The Parent property of a Species object,

* The Owner property of a Compartment object,

* The ReactionRate property of a Reaction object,

* The ParameterVariableNames property of a KineticLaw object,

* The Rule property of a Rule object,

» The Trigger or EventFcns property of an Event object, and

* The Content property of a Variant object.

Unit and UnitPrefix Usage

A unit or unit prefix is used when it is referenced in any of the following properties of
other components:

* The Composition property of all units in the BuiltInLibrary and
UserDefinedLibrary,

* The InitialAmountUnits property of all species in the specified models,

* The CapacityUnits property of all compartments in the specified models,

* The ValueUnits property of all parameters in the specified models,

* The TimeUnits property of all specified doses,

* The AmountUnits property of all specified doses, and

* The RateUnits property of all specified doses.

Abstract Kinetic Law Usage

An abstract kinetic law object akiObj can only be used by a Reaction object robj. It is
used when:
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* The KineticLaw property of the reaction object is not empty, and

* robj.KineticlLaw.KineticLawName matches the name of the abstract kinetic law
akl0bj .Name.

See Also

findUnusedComponents | findUsages (AbstractKineticLaw) |
findUsages(species,parameter, compartment) |
findUsages(unit,unitprefix)

More About

. “What is a SimBiology Model?” on page 2-2

. “SimBiology Apps”

. “Model Views in SimBiology App” on page 1-4

. “Evaluation of Model Component Names in Expressions” on page 2-61
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Evaluation of Model Component Names in Expressions

SimBiology model components on page 2-2 include quantities and expressions. You can
refer to model quantities (compartments, species, and parameters) by their names in an
expression, such as a reaction or an assignment equation. Follow these guidelines when
you name model components or referencing their names in expressions. When evaluating
a name that matches different quantities, SimBiology resolves it by following precedence
rules.

Guidelines for Naming Model Components

* Model and parameter names cannot contain brackets [ ] and cannot be empty, the
word time, or all whitespace.

* Compartment and species names cannot contain the characters ->, <->, [ or ] and
cannot be empty, the word null, or the word time. However, a name can contain the
words null and time within the name, such as nullDrug.

* Reaction, event, and rule names cannot contain brackets [ ] and cannot be the word
time.

Guidelines for Referencing Names in Expressions

« If the quantity name is not a valid MATLAB variable name, you must enclose the name
in brackets when referring to it in an expression. For example, if the name of a species
is DNA polymerase+, write [DNA polymerase+].

» If you have multiple species with the same name in different compartments, you must
qualify the name by referring to the name of the compartment that contains the
species. For example, the qualified name nucleus. [DNA polymerase+] refers to
the DNA polymerase+ species that resides in the nucleus compartment.

Precedence Rules for Evaluating Quantity Names
If a name referenced in an expression matches multiple quantities, SimBiology evaluates

the expression using precedence rules. The rules depend on whether the name is
referenced in a reaction or other expressions that are not reactions.
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For Reactions

When a reaction refers to a name that matches different quantities, SimBiology evaluates
the name as the first quantity with a matching name in this order: species, parameter
scoped to the reaction, compartment, or parameter scoped to the model.

For Other Expressions

There are different types of expressions that are not reactions, namely rules and events.
Rules include initial and repeated assignment equations, algebraic equations, and
differential rate equations. An event contains expressions that represent an event trigger
and one or more event functions to model discrete transitions in the values of quantities
or expressions in the model.

When a nonreaction expression refers to a name that matches different quantities,
SimBiology evaluates the name as the first quantity with a matching name in this order:
species, compartment, or parameter scoped to the model.

See Also

Name

More About

. “What is a SimBiology Model?” on page 2-2

. “Definitions and Evaluations of Reactions in SimBiology Models” on page 2-10
. “Definitions and Evaluations of Rules in SimBiology Models” on page 2-17

. “Events in SimBiology Models” on page 2-30

. “Component Usage” on page 2-58
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* “Model Verification” on page 3-2

* “Conserved Moiety Determination” on page 3-4

* “Determining Conserved Moieties” on page 3-7

* “Determining the Adjacency Matrix for a Model” on page 3-10

* “Determining the Stoichiometry Matrix for a Model” on page 3-12

» “Selecting Absolute Tolerance and Relative Tolerance for Simulation” on page 3-15
* “Troubleshooting Simulation Problems” on page 3-18

» “Simulate Model of Glucose-Insulin Response with Different Initial Conditions”
on page 3-22

* “Combine Simulation Scenarios in SimBiology” on page 3-29
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Model Verification

3-2

In this section...

“What is Model Verification?” on page 3-2
“When to Verify a Model” on page 3-2
“Verifying That a Model Has No Warnings or Errors” on page 3-3

“Model Verification Example” on page 3-3

What is Model Verification?

SimBiology has functionality that helps you find and fix warnings that you might need to
be aware of, and errors that would prevent you from simulating and analyzing your
model.

Model verification checks many aspects of the model including:

* Model structure

+ Validity of mathematical expressions
* Dimensional analysis

* Unit conversion issues

When to Verify a Model

You can check your model for warnings and errors at any time when constructing or
working with your model. For example:

* Verify your model during construction to ensure that the model is complete.

» Verify the model after changing simulation settings, dimensional analysis settings, or
unit conversion settings.

Analyses such as simulation, scanning, and parameter fitting automatically verify a model.

Tip Repeatedly running a task using a different variant or setting a different value for the
InitialAmount property of a species, the Capacity property of a compartment, or the
Value property of a parameter, generates warnings only the first time you simulate a
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model. Use the verification functionality described in this section to display warnings
again.

Verifying That a Model Has No Warnings or Errors
Use the verify method to see a list of warnings and errors in your model.

Use the sbiolastwarning and sbiolasterror functions to return the last warning
and last error encountered during verification.

Model Verification Example

1 Create a model with a reaction that references K1, an undefined parameter:

% Create a model named example

model = sbiomodel('example');

% Add a compartment named cell to model

compartment = addcompartment(model, 'cell');

% Add two species, A and B, to the cell compartment

species 1 = addspecies(compartment, 'A');

species 2 = addspecies(compartment, 'B');

% Add the reaction A -> B to the model

reaction = addreaction(model, 'A -> B', 'ReactionRate', 'Kl1l');

2 Verify the model to check for warnings and errors:
verify(model)
??? --> Error reported from Expression Validation:

The name 'K1' in reaction 'A -> B' does not refer to any in-scope species,
parameters, or compartments.

3  Address the error by defining the parameter K1:

% Add a parameter, K1, to the model with a value of 3
parameter = addparameter(model, 'K1', 3);

4 Verify the model again:

verify(model)

3-3
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Conserved Moiety Determination

3-4

In this section...

“Introduction to Moiety Conservation” on page 3-4
“Algorithms for Conserved Cycle Calculations” on page 3-4
“More About” on page 3-6

Introduction to Moiety Conservation

Conserved moieties represent quantities that are conserved in a system, regardless of the
individual reaction rates.

Consider this simple network:

reaction 1: A -> B
reaction 2: B -> C
reaction 3: C -> A

Regardless of the rates of reactions 1, 2, and 3, the quantity A + B + Cis conserved
throughout the dynamic evolution of the system. This conservation is termed structural
because it depends only on the structure of the network, rather than on details such as
the kinetics of the reactions involved. In the context of systems biology, such a conserved
quantity is sometimes referred to as a conserved moiety. A typical, real-world example of
a conserved moiety is adenine in its various forms ATP, ADP, AMP, etc. Finding and
analyzing conserved moieties can yield insights into the structure and function of a
biological network. In addition, for the quantitative modeler, conserved moieties
represent dependencies that can be removed to reduce a system’s dimensionality, or
number of dynamic variables. In the previous simple network, in principle, it is only
necessary to calculate the time courses for A and B. After this is done, C is fixed by the
conservation relation.

Algorithms for Conserved Cycle Calculations

The sbioconsmoiety function analyzes conservation relationships in a model by
calculating a complete set of linear conservation relations for the species in the model
object.

sbioconsmoiety lets you specify one of three algorithms based on the nature of the
model and the required results:
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* 'gqr' — sbioconsmoiety uses an algorithm based on QR factorization. From a
numerical standpoint, this is the most efficient and reliable approach.

* 'rreduce' — sbioconsmoiety uses an algorithm based on row reduction, which
yields better numbers for smaller models. This is the default.

* 'semipos' — sbioconsmoiety returns conservation relations in which all the
coefficients are greater than or equal to zero, permitting a more transparent
interpretation in terms of physical quantities.

For larger models, the QR-based method is recommended. For smaller models, row
reduction or the semipositive algorithm may be preferable. For row reduction and QR
factorization, the number of conservation relations returned equals the row rank
degeneracy of the model object's stoichiometry matrix. The semipositive algorithm can
return a different number of relations. Mathematically speaking, this algorithm returns a
generating set of vectors for the space of semipositive conservation relations.

In some situations, you may be interested in the dimensional reduction of your model via
conservation relations. Recall the simple model, presented in “Introduction to Moiety
Conservation” on page 3-4, that contained the conserved cycle A + B + C. Given A and
B, C is determined by the conservation relation; the system can be thought of as having
only two dynamic variables rather than three. The 'link"' algorithm specification caters
to this situation. In this case, sbioconsmoiety partitions the species in the model into
independent and dependent sets and calculates the dependence of the dependent species
on the independent species.

Consider a general system with an n-by-m stoichiometry matrix N of rank k, and suppose

that the rows of N are permuted (which is equivalent to permuting the species ordering)

so that the first k rows are linearly independent. The last n - k rows are then necessarily
dependent on the first k rows.

The matrix N can be split into the following independent and dependent parts,

N =

NR
ND

where R in the independent submatrix Ny denotes 'reduced’; the (n - k)-by-k link matrix
LO is defined so that N, = LO*Ng. In other words, the link matrix gives the dependent
rows Np of the stoichiometry matrix, in terms of the independent rows Ng. Because each
row in the stoichiometry matrix corresponds to a species in the model, each row of the
link matrix encodes how one dependent species is determined by the k independent
species.



3 Sstructural Analysis

More About

For examples of determining conserved moieties, see:

* “Determining Conserved Moieties” on page 3-7
* “Finding Conserved Quantities in a Pathway Model”

3-6
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Determining Conserved Moieties

1

3

Load the Goldbeter Mitotic Oscillator project, which includes the variable m1, a
model object:

sbioloadproject Goldbeter Mitotic Oscillator with reactions

The m1 model object appears in the MATLAB Workspace.
Display the species information:

ml.Compartments.Species

SimBiology Species Array

Index: Compartment: Name: InitialAmount: InitialAmountUnits:

1 unnamed C 0.01
2 unnamed M 0.01
3 unnamed Mplus 0.99
4 unnamed Mt 1
5 unnamed X 0.01
6 unnamed Xplus 0.99
7 unnamed Xt 1
8 unnamed V1 0
9 unnamed V3 0
10 unnamed AA 0
Display the reaction information:
ml.Reactions
SimBiology Reaction Array
Index: Reaction:
1 AA -> C
2 C -> AA
3 C+ X ->AA + X
4 Mplus + C -> M + C
5 M -> Mplus
6 Xplus + M -> X + M
7 X -> Xplus

Use the simplest form of the sbioconsmoiety function and display the results. The
default call to sbhioconsmoiety, in which no algorithm is specified, uses an
algorithm based on row reduction.

[g sp] = sbioconsmoiety(ml)



3 Sstructural Analysis

3-8

[cRoNo)
[cRoN=
[cRo =
=
[
oo

sp =

c
M
'Mplus'
Y
'Xplus'
TAA

The columns in g are labeled by the species sp. Thus the first row describes the
conserved relationship, M + Mplus. Notice that the third row indicates that the
species AA is conserved, which is because AA is constant (ConstantAmount = 1).

Call sbioconsmoiety again, this time specifying the semipositive algorithm to
explore conservation relations in the model. Also specify to return the conserved
moieties in a cell array of character vectors, instead of a matrix.

cons_rel = sbioconsmoiety(ml, 'semipos','p"')

cons_rel

IAAI
'X + Xplus'
'M + Mplus'

Use the 'link"' option to study the dependent and independent species.

[SI,SD,LO,NR,ND] = sbioconsmoiety(ml, 'link');
Show the list of independent species:

SI

SI =
ct
™!
'

Show the list of dependent species:
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10

11

SD

SD =
'Mplus'
'Xplus'
IAAI

Show the link matrix relating SD and SI by converting the LO output from a sparse
matrix to a full matrix:

LO full = full(LO)

Lo full =
0 -1.0000 0
0 0 -1.0000
0 0 0

Show the independent stoichiometry matrix, Ng by converting the NR output from a
sparse matrix to a full matrix:

NR full = full(NR)

NR full =
1 -1 -1 0 0 0 0
0 0 0 1 -1 0 0
0 0 0 0 0 1 -1

Show the dependent stoichiometry matrix, Np by converting the ND output from a
sparse matrix to a full matrix:

ND full = full(ND)
ND_full =
0 0 o -1 1 0 0
0 0 0 0 o -1 1
0 0 0 0 0 0 0

3-9
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Determining the Adjacency Matrix for a Model

3-10

In this section...

“What Is an Adjacency Matrix?” on page 3-10

“Retrieving an Adjacency Matrix for a Model” on page 3-10

What Is an Adjacency Matrix?

An adjacency matrix lets you easily determine:

* The reactants and products in a specific reaction in a model

* The reactions that a specific species is part of, and whether the species is a reactant or
product in that reaction

An adjacency matrix is an N-by-N matrix, where N equals the total number of species and
reactions in a model. Each row corresponds to a species or reaction, and each column
corresponds to a species or reaction.

The matrix indicates which species and reactions are involved as reactants and products:
* Reactants are represented in the matrix with a 1 at the appropriate location (row of

species, column of reaction). Reactants appear above the diagonal.

* Products are represented in the matrix with a 1 at the appropriate location (row of
reaction, column of species). Products appear below the diagonal.

o All other locations in the matrix contain a 0.

For example, if a model object contains one reaction equalto A + B -> C and the
Name property of the reaction is R1, the adjacency matrix is:

A B C Rl
A 0 0 0 1
B 0 0 0 1
C 0 0 0 0
Rl © 0 1 0

Retrieving an Adjacency Matrix for a Model

Retrieve an adjacency matrix for a model by passing the model object as an input
argument to the getadjacencymatrix method.
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Read in m1, a model object, using sbmlimport:

ml = sbmlimport('lotka.xml");

Get the adjacency matrix for m1:

[M, Headings] = getadjacencymatrix(ml)

M =

~ e~~~ o~~~ o~ —~
WWNNRERENO UL,
Noouuhsh WN =
—_— — — — — — — — ~—

Headings

X
|y1|
|y2|
|Z|

'Reactionl!
'Reaction?2’
'Reaction3"

N e e

Convert the adjacency matrix from a sparse matrix to a fTull matrix to more easily

see the relationships between species and reactions:

M full

M full

[oNol SR oNoNoNo]

full(M)

[cNoR NoNoNoNo]

[cl S NoNoNoNoNO]

HPOOOOOO

[cNoNoNo NN N

[cNoNoNoN N N o]

[cNoNoNoN DNoNO]
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Determining the Stoichiometry Matrix for a Model

In this section...

“What Is a Stoichiometry Matrix?” on page 3-12

“Retrieving a Stoichiometry Matrix for a Model” on page 3-13

What Is a Stoichiometry Matrix?

A stoichiometry matrix lets you easily determine:

* The reactants and products in a specific reaction in a model, including the
stoichiometric value of the reactants and products

» The reactions that a specific species is part of, and whether the species is a reactant or
product in that reaction

A stoichiometry matrix is an M-by-R matrix, where M equals the total number of species
in a model, and R equals the total number of reactions in a model. Each row corresponds
to a species, and each column corresponds to a reaction.

The matrix indicates which species and reactions are involved as reactants and products:

* Reactants are represented in the matrix with their stoichiometric value at the
appropriate location (row of species, column of reaction). Reactants appear as
negative values.

* Products are represented in the matrix with their stoichiometric value at the
appropriate location (row of species, column of reaction). Products appear as positive
values.

* All other locations in the matrix contain a 0.
For example, consider a model object containing two reactions. One reaction (named

Rl)isequalto2 A + B -> 3 (, and the other reaction (named R2) isequaltoB + 3 D
-> 4 A. The stoichiometry matrix is:

Rl R2
A -2 4
B -1 -1
C 3 0
D 0 -3

3-12
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Retrieving a Stoichiometry Matrix for a Model

Retrieve a stoichiometry matrix for a model by passing the model object as an input
argument to the getstoichmatrix method.

1 Read in ml, a model object, using sbmlimport:

ml = sbmlimport('lotka.xml");
2 Get the stoichiometry matrix for m1:

[M,objSpecies,objReactions] = getstoichmatrix(ml)

M =
(2,1) 1
(212) ‘1
(3,2) 1
(313) ‘1
(4,3) 1

objSpecies =

IXI

Iyll

Iy2I

IZI
objReactions =

'Reactionl’

'Reaction2’

'Reaction3’

3 Convert the stoichiometry matrix from a sparse matrix to a full matrix to more
easily see the relationships between species and reactions:

M _full = full(M)

M full =
0 0 0
1 -1 0

3-13
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Selecting Absolute Tolerance and Relative Tolerance for
Simulation

In this section...

“Algorithm” on page 3-15

“Absolute Tolerance Scaling” on page 3-16

SimBiology uses AbsoluteTolerance and RelativeTolerance to control the accuracy of
integration during simulation. Specifically, AbsoluteTolerance is used to control the
largest allowable absolute error at any step during simulation. It controls the error when
a solution is small. Intuitively, when the solution approaches 0, AbsoluteTolerance is
the threshold below which you do not worry about the accuracy of the solution since it is
effectively 0. RelativeTolerance controls the relative error of a single step of the
integrator. Intuitively, it controls the number of significant digits in a solution, except
when it is smaller than the absolute tolerance, and —logqg(RelativeTolerance) is the

number of correct digits.

Algorithm

At each simulation step i, the solver estimates the local error e in the state j of the
simulation. The solver reduces the size of time step i until the error of the state satisfies:

le(i, j)| = max(RelativeTolerance * |y(i, j)|, AbsoluteTolerance(i, j))

Thus at state values of larger magnitude, the accuracy is determined by
RelativeTolerance. As the state values approach zero, the accuracy is controlled by
AbsoluteTolerance.

The correct choice of values for RelativeTolerance and AbsoluteTolerance varies
depending on the problem. The default values may work for first trials of the simulation.
As you adjust the tolerances, consider that there are trade-offs between speed and
accuracy:

» If the simulation takes too long, you can increase (or loosen) the values of
RelativeTolerance and AbsoluteTolerance at the cost of some accuracy.

» If the results seem inaccurate, you can decrease (or tighten) the relative tolerance
values by dividing with 10N, where N is a real positive number. But this tends to slow
down the solver.

3-15
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+ If the magnitude of the state values is high, you can decrease the relative tolerance to
get more accurate results.

Absolute Tolerance Scaling

How SimBiology uses AbsoluteTolerance to determine the error depends on whether
the AbsoluteToleranceScaling property is enabled. By default,
AbsoluteToleranceScaling is enabled which means each state has its own absolute
tolerance that may increase over the course of simulation:

AbsoluteTolerance(i, j) = CSAbsTol* Scale(i, j)

CSAbsTol is the AbsoluteTolerance property defined in SolverOptions of the active
configuration set object.

For a state that has a nonzero initial value, the scale is the maximum magnitude over the
state, as seen over the simulation thus far:

Scale(i, j) = max(|y(1:i, j)|)
For a state that has an initial value of zero, the scale is estimated as the state value after

taking a trial step of size AbsoluteToleranceStepSize using the Euler method. Let us call
this value ye (j). Then:

Scale(i, j) = max(|[ye(j); y(2:1, )])
If an initial state is zero and has no dynamic at time = 0, then:
AbsoluteTolerance(i, j) = CSAbsTol

Doses, events, and initial assignment rules at simulation time = 0 are not considered
when calculating absolute tolerance scaling.

See Also

More About

. “Model Simulation” on page 4-2
. “Choosing a Simulation Solver” on page 4-7
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See Also

“Ordinary Differential Equations” (MATLAB)
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Troubleshooting Simulation Problems

3-18

SimBiology uses ODE solvers for model simulation on page 4-2. Solver errors can cause
simulation problems. Many solver errors relate to the stiffness of the model and the
relative and absolute tolerances. As a result, the simulation can take long. You might also
see one of the following error messages, indicating that the solver is not able to solve the
problem within the tolerances.

* Integration tolerance not met

* CVODES returned -4 from module CVODES function CVode: Att= ... andh= ...
the corrector convergence test failed repeatedly or with |h| = hmin.

You might also see one or more of the following warning messages, which are precursors
to potential solver tolerance issues.

* The right-hand side of the system of SimBiology ODEs results in complex numbers.
The imaginary part of the result will be ignored.

* The right-hand side of the system of SimBiology ODEs results in infinite or NaN
values. This usually indicates a modeling error and can lead to solver integration
errors.

* The repeated assignment rules of the SimBiology model result in complex numbers.
The imaginary part of the result will be ignored.

Tips for Solving Simulation Problems

To fix the simulation problems that solver errors can cause, try the following
troubleshooting tips.

Improve Performance by Acceleration

You can accelerate the simulation by converting the model to compiled C code, which
executes faster. For details, see “Accelerating Model Simulations and Analyses” on page
4-111. If the simulation is still slow after acceleration, there might be solver tolerance
issues. Try the remaining tips without accelerating the model.

Debug the Model Using MaximumNumberOfLogs and MaximumWallClock

MaximumNumberOfLogs and MaximumWallClock are some of the configuration options
you can use to stop the simulation just before the error happens. Then you can check for
unusual simulated values, such as negative species amounts.
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For instance, set MaximumNumberOfLogs to 1 to get the values of the model immediately
after applying initial and repeated assignment rules. If you set the value to 2, and the
simulation fails with the integration error, then it probably indicates an error with the
assignment rules.

While varying MaximumNumberOfLogs, simulate the model repeatedly using the same
conditions that produce the error. The model might simulate without error until you reach
a certain value of MaximumNumberQfLogs. Then check the simulated values at the final
simulation time. If you see negative values for certain states, such as negative species
amounts, examine the expressions in your model that can affect those states. Update the
expressions to account for possible issues, such as negative values or division-by-0, by
either rearranging the equations and/or inserting some protections, such as max (0, x) or
max (eps, x), where x is the variable that is responsible for the error.

Alternatively, you can look at the equations view of the model to check the initial
conditions, such as species amounts and parameter values at simulation time = 0, and
mathematical expressions of the model. For details, see getequations or “Equations View”
on page 1-27.

Check the ODE Solver

If your model is stiff, and you have selected an inappropriate solver, the step size taken by
the solver might be forced down to an unreasonably small level compared to the interval
of integration. Make sure that you have selected either odel5s or sundials as your
solver for stiff ODEs.

Disable AbsoluteToleranceScaling
Turn off AbsoluteToleranceScaling.

SimBiology uses AbsoluteTolerance and RelativeTolerance to control the accuracy of
integration during simulation. Specifically, AbsoluteTolerance controls the largest
allowable absolute error at any step during simulation.

When AbsoluteToleranceScaling is enabled (by default), each state has its own
absolute tolerance that can increase over the course of simulation. Sometimes the
automatic scaling is inadequate for models that have kinetics at largely different scales.
For example, the reaction rate of a reaction can be in the order of 1022, while another is
0.1. By turning off AbsoluteToleranceScaling, you might be able to simulate the
model.
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Loosen Tolerances

If the simulation tolerance error still exists after disabling AbsoluteToleranceScaling, try
loosening the relative and absolute tolerances.

Set RelativeTolerance to 10"™* ! where m is the number of significant digits desired
in the solution X. If X has multiple scales, start with using the smaller X and increase from
there if the tolerance is not met.

Set AbsoluteTolerance to a value of X that is negligibly small for your problem.
Similarly, start from the smaller X and increase from there.

For details, see “Selecting Absolute Tolerance and Relative Tolerance for Simulation” on
page 3-15.

Set MassUnits and AmountUnits

The MassUnits and AmountUnits properties define the appropriate mass or amount unit
that SimBiology uses internally during model simulation when UnitConversion is on. It is
recommended that you use the default unit (<automatic>) but in some edge cases, you
may need to change it.

Change MassUnits or AmountUnits to a unit so that the simulated values are not too
large (that is, greater than 108) or too small (that is, smaller than 10-6).

Suppose that you have a model with a state that takes on values around 10-'? moles for

the entire simulation. It might be appropriate to set AmountUnits to picomole. In this
case, the internal simulation values would be around 1, instead of around 10-2 as in the
default case.

How to Change Solver Options and Simulation Options

Solver and simulation options are stored in the configuration set object (configset
object) of the model. Solver options contain settings such as relative and absolute
tolerances. Simulation options are settings such as MaximumNumberOfLogs and
MaximumWallClock. Depending on whether you are using the command line or
graphical interface, the way to access and change the options differs.

Using the Command line

To access and change the SolverOptions, use the following commands, where m1 is a
SimBiology model.
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configset = getconfigset(ml);

solverOpts = configset.SolverOptions;
solverOpts.AbsoluteTolerance = le-5;
solverOpts.RelativeTolerance = le-5;
solverOpts.AbsoluteToleranceScaling = false;

Access simulation options directly from the configset object.
configset = getconfigset(ml);
configset.MaximumNumberOfLogs = 1;
configset.MaximumWallClock = 10;

Using the Graphical Interface

If you are using the SimBiology Model Analyzer app, you can access the options by
clicking Simulation Settings from the Home tab.

See Also

getequations | AbsoluteTolerance | Configset object | MaximumNumberOfLogs |
MaximumWallClock | RelativeTolerance | SolverOptions

More About

. “Model Simulation” on page 4-2

. “Selecting Absolute Tolerance and Relative Tolerance for Simulation” on page 3-15
. “Equations View” on page 1-27
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Simulate Model of Glucose-Insulin Response with
Different Initial Conditions

3-22

This example shows how to simulate the glucose-insulin responses for the normal and
diabetic subjects.

Load the model of glucose-insulin response. For details about the model, see the
Background section in “Simulating the Glucose-Insulin Response”.

sbioloadproject('insulindemo', 'ml")

The model contains different initial conditions stored in various variants.
variants = getvariant(ml);

Get the initial conditions for the type 2 diabetic patient.

type2 = variants(1)

type2 =
SimBiology Variant - Type 2 diabetic (inactive)
ContentIndex: Type: Name: Property: Value:
1 parameter Plasma Volume ... Value 1.49
2 parameter k1l Value 0.042
3 parameter k2 Value 0.071
4 parameter Plasma Volume ... Value 0.04
5 parameter ml Value 0.379
6 parameter m2 Value 0.673
7 parameter mé4 Value 0.269
8 parameter m5 Value 0.0526
9 parameter m6 Value 0.8118
10 parameter Hepatic Extrac... Value 0.6
11 parameter kmax Value 0.0465
12 parameter kmin Value 0.0076
13 parameter kabs Value 0.023
14 parameter kgri Value 0.0465
15 parameter f Value 0.9
16 parameter a Value 6e-05
17 parameter b Value 0.68
18 parameter C Value 0.00023
19 parameter d Value 0.09
20 parameter Stomach Glu Af... Value 12
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21 parameter kpl Value 3.09
22 parameter kp2 Value 0.0007
23 parameter kp3 Value 0.005
24 parameter kp4 Value 0.0786
25 parameter ki Value 0.0066
26 parameter [Ins Ind Glu U... Value 1

27 parameter VmO Value 4.65
28 parameter Vmx Value 0.034
29 parameter Km Value 466.21
30 parameter p2U Value 0.084
31 parameter K Value 0.99
32 parameter alpha Value 0.013
33 parameter beta Value 0.05
34 parameter gamma Value 0.5

35 parameter kel Value 0.0007
36 parameter ke2 Value 269

37 parameter Basal Plasma G... Value 164.18
38 parameter Basal Plasma I... Value 54.81

Suppress an informational warning that is issued during simulations.

warnSettings = warning('off', 'SimBiology:DimAnalysisNotDone MatlabFcn Dimensionless');

Create SimFunction objects to simulate the glucose-insulin response for the normal and
diabetic subjects.

* Specify an empty array {} for the second input argument to denote that the model will
be simulated using the base parameter values (that is, no parameter scanning will be
performed).

» Specify the plasma glucose and insulin concentrations as responses (outputs of the
function to be plotted).

* Specify the species Dose as the dosed species. This species represents the initial
concentration of glucose at the start of the simulation.

normSim = createSimFunction(ml,{},...
{'[Plasma Glu Conc]','[Plasma Ins Conc]'}, 'Dose')

normSim =
SimFunction

Parameters:

Observables:
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Name Type Units
{'[Plasma Glu Conc]'} {'species'} {'milligram/deciliter'}
{'[Plasma Ins Conc]'} {'species'} {'picomole/liter' }
Dosed:
TargetName TargetDimension
{'Dose'} {'Mass (e.g., gram)'}

For the diabetic patient, specify the initial conditions using the variant type?2.

diabSim = createSimFunction(ml,{},...
{'[Plasma Glu Conc]','[Plasma Ins Conc]'}, 'Dose', type2)

diabSim =
SimFunction

Parameters:
Observables:

Name Type Units

{'[Plasma Glu Conc]'} {'species'} {'milligram/deciliter'}

{'[Plasma Ins Conc]'} {'species'} {'picomole/liter' }
Dosed:
TargetName TargetDimension
{'Dose'} {'Mass (e.g., gram)'}

Select a dose that represents a single meal of 78 grams of glucose at the start of the
simulation.

singleMeal = sbioselect(ml, 'Name', 'Single Meal');
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Convert the dosing information to the table format.
mealTable = getTable(singleMeal);
Simulate the glucose-insulin response for a normal subject for 24 hours.

sbioplot(normSim([],24,mealTable));

States versus Time =+ [ All Runs
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Simulate the glucose-insulin response for a diabetic subject for 24 hours.

sbioplot(diabSim([],24,mealTable));
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States versus Time =[] All Runs
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Perform a scan using variants

Suppose you want to perform a parameter scan using an array of variants that contain
different initial conditions for different insulin impairments. For example, the model m1

has variants that correspond to the low insulin sensitivity and high insulin sensitivity. You
can simulate the model for both conditions via a single call to the SimFunction object.

Select the variants to scan.

varToScan = sbioselect(ml, 'Name', ...

{'Low insulin sensitivity', 'High insulin sensitivity'});
Check which model parameters are being stored in each variant.
varToScan(1)
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ans =
SimBiology Variant - Low insulin sensitivity (inactive)

ContentIndex: Type: Name: Property: Value:
1 parameter Vmx Value 0.0235
2 parameter kp3 Value 0.0045
varToScan(2)
ans =

SimBiology Variant - High insulin sensitivity (inactive)

ContentIndex: Type: Name: Property: Value:
1 parameter Vmx Value 0.094
2 parameter kp3 Value 0.018

Both variants store alternate values for Vmx and kp3 parameters. You need to specify
them as input parameters when you create a SimFunction object.

Create a SimFunction object to scan the variants.

variantScan = createSimFunction(ml,{'Vmx"', 'kp3'},...
{'[Plasma Glu Conc]', '[Plasma Ins Conc]'}, 'Dose');

Simulate the model and plot the results. Run 1 include simulation results for the low
insulin sensitivity and Run 2 for the high insulin sensitivity.

sbioplot(variantScan(varToScan,24,mealTable));
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Low insulin sensitivity lead to increased and prolonged plasma glucose concentration.

Restore warning settings.

warning(warnSettings);
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Combine Simulation Scenarios in SimBiology

There are two different methods to combine SimBiology simulation scenarios that have
different doses, different variants, or different sample values for model quantities. After
the combination, you get a final set of values (parameter set) that you can use to simulate
and explore the model behavior. For instance, you can combine different dosing regimens
with different categories of patients (variants) and simulate to explore the efficacy of the
drug.

Cartesian Combination

This method is the Cartesian product of two sets. Suppose doses is a set of different
RepeaDose objects [d1,d2,d3], and variants is a set of variant objects: [v1,v2,v3].
The Cartesian combination of doses and variants is: doses x variants = (d1,vl),
(d2,v1l), (d3,vl), (d1,v2),(d2,v2),(d3,v2),(d1,v3),(d2,v3), (d3,v3).

Varants vl vz v3
doses

dl dinwl dlyv2 dil,v3
doses X variants =

d2 d2wl d2v2 d2,v3

d3 d3,vl d3v2 d3, v

Elementwise Combination

This combination method combines the entries one to one, that is, elementwise. In other
words, the first element of the first set (entry) is combined with the first element of the
second set (entry) and so on. Using the same variables above, the elementwise
combination of doses and variants is: doses + variants = (d1,vl), (d2,v2), (d3,v3).
Both sets must have the same number of elements (samples) for this combination method.

doses variants

dl, vl
doses + variants = az V2
d3 w3

il
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See Also

SimBiology.Scenarios

More About

. “SimBiology.Scenarios Terminology”
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Model Simulation

4-2

SimBiology lets you simulate the dynamic behavior of a model. Before and during
simulation, SimBiology performs a series of steps including converting the model
reactions and rate rules into a set of ordinary differential equations (ODEs) that
mathematically describe the model dynamics.

Specifically, before simulation begins, SimBiology:

Verifies the model. For details, see “Model Verification” on page 3-2.

2 Determines the initial conditions, that is, the quantity values at the beginning of
simulation. In particular, SimBiology first initializes the quantity values based on the
values specified in the model. Second, it updates the values by replacing them with
the corresponding alternate values from variants if any. Then it updates the values
based on the initial assignments and repeated assignments. SimBiology evaluates
initial assignments and repeated assignments as a set of simultaneous constraints,
and their order do not affect the final quantity values. For details, see “Evaluation
Order of Rules” on page 2-19.

3  Constructs the ODEs based on model reactions and rate rules. Specifically, the left-
hand-side (LHS) of each ODE represents the time-derivative of a model quantity. The
right-hand-side (RHS) is defined using reaction fluxes that are derived from reaction
rates. For details, see “Deriving ODEs from Reactions” on page 4-4.

Converts doses to state transitions that occur at specific simulation times.

5 Converts event functions to state transitions that depend on the conditions specified
in the event triggers.

When the simulation begins, that is, at simulation time = 0, SimBiology:

1 Updates values based on initial assignments and repeated assignments.
2  Applies any state transitions due to dosing specified at simulation time = 0.
3 Logs the updated quantity values.

Note Events cannot cause transitions at time = 0 since events only apply when a trigger
changes from false to true. If a trigger is true at simulation time = 0, then no transition
has occurred and the event is not triggered.




See Also

During the simulation, SimBiology uses a solver to compute solutions for ODEs at
different times. Specifically, the solver determines appropriate time steps and performs
the following at each step.

Updates values for any repeated assignments.

2 Checks each event’s trigger condition. If it switches from false to true at this time
step, then it applies the state transitions according to the event functions, and
updates values for any repeated assignments.

3  Logs the updated quantity values.

To see the system of ODEs of a model, use getequations in the command line or open the
Equations View on page 1-27 in the SimBiology app.

Note If a model has algebraic equations, you must specify one of the following
differential-algebraic-equation (DAE) solvers: sundials, odel5s, ode23t. SimBiology
converts the algebraic equations to algebraic constraints and solves them along with the
rest of ODEs. For details about available solvers, see “Choosing a Simulation Solver” on
page 4-7.

See Also

Equations View on page 1-27 | getequations

Related Examples
. “Simulate the Yeast Heterotrimeric G Protein Cycle” on page 4-23
. “Create Model of Receptor-Ligand Kinetics” on page 4-18

More About
. “Simulation”
. “Choosing a Simulation Solver” on page 4-7

. “Configuring Simulation Settings” on page 4-17
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Deriving ODEs from Reactions

4-4

For model simulation on page 4-2, SimBiology derives ordinary differential equations
(ODEs) from model reactions using mass-balance principles. The left-hand-side (LHS) of
each ODE is the time-derivative of a model quantity and the right-hand-side (RHS) is
defined using reaction fluxes that are derived from reaction rates and rate rules. In other
words, SimBiology represents a system of ODEs as:

x=S-v

x is an M-by-1 vector containing the rates of change for model quantities, S is an M-by-R
stoichiometry matrix on page 3-12, v is an R-by-1 flux vector. M equals the total number of
species, and R equals the total number of reactions in the model

During the conversion of model reactions into ODEs, SimBiology performs a dimensional
analysis to ensure each reaction flux has the dimension of substance/time such as
amount/time or mass/time. If the reaction rate has the dimension of concentration/
time, then SimBiology multiplies it by the compartment volume to get the reaction flux. If
the reaction rate has the dimension of substance/time, then the flux is identical to the
rate, and no volume-correction is performed. If there are no units specified with the
model, the default dimension for a species (DefaultSpeciesDimension) is
concentration, and that for a flux is substance/time. For such cases, the ODE is the
flux divided by a compartment volume to make the dimension of LHS and RHS consistent.
See the following figure for an illustration.

Suppose there is a reaction x —> y, with the reaction rate R1. The following figure
explains the dimensional analysis performed by SimBiology to make the dimensions of
LHS and RHS of an ODE consistent.



See Also

]
- - X, ¥ = species
I._'—O—"'._' Rl =reactionrate
* R1 ¥ V =compartment volume
W
Flux
Ifthe dimension of the reactionrate R1 is substance/ time, then:
flux=R1
Ifthe dimension of R1is concentration/time, then:
flux=R1-V
ODE
Ifthe dimension of speciesis substance, then:
dx E
— = —flux
dt f
Ifthe dimension of speciesis concentration, then:
dx
— = (—flux) - 1
o (—flux) -/}
See Also

getstoichmatrix (model)
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More About

. “Model Simulation” on page 4-2
. “Determining the Stoichiometry Matrix for a Model” on page 3-12
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Choosing a Simulation Solver

To simulate a model, the SimBiology software converts a model to a system of differential
equations. It then uses a solver function to compute solutions for these equations at
different time intervals, giving the model's states and outputs over a span of time.

Available solvers are:

* ODE Solvers — These include Nonstiff Deterministic Solvers and Stiff Deterministic
Solvers. The solver functions implement numerical integration methods for solving
initial value problems for ordinary differential equations (ODEs). Beginning at the
initial time with initial conditions, they step through the time interval, computing a
solution at each time step. If the solution for a time step satisfies the solver's error
tolerance criteria, it is a successful step. Otherwise, it is a failed attempt; the solver
shrinks the step size and tries again. For more information, see ODE Solvers
(MATLAB).

* SUNDIALS Solvers — At a fundamental level the core algorithms for the SUNDIALS
solvers are similar to those for some of the solvers in the MATLAB ODE suite and work
as described above in ODE Solvers. SimBiology always uses the SUNDIALS solver to
perform sensitivity analysis on a model, regardless of what you have selected as the
SolverType. For more information, see “SUNDIALS Solvers” on page 4-9.

* Stochastic Solvers — Use with models containing a small number of molecules.
Stochastic solvers include stochastic simulation algorithm, explicit tau-leaping
algorithm, and implicit tau-leaping algorithm. For more information, see “Stochastic
Solvers” on page 4-11.

See Also

Related Examples
. “Simulate the Yeast Heterotrimeric G Protein Cycle” on page 4-23
. “Create Model of Receptor-Ligand Kinetics” on page 4-18

More About
. “Model Simulation” on page 4-2
. ODE Solvers (MATLAB)
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. “SUNDIALS Solvers” on page 4-9
. “Stochastic Solvers” on page 4-11
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SUNDIALS Solvers

SUNDIALS (Suite of Nonlinear and Differential/Algebraic Equation Solvers) are part of a
freely available third-party package developed at Lawrence Livermore National
Laboratory. All other ODE solvers used for simulation of SimBiology models, such as
ode45 and odel5s, are part of the MATLAB ODE suite. SimBiology currently (R2018b or
later) uses SUNDIALS 3.1.0.

SimBiology always uses the SUNDIALS solver to perform sensitivity analysis on a model,
regardless of what you have selected as the SolverType in the configuration set.

In addition, if you are estimating model parameters using sbiofit or the Fit Data
program with one of these gradient-based estimation functions: fmincon, fminunc,
lsgnonlin, or Lsqcurvefit, SimBiology uses the SUNDIALS solver by default to
calculate sensitivities and use them to improve fitting. If you are using sbiofit, you can
turn off this sensitivity calculation feature by setting the “'SensitivityAnalysis'” name-
value pair argument to false. However, if you are using the Fit Data program, you
cannot turn off this feature. It is recommended that you keep the sensitivity analysis
feature on whenever possible for more accurate gradient approximations and better
parameter fits.

When you specify sundials for the solver, the software chooses one of two SUNDIALS
solvers, CVODE or IDA, as appropriate for your model:

* CVODE is a solver for systems of ODEs, both nonstiff and stiff. This is used when a
model has no algebraic rules.

« IDA is a differential-algebraic equation (DAE) solver, used when one or more algebraic
rules are present.

For more information on the SUNDIALS solvers, see https://www.llnl.gov/casc/
sundials/description/description.html.

See Also
More About

. “Model Simulation” on page 4-2
. ODE Solvers (MATLAB)
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. “Stochastic Solvers” on page 4-11

4-10



Stochastic Solvers

Stochastic Solvers

In this section...

“When to Use Stochastic Solvers” on page 4-11

“Model Prerequisites for Simulating with a Stochastic Solver” on page 4-11
“What Happens During a Stochastic Simulation?” on page 4-12

“Stochastic Simulation Algorithm (SSA)” on page 4-12

“Explicit Tau-Leaping Algorithm” on page 4-12

“Implicit Tau-Leaping Algorithm” on page 4-13

“References” on page 4-14

When to Use Stochastic Solvers

The stochastic simulation algorithms provide a practical method for simulating reactions
that are stochastic in nature. Models with a small number of molecules can realistically
be simulated stochastically, that is, allowing the results to contain an element of
probability, unlike a deterministic solution.

Model Prerequisites for Simulating with a Stochastic Solver

Model prerequisites include:

* All reactions in the model must have their KineticLaw property set to MassAction.

» If your model contains events, you can simulate using the stochastic ssa solver. Other
stochastic solvers do not support events.

* Your model must not contain doses. No stochastic solvers support doses.

Additionally, if you perform an individual or population fitting on a model whose
Configset object specifies a stochastic solver and options, be aware that during the
fitting SimBiology temporarily changes:

* SolverType property to the default solver of odel5s

* SolverOptions property to the options last configured for a deterministic solver
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What Happens During a Stochastic Simulation?

During a stochastic simulation of a model, the software ignores any rate, assignment, or
algebraic rules if present in the model. Depending on the model, stochastic simulations
can require more computation time than deterministic simulations.

Tip When simulating a model using a stochastic solver, you can increase the
LogDecimation property of the configset object to record fewer data points and
decrease run time.

Stochastic Simulation Algorithm (SSA)

The Chemical Master Equation (CME) describes the dynamics of a chemical system in
terms of the time evolution of probability distributions. Directly solving for this
distribution is impractical for most realistic problems. The stochastic simulation algorithm
(SSA) instead efficiently generates individual simulations that are consistent with the
CME, by simulating each reaction using its propensity function. Thus, analyzing multiple
stochastic simulations to determine the probability distribution is more efficient than
directly solving the CME.

Advantage
* This algorithm is exact.
Disadvantages

* Because this algorithm evaluates one reaction at a time, it might be too slow for
models with a large number of reactions.

» If the number of molecules of any reactants is huge, it might take a long time to
complete the simulation.

Explicit Tau-Leaping Algorithm

Because the stochastic simulation algorithm might be too slow for many practical
problems, this algorithm was designed to speed up the simulation at the cost of some
accuracy. The algorithm treats each reaction as being independent of the others. It
automatically chooses a time interval such that the relative change in the propensity
function for each reaction is less than your error tolerance. After selecting the time
interval, the algorithm computes the number of times each reaction occurs during the
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time interval and makes the appropriate changes to the concentration of various chemical
species involved.

Advantages

* This algorithm can be orders of magnitude faster than the SSA.
* You can use this algorithm for large problems (if the problem is not numerically stiff).

Disadvantages

» This algorithm sacrifices some accuracy for speed.
* This algorithm is not good for stiff models.

* You need to specify the error tolerance so that the resulting time steps are of the order
of the fastest time scale.

Implicit Tau-Leaping Algorithm

Like the explicit tau-leaping algorithm, the implicit tau-leaping algorithm is also an
approximate method of simulation designed to speed up the simulation at the cost of
some accuracy. It can handle numerically stiff problems better than the explicit tau-
leaping algorithm. For deterministic systems, a problem is said to be numerically stiff if
there are “fast” and “slow” time scales present in the system. For such problems, the
explicit tau-leaping method performs well only if it continues to take small time steps that
are of the order of the fastest time scale. The implicit tau-leaping method can potentially
take much larger steps and still be stable. The algorithm treats each reaction as being
independent of others. It automatically selects a time interval such that the relative
change in the propensity function for each reaction is less than the user-specified error
tolerance. After selecting a time interval, the algorithm computes the number of times
each reaction occurs during the time interval and makes the appropriate changes to the
concentration of various chemical species involved.

Advantages

* This algorithm can be much faster than the SSA. 1t is also usually faster than the
explicit tau-leaping algorithm.

* You can use this algorithm for large problems and also for numerically stiff problems.
* The total number of steps taken is usually less than the explicit-tau-leaping algorithm.

Disadvantages
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» This algorithm sacrifices some accuracy for speed.

» There is a higher computational burden for each step as compared to the explicit tau-
leaping algorithm. This leads to a larger CPU time per step.

» This method often dampens perturbations of the slow manifold leading to a reduced
state variance about the mean.
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Ensemble Runs of Stochastic Simulations

4-16

Because stochastic simulations rely on an element of probability, sequential runs produce
different results. Therefore, multiple stochastic runs are needed to determine the
probability distribution of the simulation results.

Ensemble runs perform multiple simulations of a model using a stochastic solver. They let
you gather data from multiple stochastic runs of the model so you can compare and
analyze fluctuations in the behavior of a model over repeated stochastic simulations.

Running Ensemble Simulations

The following functions let you perform and analyze ensemble runs at the command line:
* sbioensemblerun — Perform a stochastic ensemble run of the MATLAB model
object.

* sbioensembleplot — Show a 2-D distribution plot or a 3-D shaded plot of the time
varying distribution of one or more specified species.

* sbioensemblestats — Get mean and variance as a function of time for all the
species in the model used to generate ensemble data by running sbioensemblerun.

See Also

More About

. “Stochastic Solvers” on page 4-11

. “Model Simulation” on page 4-2

. “Choosing a Simulation Solver” on page 4-7
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Configuring Simulation Settings

A model has a configuration set (Configset object) associated with it to control the
simulation. You can edit the properties of a Configset object to control all aspects of
the simulation, including:

Stop time (StopTime, MaximumNumberOfLogs, and MaximumWallClock properties)
Time units (TimeUnits property)

Solver and error tolerances (SolverType and SolverOptions properties)

Maximum time step size (MaxStep property)

Data to record (RuntimeOptions property)

Frequency of data recording (OutputTimes and LogDecimation properties)
Sensitivity analysis (SensitivityAnalysisOptions and SolverOptions properties)
Dimensional analysis and unit conversion (CompileOptions property)

To view the Configset object, provide the model object as an input argument to
the getconfigset method.

To edit the properties of a Configset object, use the set method.

For more information on viewing and editing the stop time and other simulation settings,
see “Simulate the Yeast Heterotrimeric G Protein Cycle” on page 4-23.

See Also

More About

“Model Simulation” on page 4-2
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Create Model of Receptor-Ligand Kinetics

4-18

This example shows how to create and simulate a simple model of receptor-ligand kinetics
using the SimBiology app and SimBiology Model Analyzer app.

Use the SimBiology app to create a model in which ligand L and receptor R species form
receptor-ligand complexes through reversible binding reactions. These reactions are
defined using mass action kinetics by %—f = Kon 'L - R —koff - C, where k,, and k. are

forward and reverse rate constants. L, R, and C are the concentrations of ligand, receptor,
and receptor-ligand complex respectively.

kon
m + P >
L

R koff C (RL complex)

Open the app by typing simbiology at the command line or clicking the app icon on the
Apps tab. Then on the Home tab of the app, select Add Model > Create New Blank
Model. Enter a name for the model, such as m1. Open the Diagram view by selecting
Open > Diagram.

Drag and drop three species blocks ©= and one reaction block © into the compartment.
Rename the species and compartment by double-clicking the default text. For instance,
change unnamed to cell.

]

L
O
reaction_1 c
R
cell



Create Model of Receptor-Ligand Kinetics

To connect the species to the reaction, press and hold the Ctrl key (onWindows® and
Linux® systems) or the Option key (on Macintosh® systems), click the species block, and
drag the line.

L]

cell

Define the reaction properties:

* Double-click the reaction block to open the Block Property Editor.
* In the Settings tab, select Reversible.
* Set KineticLaw to MassAction.

* For Forward Rate Parameter, set the name to kon and the value to 0.05. Set the
unit to Liter/nanomole/hour. For Reverse Rate Parameter, set the name to koff
and the value to 0.1 with the unit 1/hour.

» Update the initial amounts of L to 5 and R to 10 with the unit nanomole/liter.
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Block Property Editor

”

Mame:

reaction_1 Active
Reaction:

L+R<->C :'__E
ineticlaw: Expression:

Masshction ~ |[(Forward Rate Parameter)*(MassAction Species) - (Reverse Rate Parameter)*(MassAction Spec
Quantities Used by Reaction: < —

Kinetic Law Variable Mame = Type Scope Mame Value Units onstant gt
Forward Rate Parameter - | parameter L+ R<->C J kon 0.05 liter/nanomale/hour g
Reverse Rate Parameter .  parameter L+ R<->C J koff 0.01 1/hour

Masshction Species species unnarmed L 50 nanomaole/liter ]

Masshction Species species unnarmed R 10.0 nanomaole/liter ]

Masshction Species species unnarmed C 0.0 nanomaole/liter ]
[[JReactionRate:

kon*L*R - koff*C

Open the SimBiology Model Analyzer app by typing simBiologyModelAnalyzer at
the command line or clicking the app icon from the Home tab.

To simulate this reaction, select Program > Simulate Model in the Project section from
the Home tab. Set the Stop Time to 20 seconds in the Simulation step since the model
reaches a saturated state after that. Click Run from the Home tab.
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HOME - e
™ H éﬁg =X E‘" - ) : o~ ] BE] Run Step {B @
LEr HE (B & (& \ /\ \; BB Run and Ad e
Open | Save Ciose Model Data Program New New = T AnG SEVANEE | Simulation SimBiclogy Preferences RESOURCES
> o, > o e Datasheet Plot time / |35 Advance Settings v
FILE 2 T LO RUM STEP TOOLS ENVIRONMENT ry
Workspace | Documents | Model ® &p ~ Simulation o
o) @)
s Size Type PROGRAM DESCRIPTION
DESCRIPTION
- [=1 Model: 1x1
=l ) asaiy i Click to edit the description
& mt 1x1 SimBiology. Model
- L3 Program1 simulation MODEL
71 LastRun MODEL
B m
Prepare the model for accelerated simulation
VARIANTS
No variants are being applied to the model
DOSES
Mo doses are being applied 1o the model
STATES TOLOG
All states are being logged. Click to change
= [ SIMULATION
DESCRIPTION
Click to edit the description
STCP TIME
20 second
(3 Add sensitivity calculation
MESSAGES
MESSAGES
+ EXPLORER o There are no erors or wamings from running the program
OVERLAY RESULTS
Keep results from each run v

4
Running the program plots the results in the Plot1 tab. The plot shows the simulated

responses in different colors. The program stores the simulation results in the LastRun
folder of the program.
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Simulate the Yeast Heterotrimeric G Protein Cycle

This example shows how to configure simulation settings, add an event to the model to
trigger a time-based change, save, and plot the simulation results. This example uses the
model described in “Model of the Yeast Heterotrimeric G Protein Cycle” on page B-17 to
illustrate model simulation.

Load the gprotein.sbproj project, which includes the variable m1, a SimBiology model
object.

sbioloadproject gprotein

Set the simulation solver to ode15s and set a stop time of 500 by editing the
SolverType and StopTime properties of the configset object associated with the
m1l model.

csObj = getconfigset(ml);
csObj.SolverType = 'odel5s';
csObj.StopTime = 500;

Specify to log simulation results of all species.

csObj.RuntimeOptions.StatesToLog = 'all’;

Suppose the amount of the ligand species L is 0 at the start of the simulation, but it
increases to a particular amount at time = 100. Use sbioselect to select the species
named L and set its initial amount to 0. Use addevent to set up the desired event.

speciesObj = sbioselect(ml, 'Type', 'species', 'Name','L"');
speciesObj.InitialAmount = 0;
evt = addevent(ml, 'time >= 100','L = 6.022E17"');

Simulate the model.
[t,x,names] = sbiosimulate(ml);

Simulate the simulation results. Notice that the species L. amount increases when the
event is triggered at simulation time 100. Changes in other species do not show up in the
plot due to the wide range in species amounts.

plot(t,x);
legend(names)
xlabel('Time");
ylabel('Amount');
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To see the changes of other species, plot without the species L (the 5th species) data.

figure
plot(t,x(:,[1:4 6:8]1));
legend(names{[1:4 6:8]1});
xlabel('Time");
ylabel('Amount');
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Alternative to storing simulation data in separate outputs, such as t, x, and names as
above, you can store them all in a single SimData object. You can then use
selectbyname to extract arrays containing the simulation data of your interest.

simdata = sbiosimulate(ml);
sbioplot(simdata);
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Expand Run 1 to see the names of species and parameter that are plotted.

simdata noL = selectbyname(simdata, {'Ga','G','Gd', 'GaFrac','RL','R'});
sbioplot(simdata nolL);
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Sensitivity Calculation
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In this section...

“About Calculating Sensitivities” on page 4-28
“Model Requirements for Calculating Sensitivities” on page 4-28
“SUNDIALS as Default Solver” on page 4-29

“Calculate Sensitivities using sbiosimulate or SimFunctionSensitivity Object” on page 4-
30

“References” on page 4-31

About Calculating Sensitivities

Calculating sensitivities lets you determine which species or parameter in a model is most
sensitive to a specific condition (for example, a drug), defined by a species or parameter.
Calculating sensitivities calculates the time-dependent sensitivities of all the species
states with respect to species initial conditions and parameter values in the model.

Thus, if a model has a species x, and two parameters y and z, the time-dependent
sensitivities of x with respect to each parameter value are the time-dependent derivatives

ax ox
ay’ 0z

where, the numerator is the sensitivity output and the denominators are the sensitivity
inputs to sensitivity analysis.

For more information on the calculations performed, see “References” on page 4-31.

Model Requirements for Calculating Sensitivities

Sensitivity analysis is supported only by the ordinary differential equation (ODE) solvers.
The software calculates local sensitivities by combining the original ODE system for a
model with the auxiliary differential equations for the sensitivities. The additional
equations are derivatives of the original equations with respect to parameters. This
method is sometimes called “forward sensitivity analysis” or “direct sensitivity analysis”.
This larger system of ODEs is solved simultaneously by the solver.

SimBiology sensitivity analysis calculates derivatives by using a technique called complex-
step approximation. This technique yields accurate results for the vast majority of typical
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reaction kinetics, which involve only simple mathematical operations and functions.
However, this technique can produce inaccurate results when analyzing models that
contain mathematical expressions that involve nonanalytic functions, such as abs. In this
case, SimBiology either disables the sensitivity analysis or warns you that the computed
sensitivities may be inaccurate. If sensitivity analysis gives questionable results for a
model with reaction rates that contain unusual functions, you may be running into
limitations of the complex-step technique. Contact MathWorks Technical Support for
additional information.

Note Models containing the following active components do not support sensitivity
analysis:

* Nonconstant compartments

* Algebraic rules

* Events

Note You can perform sensitivity analysis on a model containing repeated assignment
rules, but only if the repeated assignment rules do not determine species or parameters
used as inputs or outputs in sensitivity analysis.

SUNDIALS as Default Solver

SimBiology always uses the SUNDIALS solver to perform sensitivity analysis on a model,
regardless of what you have selected as the SolverType in the configuration set.

In addition, if you are estimating model parameters using sbiofit or the Fit Data
program with one of these gradient-based estimation functions: fmincon, fminunc,
lsgnonlin, or Lsqcurvefit, SimBiology uses the SUNDIALS solver by default to
calculate sensitivities and use them to improve fitting. If you are using sbiofit, you can
turn off this sensitivity calculation feature by setting the “'SensitivityAnalysis'” name-
value pair argument to false. However, if you are using the Fit Data program, you
cannot turn off this feature. It is recommended that you keep the sensitivity analysis
feature on whenever possible for more accurate gradient approximations and better
parameter fits.
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Calculate Sensitivities using sbiosimulate or
SimFunctionSensitivity Object

You can calculate sensitivities using sbiosimulate or the SimFunctionSensitivity
object.

Calculate using shiosimulate

Set the following properties of the SolverOptions property of your configset object,
before running the sbiosimulate function:

» SensitivityAnalysis — Set to true to calculate the time-dependent sensitivities of all
the species states defined by the Outputs property with respect to the initial
conditions of the species and the values of the parameters specified in Inputs.

* SensitivityAnalysisOptions — An object that holds the sensitivity analysis options in
the configuration set object. Properties of SensitivityAnalysisOptions are:

* Qutputs — Specify the species and parameters for which you want to compute the
sensitivities. This is the numerator as described in “About Calculating Sensitivities”
on page 4-28.

* Inputs — Specify the species and parameters with respect to which you want to
compute the sensitivities. Sensitivities are calculated with respect to the
InitialAmount property of the specified species. This is the denominator, described
in “About Calculating Sensitivities” on page 4-28.

* Normalization — Specify the normalization for the calculated sensitivities:

* 'None' — No normalization
* 'Half' — Normalization relative to the numerator (species output) only
* 'Full' — Full dedimensionalization

For more information about normalization, see Normalization.

After setting SolverOptions properties, calculate the sensitivities of a model by
providing the model object as an input argument to the sbhiosimulate function.

The sbiosimulate function returns a SimData object containing the following
simulation data:

+ Time points, state data, state names, and sensitivity data
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* Metadata such as the types and names for the logged states, the configuration set
used during simulation, and the date of the simulation

A SimData object is a convenient way of keeping time data, state data, sensitivity data,
and associated metadata together. A SimData object has properties and methods
associated with it, which you can use to access and manipulate the data.

For illustrated examples, see:

* “Calculate Sensitivities” on page 4-32

* “Parameter Scanning, Parameter Estimation, and Sensitivity Analysis in the Yeast
Heterotrimeric G Protein Cycle”

Calculate using SimFunctionSensitivity object

Create a SimFunctionSensitivity object using the createSimFunction
specifying the 'SensitivityOutputs' and 'SensitivityInputs' name-value pair
arguments. Then execute the object. For an illustrated example, see “Calculate
Sensitivities Using SimFunctionSensitivity Object”.

Calculate using SimBiology Model Analyzer

For a workflow example using the app, see “Find Important Parameters with Sensitivity
Analysis Using SimBiology Model Analyzer App” on page 1-38.

References
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Calculate Sensitivities

In this section...

“Overview” on page 4-32
“Load and Configure the Model for Sensitivity Analysis” on page 4-33
“Perform Sensitivity Analysis” on page 4-34

“Extract and Plot Sensitivity Data” on page 4-34

Overview
About the Example Model

This example uses the model described in “Model of the Yeast Heterotrimeric G Protein
Cycle” on page B-17 to illustrate SimBiology sensitivity analysis options.

This table lists the reactions used to model the G protein cycle and the corresponding rate
parameters (rate constants) for each mass action reaction. For reversible reactions, the
forward rate parameter is listed first.

No. [IName Reaction? Rate
Parameters

Receptor-ligand interaction L +R <->RL kRL, kRLm

2 Heterotrimeric G protein Gd + Gbg -> G kG1
formation

3 |G protein activation RL + G -> Ga + Gbg + RL kGa

4 Receptor synthesis and R <-> null kRdo, kRs
degradation

5 Receptor-ligand degradation |RL -> null kRD1

6 G protein inactivation Ga -> Gd kGd

! Legend of species: L = ligand (alpha factor), R = alpha-factor receptor, Gd = inactive

G-alpha-GDP, Gbg = free levels of G-beta:G-gamma complex, G = inactive Gbg:Gd

complex, Ga = active G-alpha-GTP
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About the Example

Assume that you are calculating the sensitivity of species Ga with respect to every
parameter in the model. Thus, you want to calculate the time-dependent derivatives

d(Ga) 9(Ga) 9(Ga) d(Ga)

3(kRLm)’ 9(kRL)’ 3(kG1)’ 9(kGa)""

Load and Configure the Model for Sensitivity Analysis

1

The gprotein norules.sbproj project contains a model that represents the wild-
type strain (stored in variable m1).

sbioloadproject gprotein norules ml
The options for sensitivity analysis are in the configuration set object. Get the
configuration set object from the model.

csObj = getconfigset(ml);
Use the sbioselect function, which lets you query by type, to retrieve the Ga
species from the model.

Ga = sbioselect(ml, 'Type', 'species', 'Where', 'Name','=="','Ga');
Set the Outputs property of the SensitivityAnalysisOptions object to the Ga
species.

csObj.SensitivityAnalysisOptions.Outputs = Ga;
Use the sbioselect function, which lets you query by type, to retrieve all the
parameters from the model and store the vector in a variable, pif.

pif = sbioselect(ml, 'Type', 'parameter');
Set the Inputs property of the SensitivityAnalysisOptions object to the pif
variable containing the parameters.

csObj.SensitivityAnalysisOptions.Inputs = pif;
Enable sensitivity analysis in the configuration set object (cs0bj) by setting the
SensitivityAnalysis option to true.

csObj.SolverOptions.SensitivityAnalysis = true;
Set the Normalization property of the SensitivityAnalysisOptions object to
perform 'Full' normalization.

csObj.SensitivityAnalysisOptions.Normalization = 'Full’;
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Perform Sensitivity Analysis

Simulate the model and return the data to a SimData object:

simDataObj = sbiosimulate(ml);

Extract and Plot Sensitivity Data

You can extract sensitivity results using the getsensmatrix method of a SimData
object. In this example, R is the sensitivity of the species Ga with respect to eight
parameters. This example shows how to compare the variation of sensitivity of Ga with
respect to various parameters, and find the parameters that affect Ga the most.

1

Extract sensitivity data in output variables T (time), R (sensitivity data for species
Ga), snames (names of the states specified for sensitivity analysis), and ifacs
(names of the input factors used for sensitivity analysis):

[T, R, snames, ifacs] = getsensmatrix(simDataObj);

Because R is a 3-D array with dimensions corresponding to times, output factors, and
input factors, reshape R into columns of input factors to facilitate visualization and
plotting:

R2 = squeeze(R);
After extracting the data and reshaping the matrix, plot the data:

figure;

plot(T,R2);

title('Normalized Sensitivity of Ga With Respect To Various Parameters');
xlabel('Time (seconds)');

ylabel('Normalized Sensitivity of Ga');

leg = legend(ifacs, 'Location', 'NorthEastOutside');

set(leg, 'Interpreter', 'none');
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Normalized Sensitivity of Ga With Respect To Various Parameters
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From the previous plot you can see that Ga is most sensitive to parameters kGd, kRs,
kRD1, and kGa. This suggests that the amounts of active G protein in the cell depends on
the rate of:

* Receptor synthesis

* Degradation of the receptor-ligand complex

* G protein activation

* G protein inactivation
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Perform a Parameter Scan
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This example shows how to perform a parameter scan by simulating a model multiple
times, each time varying the value of a parameter.

In the model described in Model of the Yeast Heterotrimeric G Protein Cycle, the rate of G
protein inactivation (kGd) is much lower in the mutant strain versus the wild-type strain
(kGd = 0.004 versus kGd = 0.11), which explains higher levels of activated G protein
(Ga) in the mutant strain. For a detailed look at how varying the level of kGd affects the
level of Ga, perform a parameter scan over different values of kGd.

Load the gprotein.sbproj project, which includes the variable m1, a model object.
sbioloadproject gprotein

Create a vector of five evenly spaced values for kGd ranging from 0.001 to 0.15.
kGdValues = linspace(le-3,0.15,5)"';

Create a SimFunction object, where kGd is the input parameter to scan, and Ga is the
observed species. Pass in an empty array [] as the last input argument to denote there are
no dosed species.

simfunc = createSimFunction(ml,{'kGd"'},{'Ga"'},[1);
Simulate the model multiple times with different kGd values. Set the stop time to 1000.
sd = simfunc(kGdValues,1000);

Plot the simulation results to see how varying the level of kGd affects the level of Ga.

sbioplot(sd);



See Also

States

States versus Time
10000 f

9000 ||
8000 f
7000 1
6000 | .
5000 .

3000 [ N

2000 | —

1000 TTe—

See Also

SimFunction object | createSimFunction

More About

= [+] All Runs
-- Run 1
-- Run 2
-- Run 3
-- Run 4
-- Run 5

. “Model of the Yeast Heterotrimeric G Protein Cycle” on page B-17
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Nonlinear Mixed-Effects Modeling
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In this section...

“What Is a Nonlinear Mixed-Effects Model?” on page 4-38
“Nonlinear Mixed-Effects Modeling Workflow” on page 4-40
“Specify a Covariate Model” on page 4-41

“Specify an Error Model” on page 4-43

“Maximum Likelihood Estimation” on page 4-43

“Obtain the Fitting Status” on page 4-44

What Is a Nonlinear Mixed-Effects Model?

A mixed-effects model is a statistical model that incorporates both fixed effects and
random effects. Fixed effects are population parameters assumed to be the same each
time data is collected, and random effects are random variables associated with each
sample (individual) from a population. Mixed-effects models work with small sample sizes
and sparse data sets, and are often used to make inferences on features underlying
profiles of repeated measurements from a group of individuals from a population of
interest.

As with all regression models, their purpose is to describe a response variable as a
function of the predictor (independent) variables. Mixed-effects models, however,
recognize correlations within sample subgroups, providing a reasonable compromise
between ignoring data groups entirely, thereby losing valuable information, and fitting
each group separately, which requires significantly more data points.

For instance, consider population pharmacokinetic data that involve the administration of
a drug to several individuals and the subsequent observation of drug concentration for
each individual, and the objective is to make a broader inference on population-wide
parameters while considering individual variations. The nonlinear function often used for
such data is an exponential function since many drugs once distributed in a patient are
eliminated in an exponential fashion. Thus the measured drug concentration of an
individual can be described as:

Di i
yij = Ve J 4+ 081’]‘,
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where y; is the jth response of the ith individual, D; is the dose administered to the ith

individual, V is the population mean volume of distribution, a is an error parameter, and

gj ~ N(0, 1), representing some measurement error. The elimination rate parameter (k;)
Cl;

depends on the clearance and volume of the central compartment k; = 71 Both k; and Cl;

are for the ith patient, meaning they are patient-specific parameters.

To account for variations between individuals, assume that the clearance is a random
variable depending on individuals, varying around the population mean. For the ith
individual, Cl; = 61 + n;, where 6, is the fixed effect (population parameter for the

clearance) and n; is the random effect, that is, the deviation of the ith individual from the
mean clearance of the population n; ~ N(0, 0,%).

If you have any individual-specific covariates such as weight w that linearly relate to the
clearance, you can try explaining some of the between-individual differences. For
example, if w; is the weight of the ith individual, then the model becomes

Cli = 01 + 6, *w; + n;, where 0, is the fixed effect of weight on clearance.

A general nonlinear mixed-effects (NLME) model with constant variance is as follows:

Vij = f(xij, p) + &

pi = A + Bin;

& j o~ N (0, (02 2)

ni ~ N, ¥)

Vi Data vector of individual-specific response values

f General, real-valued function of p; and x;

Xij Data matrix of individual-specific predictor values

pi Vector of individual-specific model parameters

0 Vector of fixed effects, modeling population parameters

n; Vector of multivariate normally distributed individual-specific random effects
A; Individual-specific design matrix for combining fixed effects

B; Individual-specific design matrix for combining random effects

Ejj Vector of group-specific errors, assumed to be independent, identically,

normally distributed, and independent of n;

4-39



4 simulation and Analysis

4-40

v Covariance matrix for the random effects
o2 Error variance, assumed to be constant across observations

In addition to the constant error model, there are other error models such as
proportional, exponential, and combined error models. For details, see “Error Models” on
page 4-56.

Nonlinear Mixed-Effects Modeling Workflow

SimBiology lets you estimate fixed effects s and random effects ns as well as the
covariance matrix of random effects W. However, you cannot alter A and B design
matrices since they are automatically determined from the covariate model you specify.
Use the sbiofitmixed function to estimate nonlinear mixed-effects parameters. These
steps show one of the workflows you can use at the command line.

1 TImport data.

2  Convert the data to the groupedData format.

3 Define dosing data. For details, see “Doses in SimBiology Models” on page 2-42.
4

Create a structural model (one-, two-, or multicompartment model). For details, see
“Create Pharmacokinetic Models” on page 5-14.

5 Create a covariate model to define parameter-covariate relationships if any. For
details, see “Specify a Covariate Model” on page 4-41.

6 Map the response variable from data to the model component. For example, if you
have the measured drug concentration data for the central compartment, then map it
to the drug species in the central compartment (typically the Drug Central
species).

7  Specify parameters to estimate using the EstimatedInfo object. It lets you
optionally specify parameter transformations, initial values, and parameter bounds.
Supported transforms are log, probit, logit, and none (no transform).

8 (Optional) You can also specify an error model. The default model is the constant
error model. For instance, you can change it to the proportional error model if you
assume the measurement error is proportional to the response data. See “Specify an
Error Model” on page 4-43.

9 Estimate parameters using sbiofitmixed, which performs “Maximum Likelihood
Estimation” on page 4-43.
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10 (Optional) If you have a large, complex model, the estimation might take longer.
SimBiology lets you check the status of fitting as it progresses. See “Obtain the
Fitting Status” on page 4-44.

For a complete workflow example, see “Modeling the Population Pharmacokinetics of
Phenobarbital in Neonates”.

Specify a Covariate Model

When specifying a nonlinear mixed-effects model, you define parameter-covariate
relationship using a covariate model (CovariateModel object). For example, suppose
you have PK profile data for multiple individuals and are estimating three parameters
(clearance CI, compartment volume V, and elimination rate k) that have both fixed and
random effects. Assume the clearance CI has a correlation with a covariate variable
weight (w) of each individual. Each parameter can be described as a linear combination of
fixed and random effects.

Cli =01 + 0% w; + ny;,

Vi= 03+,
ki = 04 + n3;,
where 0s represent fixed effects and ns represent random effects, which are normally
Mi
distributed |mi| ~ MVN(O, ¥). By default, the random effects are uncorrelated. So
3i
o} 0 0
=005 0]
0 0 o3

1 Construct an empty CovariateModel object.

covModel = CovariateModel;

2 Setthe Expression property to define the relationships between parameters (Cl, V,
and k) and covariate (w). You must use theta as a prefix for all fixed effects and eta
for random effects.

covModel.Expression = {'Cl = thetal + theta2*w + etal','V = theta3 + eta2', 'k = the
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The FixedEffectNames property displays the fixed effects defined in the model.
covModel.FixedEffectNames
ans =

"thetal'
"theta3'
"theta4d'
"theta2'

The FixedEffectDescription property displays which fixed effects correspond to
which parameter. For instance, thetal is the fixed effect for the CI parameter, and
thetaZ2 is the fixed effect for the weight covariate that has a correlation with CI
parameter, denoted as Cl/w.

covModel.FixedEffectDescription
ans =

IC'LI
N
Ikl
"Cl/w'

Specify initial estimates for the fixed effects. Create a structure containing initial
estimates using the constructDefaultFixedEffectValues function.
initialEstimates = constructDefaultFixedEffectValues(covModel)

initialEstimates =

thetal:
theta2:
theta3:
theta4:

[cNoNoNO]

initialEstimates.thetal
initialEstimates.theta2
initialEstimates.theta3
initialEstimates.thetad

1.20;
0.30;
0.90;
0.10;

Set the initial estimates to the FixedEffectValues property.

covModel.FixedEffectValues = initialEstimates;



Nonlinear Mixed-Effects Modeling

Specify a Covariance Pattern Among Random Effects

By default, sbiofitmixed assumes no covariance among random effects, that is, a
diagonal covariance matrix is used. Suppose you have 1, n,, and ns, and there is a
covariance g, between 1, and n,. You can indicate this using a pattern matrix where 1
indicates a variance or covariance parameter which is estimated by sbiofitmixed. For

110 ot 012 0
instance, a pattern matrix (1 1 Of represents [0y 0% 0

001 0 0 o?
Define such a pattern using an options struct.
options.CovPattern = [1 1 0;1 1 0;0 0 1];

Then you can use options as an input argument for sbiofitmixed. For a complete
workflow, see “Nonlinear Mixed-Effects Modeling Workflow” on page 4-40.

Specify an Error Model

During the “Nonlinear Mixed-Effects Modeling Workflow” on page 4-40, you can
optionally specify an error model using a structure.

options.ErrorModel = 'proportional';

Then you can use options as one of the input arguments when you run sbiofitmixed.

Supported error models are constant (default), proportional, combined, and exponential
models. For details, see “Error Models” on page 4-56.

Maximum Likelihood Estimation

SimBiology estimates the parameters of a nonlinear mixed-effects model by maximizing a
likelihood function. The function can be described as:

p(y|9, o, ¥) = fp(y

6,n, 02)p(n| W) dn,

where y is the response data, 6 is the vector of fixed effects, o2 is the error variance, ¥ is
the covariance matrix for random effects, and n is the vector of unobserved random
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effects. p(y | 0, 0%, ¥) is the marginal density of y, p( y| 0, n, o) is the conditional density of
y given the random effects n, and the prior distribution of n is p(n|¥).

This integral contains a nonlinear function of the fixed effects and variance parameters
that you want to maximize. Typically for nonlinear models, the integral does not have a
closed form, and needs to be solved numerically, which involves simulating the function at
each time step of an optimization algorithm. Therefore, the estimation can take a long
time for complex models, and initial values of parameters might play an important role for
successful convergence. SimBiology provides these iterative algorithms to solve the
integral and maximize the likelihood if you have Statistics and Machine Learning Toolbox.

* |LME — Use the likelihood for the linear mixed-effects model at the current conditional
estimates of 6 and 7. This is the default.

* RELME — Use the restricted likelihood for the linear mixed-effects model at the current
conditional estimates of 6 and n.

* FO — First-order (Laplacian) approximation without random effects.
* FOCE — First-order (Laplacian) approximation at the conditional estimates of 6.

» stochastic EM — Use the Expectation-Maximization (EM) algorithm in which the E
step is replaced by a stochastic procedure.

For a complete workflow, see “Nonlinear Mixed-Effects Modeling Workflow” on page 4-40.

Obtain the Fitting Status

During the estimation of mixed-effects parameters of a large and complex model that may
take a longer time, you may want to obtain the status of fitting as it progresses. Set
'ProgressPlot' to true when you run sbiofitmixed to display the progress of the
fitting. For details, see “Progress Plot” on page 4-57.

For a complete workflow, see “Nonlinear Mixed-Effects Modeling Workflow” on page 4-40.

See Also

sbiofit | shiofitmixed

More About
. “Progress Plot” on page 4-57
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“Nonlinear Regression” on page 4-46
“Supported Methods for Parameter Estimation” on page 4-53
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In this section...

“What is Nonlinear Regression?” on page 4-46
“Fitting Options in SimBiology” on page 4-47
“Maximum Likelihood Estimation” on page 4-49

“Fitting Workflow for sbiofit” on page 4-51

What is Nonlinear Regression?

The purpose of regression models is to describe a response variable as a function of
independent variables. Multiple linear regression models describe the response as a
linear combination of coefficients and functions of independent variables. Nonlinearities
can be modeled using nonlinear functions of independent variables. However, the
coefficients always enter the model in a linear fashion.

Nonlinear regression models are more mechanistic models of nonlinear relationships
between the response and independent variables. The parameters can enter the model as
exponential, trigonometric, power, or any other nonlinear function. The unknown
parameters in the model are estimated by minimizing a statistical criterion such as the
negative log likelihood or the sum of squared deviations between observed and predicted
values.

In the case of pharmacokinetic (PK) studies, the response data usually represent some
measured drug concentrations, and independent variables are often dose and time. The
nonlinear function often used for such data is an exponential function since many drugs
once distributed in a patient are eliminated in an exponential fashion. One PK parameter
to estimate in this case is the rate at which the drug is eliminated from the body given the
concentration-time data.

For instance, consider drug plasma concentration data from a single individual after an
intravenous bolus dose measured at different time points with some errors. Assume the

measured drug concentration follows a monoexponential decline: C; = Coe_ket + ac.

This model describes the time course of drug concentration in the body (C;), as a function
of the drug concentration after an intravenous bolus dose at t = 0 (Cy), time (t), and
elimination rate parameter (k.). € is the mean-zero and unit-variance variable, that is,




Nonlinear Regression

£ ~ N(0, 1) representing the measurement error and a is the error model parameter
(here, standard deviation).

More generically, you can write the model as y; = f(x;; p) + g(g;), where y; is the jth
response of interest (such as C,), f'is a function of known quantities x (such as C, and time
t), model parameters p (such as k), and an error model g(g;).

If there are multiple observations on multiple individuals, the model becomes
Vij = f(xij; pj) + gl(&;;) where yj; is the jth observation of the ith individual. Additionally, you

can categorize your data into different groups based on different categories such as sex,
age, or height.

Fitting Options in SimBiology

This table summarizes nonlinear regression options available in SimBiology.

Fitting Option Example

Individual-specific parameter estimation

(Unpooled fitting) 401
| i 2
jdual 3
Fit each individual separately, resulting in 30}
one set of parameter estimates for each
individual. 257

Response
M
(=1
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Category- or group-specific parameter

estimation 0
& Nalg
Female
Malkg Fit
Fit each category or group separately, Fenjale Fi
resulting in one set of parameter estimates
for each category. o
=
2
@
o
P
25 30 35 40

Population-wide parameter estimation
(Pooled fitting) *r

®  Indivjdual 1
jdual 2
0 jdual 3

ed Fit

Fit all of the data pooled together, resulting
in just one set of parameter estimates.

Response

10r

In addition, SimBiology supports four kinds of error models for measured or observed
responses, namely, constant (default), proportional, combined, and exponential. For
details, see “Error Models” on page 4-56. Depending on the optimization method, you

can specify an error model for each response or all responses. For details, see “Supported
Methods for Parameter Estimation” on page 4-53.
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Maximum Likelihood Estimation

SimBiology estimates parameters by the method of maximum likelihood. Rather than
directly maximizing the likelihood function, SimBiology constructs an equivalent
minimization problem. Whenever possible, the estimation is formulated as a weighted
least squares (WLS) optimization that minimizes the sum of the squares of weighted
residuals. Otherwise, the estimation is formulated as the minimization of the negative of
the logarithm of the likelihood (NLL). The WLS formulation often converges better than
the NLL formulation, and SimBiology can take advantage of specialized WLS algorithms,
such as the Levenberg-Marquardt algorithm implemented in Isqnonlin and Isqcurvefit.
SimBiology uses WLS when there is a single error model that is constant, proportional, or
exponential. SimBiology uses NLL if you have a combined error model or a multiple-error
model, that is, a model having an error model for each response.

sbiofit supports different optimization methods, and passes in the formulated WLS or
NLL expression to the optimization method that minimizes it.

Expression that is being minimized

Weighted N 9

Least For the constant error model, » (y; - fi)

Squares !

(WLS) - £
For the proportional error model, E

i fgm

For the exponential error model, E(Inyi = Inf,-)2
i

N (v - i)

For numeric weights, » ———
ghts 35y

Negative |For the combmed error model and multiple-error model,
Log- N

likelihood
'S 018 o

i 1

The variables are defined as follows.

N |Number of experimental observations
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Vi The ith experimental observation
fi Predicted value of the ith observation
Oj Standard deviation of the ith observation.

* For the constant error model, g; = a
» For the proportional error model, g; = b|fj]

* For the combined error model, g; = a + b|fj]

fam N \Un
f gm = H Ifil
1
wj The weight of the ith predicted value
Wgm N \N
Wgm = |1 | Wi
1

When you use numeric weights or the weight function, the weights are assumed to be
2

inversely proportional to the variance of the error, i.e., 0,2 = % where a is the constant
1

error parameter. If you use weights, you cannot specify an error model except the

constant error model.

Various optimization methods have different requirements on the function that is being
minimized. For some methods, the estimation of model parameters is performed
independently of the estimation of the error model parameters. The following table
summarizes the error models and any separate formulas used for the estimation of error
model parameters, where a and b are error model parameters and e is the standard
mean-zero and unit-variance (Gaussian) variable.

Error Error Parameter Estimation Function
Model
"constan 1 N 9
thy=fi |20 = § 20~
+ ae !
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Error
Model

Error Parameter Estimation Function

'exponen
tial':

Vi = fiexp
(ae)

N
E Iny; - Infy)?
1

'proport
ional':
Vi=fi

+ blfile

Nyi—fi)?
-v3 [

'combine
d':

Vi =fi

+ (a + b|f;
e

Error parameters are included in the minimization.

Weights

1 N
= NE(M -
i

Note nlinfit only support single error models, not multiple-error models, that is,
response-specific error models. For a combined error model, it uses an iterative WLS
algorithm. For other error models, it uses the WLS algorithm as described previously. For
details, see nlinfit.

Fitting Workflow for sbiofit

The following steps show one of the workflows you can use at the command line to fit a

PK model.

A W N

Import data.

Convert the data to the groupedData format.

Define dosing data. For details, see “Doses in SimBiology Models” on page 2-42.
Create a structural model (one-, two-, or a multicompartment model). For details, see

“Create Pharmacokinetic Models” on page 5-14.

5 Map the response variable from data to the model component. For example, if you
have the measured drug concentration data for the central compartment, then map it
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7

to the drug species in the central compartment (typically the Drug Central
species).

Specify parameters to estimate using an EstimatedInfo object. Optionally, you
can specify parameter transformations, initial values, and parameter bounds.

Perform parameter estimation using sbiofit.

For illustrated examples, see the following.

“Fit a One-Compartment Model to an Individual's PK Profile”
“Fit a Two-Compartment Model to PK Profiles of Multiple Individuals”
“Estimate Category-Specific PK Parameters for Multiple Individuals”

See Also

EstimatedInfo object | groupedData | sbiofit | sbiofitmixed

More About

4-52

“Multiple Parameter Estimations in Parallel”

“Parameter Estimation with Hybrid Solvers”

“Progress Plot” on page 4-57

“Supported Methods for Parameter Estimation” on page 4-53
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Supported Methods for Parameter Estimation

SimBiology supports a variety of optimization methods for least-squares and mixed-effects
estimation problems. Depending on the optimization method, you can specify parameter
bounds for estimated parameters as well as response-specific error models, that is, an
error model for each response variable. The following table summarizes the supported
optimization methods in SimBiology, fitting options, and the corresponding toolboxes that
are required in addition to MATLAB and SimBiology.

Method Addition |[Support |(Uses Respons |Fixed or (Support |SimBiolo
al S Paramet |e- Mixed S gy
Toolbox |Paramet |er specific |Effects |Stochast|Function
Require |er Sensitivi |Error ic EM to Use
d Bounds |ties! Models Algorith
m
fminsearch — Yes* No Yes Fixed No sbiofit
scattersearch — Yes Depends |Depends |Fixed No
on the on the
selected |selected
local local
solver. solver.
nlinfit Statistics |Yes* No No Fixed No
and
Machine
Learning
Toolbox
fminunc Optimizat | Yes* Yes Yes Fixed No
ion
Toolbox
fmincon Optimizat |Yes Yes Yes Fixed No
ion
Toolbox
lsqcurvefi |Optimizat|Yes Yes Yes Fixed No
t ion
Toolbox
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Method

Addition
al
Toolbox
Require
d

Support
S
Paramet
er
Bounds

Uses
Paramet
er
Sensitivi
tiest

Respons
e-
specific
Error
Models

Fixed or
Mixed
Effects

Support
S
Stochast
ic EM
Algorith
m

SimBiolo
gy
Function
to Use

lsgnonlin

Optimizat
ion
Toolbox

Yes

Yes

Yes

Fixed

No

patternsea

rch

Global
Optimizat
ion
Toolbox

Yes

No

Yes

Fixed

No

ga

Global
Optimizat
ion
Toolbox

Yes

No

Yes

Fixed

No

particlesw

arm

Global
Optimizat
ion
Toolbox

Yes

No

Yes

Fixed

No

nlmefit

Statistics
and
Machine
Learning
Toolbox

No

No

No

Mixed

No

nlmefitsa

Statistics
and
Machine
Learning
Toolbox

No

No

No

Mixed

Yes

sbiofit
mixed

T This column indicates whether the algorithm allows using parameter sensitivities to
determine gradients of the objective function.

* When using fminsearch, nlinfit, or fminunc with bounds, the objective function
returns Inf if bounds are exceeded. When you turn on options such as FunValCheck, the
optimization may error if bounds are exceeded during estimation. If using nlinfit, it




See Also

may report warnings about the Jacobian being ill-conditioned or not being able to
estimate if the final result is too close to the bounds.

See Also

sbiofit | shiofitmixed

More About

. “Nonlinear Regression”
. “Nonlinear Mixed-Effects Modeling”

4-55



4 Ssimulation and Analysis

Error Models
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SimBiology supports the error models described in the following table. For instance, if
you assume every observation has a constant amount of noise, use the constant error
model, which is the default. Instead, if you assume the error is proportional to the
response data, then the proportional error model might be more appropriate.

Error |Mathematical Representation Standard Deviation of Error Model
Model

consta |y = f +ae a

nt

(defaul

t)

propor |y = f + b|fle blf]

tional

combi |y =f+(a+b|f])e a+blf]

ned

expone y = f * exp(ag) or equivalently, /eaz _ 1 %gd

ntial - 1150(y) = log(f) + ae a

Here, y is the response, fis the function value, ¢ is a standard mean-zero and unit-
variance (Gaussian) variable, and a and b are error parameters. For instance, if you
assume the error is approximately 5% of each observation, use the proportional error
model with b = 0.05. In SimBiology, f typically represents the simulation result.

See Also

More About

. “Nonlinear Regression”
. “Nonlinear Mixed-Effects Modeling”



Progress Plot

Progress Plot

The progress plot provides the live feedback on the status of parameter estimation while
using sbiofit, sbiofitmixed, or the Fit Data program in the SimBiology Model
Analyzer app. When you enable this feature, a new figure opens and shows the fitting
quality measures such as log-likelihood and estimated parameter values for each function
iteration. The plot monitors the progress whether you are running the fit on a local
machine or in parallel using remote clusters.

When you estimate parameters, you can specify which estimation method on page 4-53 to
use during the fitting. The progress plot is shown for all the estimation methods except
for nlinfit. However, the progress plot differs depending on whether you are using a
nonlinear mixed-effects method (nlmefit or nlmefitsa) or a nonlinear regression
method, such as Lsqnonlin.

Progress Plot for Nonlinear Mixed-Effects Methods

The progress plot figure contains a series of subplots. Specifically, the subplots show the
values of fixed-effect parameters (theta), the estimates of the variance parameters, that
is, the diagonal elements of the covariance matrix of the random effects (¥), and the log-
likelihood.
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theta1
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Here are some tips for interpreting the plots.

» The fitting function tries to maximize the log-likelihood. When the plot begins to
display a flat line, this might indicate that maximization is complete. Try setting the
maximum iterations to a lower number to reduce the number of iterations you need
and improve performance.

* Plots for the fixed effects (thetas) and the variance parameters (¥s) should show
convergence. If you see oscillations, or jumps without accompanying improvements in
the log-likelihood, the model may be overparameterized. Try the following:



Progress Plot

* Reduce the number of fixed effects.
* Reduce the number of random effects.

* Simplify the covariance matrix pattern of random effects (if you have previously
changed it from the default diagonal matrix).

Progress Plot for Nonlinear Regression Methods

The progress plot figure shows a series of subplots, and there are two categories of plots:
quality measure plots on page 4-59 and estimated parameter plots on page 4-62. For a
pooled fit, that is, estimating one set of parameter values for all groups (or individuals),
there is only one line for each plot and the line is faded when the fit is finished. For an
unpooled fit, that is, estimating one set of parameter values for each group (or individual),
each line represents a single individual or group. You can select one or more lines by
clicking and dragging the mouse cursor to create a rectangle on any plot. All lines that
intersect the rectangle are selected and highlighted across all plots.

You can terminate the fitting at any time by selecting Stop, and partial results are
returned. Specifically, for a pooled fit, the result up to the last function iteration is
returned. For an unpooled fit, results for any groups that have finished running are
returned. The groups currently running are interrupted and partial results from the last
iteration are also returned.

Quality Measure Plots

The quality measure plots include the log-likelihood, first-order optimality, and
termination condition plots. They occupy the first row of the figure.

Log-likelihood

The estimation method tries to maximize the log-likelihood, and the plot shows the log-
likelihood value for each function iteration. When the plot begins to display a flat line, it
often indicates that maximization is complete. Try setting the maximum iterations to a
lower number to reduce the number of iterations you need and improve performance.

For a pooled fit, there is only one line in the plot and the line is faded when the fit
finishes. The log-likelihood plot shows whether the fit converges or fails along with the
information on the estimation method termination condition. The next figure is an
example of the log-likelihood plot of a pooled fit.
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Log Likelihood

0
The fit converged with criterion Residual
-500 | 1
-1000 |
-1500 |
-2000 ' ' ' ' ' ' '
0 0.5 1 1.5 2 25 3 3.5 4

First-order Optimality

First-order optimality is a measure of how close a point x is to optimal, and the plot is
shown when you are using the Optimization Toolbox methods (Lsqnonlin,
lsqcurvefit, fminunc, and fmincon). The first-order optimality measure must be zero
at a minimum, but a point with first-order optimality equal to zero is not necessarily a
minimum. For details, see First-order optimality (Optimization Toolbox).

Termination Condition

For a pooled fit, the termination condition is displayed together with the log-likelihood
plot. For details about the termination condition, refer to the exitflag output argument
description of the corresponding estimation method. Suppose that you are using the
lsgnonlin method and see a message: The fit converged with criterion
Residual. By checking the exitflag conditions of the Lsqnonlin with the keyword
Residual, this termination condition corresponds to the exitflag value of 3, that is,
change in the residual was less than the specified tolerance.

For an unpooled fit, the Termination Conditions plot contains the summary (histogram)
of termination criteria for all groups (or individuals) as shown in the next figure. The y-
axis represents the total number of fits for each termination condition, and the x-axis
displays all the termination criteria.



Progress Plot

Termination Conditions

EPD T T T
B Failed
I Converged

Hybrid Functions

If you are performing a hybrid optimization by first running a global solver, such as ga or
particleswarm, followed by a hybrid function, the ProgressPlot also shows the
quality measure plots for the hybrid function in the second row. The following figure is an
example where the global optimization algorithm is ga and the hybrid function is
fminunc. For an illustrated example, see “Parameter Estimation with Hybrid Solvers”.
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Estimated Parameter Plot

This plot displays the value of the estimated parameter versus iteration for each group.
One estimated parameter plot is displayed for each parameter. The plots start on the
second row of the figure and can span multiple rows. Each plot displays a horizontal
dashed line for any lower or upper bound you specify for the estimated parameter. The
bound lines show only if the range of the plot can include the lines.

For an unpooled fit, the Progress Plot also displays a histogram that shows the
distribution of the parameter values for the completed runs. Use the toggle button over
the y-axis for each plot to switch between the log and linear scale. The next figure shows
an example of an estimated parameter plot with the bound information and distribution of
estimated values.
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If you have a hierarchical model and are estimating parameters for each category such as
estimating parameters for males versus females, the Progress Plot displays one plot per
estimated parameter for each category. For example, in the next figure, the Central and
Peripheral parameters are estimated for the age categories while Q12 and CI Central are

estimated for the sex categories.
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For an unpooled fit running in parallel, the Progress Plot displays a status bar in the
bottom right corner. The bar shows information about the remaining and completed
number of individuals (or groups) throughout the fit.

Number of individuals
currently running in parallel

I 5~

45

i

Completed

'

Total number of individuals

4
10
Remaining




See Also

See Also

sbiofit | sbiofitmixed | sbhiofitstatusplot
More About

. “Nonlinear Regression” on page 4-46

. “Nonlinear Mixed-Effects Modeling” on page 4-38
. “Supported Methods for Parameter Estimation” on page 4-53
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Fit a One-Compartment Model to an Individual's PK
Profile

4-66

Background

This example shows how to fit an individual's PK profile data to one-compartment model
and estimate pharmacokinetic parameters.

Suppose you have drug plasma concentration data from an individual and want to
estimate the volume of the central compartment and the clearance. Assume the drug
concentration versus the time profile follows the monoexponential decline C; = Coe_ket,
where C; is the drug concentration at time t, Cy is the initial concentration, and k, is the
elimination rate constant that depends on the clearance and volume of the central
compartment k, = CI/V.

The synthetic data in this example was generated using the following model and
parameters:

* One-compartment model with bolus dosing and first-order elimination

* Volume of the central compartment (Central) = 1.70 liter

* Clearance parameter (Cl _Central) = 0.55 liter/hour

» Constant error model

Load Data and Visualize

The data is stored as a table with variables Time and Conc that represent the time course
of the plasma concentration of an individual after an intravenous bolus administration
measured at 13 different time points. The variable units for Time and Conc are hour and
milligram/liter, respectively.

clear all
load(fullfile(matlabroot, 'examples', 'simbio', 'datal5.mat'))

plot(data.Time,data.Conc, 'b+")
xlabel('Time (hour)');
ylabel('Drug Concentration (milligram/liter)');



Fit a One-Compartment Model to an Individual's PK Profile
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Convert to groupedData Format

Convert the data set to a groupedData object, which is the required data format for the
fitting function sbiofit for later use. A groupedData object also lets you set
independent variable and group variable names (if they exist). Set the units of the Time
and Conc variables. The units are optional and only required for the UnitConversion
feature, which automatically converts matching physical quantities to one consistent unit
system.

gbata = groupedData(data);

gData.Properties.VariableUnits = {'hour', 'milligram/liter'};
gData.Properties
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ans = struct with fields:

Description: "'
UserData: []
DimensionNames: {'Row' 'Variables'}
VariableNames: {'Time' 'Conc'}
VariableDescriptions: {}
VariableUnits: {'hour' 'milligram/liter'}

VariableContinuity: []
RowNames: {}
CustomProperties: [1x1 matlab.tabular.CustomProperties]
GroupVariableName: "'
IndependentVariableName: 'Time'

groupedData automatically set the name of the IndependentVariableName property
to the Time variable of the data.

Construct a One-Compartment Model

Use the built-in PK library to construct a one-compartment model with bolus dosing and
first-order elimination where the elimination rate depends on the clearance and volume of
the central compartment. Use the configset object to turn on unit conversion.

pkmd = PKModelDesign;
pkcl = addCompartment (pkmd, 'Central');
pkcl.DosingType = 'Bolus';

pkcl.EliminationType 'linear-clearance’;
pkcl.HasResponseVariable = true;

model construct(pkmd);
configset getconfigset(model);
configset.CompileOptions.UnitConversion = true;

For details on creating compartmental PK models using the SimBiology® built-in library,
see “Create Pharmacokinetic Models” on page 5-14.

Define Dosing

Define a single bolus dose of 10 milligram given at time = 0. For details on setting up
different dosing schedules, see “Doses in SimBiology Models” on page 2-42.

dose
dose.TargetName
dose.StartTime
dose.Amount

sbiodose('dose');
‘Drug Central';
0;

10;
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dose.AmountUnits
dose.TimeUnits

‘'milligram’;
"hour';

Map Response Data to the Corresponding Model Component

The data contains drug concentration data stored in the Conc variable. This data
corresponds to the Drug_Central species in the model. Therefore, map the data to
Drug Central as follows.

responseMap = {'Drug Central = Conc'};

Specify Parameters to Estimate

The parameters to fit in this model are the volume of the central compartment (Central)
and the clearance rate (Cl Central). In this case, specify log-transformation for these
biological parameters since they are constrained to be positive. The estimatedInfo
object lets you specify parameter transforms, initial values, and parameter bounds if
needed.

paramsToEstimate
estimatedParams

{'log(Central)', 'log(Cl Central)'};
estimatedInfo(paramsToEstimate, 'InitialValue',[1 1], 'Bounds',[1 !

Estimate Parameters

Now that you have defined one-compartment model, data to fit, mapped response data,
parameters to estimate, and dosing, use sbiofit to estimate parameters. The default
estimation function that sbiofit uses will change depending on which toolboxes are
available. To see which function was used during fitting, check the
EstimationFunction property of the corresponding results object.

fitConst = sbiofit(model,gData, responseMap,estimatedParams,dose);

Display Estimated Parameters and Plot Results

Notice the parameter estimates were not far off from the true values (1.70 and 0.55) that
were used to generate the data. You may also try different error models to see if they
could further improve the parameter estimates.

fitConst.ParameterEstimates

ans=2x4 table
Name Estimate StandardError Bounds
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{'Central"’ }
{'Cl _Central'}

s.Labels.XLabel

1.6993
0.53358

0.034821 1
0.01968 0.5

'Time (hour)';

s.Labels.YLabel "Concentration (milligram/liter)"';
plot(fitConst, 'AxesStyle',s);

Individual Fit
Group One group

+  OBS1 [Conc)
PRED1 (Cantral Drug_Cantral)

Concentration (milligramy/liter)
[#:]

0 2 o

m F

Time (hour)

Use Different Error Models

Try three other supported error models (proportional, combination of constant and
proportional error models, and exponential).

fitProp = sbiofit(model, gData, responseMap,estimatedParams,dose, ...
'"ErrorModel’, 'proportional');
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fitExp sbiofit(model,gData, responseMap,estimatedParams,dose, ...
"ErrorModel’', 'exponential');
fitComb = sbiofit(model, gData, responseMap,estimatedParams,dose, ...

"ErrorModel’', 'combined');
Use Weights Instead of an Error Model

You can specify weights as a numeric matrix, where the number of columns corresponds
to the number of responses. Setting all weights to 1 is equivalent to the constant error
model.

weightsNumeric = ones(size(gData.Conc));
fitWeightsNumeric = sbiofit(model,gData, responseMap,estimatedParams,dose, 'Weights', weil

Alternatively, you can use a function handle that accepts a vector of predicted response
values and returns a vector of weights. In this example, use a function handle that is
equivalent to the proportional error model.

weightsFunction = @(y) 1./y."2;
fitWeightsFunction = sbiofit(model,gData, responseMap,estimatedParams,dose, 'Weights', we:

Compare Information Criteria for Model Selection

Compare the loglikelihood, AIC, and BIC values of each model to see which error model
best fits the data. A larger likelihood value indicates the corresponding model fits the
model better. For AIC and BIC, the smaller values are better.

allResults = [fitConst, fitWeightsNumeric, fitWeightsFunction,fitProp, fitExp,fitComb];

errorModelNames = {'constant error model', 'equal weights', 'proportional weights"',
"proportional error model', 'exponential error model',...
'combined error model'};

LogLikelihood = [allResults.LoglLikelihood]';

AIC = [allResults.AIC]';

BIC = [allResults.BIC]';

t = table(LogLikelihood,AIC,BIC);

t.Properties.RowNames = errorModelNames;

t
t=6x3 table
LogLikelihood AIC BIC
constant error model 3.9866 -3.9732 -2.8433
equal weights 3.9866 -3.9732 -2.8433
proportional weights -3.8472 11.694 12.824
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proportional error model -3.8257 11.651 12.781
exponential error model 1.1984 1.6032 2.7331
combined error model 3.9163 -3.8326 -2.7027

Based on the information criteria, the constant error model (or equal weights) fits the
data best since it has the largest loglikelihood value and the smallest AIC and BIC.

Display Estimated Parameter Values
Show the estimated parameter values of each model.

Estimated Central zeros(6,1);
Estimated Cl Central zeros(6,1);
t2 = table(Estimated Central,Estimated Cl Central);
t2.Properties.RowNames = errorModelNames;
for 1 = l:height(t2)
t2{i, 1} allResults(i).ParameterEstimates.Estimate(1);
t2{i,2} allResults(i).ParameterEstimates.Estimate(2);

end
t2

t2=6x2 table
Estimated Central Estimated Cl Central

constant error model 1.6993 0.53358
equal weights 1.6993 0.53358
proportional weights 1.9045 0.51734
proportional error model 1.8777 0.51147
exponential error model 1.7872 0.51701
combined error model 1.7008 0.53271

Conclusion

This example showed how to estimate PK parameters, namely the volume of the central
compartment and clearance parameter of an individual, by fitting the PK profile data to
one-compartment model. You compared the information criteria of each model and
estimated parameter values of different error models to see which model best explained
the data. Final fitted results suggested both the constant and combined error models
provided the closest estimates to the parameter values used to generate the data.
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However, the constant error model is a better model as indicated by the loglikelihood,
AIC, and BIC information criteria.

See Also

sbiofit

More About

. “Fit a Two-Compartment Model to PK Profiles of Multiple Individuals” on page 4-92
. “Estimate Category-Specific PK Parameters for Multiple Individuals” on page 4-74
. “Nonlinear Regression” on page 4-46

4-73



4 simulation and Analysis

Estimate Category-Specific PK Parameters for Multiple
Individuals

4-74

This example shows how to estimate category-specific (such as young versus old, male
versus female), individual-specific, and population-wide parameters using PK profile data
from multiple individuals.

Background

Suppose you have drug plasma concentration data from 30 individuals and want to
estimate pharmacokinetic parameters, namely the volumes of central and peripheral
compartment, the clearance, and intercompartmental clearance. Assume the drug
concentration versus the time profile follows the biexponential decline

Cy = Ae™ % 4+ Be™Pt where C is the drug concentration at time t, and a and b are slopes
for corresponding exponential declines.

Load Data

This synthetic data contains the time course of plasma concentrations of 30 individuals
after a bolus dose (100 mg) measured at different times for both central and peripheral
compartments. It also contains categorical variables, namely Sex and Age.

clear
load(fullfile(matlabroot, 'examples', 'simbio', 'sd5 302RAgeSex.mat'))

Convert to groupedData Format

Convert the data set to a groupedData object, which is the required data format for the
fitting function sbiofit. A groupedData object also allows you set independent variable
and group variable names (if they exist). Set the units of the ID, Time, CentralConc,
PeripheralConc, Age, and Sex variables. The units are optional and only required for
the UnitConversion feature, which automatically converts matching physical quantities
to one consistent unit system.

gbata = groupedData(data);

gData.Properties.VariableUnits = {'', "hour', 'milligram/liter', 'milligram/liter"',"'",""}

gData.Properties

ans = struct with fields:
Description:
UserData: []
DimensionNames: {'Row' 'Variables'}
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VariableNames: {1x6 cell}
VariableDescriptions: {}

VariableUnits: {1x6 cell}
VariableContinuity: []
RowNames: {}

CustomProperties: [1x1 matlab.tabular.CustomProperties]
GroupVariableName: 'ID'
IndependentVariableName: 'Time'

The IndependentVariableName and GroupVariableName properties have been
automatically set to the Time and ID variables of the data.

Visualize Data

Display the response data for each individual.

t = sbiotrellis(gbata, 'ID', 'Time',{'CentralConc', 'PeripheralConc'}, ...
'Marker','+','LineStyle', 'none');

% Resize the figure.
t.hFig.Position(:) = [160 160 1280 800];
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Set Up a Two-Compartment Model

+  CenkaiConc
+  ParipheralConc

Use the built-in PK library to construct a two-compartment model with infusion dosing
and first-order elimination where the elimination rate depends on the clearance and

volume of the central compartment. Use the configset object to turn on unit

conversion.

pkmd
pkcl
pkcl.DosingType

pkcl.EliminationType
pkcl.HasResponseVariable

pkc2
model
configset

configset.CompileOptions.UnitConversion
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PKModelDesign;
addCompartment (pkmd, 'Central');

'Bolus';

'linear-clearance’';

true;

addCompartment(pkmd, 'Peripheral');
construct(pkmd);

getconfigset(model);

true;
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For details on creating compartmental PK models using the SimBiology® built-in library,
see “Create Pharmacokinetic Models” on page 5-14.

Define Dosing

Assume every individual receives a bolus dose of 100 mg at time = 0. For details on
setting up different dosing strategies, see “Doses in SimBiology Models” on page 2-42.

dose = sbiodose('dose', 'TargetName', 'Drug Central');
dose.StartTime = 0;

dose.Amount = 100;

dose.AmountUnits = 'milligram';

dose.TimeUnits = 'hour';

Map the Response Data to Corresponding Model Components

The data contains measured plasma concentration in the central and peripheral
compartments. Map these variables to the appropriate model components, which are
Drug Central and Drug Peripheral.

responseMap = {'Drug Central = CentralConc', 'Drug Peripheral = PeripheralConc'};

Specify Parameters to Estimate

Specify the volumes of central and peripheral compartments Central and Peripheral,
intercompartmental clearance Q12, and clearance Cl_Central as parameters to
estimate. The estimatedInfo object lets you optionally specify parameter transforms,
initial values, and parameter bounds. Since both Central and Peripheral are
constrained to be positive, specify a log-transform for each parameter.

paramsToEstimate
estimatedParam

{'log(Central)', 'log(Peripheral)', 'Q12', 'Cl Central'};
estimatedInfo(paramsToEstimate, 'InitialValue',[1 1 1 11);

Estimate Individual-Specific Parameters

Estimate one set of parameters for each individual by setting the 'Pooled' name-value
pair argument to false.

unpooledFit = sbiofit(model,gData, responseMap,estimatedParam,dose, 'Pooled', false);

Display Results

Plot the fitted results versus the original data for each individual (group).
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t = plot(unpooledFit);
% Resize the figure.
t.hFig.Position(:) = [100 100 1280 800];
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For an unpooled fit, sbiofit always returns one results object for each individual.

Examine Parameter Estimates for Category Dependencies

Explore the unpooled estimates to see if there is any category-specific parameters, that is,
if some parameters are related to one or more categories. If there are any category
dependencies, it might be possible to reduce the number of degrees of freedom by
estimating just category-specific values for those parameters.

First extract the ID and category values for each ID

catParamValues = unique(gData(:,{'ID','Sex','Age'}));
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Add variables to the table containing each parameter's estimate.

allParamValues
catParamValues.Central
catParamValues.Peripheral
catParamValues.Q12
catParamValues.Cl Central

vertcat(unpooledFit.ParameterEstimates);

allParamValues.Estimate(strcmp(allParamValues.Name, 'Centr:
allParamValues.Estimate(strcmp(allParamValues.Name, 'Peripl
allParamValues.Estimate(strcmp(allParamValues.Name, 'Q12')
allParamValues.Estimate(strcmp(allParamValues.Name, 'Cl Cer

Plot estimates of each parameter for each category. gscatter requires Statistics and
Machine Learning Toolbox™. If you do not have it, use other alternative plotting functions
such as plot.

h

ylabels
plotNumber

figure;
{'Central', 'Peripheral', 'Cl\ _Central','Ql2'};
1;

for i = 1:4

end

thisParam = estimatedParam(i).Name;

% Plot for Sex category

subplot(4,2,plotNumber);

plotNumber = plotNumber + 1;

gscatter(double(catParamValues.Sex), catParamValues.(thisParam), catParamValues.Se;
ax = gca;

ax.XTick = [1;

ylabel(ylabels(i));

legend('Location', 'bestoutside')

% Plot for Age category

subplot(4,2,plotNumber);

plotNumber = plotNumber + 1;

gscatter(double(catParamValues.Age), catParamValues.(thisParam), catParamValues.Ag:
ax = gca;

ax.XTick = [1;

ylabel(ylabels(i));

legend('Location', 'bestoutside')

% Resize the figure.
h.Position(:) = [100 100 1280 8001];
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Based on the plot, it seems that young individuals tend to have higher volumes of central
and peripheral compartments (Central, Peripheral) than old individuals (that is, the
volumes seem to be age-specific). In addition, males tend to have higher clearance rates
(CL _Central) than females but the opposite for the Q12 parameter (that is, the
clearance and Q12 seem to be sex-specific).

Estimate Category-Specific Parameters

Use the 'CategoryVariableName' property of the estimatedInfo object to specify
which category to use during fitting. Use 'Sex' as the group to fit for the clearance

Cl Central and Q12 parameters. Use 'Age' as the group to fit for the Central and
Peripheral parameters.

estimatedParam(1l).CategoryVariableName = 'Age’;
estimatedParam(2).CategoryVariableName = 'Age’;
estimatedParam(3).CategoryVariableName = 'Sex';



Estimate Category-Specific PK Parameters for Multiple Individuals

estimatedParam(4).CategoryVariableName =

'Sex';

categoryFit = sbiofit(model,gData, responseMap,estimatedParam,dose)

categoryFit =
OptimResults with properties:
ExitFlag: 3
Output: [1x1 struct]
GroupName: []
Beta: [8x5 table]
ParameterEstimates: [120x6 table]
J: [240x8x2 doublel]
COVB: [8x8 double]
CovarianceMatrix: [8x8 double]
R: [240x2 double]
MSE: 0.4362
SSE: 205.8690
Weights: []
LogLikelihood: -477.9195
AIC: 971.8390
BIC: 1.0052e+03
DFE: 472
DependentFiles: {1x3 cell}
EstimatedParameterNames: {'Central' ‘'Peripheral' 'Q12' 'Cl Central'}
ErrorModelInfo: [1x3 table]
EstimationFunction: 'lsgnonlin’

When fitting by category (or group), sbiofit always returns one results object, not one
for each category level. This is because both male and female individuals are considered
to be part of the same optimization using the same error model and error parameters,
similarly for the young and old individuals.

Plot Results
Plot the category-specific estimated results.
t = plot(categoryFit);

% Resize the figure.
t.hFig.Position(:) = [100 100 1280 800];
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For the Cl_Central and Q12 parameters, all males had the same estimates, and
similarly for the females. For the Central and Peripheral parameters, all young
individuals had the same estimates, and similarly for the old individuals.

Estimate Population-Wide Parameters

To better compare the results, fit the model to all of the data pooled together, that is,
estimate one set of parameters for all individuals by setting the 'Pooled' name-value
pair argument to true. The warning message tells you that this option will ignore any
category-specific information (if they exist).

pooledFit = sbiofit(model,gData, responseMap,estimatedParam,dose, 'Pooled’, true);

Warning: CategoryVariableName property of the estimatedInfo object is ignored when usii
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Concentration

2

5]

Plot Results

Plot the fitted results versus the original data. Although a separate plot was generated for
each individual, the data was fitted using the same set of parameters (that is, all
individuals had the same fitted line).

t = plot(pooledFit);
% Resize the figure.

t.hFig.Position(:) = [100 100 1280 800];
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Compare Residuals

Compare residuals of CentralConc and PeripheralConc responses for each fit.

t = gData.Time;
allResid(:,:,1) = pooledFit.R;
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allResid(:,:,2)
allResid(:,:,3)

categoryFit.R;
vertcat(unpooledFit.R);

h = figure;
responseList = {'CentralConc', 'PeripheralConc'};
for i = 1:2
subplot(2,1,1);
oneResid = squeeze(allResid(:,1i,:));
plot(t,oneResid, '0");
refline(0,0); % A reference line representing a zero residual
title(sprintf('Residuals (%s)', responselList{i}));
xlabel('Time");
ylabel('Residuals');
legend({'Pooled', 'Category-Specific', 'Unpooled'});
end
% Resize the figure.
h.Position(:) = [100 100 1280 800];
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As shown in the plot, the unpooled fit produced the best fit to the data as it fit the data to
each individual. This was expected since it used the most number of degrees of freedom.
The category-fit reduced the number of degrees of freedom by fitting the data to two
categories (sex and age). As a result, the residuals were larger than the unpooled fit, but
still smaller than the population-fit, which estimated just one set of parameters for all
individuals. The category-fit might be a good compromise between the unpooled and
pooled fitting provided that any hierarchical model exists within your data.

See Also

sbiofit
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More About

. “Fit a One-Compartment Model to an Individual's PK Profile” on page 4-66
. “Fit a Two-Compartment Model to PK Profiles of Multiple Individuals” on page 4-92
. “Nonlinear Regression” on page 4-46
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Perform Hybrid Optimization Using sbiofit

This example shows how to configure sbiofit to perform a hybrid optimization by first
running the global solver particleswarm, followed by another minimization function,
fmincon.

Load Data

Load the sample data to fit. The data is stored as a table with variables ID, Time,
CentralConc, and PeripheralConc. This synthetic data represents the time course of
plasma concentrations measured at eight different time points for both central and
peripheral compartments after an infusion dose for three individuals.

clear all

load(fullfile(matlabroot, 'examples', 'simbio', 'datal® 32R.mat'))

gbData = groupedData(data);

gData.Properties.VariableUnits = {'', 'hour', 'milligram/liter', 'milligram/liter'};

sbiotrellis(gData, 'ID', 'Time"',{'CentralConc', 'PeripheralConc'}, 'Marker"','+"',...
'LineStyle', 'none');
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Time

Create Model

Create a two-compartment model with an infusion dose.

pkmd

pkcl

pkcl.DosingType
pkcl.EliminationType
pkcl.HasResponseVaria
pkc2

model

configset =

L T [ 2 | R | O | I 1

ID 1 ID 2
+
+
++
+
++
+ + + +
o+ +H | ¥ + I %
ID 3
+
T+
+
+ T4 I o+ +
10 20 30

PKModelDesign;

addCompartment (pkmd, 'Central');

'Infusion';
'linear-clearance';

le = true;

addCompartment(pkmd, 'Peripheral');

construct(pkmd);

getconfigset(model);

configset.CompileOptions.UnitConversion =
dose = sbiodose('dose', 'TargetName', 'Drug Central');
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dose.StartTime = 0;
dose.Amount = 100;
dose.Rate = 50;
dose.AmountUnits = 'milligram';
dose.TimeUnits = 'hour';

dose.RateUnits 'milligram/hour’;
responseMap = {'Drug Central = CentralConc', 'Drug Peripheral = PeripheralConc'};

Define Parameters to Estimate

Use the estimatedInfo object to define the estimated parameters.

paramsToEstimate
estimatedParam

{'log(Central)', 'log(Peripheral) ', 'Q12"','Cl Central'};
estimatedInfo(paramsToEstimate, 'Initialvalue',[1 1 1 17,...
'Bounds', [0 10]1);

Define the Options for Hybrid Optimization

Define the options for the global solver and the hybrid solver. Because the parameters are
bounded, make sure you use a compatible hybrid function for a constrained optimization,
such as fmincon. Use optimset to define the options for fminsearch. Use
optimoptions to define the options for fminunc, patternsearch, and fmincon.

rng('default');

globalMethod = 'particleswarm';

options = optimoptions(globalMethod);

hybridMethod = 'fmincon';

hybridopts = optimoptions(hybridMethod, 'Display', 'none');

options = optimoptions(options, 'HybridFcn', {hybridMethod, hybridopts});

Fit Data

Estimate model parameters. Turn on ProgressPlot to see the live feedback on the
status of fitting. The first row of plots are the quality measure plots for the global solver.
The second row plots are for the hybrid function. For details, see “Progress Plot” on page
4-57.

unpooledFit = sbiofit(model,gData, responseMap,estimatedParam,dose,globalMethod, ...

options, 'Pooled', false, 'ProgressPlot',true);

4-89



4 simulation and Analysis
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Plot Results

plot(unpooledFit);
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See Also

sbiofit

More About

“Fit a One-Compartment Model to an Individual's PK Profile” on page 4-66

+  O0BS1(CaentralConc)

+  OBSZ (PerpharalCaonc)

PRED1 (Cantral Drug_Cantral)
— PREDZ (Paripharal Drug_Paripharal)

“Fit a Two-Compartment Model to PK Profiles of Multiple Individuals” on page 4-92

“Nonlinear Regression” on page 4-46
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Fit a Two-Compartment Model to PK Profiles of Multiple
Individuals

4-92

This example shows how to estimate pharmacokinetic parameters of multiple individuals
using a two-compartment model.

Suppose you have drug plasma concentration data from three individuals that you want to
use to estimate corresponding pharmacokinetic parameters, namely the volume of central
and peripheral compartment (Central, Peripheral), the clearance rate (Cl_Central),
and intercompartmental clearance (Q12). Assume the drug concentration versus the time

profile follows the biexponential decline C; = Ae~ 9 + Be™Pt, where C, is the drug
concentration at time t, and a and b are slopes for corresponding exponential declines.

The synthetic data set contains drug plasma concentration data measured in both central
and peripheral compartments. The data was generated using a two-compartment model
with an infusion dose and first-order elimination. These parameters were used for each
individual.

Central Peripheral Q12 Cl_Central
Individual 1 1.90 0.68 0.24 0.57
Individual 2 2.10 6.05 0.36 0.95
Individual 3 1.70 4.21 0.46 0.95

The data is stored as a table with variables ID, Time, CentralConc, and
PeripheralConc. It represents the time course of plasma concentrations measured at
eight different time points for both central and peripheral compartments after an infusion
dose.

clear all
load(fullfile(matlabroot, 'examples', 'simbio’, 'datal® 32R.mat'))

Convert the data set to a groupedData object which is the required data format for the
fitting function sbiofit for later use. A groupedData object also lets you set
independent variable and group variable names (if they exist). Set the units of the ID,
Time, CentralConc, and PeripheralConc variables. The units are optional and only
required for the UnitConversion feature, which automatically converts matching
physical quantities to one consistent unit system.
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gbata = groupedData(data);
gData.Properties.VariableUnits = {'', "hour', 'milligram/liter', 'milligram/liter'};
gData.Properties

ans =

struct with fields:

Description: "'
UserData: []
DimensionNames: {'Row' 'Variables'}
VariableNames: {'ID' 'Time' 'CentralConc' 'PeripheralConc'}

VariableDescriptions: {}
VariableUnits: {1x4 cell}
VariableContinuity: []
RowNames: {}
CustomProperties: [1x1 matlab.tabular.CustomProperties]
GroupVariableName: 'ID'
IndependentVariableName: 'Time'

Create a trellis plot that shows the PK profiles of three individuals.

sbiotrellis(gData, 'ID', 'Time"',{'CentralConc', 'PeripheralConc'}, ...
'Marker','+','LineStyle', 'none');
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Use the built-in PK library to construct a two-compartment model with infusion dosing
and first-order elimination where the elimination rate depends on the clearance and
volume of the central compartment. Use the configset object to turn on unit conversion.

pkmd = PKModelDesign;

pkcl = addCompartment (pkmd, 'Central');
pkcl.DosingType = 'Infusion’;

pkcl.EliminationType = 'linear-clearance’;
pkcl.HasResponseVariable = true;

pkc2 = addCompartment (pkmd, 'Peripheral');
model = construct(pkmd);

configset = getconfigset(model);

configset.CompileOptions.UnitConversion =
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Assume every individual receives an infusion dose at time = 0, with a total infusion
amount of 100 mg at a rate of 50 mg/hour. For details on setting up different dosing
strategies, see “Doses in SimBiology Models” on page 2-42.

dose = sbiodose('dose', 'TargetName', 'Drug Central');
dose.StartTime = 0;

dose.Amount = 100;

dose.Rate = 50;

dose.AmountUnits = 'milligram';

dose.TimeUnits = 'hour';

dose.RatelUnits 'milligram/hour’;

The data contains measured plasma concentrations in the central and peripheral
compartments. Map these variables to the appropriate model species, which are
Drug Central and Drug Peripheral.

responseMap = {'Drug _Central = CentralConc', 'Drug Peripheral = PeripheralConc'};

The parameters to estimate in this model are the volumes of central and peripheral
compartments (Central and Peripheral), intercompartmental clearance Q12, and
clearance rate CL_Central. In this case, specify log-transform for Central and
Peripheral since they are constrained to be positive. The estimatedInfo object lets
you specify parameter transforms, initial values, and parameter bounds (optional).

paramsToEstimate
estimatedParam

{'log(Central)', 'log(Peripheral)', 'Q12"','Cl Central'};
estimatedInfo(paramsToEstimate, 'InitialValue',[1 1 1 11);

Fit the model to all of the data pooled together, that is, estimate one set of parameters for
all individuals. The default estimation method that sbiofit uses will change depending
on which toolboxes are available. To see which estimation function sbiofit used for the
fitting, check the EstimationFunction property of the corresponding results object.

pooledFit = sbiofit(model, gData, responseMap,estimatedParam,dose, 'Pooled', true)

pooledFit

OptimResults with properties:

ExitFlag: 3
OQutput: [1x1 struct]
GroupName: []
Beta: [4x3 table]
ParameterEstimates: [4x3 table]
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J:

COVB:
CovarianceMatrix:
R:

MSE:

SSE:

Weights:
LogLikelihood:

AIC:

BIC:

DFE:
DependentFiles:
EstimatedParameterNames:
ErrorModelInfo:
EstimationFunction:

4x4 double]
4x4 double]

—_r———

6.6220
291.3688

[]
-111.3904
230.7808
238.2656
44

{1x3 cell}
{'Central’
[1x3 tablel]
"lsgnonlin'

24x4x2 double]

24x2 doublel]

'Peripheral’

|012|

'Cl_Central'}

Plot the fitted results versus the original data. Although three separate plots were
generated, the data was fitted using the same set of parameters (that is, all three
individuals had the same fitted line).

plot(pooledFit);
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Estimate one set of parameters for each individual and see if there is any improvement in
the parameter estimates. In this example, since there are three individuals, three sets of
parameters are estimated.

unpooledFit = sbiofit(model,gData, responseMap,estimatedParam,dose, 'Pooled', false);

Plot the fitted results versus the original data. Each individual was fitted differently (that
is, each fitted line is unique to each individual) and each line appeared to fit well to
individual data.

plot(unpooledFit);
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Display the fitted results of the first individual. The MSE was lower than that of the
pooled fit. This is also true for the other two individuals.

unpooledFit(1)

ans =

OptimResults with properties:

ExitFlag: 3
Output: [1x1 struct]

GroupName: 1
Beta: [4x3 table]
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ParameterEstimates: [4x3 table]
J: [8x4x2 double]
COVB: [4x4 double]
CovarianceMatrix: [4x4 double]
R: [8x2 double]
MSE: 2.1380
SSE: 25.6559
Weights: []
LogLikelihood: -26.4805
AIC: 60.9610
BIC: 64.0514
DFE: 12
DependentFiles: {1x3 cell}
EstimatedParameterNames: {'Central' 'Peripheral' 'Q12' 'Cl Central'}
ErrorModelInfo: [1x3 table]
EstimationFunction: 'lsgnonlin’

Generate a plot of the residuals over time to compare the pooled and unpooled fit results.
The figure indicates unpooled fit residuals are smaller than those of pooled fit as
expected. In addition to comparing residuals, other rigorous criteria can be used to

compare the fitted results.

t = [gData.Time;gData.Time];

res pooled = vertcat(pooledFit.R);

res pooled = res pooled(:);

res unpooled = vertcat(unpooledFit.R);

res unpooled = res unpooled(:);

plot(t,res pooled, ‘o', 'MarkerFaceColor','w', "markerEdgeColor','b")
hold on

plot(t,res unpooled, 'o', 'MarkerFaceColor','b", 'markerEdgeColor"','b")
refl = refline(0,0); % A reference line representing a zero residual
title('Residuals versus Time');

xlabel('Time');

ylabel('Residuals"');

legend({'Pooled', 'Unpooled'});

4-99



4 simulation and Analysis

Residuals versus Time
'5 T T T T T T T

O Podled
® Unpooled

o0

m
o o
.13 2+ O .
i o
o
_‘4 - -
] o &
_E - -
o
A+ -
o
_,ID 1 1 i 1 1 1 1
0 5 10 15 20 25 30 35 40

Time

This example showed how to perform pooled and unpooled estimations using sbiofit.

As illustrated, the unpooled fit accounts for variations due to the specific subjects in the
study, and, in this case, the model fits better to the data. However, the pooled fit returns
population-wide parameters. If you want to estimate population-wide parameters while

considering individual variations, use sbiofitmixed.

See Also

sbiofit
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More About

. “Fit a One-Compartment Model to an Individual's PK Profile” on page 4-66
. “Estimate Category-Specific PK Parameters for Multiple Individuals” on page 4-74
. “Nonlinear Regression” on page 4-46
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In this example, you will use the parameter estimation capabilities of SimBiology™ to
calculate F, the bioavailability, of the drug ondansetron. You will calculate F by fitting a
model of absorption and excretion of the drug to experimental data tracking drug
concentration over time.

This example requires Optimization Toolbox™.
Background

Most drugs must be absorbed into the bloodstream in order to become active. An
intravenous (IV) administration of a drug is one way to achieve this. However, it is
impractical or impossible in many cases.

When a drug is not given by IV, it follows some other route into the bloodstream, such as
absorption through the mucous membranes of the GI tract or mouth. Drugs administered
through a route other than IV administration are generally not completely absorbed.
Some portion of the drug is directly eliminated and never reaches the bloodstream.

The percentage of drug absorbed is the bioavailability of the drug. Bioavailability is one of
the most important pharmacokinetic properties of a drug. It is useful when calculating
safe dosages for non-IV routes of administration. Bioavailability is calculated relative to
an IV administration. When administered intravenously, a drug has 100% bioavailability.
Other routes of administration tend to reduce the amount of drug that reaches the blood
stream.

Modeling Bioavailability

Bioavailability can be modeled using one of several approaches. In this example, you use
a model with a GI compartment and a blood plasma compartment. Oral administration is
modeled by a dose event in the GI compartment. IV administration is modeled by a dose
event in the blood plasma compartment.

The example models the drug leaving the GI compartment in two ways. The available
fraction of the drug is absorbed into the bloodstream. The remainder is directly
eliminated. The total rate of elimination, ka, is divided into absorption, ka Central, and
direct elimination, Cl_0Oral. The bioavailability, F, connects total elimination with

ka _Central and Cl_Oral via two initial assignment rules.

ka Central = F*ka
Cl Oral = (1-F)*ka
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The drug is eliminated from the Blood Plasma compartment through first-order
kinetics, at a rate determined by the parameter CL_Central.

fun]
Drug_Oral
faar]
Gl_Compartment

- Orug_Central
Direct Elimination Central Absorption
] =
C J=——8|(1-Frka (- @ Fka

Cl_Qral ka_Central Blood Plasma

Drug Elimination

Cl_Central

@

Load the project that contains the model m1.
sbioloadproject(fullfile(matlabroot, 'examples', 'simbio', 'Bioavailability.sbproj'), 'ml"
Format of the Data for Estimating Bioavailability

You can estimate bioavailability by comparing intrapatient measurements of drug
concentration under different dosing conditions. For instance, a patient receives an IV
dose on day 1, then receives an oral dose on day 2. On both days, we can measure the
blood plasma concentration of the drug over some period of time.

Such data allow us to estimate the bioavailability, as well as other parameters of the
model. Intrapatient time courses were generated for the drug ondansetron, reported in
[2] and reproduced in [1].

Load the data, which is a table.

load(fullfile(matlabroot, 'examples', 'simbio', 'ondansetron data.mat'));
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Convert the data to a groupedData object because the fitting function sbiofit requires
it to be a groupedData object.

gd = groupedData(ondansetron_data);
Display the data.

qd

gd =

33x5 groupedData

Time Drug Group IV Oral
0 NaN 1 8 NaN
0.024358 69.636 1 NaN NaN
0.087639 58.744 1 NaN NaN
0.15834 49.824 1 NaN NaN
0.38895 44 .409 1 NaN NaN
0.78392 40.022 1 NaN NaN
1.3182 34.522 1 NaN NaN
1.8518 28.972 1 NaN NaN
2.4335 25.97 1 NaN NaN
2.9215 22.898 1 NaN NaN
3.41 20.75 1 NaN NaN
3.8744 18.095 1 NaN NaN
4.9668 13.839 1 NaN NaN
5.8962 10.876 1 NaN NaN
7.8717 6.6821 1 NaN NaN
10.01 4.0166 1 NaN NaN
12.08 2.5226 1 NaN NaN
15.284 0.97816 1 NaN NaN
0 NaN 2 NaN 8
0.54951 5.3091 2 NaN NaN
0.82649 14.262 2 NaN NaN
1.0433 19.72 2 NaN NaN
1.4423 21.654 2 NaN NaN
2.0267 22.144 2 NaN NaN
2.5148 19.739 2 NaN NaN
2.9326 17.308 2 NaN NaN
3.3743 15.599 2 NaN NaN
3.9559 13.906 2 NaN NaN
4.9309 10.346 2 NaN NaN
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6.1155 7.4489 2 NaN NaN
8.0002 5.1919 2 NaN NaN
10.091 2.9058 2 NaN NaN
12.228 1.6808 2 NaN NaN

The data have variables for time, drug concentration, grouping information, IV, and oral
dose amounts. Group 1 contains the data for the IV time course. Group 2 contains the
data for the oral time course. NaN in the Drug column means no measurement was made
at that time. NaN in one of the dosing columns means no dose was given through that
route at that time.

Plot the pharmacokinetic profiles of the oral dose and IV administration.

plot(gd.Time(gd.Group==1),g9d.Drug(gd.Group==1), 'Marker','+")
hold on
plot(gd.Time(gd.Group==2),gd.Drug(gd.Group==2), 'Marker"', 'x")
legend({'8 mg IV','8 mg Oral'})

xlabel('Time (hour)")

ylabel('Concentration (milligram/liter)")
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Notice there is a lag phase in the oral dose of about an hour while the drug is absorbed
from the GI tract into the bloodstream.

Fitting the Data

Estimate the following four parameters of the model:

» Total forward rate out of the dose compartment, ka

* Clearance from the Blood Plasma compartment, clearance
* Volume of the Blood Plasma compartment

* Bioavailability of the orally administered drug, F
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Set the initial values of these parameters and specify the log transform for all parameters
using an estimatedInfo object.

init =[11 2 .8];
estimated parameters = estimatedInfo({'log(ka)"', 'log(clearance)’',...
‘log(Blood Plasma)', 'logit(F) '}, 'InitialValue',init);

Because ka, clearance, and Blood Plasma are positive physical quantities, log
transforming reflects the underlying physical constraint and generally improves fitting.
This example uses a logit transform on F because it is a quantity constrained between 0
and 1. The logit transform takes the interval of 0 to 1 and transforms it by taking the log-
odds of F (treating F as a probability). For a few drugs, like theophyline, constraining F
between 0 and 1 is inappropriate because oral bioavailability can be greater than 1 for
drugs with unusual absorption or metabolism mechanisms.

Next, map the response data to the corresponding model component. In the model, the
plasma drug concentration is represented by Blood Plasma.Drug Central. The
corresponding concentration data is the Drug variable of the groupedData object gd.

responseMap = {'Blood Plasma.Drug Central = Drug'};

Create the dose objects required by sbiofit to handle the dosing information. First,
create the IV dose targeting Drug Central and the oral dose targeting Dose Central.

iv_dose
oral dose

sbiodose('IV', 'TargetName', 'Drug Central');
sbiodose('Oral', 'TargetName', 'Drug Oral');

Use these dose objects as template doses to generate an array of dose objects from the
dosing data variables IV and Oral.

doses for fit = createDoses(gd,{'IV','Oral'},"'',[iv_dose, oral dosel);

Estimate parameters using sbiofit.

opts = optimoptions('lsgnonlin', 'Display','final');

results = sbiofit(ml, gd, responseMap,estimated parameters,doses for fit,...
'lsgnonlin',opts,[], 'pooled', true);

Local minimum possible.

lsgnonlin stopped because the final change in the sum of squares relative to
its initial value is less than the value of the function tolerance.
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Interpreting Results
First, check if the fit is successful.

plot(results)
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Overall, the results seem to be a good fit. However, they do not capture a distribution
phase over the first hour. It might be possible to improve the fit by adding another
compartment, but more data would be required to justify such an increase in model
complexity.

When satisfied with the model fit, you can draw conclusions about the estimated
parameters. Display the parameters stored in the results object.
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results.ParameterEstimates

ans=4x3 table

Name Estimate StandardError
{'ka' } 0.77947 0.1786
{'clearance' } 45,19 2.8674
{'Blood Plasma'} 138.73 4.5249
{'F' } 0.64455 0.066013

The parameter F is the bioavailability. The result indicates that ondansetron has
approximately a 64% bioavailability. This estimate in line with the literature reports that
oral administration of ondansetron in the 2-24 milligram range has a 60% bioavailability
[1,2].

Blood Plasma is the volume of distribution. This result is reasonably close to the 160
liter Vd reported for ondansetron [1]. The estimated clearance is 45.4 L/hr.

ka does not map directly onto a widely reported pharmacokinetic parameter. Consider it
from two perspectives. We can say that 64% of the drug is available, and that the
available drug has an absorption parameter of 0.4905/hr. Or, we can say that drug
clearance from the GI compartment is 0.7402/hr, and 64% of the drug cleared from the GI
tract is absorbed into the bloodstream.

Generalizing This Approach

lsgnonlin, as well as several other optimization algorithms supported by sbiofit, are
local algorithms. Local algorithms are subject to the possibility of finding a result that is
not the best result over all possible parameter choices. Because local algorithms do not
guarantee convergence to the globally best fit, when fitting PK models, restarting the fit
with different initial conditions multiple times is a good practice. Alternatively, sbiofit
supports several global methods, such as particle swarm, or genetic algorithm
optimization. Verifying that a fit is of sufficient quality is an important step before
drawing inferences from the values of the parameters.

This example uses data that was the mean time course of several patients. When fitting a
model with data from more patients, some parameters might be the same between
patients, some not. Such requirements introduce the need for hierarchical modeling. You
can perform hierarchical modeling can by configuring the CategoryVariableName flag
of EstimatedInfo object.
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. “Fit a Two-Compartment Model to PK Profiles of Multiple Individuals” on page 4-92
. “Nonlinear Regression” on page 4-46
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Accelerating Model Simulations and Analyses

In this section...

“What Is Acceleration?” on page 4-111

“When to Accelerate” on page 4-111

“Prerequisites for Accelerating Simulations and Analyses” on page 4-111
“Accelerate Simulations Programmatically” on page 4-112

“Accelerate Simulations using SimBiology Model Analyzer” on page 4-114

“Troubleshooting Accelerated Simulations” on page 4-114

What Is Acceleration?

Normally, when simulating or analyzing a model in SimBiology, the model is expressed in
MATLAB code. You can accelerate the simulation by converting the model to compiled C
code, which executes faster. Because this compilation step has a small time overhead,
acceleration is not recommended for individual simulations of small models. However, for
large models, or for repeated simulations during analysis, acceleration can provide a
significant speed increase that outweighs the small time overhead.

When to Accelerate

The functionality to accelerate simulations performs optimally under the following
conditions:

* Running repeated simulations with different initial conditions

* Running very long simulations (for example, simulations that take longer than a
minute to run)

Prerequisites for Accelerating Simulations and Analyses

To prepare your models for accelerated simulations, install and set up a compiler:

1 Install a C compiler (if one is not already installed on your system). For a current list
of supported compilers, see Supported and Compatible Compilers.

2 Ensure that any user-defined functions in your model can be used for code generation
from MATLAB, so they can convert to compiled C. For more information, see
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Language, Function, and Object support for C and C++ code generation (MATLAB
Coder) or contact MathWorks Technical Support.

Note

* On 32-bit Windows platforms, the LCC compiler is automatically installed. However,
for better performance of the acceleration functionality, you may want to install a
supported compiler other than LCC, and it will be selected automatically.

* On 64-bit Windows platforms, if you have not installed another compiler, SimBiology
uses the LCC64 compiler for model accelerations. If you have installed another
supported compiler, it will be selected automatically.

* Microsoft® Visual Studio® 2010 run-time libraries must be available on any computer
running accelerated models generated using Microsoft Windows SDK.

* Ifyou plan to redistribute your accelerated models to other MATLAB users, be sure
they have the same run-time libraries.

Accelerate Simulations Programmatically

Use sbioaccelerate if you are accelerating a SimBiology model. For a SimFunction
object and an exported model (SimBiology.export.Model), use the corresponding
accelerate method.

Using shioaccelerate

Follow the two-step process for acceleration.

1 Run sbioaccelerate to prepare your model for accelerated simulations. Use the
same input arguments that you plan to use with sbhiosimulate in the next step. For
example:

sbioaccelerate(model, configset,doses);

For a very large model, this step may take a minute or longer to complete.

2 Run sbiosimulate with the same input arguments that you used with
sbioaccelerate. For example:

simdata = sbiosimulate(model,configset,doses);
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If you pass in an array of doses to sbhioaccelerate, you can simulate the model using
any subset of these doses and do not need to run acceleration again.

For illustrated examples, see the following.

* “Prepare a Model for Accelerated Simulation”
* “Accelerate Simulation With Array of Doses”

Using accelerate

A SimFunction object is automatically accelerated at the first function execution. Hence
it is not necessary to accelerate the model before you create the object. However,
manually accelerate using the accelerate method of the object if you want it
accelerated in your deployment applications.

For exported model, see accelerate.
When to Rerun Acceleration

If you make any modifications to the model, such as changes to reactions or adding
events, you need to rerun the acceleration, before running simulations.

However, there are exceptions. You do not need to accelerate again if you are making the
changes to:

* Any variants

» InitialAmount property of species

* Capacity property of compartments

* Value property of parameters

* StopTime property of configset

* OutputTimes property of SolverOptions

» Active, Amount, and Rate properties of ScheduleDose and RepeatDose
* Time property of ScheduleDose

* Interval, RepeatCount, and StartTime properties of RepeatDose

* Notes, Tag, and UserData properties of any applicable objects
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Accelerate Simulations using SimBiology Model Analyzer

You can enable the model acceleration in the SimBiology Model Analyzer app by
checking the Prepare the model for accelerated simulation box in the Model step of
the program.

Troubleshooting Accelerated Simulations

If you have custom functions, use persistent variables only for those (constant) variables
that you do not want to recalculate or reload every function call. The reason is that during
the acceleration process, SimBiology converts the model and custom functions to
compiled C code. If you try to use a persistent variable to share data across generated (or
compiled) C functions, you may have different results. For instance, if you use a persistent
variable to count how many times a function is called, each compiled function will have a
separate count. Those persistent variables in the corresponding compiled functions will
be different from the one used in the MATLAB function that you defined.

If you specify custom functions in SimBiology expressions, you might see the following
warning if your code is not compatible with code generation from MATLAB:

The SimBiology Expression and any user-defined functions

could not be accelerated. Please check that these expressions
and any user-defined functions are supported for code generation
as described in the Code Generation from MATLAB documentation.

where Expression is any of the following:

* Reaction rate/rule expression

* Initial assignment rule expression

* Repeated assignment rule expression
* Event trigger expression

* Event function expression

For more information, see Language, Function, and Object support for C and C++ code
generation (MATLAB Coder) or contact MathWorks Technical Support.


https://www.mathworks.com/support/contact_us.html

See Also

See Also

accelerate | SimBiology.export.Model | SimFunction object | accelerate |
sbioaccelerate

More About
. “SimBiology Apps”
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Noncompartmental analysis (NCA) lets you compute pharmacokinetic (PK) parameters of
a drug from the time course of measured drug concentrations. This approach does not
require the assumption of a specific compartmental model. NCA is often used to
determine the degree of exposure following administration of a drug, such as AUC, and
other PK parameters, such as the clearance and the terminal half-life.

Data

SimBiology lets you calculate NCA parameters from concentration-time data. The data
must contain a time column, a concentration column, and a dose column that defines dose
amounts. Three types of drug administration routes are supported: IV bolus, IV infusion,
and Extravascular. You can have a column for each type. For infusion doses, an infusion
rate column is also needed.

If you have data containing multiple groups of observations, you can define a group
column. If needed, you can use two levels of hierarchy to specify grouping. Specify the
outer level of grouping using the group column, and specify the inner level (subgroups) in
the ID column. Consider data that contains three groups, where each group contains four
patients. The group column labels the three groups, and the ID column labels each
patient.

Dosing

Single-dosing data contains a single dose amount for each individual. Multiple-dosing
data has several doses at different times for each individual. There are common
parameters calculated for either type of dosing data, and parameters that are specific to
single or multiple dosing.

Common Parameters for Single and Multiple Dosing

SimBiology computes some common parameters for single- or multiple-dosing data. This
figure represents the concentration-time profile after a single dose. For multiple dosing,
the same principles apply, except that SimBiology uses the first period, that is, after the

first dose and before the second.
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Figure A shows concentration-time data in a linear scale and illustrates how the AUC
from time O to infinity is calculated. Figure B shows the same data in a semilogarithmic
scale. To compute the terminal rate constant (Lambda z), SimBiology performs a set of
linear regressions of the log-transformed data using each of the last n points (n =3, 4,
5, ...)from the terminal portion of the curve. Lambda z is chosen from the regression
that uses the most points and has the maximum adjusted RZ.

This table describes the common parameters for single and multiple dosing.

Paramete |Description
r
AUC 0 las |Area under the measured concentration-time curve from time = 0 to the last
t time point.
Tlast
AUC 0 last = f Cc(tydt,
0

where C(t) is the plasma concentration at time t.

SimBiology uses the linear trapezoidal method (MATLAB) to calculate the
AUC.
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Paramete |Description

r

AUC infini |Total area under the concentration-time curve extrapolating to Inf using the

ty terminal rate constant Lambda z.

e C last
AUC_lnflnlty = AUC_O_IaSt + W,
where C last is the last observed concentration and Lambda_z is the terminal
rate constant.

AUC infini P _ AUC infinity

ty dose AUC infinity dose = DM

AUCx y |Partial AUC computed for a custom time range, where x and y are the start
and end times, respectively.

AUC extra|Fraction of total AUC infinity obtained from extrapolation.

p_percent ‘ |

_ AUC _infinity — AUC 0 _last
AUC extrap percent = AUC infinity 100.

Lambda z |To calculate the terminal rate constant (Lambda z), SimBiology performs a
set of linear regressions of the log(concentration)-time data using each of
the last n points (n = 3, 4, 5, ...)from the terminal portion of the
curve, that is, points satisfying the conditions: (Time = Tpax)&(Conc < Cpax)-
A minimum of three points is required to determine Lambda z.

Lambda z is chosen from the regression that uses the most points and has
the maximum adjusted R? among all regressions.
— R2y%(n —
adjusted R* =1 - (1-R)*n-1)
n-—2

R2 Coefficient of determination for the linear regressions used in the
Lambda z calculation.

Num_poin |Number of data points from the profile used in the determination of

ts Lambda z.
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Paramete |Description
r
CL Total drug clearance.

DM

Cl= ZC infimity’

where DM is the dose amount.

co Extrapolated concentration at time = 0, computed using a regression of the
first two data points in a profile. This parameter is for IV Bolus doses only.

C max Maximum observed concentration.

C max Do _ C max

se C max_Dose = DM

C max x_ |Maximum observed concentration within a given time range, specified by the

y start time x and the end time y. This parameter is computed when you
specify a custom time range in the Cmax Time Range box in the SimBiology
Model Analyzer app or set the C_max_ranges property of the options object
created by sbioncaoptions.

MRT Mean residence time.

_ AUMC

MRT = 25¢ fimity

Tlast Time of the last observed concentration value above the lower limit of
quantization (LOQ).

T half Terminal half-life of the drug.

- n@

i el = Lambda z

T max T max is the time point at which the maximum concentration (C_max) is
observed.

T max x_y|Time point at which maximum concentration is observed within a given time

range, specified by the start time x and the end time y. This parameter is
computed when you specify a custom time range in the Cmax Time Range
box in the SimBiology Model Analyzer or set the C_max ranges property of
the options object created by sbioncaoptions.
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Paramete |Description
r
V ss Apparent volume of distribution at equilibrium. This parameter is for IV
Bolus doses only.
DM*AUMC
V_ss= A T
AUC infinity
Vz Volume of distribution during the terminal phase.
V2= DM
-~ AUC infinity* Lambda 2z
DM Administered dose amount. For multiple dosing, the last administered dose is
reported.
doseSched |Single- or multiple-dosing data.
ule
administra |Dose administration route. Supported routes are IVBolus, IVInfusion,
tionRoute |ExtraVascular.

Parameters for Single Dosing

In addition to the common parameters, SimBiology reports parameters for single-dosing

data.
Paramete |Description
r
AUMC 0 I |Area under the first moment of the concentration-time curve from time 0 to
ast the last time point Tlast.
Tlast
AUMC 0 last = f L*C(t)dt.
0
AUMC Total area under the first moment of the concentration-time curve

extrapolating to Inf using Lambda z.

Tlast*C last
Lambda z

C last

AUMC = AUMC 0 last + 5
T Lambda z
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Paramete |Description

r

AUMC ext |Fraction of total AUMC obtained from extrapolation.

rap perce ,

nt _ AUMC - AUMC 0 _last
AUMC extrap_percent = AUMC 100.

Parameters for Multiple Dosing

This figure shows the concentration-time profile after multiple doses. SimBiology uses the
first period, that is, after the first dose and before the second, to compute the following
NCA parameters for multiple-dosing data, in addition to the common parameters listed

previously.
4000 — ' ' ! '
Tau |
3500 - : 't ¥ ﬂ 't )
Q Pk t ] E.t' L rjg{;} ¢ b
sooof Jl i T b1 T W 8 |
I.T I : i |I | '?S | 1 |I r TN |
4 ifo 60 60 90¢ 429
it i (Y L N /R ! A tlb )
= s o D €
% r? I'.hl ] ?L ? Jl\' :'r u['; j} JI; ? I'
5 B " D @ I ) LR (3] ® @ ®
=2000fq !4 - ' \ \
¢ | '
% JI e i I| _%;g; i.J ll dr'f] ,L d'fﬁ rl "JP
S ,old B4 &9 gpﬁb &P } o 1
I| 1:,:| Cﬁ ( "i:'
d ._ o 2 0 &t
1000 H H |
lAUC Ta Xg
500 § \& |
: b
D':.J : g : : ; ‘EL@ :
0 10 20 30 40 o o

Time (hour)

4-121



4 simulation and Analysis

Paramete |Description
r
AUC Tau |Area under the concentration-time curve during a dosing period of length
Tau. SimBiology uses the first period, that is, after the first dose and before
the second.
T first period + Tau
AUC_Tau = _first_period
Tau Dosing interval.
C Avg Average concentration over one period.
_ AUC Tau
C Avg = ~Tar
C min Minimum observed concentration during the first period, thatis, C min =
C(T _min).
PTF perce |Peak trough fluctuation over one dosing interval at steady state.
nt
PTF Percent = S-aX~C min ;g
- C Avg
Accumulat |Theoretical accumulation ratio.
ion_Index
. 1
Accumulation Index = [~ o-Lambda z°Tau"
T min Time at which the minimum concentration is reached in a dosing interval.

Sparse Sampling

To calculate PK parameters, measured concentrations at multiple time points for each
individual is needed after the drug administration. Under certain circumstances, it is not
feasible or not practical to obtain such longitudinal data on a single subject. In such
cases, concentration data is collected from multiple individuals at each time point and
then averaged to calculate NCA parameters for each group instead. SimBiology performs
such sparse sampling by taking the average of the dependent variable for all individuals
at the same time point. It then returns the values of NCA parameters for each group.
Time values for each measurement across individuals (IDs) within a group must be

identical.




See Also

Calculating NCA Parameters

You can calculate NCA parameters using the sbionca function in the command line or
using the SimBiology Model Analyzer app.

Using shionca

sbionca provides command line functionality to compute NCA parameters. Define the
data classification options and parameter calculation options using an option object
created by sbioncaoptions. For an example, see “Compute NCA Parameters from
Concentration-Time Data”.

Using SimBiology Model Analyzer

After you import the data, select Program > Non-Compartmental Analysis on the
Home tab. You can classify your data column in the NCA step of the program. If your
data has a grouping column, specify it using Group. Use ID to specify the inner level of
grouping. Specify the dosing data column (IV Bolus Dose or Extravascular Dose).
Lower limit of quantization (LOQ) is a threshold below which the values of dependent
variables are truncated to zero.

Lambda Time Range lets you specify a custom time range to compute the terminal rate
constant (Lambda z). The time range applies to all groups; you cannot specify a different
time range for each group.

Cmax Time Range lets you specify a custom time range to report the maximum
observed concentration within the range (C_max) and the time (T_max) when it is
observed. You can specify a different time range for each group.

Partial AUC lets you specify a custom time range to compute the partial AUC bounded by
the start and end times. You can specify a different time range for each group.

You can export the NCA results to MATLAB workspace. By default, the data is exported as
a table (MATLAB). To convert it to a dataset, use table2dataset.

For a workflow example, see “Calculate NCA Parameters and Fit Model to PK/PD Data
Using SimBiology Model Analyzer App” on page 1-79.

See Also

sbionca | sbioncaoptions
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More About
. “SimBiology Apps”
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Stochastic Simulation of Radioactive Decay

This example shows how to build and simulate a model using the SSA stochastic solver.
The following model will be constructed and stochastically simulated:

* Reaction 1: x -> z with a first-order reaction rate, c = 0.5.
* Initial conditions: x = 1000 molecules, z = 0.

This model can also be used to represent irreversible isomerization.

This example uses parameters and conditions as described in Daniel T. Gillespie, 1977,
"Exact Stochastic Simulation of Coupled Chemical Reactions," The Journal of Physical
Chemistry, vol. 81, no. 25, pp. 2340-2361.

Read the Radioactive Decay Model Saved in SBML Format

SBML = Systems Biology Markup Language, www.sbml.org
model = sbmlimport('radiodecay.xml")

model =
SimBiology Model - RadioactiveDecay

Model Components:
Compartments:
Events:
Parameters:
Reactions:
Rules:

Species:

NOREFORK

View Species Objects of the Model
model.Species

ans =
SimBiology Species Array

Index: Compartment: Name: Value: Units:
1 unnamed X 1000 molecule
2 unnamed z 0 molecule
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View Reaction Objects of the Model
model.Reactions

ans =
SimBiology Reaction Array

Index: Reaction:
1 X -> z

View Parameter Objects for the Kinetic Law
model.Reactions (1) .KineticlLaw(1l).Parameters

ans =
SimBiology Parameter Array

Index: Name: Value: Units:
1 C 0.5 1/second

Update the Reaction to use MassAction Kinetic Law for Stochastic Solvers.

model.Reactions (1) .KineticLaw(1).KineticLawName = 'MassAction';
model.Reactions (1) .KineticLaw(1l).ParameterVariableNames = {'c'};

Simulate the Model Using the Stochastic (SSA) Solver & Plot

cs = getconfigset(model, 'active');
cs.SolverType = 'ssa';

cs.StopTime = 14.0;
cs.CompileOptions.DimensionalAnalysis = false;
[t,X] = sbiosimulate(model);

plot(t,X);

legend('x"', 'z', 'AutoUpdate', 'off');
title('Stochastic Radioactive Decay Simulation');
ylabel('Number of molecules');

xlabel('Time (seconds)');
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Repeat the Simulation to Show Run-to-Run Variability

title('Multiple Stochastic Radioactive Decay Simulations');
hold on;
for loop = 1:20
[t,X] = sbiosimulate(model);
plot(t,X); % Just plot number of reactant molecules
drawnow;
end
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Overlay the Reaction's ODE Solution in Red

C

s = getconfigset(model, 'active');

cs.SolverType = 'sundials';
cs.StopTime = 20;

[t,X] = sbiosimulate(model);
plot(t,X, ' 'red");

hold off;
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* “Pharmacokinetic Modeling Functionality” on page 5-2

* “Importing Data — Supported Files and Data Types” on page 5-5
* “Importing Data” on page 5-11

* “Create Pharmacokinetic Models” on page 5-14

* “Perform Data Fitting with PK/PD Models” on page 5-26
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Pharmacokinetic Modeling Functionality

5-2

In this section...

“Overview” on page 5-2

“How SimBiology Supports Pharmacokinetic Modeling” on page 5-2
“Pharmacokinetic Modeling Examples” on page 5-3
“Acknowledgements: Tobramycin Data Set” on page 5-4

Overview

SimBiology software extends the MATLAB computing environment for analyzing
pharmacokinetic (PK) data using models. The software lets you do the following:

* Create models — Use a model construction wizard. Alternatively, extend any model
with pharmacodynamic (PD) model components, or build higher fidelity models. See
“Model” on page 5-2 for more information.

» Fit data — Fit nonlinear, mixed-effects models to data, and estimate the fixed and
random effects, or fit the data using nonlinear least squares. For more information, see
“Analyze Data Using Models” on page 5-3.

* Generate diagnostic plots — For more information, see “Analyze Data Using Models”
on page 5-3.

The software lets you work with different model structures, thus letting you try multiple
models to see which one produces the best results.

How SimBiology Supports Pharmacokinetic Modeling
Import and Work with Data

You can import tabular data into the SimBiology Model Analyzer or the MATLAB
Workspace. The supported file types are .x1s, .csv, and . txt. You can specify that the
data is in a NONMEMZ® formatted file. The import process interprets the columns
according to the NONMEM definitions. For details, see “Importing Data” on page 5-11.

Model

SimBiology provides an extensible modeling environment. You can do any of the
following:
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Create a PK model using a model construction wizard to specify the number of
compartments, the route of administration, and the type of elimination.

Extend any model with pharmacodynamic (PD) model components, or build higher
fidelity models.

Build or load your own SimBiology, or SBML model.

For more information, see “What is a SimBiology Model?” on page 2-2.

Analyze Data Using Models

Perform both individual and population fits to grouped longitudinal data:

Individual fit — Fit data using nonlinear least-squares method, specify parameter
transformations, estimate parameters, and calculate residuals and the estimated
coefficient covariance matrix. For a command line workflow, see “Fitting Workflow for
sbiofit” on page 4-51. For an app workflow, see “Calculate NCA Parameters and Fit
Model to PK/PD Data Using SimBiology Model Analyzer App” on page 1-79.

Population fit — Fit data, specify parameter transformations, and estimate the fixed
effects and the random sources of variation on parameters using nonlinear mixed-
effects models. For a command line workflow, see “Nonlinear Mixed-Effects Modeling
Workflow” on page 4-40.

Population fit using a stochastic algorithm — Fit data, specify parameter
transformations, and estimate the fixed effects and the random sources of variation on
parameters, using the Stochastic Approximation Expectation-Maximization (SAEM)
algorithm. SAEM is more robust with respect to starting values. This functionality
relaxes assumption of constant error variance. Specify nlmefitsa as the estimation
function name when you run sbiofitmixed.

In addition, you can turn on the ProgressPlot on page 4-57 option to get the live feedback
on the status of parameter estimation.

Pharmacokinetic Modeling Examples

The following examples show how to estimate pharmacokinetic parameters at the
command line.

“Modeling the Population Pharmacokinetics of Phenobarbital in Neonates”
“Fit a One-Compartment Model to an Individual's PK Profile” on page 4-66
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* “Fit a Two-Compartment Model to PK Profiles of Multiple Individuals” on page 4-92
+ “Estimate Category-Specific PK Parameters for Multiple Individuals” on page 4-74
» “Perform Hybrid Optimization Using sbiofit” on page 4-87

For an app example, see “Calculate NCA Parameters and Fit Model to PK/PD Data Using
SimBiology Model Analyzer App” on page 1-79.

Acknowledgements: Tobramycin Data Set

Acknowledgements for data in the tobramycin. txt file are located in the /matlab/
toolbox/simbio/simbiodemos folder. Data set is provided by Dr. Leon Aarons
(laarons@fsl.pa.man.ac.uk).

The data in the tobramycin. txt file were downloaded from the Web site of the
Resource Facility for Population Kinetics http://depts.washington.edu/rfpk/
service/datasets/index.html (no longer active). Funding source: NIH/NIBIB grant
P41-EB01975.

The original data set was modified as follows:

* Header comments were removed.
* The file was converted to a tab-delimited format.
* Missing values in the HT column were denoted with "." instead of 100000000.000.

References

[1] Original Publication: Aarons L, Vozeh S, Wenk M, Weiss P, and Follath F. “Population
pharmacokinetics of tobramycin.” Br J Clin Pharmacol. 1989 Sep;28(3):305-14.

See Also

sbiofit | shiofitmixed

More About

. “Nonlinear Regression”
. “Nonlinear Mixed-Effects Modeling”
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Importing Data — Supported Files and Data Types

In this section...

“Supported Files and Data Types” on page 5-5

“Support for Importing NONMEM Formatted Files” on page 5-5
“Creating a Data File with SimBiology Definitions” on page 5-10

Supported Files and Data Types

You can import tabular data to the SimBiology Model Analyzer app or to the MATLAB
Workspace. The supported file types are Excel files (.xls, .xlsx), text files (.csv, .txt), and
SAS® XPORT files (.xpt). You can also specify that the data is in a NONMEM formatted
file. The import process interprets the columns according to the NONMEM definitions.
For more information see “Support for Importing NONMEM Formatted Files” on page 5-
5.

Note If your data set contains dosing information that is infusion data, the data set must
contain the rate and not an infusion duration.

Unit Conversion

Regardless of whether unit conversion functionality is on or off, dosing in the data file
must be expressed in amounts (or as amount/time for infusion rate). By default Unit
Conversion is off, so you must ensure that units for the data are consistent with each
other. If you want to turn on unit conversion, see “Unit Conversion for Imported Data” on

page 5-24 .

Support for Importing NONMEM Formatted Files

You can specify that the data is in a NONMEM formatted file. The following table
highlights the interpretation of this data in SimBiology software.

3-5
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Column Header

Interpretation

ID

Text (character vector), numeric, or categorical values that
identify the record or group. The import process assumes
that contiguous data with the same value contains data
from one individual. If the data contains non-contiguous
references to the same value, the import process assigns
the second ID encountered an indexed valued derived from
the group first encountered. For example, if the ID columns
contains [1 1 1 2 2 2 1 1 1], theIDs assigned are 1,
2, 1 1.

TIME

Monotonically increasing positive values within each
group, indicating time of observation or dose or text
(character vector). The data file can specify clock (2:30 as
a character vector) or decimal values (6 .25). The import
process assigns a value of 0 to the first TIME value in the
data file. The import process assigns subsequent values
relative to the first value.

The following table is an example of how the import
process interprets the clock values as decimal values.

Original Clock Values Imported Values
10:00 0

10:30 0.5

11 1

12:30 2.5

If the data file also contains a DATE column, the import
process uses it with the TIME column in calculating the
relative TIME values. The column cannot contain Inf.
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Column Header

Interpretation

DATE, DAT1, DAT2, or DAT3

Defines the day of the observation or the dose. The column
can contain the month as a number (9) or a character
vector (Sep). Specify date in the following formats:

* DATE — The column can specify month/day/year or
month-day-year. If you specify two numbers, the
import process assumes they are month and day. You
can use either / or - as a separator.

* DAT1 — The column can specify day/month/year or
day-month-year. If you specify two numbers, the
import process assumes they are day and month.

* DAT2 — The column can specify year/month/day or
year-month-day. If you specify two numbers, the
import process assumes they are month and day.

* DAT3 — The column can specify year/day/month or
year-day-month. If you specify two numbers, the
import process assumes they are day and month.

Note

* Ifyou specify only one number, the import process
assumes it is the day.

* You can omit the year or specify 1, 2, 3, or 4 digits. If
you specify two-digit years, it is assumed to be in the
1900s.

+ Ifthe data has the DAT1, DAT2, or DAT3 column, set the
DatelLabel property of a NMFileDef object
accordingly using sbionmfiledef. Then specify the
object as the second input argument when you run
sbionmimport.

DV

Numeric value of an observation. Column cannot contain
Inf or —Inf.
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Column Header

Interpretation

MDV Defines whether a row describes an observation:
¢ Row contains 0 — Observation event
¢ Row contains 1 — Not an observation event
EVID Defines the type of event described for the row in the

record:

¢ 0 — Observation event; row contains an observed value.
* 1 — Dose event; row describes a dose.

e 2 — Other event; row describes some other event such
as measurement of a covariate.

If a column contains values for dose, but EVID is not 1, the
import process ignores the value. You see a warning and
the value is ignored.

If EVID is set to 2, then only those specified row data are
imported as covariate data. However, if you have an EVID
column as well as one or more covariate columns, but do
not specify a value of 2 anywhere in the EVID column, then
SimBiology imports all the row data as covariate values.

The import process does not support values 3 and 4. You
see a warning and the value is ignored.
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Column Header

Interpretation

CMT

Indicates which compartment is used for observation value
or for dose received. The interpretation also depends on
EVID:

¢ Observation event (EVID = 0 ) — CMT column indicates
which compartment was used for observation value.

¢ Dose Event (EVID = 1) — CMT column indicates which
compartment received the dose.

Note SimBiology numbers compartments starting with 1,
while NONMEM numbers them starting with 0. For
instance, if a NONMEM data file contains doses and
measurements for CMT = 0, SimBiology generates data
columns named Dosel and Responsel respectively.

AMT

Positive number indicating dose. 0 or NaN specifies no dose
administered. The column cannot contain Inf.

RATE

Positive number indicating rate of infusion. 0 specifies an
infinite rate (equivalent to a bolus dose), and NaN specifies
no rate. The column cannot contain Inf.

II

Positive number defining the time between doses.

ADDL

When the data specifies a number of identical serial doses
at specific intervals (defined by II), ADDL specifies the
number of doses in the series excluding the initial dose. If
the data specifies IT but not ADDL, then SimBiology
assumes that the dosing occurs for the duration of that
data record.

Unsupported NONMEM Definitions

The import process does not support (and therefore ignores) the rows containing the
following values or definitions:

 EVID values 3 and 4

* SS column for specifying steady state doses

*  PCMT column to define whether to compute a prediction for the row
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5-10

CALL column for calling the ERROR or the PK subroutine
If rate is specified as being less than zero, it is assumed to be zero

Creating a Data File with SimBiology Definitions

If you are creating a file containing population data that you want to later import into
SimBiology, create the data file with the following columns:

Group column — Specify text, numeric, or categorical values. The rows in the file that
have the same Group column value are for the same individual.

Time column — Specify monotonically increasing positive values within each group
that define the time of the dose, observation and/or covariate measurements.

Zero or more dosing columns — Create one dosing column for each compartment
being dosed. In each column, specify positive values representing doses in amount
that are added to a species. Use 0 or NaN to specify that no dose was applied at the
specified time. This is useful for times when an observation was recorded but no dose
was applied.

Zero, or more rate columns — Specify positive values. Zero specifies an infinite rate
and NaN specifies that no rate applies. The rate column is associated with a dosing
column and defines the rate at which the dose is administered.

Zero or more observation columns — Specify numeric values or NaNs. You can only
specify one observation value at a particular time for each group. NaN values define
that no observation was recorded at the specified time. This is useful for times when a
dose was applied but no observation was recorded.

Zero or more covariate columns — Specify numeric values or NaNs. Each value defines
the covariate value at the specified time. NaN values define that no covariate
observation was recorded at the specified time.

If you set an EVID value of 2 for some rows, then SimBiology imports only those rows
as covariate data. If you do not mention an EVID value of 2 anywhere and have one or
more covariate columns, then SimBiology imports all the row data as covariate data.
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Importing Data

In this section...

“Import Data from Files” on page 5-11

“Importing Data from NONMEM-Formatted Files” on page 5-12
“Other Resources for Importing Data” on page 5-13

Import Data from Files

Use the dataset function to import tabular data with named columns into an array that
you can use in fitting and analysis at the command line. Use this function when you want
to import the data without NONMEM interpretation of column headers. The dataset
function lets you specify parameter/value pair arguments in which you can specify options
such as the type of delimiter, and whether the first row contains header names. For more
information, see dataset.

To prepare the data file for import, remove any comments that are present at the
beginning of the file.

Examples:

% text files

data = dataset('file', 'tobramycin.txt')

% text files with . in place of missing values

data = dataset('file', 'tobramycin.txt', 'TreatAsEmpty', '.')

% For Excel files
data = dataset('xlsfile', 'tobramycin.xls')

You can also construct the dataset array from variables in the MATLAB Workspace.
% Create a 10x2 array

X = rand(10,2);

% Construct a dataset array containing x

data = dataset({x(:, 1), 'Columnl'}, {x(:,2), 'Column2'})

If you import the data as separate variables containing doubles, you can construct the
dataset array by concatenating the variables.

% Create 2 10x1 vectors
X = rand(10,1);
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5-12
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rand(10,1);
onstruct a dataset array containing x and y
a = dataset({x, 'Columnl'}, {y, 'Column2'})

After you finish analyzing your data, you can export any new variables in the MATLAB
Workspace to a variety of file formats.

Importing Data from NONMEM-Formatted Files

Use the sbionmimport function to import data from NONMEM formatted files. To import
the data without NONMEM interpretation of column headers, see “Import Data from
Files” on page 5-11.

To prepare the data file for import, remove any comments that are present at the
beginning of the file and select one of the following methods to import your data:

If the data file contains only the column header values shown in “Support for
Importing NONMEM Formatted Files” on page 5-5, use the syntax shown in the
following example:

filename = 'C:\work\datafiles\dose.xls';
ds = sbionmimport(filename);

If the data file has column header labels different from the table shown in “Support for
Importing NONMEM Formatted Files” on page 5-5 and you want to apply NONMEM
interpretation of headers:

1

Create a NONMEM file definition object. This object lets you define what the
column headers in the data file mean in SimBiology. In the following example, the
column containing response values is CP, whereas in NONMEM formatted files
the column is labelled DV.

To use the tobramycin data set [1] on page 5-4, create a NONMEM file definition
object and define the following:

def

def.
def.
def.
def.
def.
def.
def.

= sbionmfiledef;

DoseLabel = 'DOSE';

GroupLabel = 'ID';

TimeLabel = 'TIME';

DependentVariablelLabel = 'CP';

MissingDependentVariablelLabel = 'MDV';

EventIDLabel = 'EVID';

ContinuousCovariatelLabels = {'WT', 'HT', 'AGE', 'SEX', 'CLCR'};
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Your file can contain any name for column headings. See sbionmfiledef for the
list of properties you can configure in the NONMEM file definition object.

2 Use the sbionmimport function to import your data file with the column header
definitions as specified in the NONMEM file definition object. For example,
browse to matlabroot/toolbox/simbio/simbiodemos/ (where matlabroot
is the folder where MATLAB is installed).

[data, pkDataObject] = sbionmimport('tobramycin.txt', def,
'TreatAsEmpty', '.');

This example shows you how to obtain the PKData object, PKDataObj, while
importing, since you will use the PKData object in fitting the model later.

The sbionmimport function accepts property-name-value pairs accepted by
dataset. For example, if the data set does not contain column headers, use
'ReadVarNames', false to specify that sbionmimport should read values
from the first row of the file.

For information about creating a model to fit the data, see “Create a Pharmacokinetic
Model Using the Command Line” on page 5-16.

Other Resources for Importing Data

For detailed information about supported data formats and the functions for importing
data into the MATLAB Workspace, see the “Methods for Importing Data” (MATLAB).

You also can import data using the MATLAB Import Wizard (see “Import Images, Audio,
and Video Interactively” (MATLAB). Use the Import Wizard, to import data as text files
(such as . txt and .dat), MATfiles, and spreadsheet files, (such as .x1s).

The MATLAB Import Wizard processes the data source. The wizard recognizes data
delimiters, as well as row or column headers, to facilitate the process of data selection
and importation into the MATLAB Workspace. You can import the data to the SimBiology
Model Analyzer app from the MATLAB Workspace.
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In this section...

“Ways to Create or Import Pharmacokinetic Model” on page 5-14

“How SimBiology Models Represent Pharmacokinetic Models” on page 5-14
“Create a Pharmacokinetic Model Using the Command Line” on page 5-16
“Dosing Types” on page 5-18

“Elimination Types” on page 5-21

“Intercompartmental Clearance” on page 5-23

“Unit Conversion for Imported Data” on page 5-24

Ways to Create or Import Pharmacokinetic Model

To start modeling, you can:

* Create a PK model using a model construction wizard that lets you specify the number
of compartments, the route of administration, and the type of elimination.

» Extend any model to build higher fidelity models.

* Build or load your own model. Load a SimBiology project or SBML model.

How SimBiology Models Represent Pharmacokinetic Models

The following figure compares a model as typically represented in pharmacokinetics with
the same model shown in the SimBiology model diagram. For this comparison, assume

that you are modeling administration of a drug using a two-compartment model with any
dosing input and linear elimination kinetics. (The model structure remains the same with

any dosing type.)
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Note the following:

* SimBiology represents the concentration or amount of a drug in a given compartment
or volume by a species object contained within the compartment.

» SimBiology represents the exchange or flow of the drug between compartments and
the elimination of the drug by reactions.

* SimBiology represents intercompartmental clearance by a parameter (Q) which
specifies the clearance between the compartments.

* SimBiology drives the dosing schedule with a combination of species (Drug and/or
Dose) and reactions (Dose -> Drug), depending on whether the administration into
the compartment follows bolus, zero-order, infusion, or first-order dosing kinetics. For
more information on the components added and parameters estimated, see “Dosing
Types” on page 5-18.

You can also view this model as a regression function, y = f(k,u), where y is the
predicted value, given values of an input u, and parameter values k. In SimBiology the
model represents f, and the model is used to generate a regression function if y, k, and u
are identified in the model.
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Create a Pharmacokinetic Model Using the Command Line

To create a PK model with the specified number of compartments, dosing type, and
method of elimination:

1

Create a PKModelDesign object. The PKModelDesign object lets you specify the
number of compartments, route of administration, and method of elimination, which
SimBiology uses to construct the model object with the necessary compartments,
species, reactions, and rules.

pkm = PKModelDesign;

Add a compartment specifying the compartment name, and optionally, the type of
dosing, and the method of elimination. Also specify whether the data contains a
response variable measured in this compartment and whether the dose(s) have time
lags. For example, if using the tobramycin data set [1] on page 5-4, specify a
compartment named Central, with Bolus for the DosingType property, linear-
clearance for the EliminationType property, and true for the
HasResponseVariable property.

pkcl = addCompartment(pkm, 'Central', 'DosingType', 'Bolus',
'EliminationType', 'linear-clearance',
'HasResponseVariable', true);

For a description of other DosingType and EliminationType property values, see
“Dosing Types” on page 5-18 and “Elimination Types” on page 5-21.

For a description of the HasResponseVariable property, see
HasResponseVariable. At least one compartment in a model must have a response.
Although SimBiology supports multiple responses per compartment, when adding
compartments to a PKModelDesign object, you are limited to one response per
compartment.

Note To add a compartment that has a time lag associated with any dose that targets
it, set the HasLag property to true:

pkc_lag = addCompartment(pkm, 'Central', 'DosingType', 'Bolus',
'EliminationType', 'linear-clearance',
'HasResponseVariable', true, 'HasLag', true);

Or after adding a compartment, set its HasLag property to true:

pkcl.HaslLag = true;
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3  Optionally, add a second compartment named Peripheral, with no dosing, no
elimination, and no time lag. Set the HasResponseVariable property to true. If
you are using the tobramycin data set [1] on page 5-4, skip this step and use only one

compartment.

pkc2 = addCompartment(pkm,

'Peripheral', 'HasResponseVariable', true);

The model construction process adds the necessary parameters, including a
parameter representing intercompartmental clearance Q. You can add more
compartments by repeating this step. The addition of each compartment creates a
chain of compartments in the order of compartment addition, with a bidirectional
flow of the drug between compartments in the model.

Use the handle to the compartment (pkcl or pkc2), to change compartment

properties.

4 Construct a SimBiology model object.

[modelObj, PKModelMapObj] = pkm.construct

The construct method returns a SimBiology model object (node10bj) and a
PKModelMap object (PKMode1lMapObj) that contains the mapping of the model

components to the elements of the regression function.

Note If you change the PKModelDesign object, you must create a new model object
using the construct method. Changes to the PKModelDesign do not automatically
propagate to a previously constructed model object.

Perform parameter fitting as shown in “Perform Data Fitting with PK/PD Models” on

page 5-26.

The model object and the PKModelMap object are input arguments for the sbionlmefit,
sbionlmefitsa and sbionlinfit functions used in parameter fitting.

For information on ...

See ...

Dosing types

“Dosing Types” on page 5-18

Elimination types

“Elimination Types” on page 5-21

Parameter fitting

“Perform Data Fitting with PK/PD Models” on page
5-26
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For information on ... See ...

Simulating the model and a “Model Simulation” on page 4-2

description of configuration sets

Dosing Types

When creating models, SimBiology creates the following model components for each
compartment in the model, regardless of the dosing type:

Two species (Drug_CompartmentName and Dose CompartmentName) for each
compartment.

A reaction (Dose_CompartmentName -> Drug CompartmentName) for each
compartment, governed by mass action kinetics.

A parameter (ka_CompartmentName) for each compartment, representing the
absorption rate of the drug when absorption follows first-order kinetics. This is the
forward rate parameter for the Dose _CompartmentName ->
Drug_CompartmentName reaction.

A parameter (TkO CompartmentName) for each compartment, representing the
duration of drug absorption when absorption follows zero-order kinetics.

A parameter (TLag CompartmentName) for each compartment, representing the time
lag for any dose that targets that compartment and also that is specified as having a
time lag.

For dosing types that have a fixed infusion or absorption duration (infusion and zero-
order), you can use overlapping doses. The doses are additive.

The following table describes the dosing types, the default parameters to estimate, and
lists the model components created and used for dosing.

Dosing Type |Description SimBiology Model Default Parameters
Components Used to Estimate

"' (empty No dose The species None

character (Drug CompartmentName) in

vector) each compartment
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Dosing Type |Description SimBiology Model Default Parameters
Components Used to Estimate
SimBiology app |Assumes that the drug The species None
— bolus amount is increased (Drug_CompartmentName) in
instantly at the dose time. |each compartment
Command line
— Bolus In the SimBiology model,
the initial concentration
of the drug is based on
dose amount and volume
of the compartment
containing the drug.
SimBiology app |Assumes that the infused |The species None
— infusion |drug amount increases at |(Drug CompartmentName) in

Command line
— Infusion

a constant known
absorption (or infusion)
rate over a known
duration.

The imported data set
must contain the rate and
not an infusion duration.
SimBiology uses this
information to change the
species concentration at
the constant rate over the
duration specified in the
data set.

each compartment

SimBiology app
— zero-order

Command line
— ZeroOrder

Assumes that the drug is
added at a constant rate
over fixed, but unknown
duration.

The species

Drug_CompartmentName in

each compartment
o The parameter

(Tk@_CompartmentName) in

TkO CompartmentN
ame (absorption
duration)

each compartment that has
zero-order dosing. This
parameter represents the
duration of drug absorption
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Dosing Type

Description

SimBiology Model
Components Used

Default Parameters
to Estimate

SimBiology app
— first-
order

Command line
— FirstOrder

Assumes that the rate at
which the drug is
absorbed is not constant.

In the SimBiology model,
absorption rate is
assumed to be governed
by mass-action kinetics.

* A species
(Dose CompartmentName)
representing the dose
amount before it is absorbed

A species
(Drug_CompartmentName)
for each compartment

* A parameter
(ka_CompartmentName)
representing the absorption
rate of the drug

* AMassAction reaction
(Dose_CompartmentName
—

Drug CompartmentName)
with forward rate parameter
(ka_CompartmentName)

ka_CompartmentNa
me (absorption rate)
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Elimination Types

Elimination Type Description SimBiology Model Default Parameters to
Components Created Estimate

SimBiology app — Assumes simple * A parameter ¢ Compartment volume
Linear mass-action kinetics representing the

{Elimination in the elimination of elimination rate (Capacity property)
Rate, Volume} the drug. In the (ke_CompartmentNam |« FElimination rate

. SimBiology model, e) constant
ICommancll line — elimination is « AMassAction (ke_CompartmentNa
LaEAT specified by mass- reaction (drug — me)

action kinetics with

the elimination rate nutl) with forward O UUIECI G
) rate parameter clearance (Q) when
constant specified by (ke_CompartmentNam there is more than
the forward rate e) specific to the one compartment.
parameter (ke). compartment
See
“Intercompartmental
Clearance” on page
5-23.
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Elimination Type

Description

SimBiology Model
Components Created

Default Parameters to
Estimate

SimBiology app —
Linear
{Clearance,
Volume}

Command line —
'linear-
clearance'

Assumes simple
mass-action kinetics
in the elimination of
the drug. In the
SimBiology model,
similar to Linear
{Elimination
Rate, Volume}.
But, in addition, this
option lets you
specify the model in
terms of clearance
(CU) where, CL = ke
* volume).

A parameter
representing the
clearance
(CU_CompartmentNam
e)

A parameter
representing the
elimination rate
constant
(ke_CompartmentNam
e)

An
InitialAssignment
rule that initializes

ke CompartmentName
based on the initial
values for

Cl CompartmentName
and compartment
volume

A MassAction
reaction (drug —
null) with forward
rate parameter
(ke_CompartmentNam
e)

* Compartment volume

(Capacity property)

Clearance
(CL _CompartmentNa
me)

* Inter-compartmental
clearance (Q) when
there is more than
one compartment.

See
“Intercompartmental
Clearance” on page
5-23.
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Default Parameters to
Estimate

Elimination Type Description SimBiology Model

Components Created

SimBiology app — Assumes that * Parameter representing|* Compartment volume
Enzymatic elimination is the Michaelis constant,

(Michaelis- governed by (Km_CompartmentNam (Capacity property)
Menten) Michaelis-Menten e) o Parameter

Command line —
'enzymatic'

kinetics.

A parameter for
maximum velocity
(Vm_CompartmentNam
e

A reaction with
Michaelis-Menten
kinetics (drug ->
null), with kinetic law
parameters
Vm_CompartmentName
and

Km CompartmentName

(Km_CompartmentNa
me)

Parameter
(Vm_CompartmentNa
me)

Inter-compartmental
clearance (Q) when
there is more than
one compartment.

See
“Intercompartmental
Clearance” on page
5-23

Intercompartmental Clearance

The compartments created when you generate a SimBiology model form a chain and each
pair of linked compartments are connected by a transport reaction similar to linear
elimination. The addition of two compartments, C1 and C2, generates a reversible mass-
action reaction C1.Drug Cl <-> C2.Drug. The forward rate parameter is the
compartmental clearance, Q,,, divided by the volume of C1. The reverse rate parameter is

Q,,, divided by the volume of C2.

The process of adding each pair of compartments in the chain C, and C, generates the
following model components:

* A parameter Q,, representing the compartmental clearance between those two
compartments. This parameter is added to the list of parameters to be estimated
(Estimated property of PKModelMap object).

* A parameter (kmn) representing the rate of transfer of the drug from Cm to Cn, where
Kon = Qun/ Vi
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* A parameter (knm) representing the rate of Cn to Cm, where k,,;, = Qun/V,.

* Areversible mass-action reaction between the two compartments, Cm.Drug Cm <->
Cn.Drug Cn, with forward rate parameter kmn, and reverse rate parameter knm.

* An initial assignment rule that initializes the value of the parameter kmn, based on the
initial values for Cm and Qmn.

* An initial assignment rule that initializes the value of the parameter knm, based on the
initial values for Cn and Qmn.

Unit Conversion for Imported Data

Unit conversion converts the matching physical quantities to one consistent unit system
in order to resolve them. This conversion is in preparation for correct simulation, but
SimBiology returns the physical quantities in the model in units that you specify.

Regardless of whether unit conversion is on or of f, you must express dosing data in
amount. By default, Unit Conversion is off, so you must ensure that units for the data
and the model are consistent with one another. If Unit Conversion is on, you must
specify units.

Parameters in the model have default units. If unit conversion is on, you can change the
units as long as the dimensions are consistent. These default units, which you might use
to specify the values for the initial guess, are as follows.

Physical Quantity or Model Parameter |Unit

Central or peripheral compartment volume |liter

(Central or Peripheral)

First-order elimination rate (ke) 1/second

Michaelis constant (Km) milligram/liter
Maximum reaction-velocity, Michaelis- milligram/second
Menten kinetics (Vm)

Clearance (ClI) liter/second
Absorption duration (Tk0) second

Absorption rate (ka) 1/second

Use the configuration settings options to turn unit conversion on or off. For details, see
“Model Simulation” on page 4-2.
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For details on dimensional analysis for reaction rates, see “How Reaction Rates Are
Evaluated” on page 2-14.

5-25



5 Pharmacokinetic Modeling

Perform Data Fitting with PK/PD Models

SimBiology lets you estimate model parameters by fitting the model to experimental time-
course data, using either nonlinear regression or mixed-effects (NLME) techniques. You
can perform both individual and population fits to grouped data.

5-26

Individual fit — Fit data using nonlinear regression (least-squares) methods, specify
parameter transformations, estimate parameters, and calculate residuals and the
estimated coefficient covariance matrix. For a command line workflow, see “Fitting
Workflow for sbiofit” on page 4-51. For an app workflow, see “Calculate NCA
Parameters and Fit Model to PK/PD Data Using SimBiology Model Analyzer App” on
page 1-79.

Population fit — Fit data, specify parameter transformations, and estimate the fixed
effects and the random sources of variation on parameters using nonlinear mixed-
effects models. For a command line workflow, see “Nonlinear Mixed-Effects Modeling
Workflow” on page 4-40.

Population fit using a stochastic algorithm — Fit data, specify parameter
transformations, and estimate the fixed effects and the random sources of variation on
parameters, using the Stochastic Approximation Expectation-Maximization (SAEM)
algorithm. SAEM is more robust with respect to starting values. This functionality
relaxes assumption of constant error variance. Specify nlmefitsa as the estimation
function name when you run sbiofitmixed or select mixed effects using
stochastic solver in the Statistical Modeling section of the Fit Data program in
the SimBiology Model Analyzer app.

In addition, you can turn on the ProgressPlot on page 4-57 option to get the live feedback
on the status of parameter estimation.

See Also

sbiofit | sbiofitmixed

More About

“Nonlinear Regression” on page 4-46
“Nonlinear Mixed-Effects Modeling” on page 4-38
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Define Reaction Rates with Mass Action Kinetics

Use mass action kinetics to define zero-order, first-order, second-order, and reversible
reactions.

Definition of Mass Action Kinetics

Mass action describes the behavior of reactants and products in an elementary chemical
reaction. Mass action kinetics describes this behavior as an equation where the velocity
or rate of a chemical reaction is directly proportional to the concentration of the
reactants.

Zero-Order Reactions

With a zero-order reaction, the reaction rate does not depend on the concentration of
reactants. Examples of zero-order reactions are synthesis from a null species, and
modeling a source species that is added to the system at a specified rate.

reaction: null -> P
reaction rate: k mole/second
species: P 0 mole
parameters: k 1 mole/second

Note When specifying a null species, the reaction rate must be defined in units of
amount per unit time not concentration per unit time.

Entering the reaction above into the software and simulating produces the following
result:
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Zero-Order Mass Action Kinetics

Note If the amount of a reactant with zero-order kinetics reaches zero before the end of
a simulation, then the amount of reactant can go below zero regardless of the solver or
tolerances you set.

First-Order Reactions

With a first-order reaction, the reaction rate is proportional to the concentration of a
single reactant. An example of a first-order reaction is radioactive decay.

reaction: R -> P
reaction rate: mole/(liter*second)
species: R = 10 mole/liter
P 0 mole/liter
parameters: k 1 1/second

=~
*
X

Entering the reaction above into the software and simulating produces the following
results:
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First-Order Mass Action Kinetics

Second-Order Reactions

A second-order reaction has a reaction rate that is proportional to the square or the
concentration of a single reactant or proportional to two reactants. Notice the space
between the reactant coefficient and the name of the reactant. Without the space, 2R
would be considered the name of a species.

reaction: 2 R -> P
reaction rate: k*R"2 mole/(liter*second)
species: R = 10 mole/liter
P 0 mole/liter
parameters: k 1 liter/(mole*second)

Entering the reaction above into the software and simulating produces the following
results:
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Second-Order Kinetics with Single Reactant

With two reactants, the reaction rate depends on the concentration of two of the
reactants.

reaction: Rl + R2 -> P
reaction rate: k*R1*R2 mole/(liter*second)
species: R1 10 mole/liter
R2 8 mole/liter
P 0 mole/liter
parameters: Kk 1 liter/(mole*second)

Enter the reaction above into the software and simulating produces the following results.
There is a difference in the final values because the initial amount of one of the reactants

is lower than the other. After the first reactant is used up, the reaction stops.
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Second-Order Kinetics with Two Reactants

Reversible Mass Action

You can model reversible reactions with two separate reactions or with one reaction. With
a single reversible reaction, the reaction rates for the forward and reverse reactions are
combined into one expression. Notice the angle brackets before and after the hyphen to

represent a reversible

reaction.

reaction: R <-> P

reaction rate: kf*R
species: R

f
r

parameters:

X X T

- kr*P mole/(liter*second)
10 mole/liter

0 mole/liter

1 1/second

0.2 1/second

Entering the reaction above into the software and simulating produces the following

results. At equilibrium
v = Kf*R - kr*p =

when the rate of the forward reaction equals the reverse reaction,
0 and P/R = kf/kr.
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Define Reaction Rates with Enzyme Kinetics

Use differential equations, mass action kinetics, or Michaelis-Menten kinetics to define
enzyme reactions.

Simple Model for Single Substrate Catalyzed Reactions

A simple model for enzyme-catalyzed reactions starts a substrate S reversibly binding
with an enzyme E. Some of the substrate in the substrate/enzyme complex is converted to
product P with the release of the enzyme.

k1 k2
S+E=ES - E+P
kir

vl = k1[S][E], vlr =k1r[ES], v2 = k2[ES]
This simple model can be defined with

+ Differential rate equations. See “Enzyme Reactions with Differential Rate Equations”
on page A-8.

* Reactions with mass action kinetics. See “Enzyme Reactions with Mass Action
Kinetics” on page A-10.

* Reactions with Henri-Michaelis-Menten kinetics. See “Enzyme Reactions with
Irreversible Henri-Michaelis-Menten Kinetics” on page A-11.

Enzyme Reactions with Differential Rate Equations

The reactions for a single-substrate enzyme reaction mechanism (see “Simple Model for
Single Substrate Catalyzed Reactions” on page A-8) can be described with differential
rate equations. You can enter the differential rate equations into the software as rate
rules.

reactions: none
reaction rate: none

rate rules: dS/dt k1r*ES - k1*S*E

dE/dt = K1r*ES + k2*ES - kI1*S*E
dES/dt = k1*S*E - K1r*ES - k2*ES
dP/dt = k2*ES

species: S = 8 mole
E= 4 mole
ES = 0 mole
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P= 0 mole

parameters: Kkl 2 1/ (mole*second)
klr 1 1/second
k2 1.5 1/second

Remember that the rate rule dS/dt = f(x) is written in a SimBiology rate rule
expression as S = f(x). For more information about rate rules see “Rate Rules” on page
2-19.
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Alternatively, you could remove the rate rule for ES, add a new species Etotal for the
total amount of enzyme, and add an algebraic rule @ = Etotal - E - ES, where the
initial amounts for Etotal and E are equal.

reactions: none
reaction rate: none

rate rules: dS/dt klr*ES - k1*S*E

dE/dt = k1r*ES + k2*ES - KkI1*S*E
dP/dt = k2*ES
algebraic rule: 0 = Etotal - E - ES
species: S = 8 mole
E= 4 mole
ES= 0 mole
P= 0 mole
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Etotal = 4 mole
parameters: kl = 2 1/ (mole*second)
klr = 1 1/second
k2 = 1.5 1/second

Enzyme Reactions with Mass Action Kinetics

Determining the differential rate equations for the reactions in a model is a time-
consuming process. A better way is to enter the reactions for a single substrate enzyme
reaction mechanism directly into the software. The following example using models an
enzyme catalyzed reaction with mass action kinetics. For a description of the reaction
model, see “Simple Model for Single Substrate Catalyzed Reactions” on page A-8.

reaction: S + E -> ES
reaction rate: k1*S*E (binding)

reaction: ES -> S + E
reaction rate: k1r*ES (unbinding)

reaction: ES -> E + P
reaction rate: k2*ES (transformation)
species: mole
mole
mole
mole
2 1/ (mole*second)
1 1/second
1.5 1/second

[oNoRF o]

parameters:

m
XX XUOTULOLMWn
N~ PR

=~
[
S
I

The results for a simulation using reactions are identical to the results from using
differential rate equations.
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Enzyme Reactions with Irreversible Henri-Michaelis-Menten
Kinetics

Representing an enzyme-catalyzed reaction with mass action kinetics requires you to
know the rate constants k1, k1r, and k2. However, these rate constants are rarely
reported in the literature. It is more common to give the rate constants for Henri-
Michaelis-Menten kinetics with the maximum velocity Vm=k2*E and the constant Km =
(k1r + k2)/Kk1. The reaction rate for a single substrate enzyme reaction using Henri-
Michaelis-Menten kinetics is given below. For information about the model, see “Simple
Model for Single Substrate Catalyzed Reactions” on page A-8.

_ Vmax([S]
V= Rm +[S]

The following example models an enzyme catalyzed reaction using Henri-Michaelis-
Menten kinetics with a single reaction and reaction rate equation. Enter the reaction
defined below into the software and simulate.

reaction: S -> P
reaction rate: Vmax*S/(Km + S)
species: S= 8 mole
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P= 0 mole
parameters: Vmax = 6 mole/second
Km = 1.25 mole

The results show a plot slightly different from the plot using mass action kinetics. The
differences are due to assumptions made when deriving the Michaelis-Menten rate

equation.
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B Minimal Cascade Model for a Mitotic Oscillator

Minimal Cascade Model for a Mitotic Oscillator

Albert Goldbeter modified a model with enzyme cascades [Goldbeter and Koshland 1981
on page B-16] to fit cell cycle data from studies with embryonic cells [Goldbeter 1991 on
page B-16]. He used this model to demonstrate thresholds with enzyme cascades and
periodic behavior caused by negative feedback.

There are two SimBiology model variations using Goldbeter's model. The first model uses
the differential rate equations directly from Goldbeter's paper. The second model is built
with reactions using Henri-Michaelis-Menten kinetics.

In this section...

“Goldbeter Model” on page B-2

“SimBiology Model with Rate Rules” on page B-5
“SimBiology Model with Reactions” on page B-7
“References” on page B-16

Goldbeter Model

* “About the Goldbeter Model” on page B-2
* “Reaction Descriptions and Model Assumptions” on page B-3
* “Mathematical Model” on page B-4

About the Goldbeter Model

Albert Goldbeter created a simple cell division model from studies with embryonic cells
[Goldbeter 1991 on page B-16]. This model demonstrates thresholds with enzyme
cascades and periodic behavior caused by negative feedback.

There are six species in Goldbeter's minimal mitotic oscillator model [Goldbeter 1991 on
page B-16].

* C — Cyclin. The periodic behavior of cyclin activates and deactivates an enzyme
cascade.

* M+, M — Inactive (phosphorylated) and active forms of cdc2 kinase. Kinases catalyze
the addition of phosphate groups onto amino acid residues.

* X+, X — Inactive and active (phosphorylated) forms of a cyclin protease. Proteases
degrade proteins by breaking peptide bonds.
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The reactions are labeled r1 to r7 on the following diagram.

r1
e B e (]
| |
r-:l+ i
[ ]
ar
e D
r

This model shows:

* How thresholds with cdc2 kinase activation (M+ -> M) and protease activation (X+ ->
X) can occur as the result of covalent modification (for example, phosphorylation or
dephosphorylation), but without the need for positive feedback.

* How periodic behavior with cdc2 kinase activation can occur with negative feedback
and the time delay associated with activation/deactivation enzyme cascades.

Reaction Descriptions and Model Assumptions

The following list describes each of the reactions in Goldbeter's minimal mitotic oscillator
with some of the simplifying assumptions. For a more detailed explanation of the model,
see [Goldbeter 1991 on page B-16].

* Cyclin (C) is synthesized at a constant rate (rl) and degraded at a constant rate (r2).
* Cyclin (C) does not complex with cdc2 kinase (M).

* Cyclin (C) activates cdc2 kinase (M+ -> M) by increasing the velocity of the
phosphatase that activates the kinase. Inactive cdc2 kinase (M+) is activated by
removing inhibiting phosphate groups (r4).

* The amount of deactivating kinase (not modeled) for the cdc2 kinase (M) is constant.
Active cdc2 kinase (M) is deactivated by adding inhibiting phosphate group (r5).

B-3
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B-4

» The activation of cyclin protease (X+ -> X) by the active cdc2 kinase (M) is direct
without other intervening cascades. Cyclin protease (X) is activated by adding
phosphate groups (r6).

* The amount of deactivating phosphatase (not modeled) for the cyclin protease (X) is
constant. Active cyclin protease (X) is deactivated by removing the activating
phosphate groups (r7).

* The three species of interest are cyclin (C), active dephosphorylated cdc2 kinase (M),
and active phosphorylated protease (X). The total amounts of (M + M+) and (X + X+)
are constant.

Mathematical Model

Goldbeter's minimal mitotic oscillator model is defined with three differential rate
equations and two algebraic equations that define changing parameters in the rate
equations.

Differential Rate Equation 1, Cyclin (C)

The following differential rate equation is from [Goldbeter 1991 on page B-16] for cyclin
(C).

C=vi—vdX

d

_Cc _
Kd +C
Differential Rate Equation 2, Kinase (M)

The following differential rate equation is for cdc2 kinase (M). Notice that (1 - M) is the
amount of inactive (phosphorylated) cdc2 kinase (M+).

o _, (1-M ., M
a 'K+ ad-M "Kh+M
v, = YMilC]
L7 K +1CT

Differential Rate Equation 3, Protease (X)

Differential rate equations for cyclin protease (X). Notice that (1 - X) is the amount of
inactive (unphosphorylated) cyclin protease (X+).

X _ ., (1-X) ., X
TG T0-0 ViR X
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V3 = VM3[M]

SimBiology Model with Rate Rules

+ “SimBiology Model with Rules” on page B-5
* “SimBiology Simulation with Rules” on page B-6

SimBiology Model with Rules

In the literature, many biological models are defined using differential rate and algebraic
equations. With SimBiology software, you can enter the equations directly as SBML rules.
The example in this section uses Goldbeter's mitotic oscillator to illustrate this point.

Writing differential rate equations in an unambiguous format that a software program can
understand is a fairly simple process.

* Use an asterisk to indicate multiplication. For example, k[a] is written k*a.

* Remove square brackets that indicate concentration from around species. The units
associated with the species will indicate concentration (moles/liter) or amount
(moles, molecules).

SimBiology software uses square brackets around species and parameter name to
allow names that are not valid MATLAB variable names. For example, you could have a
species named glucose-6-phosphate dehydrogenase but you need to add
brackets around the name in reaction rate and rule equations.

» Use parentheses to clarify the order of evaluation for mathematical operations. For
example, do not write a Henri-Michaelis-Menten rate as Vm*C/Kd + C, because Vm*C
is divided by Kd before adding C, and then C is added to the result.

The following equation is the rate rule for “Differential Rate Equation 1, Cyclin (C)” on
page B-4:

dC/dt = vi - (vd*X*C)/(Kd + C) - kd*C

The following equations are the rate and repeatedAssignment rules for “Differential
Rate Equation 2, Kinase (M)” on page B-4:

dM/dt = (V1*Mplus)/(K1 + Mplus) - (V2*M)/(K2 + M)
V1l = (VM1*C)/(Kc + C)
Mplus = Mt - M
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The following equations are the rate and repeatedAssignment rules for “Differential
Rate Equation 3, Protease (X)” on page B-4:

dX/dt = (V3*Xplus)/(K3 + Xplus) - (V4*X)/(K4 + X)
V3 = VM3*M
Xplus = Xt - X

Rules

The active (M) and inactive (Mplus) forms of the kinase are assumed to be part of a
conserved cycle with the total concentration (Mt) remaining constant during the
simulation. You need only one differential rate equation with a mass balance equation to
define the amounts of both species. Similarly, the active (X) and inactive (Xplus) forms of
the protease are part of a second conserved cycle.

SimBiology Simulation with Rules

This is a simulation of Goldbeter's minimal mitotic oscillator using differential rate and
algebraic equations. Simulate with the sundials solver and plot species C, M, and X. For
a description of the model, see “SimBiology Model with Rules” on page B-5.

A Time - Figure 1 _ (O] x|

File Edt wiew Insert Tools Deskiop Window Help e
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06
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Amount {uh)
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SimBiology Model with Reactions

* “Converting Differential Rate Equations to Reactions” on page B-7
* “Calculating Initial Values for Reactions” on page B-9
* “SimBiology Simulation with Reactions” on page B-16

Converting Differential Rate Equations to Reactions

In the literature, many models are defined with differential rate equations. With
SimBiology software, creating the differential equations from reactions is unnecessary;
you can enter the reactions and let the software calculate the equations.

Some models are defined with differential rate equations, and you might need the
reactions to be compatible with your model. Two rules you can use to convert differential
rate equations to reactions are:

* For a positive term — The species described by the equation is placed on the right as
a product, and the species in the term are placed on the left as reactants.

* For a negative term — The species described by the equation is placed on the left as
a product, and the species in the term are also placed on the left as reactants.

You need to determine the products using additional information, for example, a
reaction diagram, a description of the model, or an understanding of a reaction. If a
reaction is catalyzed by a kinase, then you can conclude that the product has one or
more additional phosphate groups.

A simple first-order reaction has differential rate equation dR/dt = +kr[P] - kf[R].
The negative term implies that the reaction is R -> ? with an unknown product. The
positive term identifies the product and completes the reaction, R <-> P.

Reactions R1 to R3 from Equation E1

The differential rate equation 1 is repeated here for comparison with the reactions. See
“Differential Rate Equation 1, Cyclin (C)” on page B-4.

dc _

ar = VviT vgX kqC

_C __
Kg+C
The reaction and reaction rate equations from the differential rate equation E1 are given

below:

ri reaction: null -> C
reaction rate: vi
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r2 reaction: C -> null
reaction rate: kd*C

r3 reaction: C -> null
reaction rate: (vd*X*C)/(Kd + C)

Reactions R4 and R5 from Equation E2

The differential rate equation 2 and algebraic equation 2 are repeated here for
comparison with the reactions. See “Differential Rate Equation 2, Kinase (M)” on page B-
4,

o _, (1-M ., M
a 'K+ a0-M "Ky+M
v, = YMilC]
7K +1CT

The reaction and reaction rate equations from the differential rate equation E2 are given
below:

ra reaction: Mplus -> M
reaction rate: V1*Mplus/(K1 + Mplus)
repeatedAssignment rule: V1 = VM1*C/(Kc + C)

r5 reaction: M -> Mplus
reaction rate: V2*M/(K2 + M)

Reactions R6 and R7 from Equation E3

The differential rate equation for equation 3 and algebraic equation 3 is repeated here for
comparison with the reactions.

X _ o (1-X . X
TG T0-0 ViR X

V3 = VM3*[M]

The reaction and reaction rate equations from the differential rate equation E3 are given
below:

ré reaction: Xplus -> X
reaction rate: V3*Xplus]/(K3 + Xplus)
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repeatedAssignment rule: V3 = VM3*M

r7 reaction: X -> Xplus
reaction rate: V4*X/(K4 + X)

Calculating Initial Values for Reactions

After you converted the differential rate equations to the reactions and reaction rate
equations, you can start to fill in initial values for the species (reactants and products)
and parameters.

The initial values for parameters and amounts for species are listed with four different

units in the same dimension:

* A — Original units in the Goldbeter 1991 paper.

* B — Units of concentration with time converted to second. When converting a to b, use
1 minute = 60 second for parameters.

X uM X 1e-6 mole/liter < 1 minute _ Y mole
minute 1 uM 60 second ~ liter*second

¢ C — Units of amount as moles. When converting concentration to moles, use a cell
volume of 1e-12 liter and assume that volume does not change.

Y mole X le-12 liter _ Z mole
liter*second ~ second

* D — Units of amount as molecules. When converting amount as moles to molecules,
use 6.022e23 molecules = 1 mole.

Z mole _ 6.022e23 molecule _ N molecules
second 1 mole ~ second

With dimensional analysis on and unit conversion off, select all of the units for one letter.
For example, select all of the As. If dimensional analysis and unit conversion are on, you
can mix and match letters and get the same answer.

Reaction 1 Cyclin Synthesis

R1 Value Units
reaction null -> C
reaction rate vi A. uM/minute

B-9
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R1
parameters vi
species C

0.025
4.167e-10
4.167e-22
205

0.01

le-8
1.0e-20
6.022e+3

Reaction 2 Cyclin Undifferentiated Degradation

R2

reaction C
reaction rate kd*C
parameters kd
species C

Reaction 3 Cyclin Protease Degradation

Value

0.010
1.6667e-4
0.01

le-8
1.0e-20
6.022e+3

Units

. mole/(liter*second)
. mole/second

. molecule/second

. UM/minute

. mole/(liter*second)
. mole/second

. molecule/second
uM

. mole/liter

. mole

oW ProoweyYow

. molecule

Units

. uM/minute

. mole/(liter*second)
. mole/second

. molecule/second

. 1/minute

C, D. 1/second

uM

. mole/liter

~

. mole

owPrweOow e

. molecule
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R3
reaction
reaction rate

parameter

parameter

species

species

Reaction 4 Cdc2 Ki

R4
reaction Mplus

reaction rate
Mplus)

C -> null
(vd*X*C)/(Kd + C)

vd

Kd

C (substrate)

X (enzyme)

nase Activation

-> M

(V1*Mplus)/ (K1 +

0.25
0.0042
0.02
2.0e-8
2.0e-020
12044
0.01

le-8
1.0e-20
6.022e+3
0.01

le-8
1.0e-20
6.022e+3

Units

. uM/minute

. mole/(liter*second)
. mole/second

. molecule/second
. 1/minute

, C, D. 1/second
uM

. mole/liter

. mole

. molecule

uM

. mole/liter

mole

. molecule

uM

. mole/liter

mole

UOoOWPU0O0OwWPUOO0O®EP>®EP>UO®E >

. molecule

Units

A. uM/minute

B. mole/(liter*second)
C. mole/second
D. molecule/second
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R4

repeatedAssignm V1 = (VM1*C)/(Kc + C)

ent rule
parameter

parameter

parameter

parameter

species

species

species

B-12

V1 (variable by rule)

VM1

Kc

K1

Mplus (inactive substrate)

M (active product)

Value

0.00

3.0

5.0e-8
5.0000e-020
30110
0.5
5.0000e-7
5.0e-19
3.011e+5
0.005
5e-9
5e-21
3.011e+3
0.99
9.9e-7
9.9e-19
5.962e+5
0.01

le-8
1.0e-20
6.022e+3
0.01

le-8

Units

WP UO0OEPUOEPUOEFPOOEPOOE>PY O @ >

. UM/minute
. mole/(liter*second)
. mole/second

. molecule/second

. UM/minute

. mole/(liter*second)
. mole/second

. molecule/second

uM

. mole/liter

mole

. molecule

uM

. mole/liter

mole

. molecule

uM

. mole/liter

mole

. molecule

uM

. mole/liter

mole

. molecule
. uM
. mole/liter
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R4

Reaction 5 Cdc2 Kinase Deactivation

R5
reaction
reaction rate

parameter

parameter

species

species

M -> M plus
(V2*M)/ (K2 + M)

V2

K2

Mplus (inactive)

M (active)

Reaction 6 Protease Activation

Value Units

1.0e-20 C. mole

6.022e+3 D. molecule
Value Units
---- A. uM/minute
-—-- B. (mole/liter-second)
- C. mole/second
--- D. molecule/second
1.5 A. uM/minute
2.5000e-008 B. mole/liter-second
2.5000e-020 C. mole/second
15055 D. molecule/second
0.005 A.uM
5.0000e-009  B. mole/liter
5.0000e-021 C. mole
3011 D. molecule
1.0e-20 C. mole
0.99 A.uM
9.9e-7 B. mole/liter
9.9e-19 C. mole
5.962e+5 D. molecule
0.01 A. uM
le-8 B. mole/liter
1.0e-20 C. mole
6.022e+3 D. molecule
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R6
reaction
reaction rate

repeatedAssign
ment rule

parameter

parameter

parameter

species

species

species

B-14

Xplus -> X

(V3*Xplus)/ (K3 +
Xplus)

V3 = VM3*M

V3 (variable by rule)

VM3

K3

Xplus (inactive substrate)

X (active product)

M (enzyme)

1.0
0.0167
0.005
5e-9
5e-21
3.011e+3
0.99
9.9e-7
9.9e-19
5.962e+5
0.01

le-8
1.0e-20
6.022e+3
0.01

le-8

Units

A. uM/minute

B. mole/(liter*second)
C. mole/second
D. molecule/second

. UM/minute
. mole/liter-second
. mole/second

. molecule/second
. 1/minute

C, D. 1/second
uM

. mole/liter

<

. mole

. molecule
uM

. mole/liter
mole

. molecule
uM

. mole/liter
mole

. molecule
. uM

. mole/liter

WP UO0OEPUOEPUOOEPEPU O ® B
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R6

Reaction 7 Protease Deactivation

R7
reaction
reaction rate

parameter

parameter

species

species

X -> X plus
(V4*X)/ (K4 + X)

V4

K4

Xplus (inactive)

X (active)

Value Units

1.0e-20 C. mole

6.022e+3 D. molecule
Value Units
- A. uM/minute
- B. mole/(liter*second)
- C. mole/second
- D. molecule/second
0.5 A. uM/minute
8.3333e-009 B. mole/(liter*second)
8.3333e-021 C. mole/second
5.0183e+003 D. molecule/second
0.005 A. uM
5e-9 B. mole/liter
5e-21 C. mole
3011 D. molecule
0.99 A. uM
9.9e-7 B. mole/liter
9.9e-19 C. mole
5.962e+5 D. molecule
0.01 A.uM
le-8 B. mole/liter
1.0e-20 C. mole
6.022e+3 D. molecule
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SimBiology Simulation with Reactions

This is a simulation of Goldbeter's minimal mitotic oscillator with rate and algebraic
equations. Simulate with the sundials solver and plot species C, M, and X. For a
description of the model, see “SimBiology Model with Reactions” on page B-7.

1

08¢ .

06

04

Amount (uM)

02

0 20 40 60 80 100
Time (minutes)
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Model of the Yeast Heterotrimeric G Protein Cycle

In this section...
“Background on G Protein Cycles” on page B-17
“Modeling a G Protein Cycle” on page B-18

“References” on page B-21

Background on G Protein Cycles

* “G Proteins” on page B-17
* “G Proteins and Pheromone Response” on page B-18

G Proteins

Cells rely on signal transduction systems to communicate with each other and to regulate
cellular processes. G proteins are GTP-binding proteins that are involved in the regulation
of many cellular processes. There are two known classes of G proteins: the monomeric G
proteins (one GTPase), and the heterotrimeric G proteins (three different monomers). The
G proteins usually facilitate a step requiring energy. This energy is supplied by the
hydrolysis of GTP by a GTPase activating protein (GAP). The exchange of GDP for GTP is
catalyzed by a guanine nucleotide releasing protein (GNRP) [Alberts et al. 1994 on page
B-21].

GAP
Gprotein + GTP —= Gprotein + GDP
GNRP

G protein-coupled receptors (GPCRs) are the targets of many pharmaceutical agents.
Some estimates suggest that 40 to 50% of currently marketed drugs target GPCRs and
that 40% of current drug discovery focus is on GPCR targets. Some examples include
those for reducing stomach acid (ranitidine which targets histamine H2 receptor),
migraine (sumatriptan, which targets a serotonin receptor subtype), schizophrenia
(olanzapine, which targets serotonin and dopamine receptors), allergies (desloratadine,
which targets histamine receptors). One approach in pharmaceutical research is to model
signaling pathways to analyze and predict both downstream effects and effects in related
pathways. This tutorial examines model building and analysis of the G protein cycle in the
yeast pheromone response pathway using the SimBiology desktop.

B-17
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G Proteins and Pheromone Response

In the yeast Saccharomyces cerevisiae, G protein signaling in pheromone response is a
well characterized signal transduction pathway. The pheromone secreted by alpha cells
activates the G protein-coupled a-factor receptor (Ste2p) in a cells which results in a
variety of cell responses including cell-cycle arrest and synthesis of new proteins. The
authors of the study performed a quantitative analysis of this cycle, compared the
regulation of G protein activation in wild-type yeast haploid a cells with cells containing
mutations that confer supersensitivity to a-factor. They analyzed the data in the context of
cell-cycle arrest and pheromone-induced transcriptional activation and developed a
mathematical model of the G protein cycle that they used to estimate rates of activation
and deactivation of active G protein in the cell.

Modeling a G Protein Cycle

* “Reactions Overview” on page B-18
+ “Assumptions, Experimental Data, and Units in the G Protein Model” on page B-20

Reactions Overview

Systems biologists represent biological pathways and processes as reactions with
reaction rates, and treat the components of these pathways as individual species.

The G protein cycle in the yeast pheromone-response pathway can be condensed into a
set of biochemical reactions. These reactions are complex formation, transformation, or
disassociation reactions that Yi and colleagues [Yi et al. 2003 on page B-21] use to
simplify and describe the system. In this example, a-factor, a-factor receptor, and the G
protein subunits are all treated as species participating in reactions. The system can be
graphically represented as follows.

B-18
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L
\\\‘__,,
_lﬁeceptol' ligand interaction
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Graphical Representation of the & protein cycle in yeast pheromone response. The numbers

represent reaction numbers referenced in the text. L= Ligand (alpha factor), R = alpha-factor receptor,
Ghyg = free levels of G-beta:G-gamma complex, Ga = active G-alpha-GTP, Gd = inactive G-alpha-GDP,

= = inactive Gby:Gd complex.

The following table shows you the reactions used to model the G protein cycle and the
corresponding rate constants (rate parameters) for each reaction. For reversible
reactions, the forward rate parameter is listed first.

No. Name

Receptor-ligand interaction

2 Heterotrimeric G protein
formation

3 G protein activation

Receptor synthesis and
degradation

5 Receptor-ligand degradation
G protein inactivation

Reaction
L + R <->RL
Gd + Gbg -> G

RL + G -> Ga + Gbg + RL
R <-> null

RL -> null
Ga -> Gd

Rate
Parameters

kRL, kRLm
kG1

kGa
kRdo, kRs

kRD1
kGd
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B-20

Note that in reaction 3 (G protein activation), RL appears on both sides of the reaction.
This is because RL is treated as a modifier or catalyst, and the model assumes that there
is no synthesis or consumption of RL in this reaction.

The authors use a set of ordinary differential equations (ODEs) to describe the system. In
the software, you can represent the biological pathway as a system of biochemical
reactions and the software creates the ODEs for you. Alternatively, if you have a set of
ODEs that describe your system you can enter these as rate rules. For an example of
modeling using rate rules, see “SimBiology Model with Rate Rules” on page B-5.

Assumptions, Experimental Data, and Units in the G Protein Model

The authors have obtained experimental data either through their own measurements or
through published literature. As with any other model, the G protein cycle model
simplifies the biological process while also trying to reconcile the experimental data.
Consider these points:

* Reaction 2 — Binding and formation of the heterotrimeric G protein complex is treated
as a single-step reaction.

* Reaction 3 — Activation of G protein is modeled as a single-step. Guanine nucleotide
exchange factors (GEFs) are not modeled.

* Reactions 3 and 6 — The parameters for the rate of G protein activation and
deactivation (kGa and kGd) have been estimated based on the dose response curves in
the reference paper. The SimBiology model being built in this tutorial directly uses
those values.

* Reactions 4 and 5 — Receptor synthesis and degradation are handled purely as two
simple reaction steps.

* Reaction 6 — Deactivation of G protein by the regulator of G protein signaling (RGS)
protein Sst2p is modeled as a single step. Sst2p is not modeled.

The reaction is modeled with an estimated reaction rate of 0.11 s-1) in the Sst2p
containing wild-type strain. The uncatalyzed reaction rate is estimated to be 0.004
s-lin a strain with a deletion of SST2 (sst2A, mutant strain).

* Free GDP,. GTP, and Pi are not included in the model.

This tutorial shows you how to plot the experimental data over the simulation plot of the
active G protein fraction. You can estimate the values of the experimental data of interest
for this example from the coordinates of the plots found in Figure 5 of the reference
paper [Yi et al. 2003 on page B-21]. The following values were obtained by comparing
the coordinates of the standards with those of the unknowns in the figure.



See Also

Time Fraction of Active Ga (Experimental)
0 0.00
10 0.35
30 0.40
60 0.36
110 0.39
210 0.33
300 0.24
450 0.17
600 0.20

Note The SimBiology Dimensional Analysis feature is not used in this tutorial. For this
tutorial, the values of all species are converted to have the unit molecule, and all rate
parameters are converted to have either the unit 1/second or the units 1/
(molecule*second), depending on whether the reaction is first or second order. You
should leave the InitialAmountUnits box for species and the ValueUnits box for rate
parameters empty for the models in this tutorial.
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See Also

Related Examples

. “Parameter Scanning, Parameter Estimation, and Sensitivity Analysis in the Yeast
Heterotrimeric G Protein Cycle”
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Model of M-Phase Control in Xenopus Oocyte Extracts

John Tyson's Computational Cell Biology Lab created a mathematical model for M-phase
control in Xenopus oocyte (frog egg) extracts [Marlovits et al. 1998 on page B-55]. The
M-phase control model shows principles by which you can apply phosphorylation and
regulatory loops in your own models. Publications typically list systems of ordinary
differential equations (ODEs) that represent a model system. This example shows you how
to interpret these ODEs in the form of reaction pathways that are easier to represent and
visualize in SimBiology software.

The model is centered around M-phase promoting factor (MPF). There are two positive
feedback loops where MPF increases its synthesis and a negative feedback loop where
MPF decreases its amount by increasing its degradation.

In this section...

“M-Phase Control Model” on page B-22

“M-Phase Control Equations” on page B-24

“SimBiology Model with Rate and Algebraic Rules” on page B-32
“SimBiology Model with Reactions and Algebraic Rules” on page B-38
“References” on page B-55

M-Phase Control Model

* “Synthesis Reactions” on page B-22
* “Regulation Reactions with Active MPF” on page B-23

Synthesis Reactions

Cyclin B (CycB) dimerizes with Cdc2 kinase (Cdc2) to form M-phase promoting factor
(MPF).

B-22




Model of M-Phase Control in Xenopus Oocyte Extracts

—_—> CycB 0 o

-L-ﬁr
(weet J-»

[weet ]+
< {caczslp) | |«{lcdeas(p)

CK
m “

Regulation Reactions with Active MPF

Positive feedback loops with M-phase promoting factor (MPF) activate the Cdc25
phosphatase and deactivate the Weel kinase. A negative feedback loop with MPF
activates anaphase-promoting complex (APC) that regulates the degradation of the Cyclin
B subunit.
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M-Phase Control Equations

* “About the Rate Equations in This Example” on page B-25

* “Converting Differential Equations to Reactions” on page B-25

* “Equation 1, Cyclin B” on page B-26

* “Equation 2, M-Phase Promoting Factor” on page B-26

* “Equation 3, Inhibited M-Phase Promoting Factor” on page B-27

* “Equation 4, Inhibited and Activated M-Phase Promoting Factor” on page B-28
+ “Equation 5, Activated M-Phase Promoting Factor” on page B-28

* “Equation 11, Cell Division Control 25” on page B-29
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* “Equation 12, Weel Activation/Deactivation” on page B-29

* “Equation 13, Intermediate Enzyme Activation/Deactivation” on page B-30
* “Equation 14, APC Activation/Deactivation” on page B-30

* “Equation 17, Rate Parameter K2” on page B-31

* “Equation 18, Rate Parameter Kcdc25” on page B-31

* “Equation 19, Rate Parameter Kweel” on page B-32

About the Rate Equations in This Example

Models in systems biology are commonly described in the literature with differential rate
equations. However, SimBiology software defines a model using reactions. This section
shows you how to convert models published in the literature to a SimBiology format. The
equation numbers match the published paper for this model [Marlovits et al. 1998 on
page B-55]. Equations that are missing in the sequence involve the Cdk inhibitor (CKI)
protein, which is not currently modeled in the SimBiology version.

Converting Differential Equations to Reactions

The rules for writing reaction and reaction rate equations from differential rate equations
include not only the equations but also an understanding of the reactions. dx/dt refers to
the species the differential rate equation is defining. kinetics refers to the species in
the reaction rate.

» DPositive terms: Rate species are placed on right side of the reactions; reaction rate
equation species are placed on the left.

kinetics — %
* Negative terms: Rate species are placed on the left side of the reaction because the

species are being used up in some way; reaction rate equation species are also placed
on left. You need to deduce the products from additional information about the model.

kinetics or (%) — products?

The following table will help you deduce the products for a reaction. In this example, by
convention, phosphate groups on the right side of a species name are activating while
phosphate groups on left are inhibiting.
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Enzyme Description Reaction

weel Kinase, add inhibiting phosphate group | MPF —> P-MPF

cdc25 Phosphatase, remove inhibiting P-MPF —> MPF + P
phosphate group

kcak Kinase, add activating phosphate group | MPF —> MPFp

kpp Phosphatase, remove activating MPF-P —> MPF + P
phosphate group

MPF Kinase, add activating or inhibiting Weel/Cdc25/IE —> X-P or P-X
phosphate group

ki Add inhibiting Cki Cki + MPF —> Cki:MPF

kir Remove inhibiting Cki Cki:MPF —> Cki + MPF

Equation 1, Cyclin B
Differential rate equation for cyclin B [Marlovits et al. 1998 on page B-55].

d[CC}’tCB] = + k1 -k2[CycB] -k3[Cdc2][CycB]

Rate rule using SimBiology format for the differential rate equation 1. For a model using
this rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 1 on page B-33 [CycB] = k1 - K2*[CycB] - k3*[Cdc2]*[CycB]

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”

on page B-38.
Reaction 1 on page B-39 AA -> CycB v = k1
Reaction 2 on page B-40 CycB -> AA v = K2*[CycB]

Reaction 3 on page B-41 (Cdc2 + CycB -> MPF v k3*[Cdc2]*[CycB]

Equation 2, M-Phase Promoting Factor
Differential rate equation for M-phase promoting factor (MPF) [Marlovits 1998 on page B-
55]. Note that the parameter name kcakr [Marlovits et al. 1998 on page B-55] is

changed to kpp [Borisuk 1998 on page B-55] in the following reaction equations. MPF is
a heterodimer of cdc2 kinase and cyclin B.
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d[MPF]
dt

= +k3[Cdc2][CycB] -K2[MPF]

+kpp[MPFp] -kcak[ MPF]
+Kcdc25[pMPF] -Kwee1[MPF]
+kir[Cki:MPF] -ki[MPF][Cki]

Rate rule using SimBiology format for the differential rate equation 1. For a model using
this rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 2 on page B-33 MPF = kpp*MPFp - (Kweel + kcak + K2)*MPF + Kcdc25*pMPF + k3*Cdc2*C

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38. A reaction name in parentheses denotes a reaction repeated in another
differential rate equation.

(Reaction 3 on page B-41) Cdc2 + CycB -> MPF v = k3*[Cdc2]*[CycB]
Reaction 4 on page B-42 MPF -> Cdc2 + AA v = K2*[MPF]
Reaction 5 on page B-43 MPFp -> MPF v = kpp*[MPFp]
Reaction 6 on page B-44 MPF -> MPFp v = kcak*[MPF]
Reaction 7 on page B-45 pMPF -> MPF v = Kcdc25*[pMPF]
Reaction 8 on page B-46 MPF -> pMPF v = Kweel*[MPF]

Equation 3, Inhibited M-Phase Promoting Factor

Differential rate equation for inhibited M-phase promoting factor (pMPF) [Marlovits 1998
on page B-55].

d[pMPF] _

T — K2[pMPF]

+kpp[pMPFp] -kcak[pMPF]
+Kweel[MPF] -Kcdc25[pMPF]
+kd[Cki:pMPF]

Rate rule using SimBiology format for the differential rate equation 3. For a model using
this rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 3 on page B-34 pMPF = Kweel*MPF - (Kcdc25 + kcak + K2)*pMPF + kpp*pMPFp
Reaction and reaction rate equations derived from the differential rate equation. For a

model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38.
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Reaction 11 on page B-48 pMPF -> Cdc2 + AA v = K2*[pMPF]
Reaction 12 on page B-48 pMPFp -> pMPF v = kpp*[pMPFp]
Reaction 13 on page B-48 pMPF -> pMPFp v = kcak*[pMPF]
(Reaction 8 on page B-46) MPF -> pMPF v = Kweel*[MPF]
(Reaction 7 on page B-45) pMPF -> MPF v = Kcdc25*[pMPF]

Equation 4, Inhibited and Activated M-Phase Promoting Factor

Differential rate equation for inhibited and activated M-phase promoting factor (pMPFp)
[Marlovits 1998 on page B-55].

+kcak[pMPF] -kpp[pMPFp]
+Kweel[MPFp] -Kcdc25[pMPFp]
+kd[Cki:pMPFp]

Rate rule using SimBiology format for the differential rate equation. For a model using
this rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 4 on page B-36 pMPFp = Kweel*MPFp - (kpp + Kcdc25 + K2)*pMPFp + kcak*pMPF

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38.

Reaction 15 on page B-49 pMPFp -> Cdc2 + AA v = K2*[pMPFp]
(Reaction 13 on page B-48) pMPF -> pMPFp v = kcak*[pMPF]
(Reaction 12 on page B-48) pMPFp -> pMPF v = kpp*[pMPFp]
Reaction 16 on page B-49 MPFp -> pMPFp v = Kweel*[MPFp]
Reaction 17 on page B-49 pMPFp -> MPFp v = Kcdc25*[pMPFp]

Equation 5, Activated M-Phase Promoting Factor

Differential rate equation for activated M-phase promoting factor (MPFp) [Marlovits 1998
on page B-55].

—d“\/gfp] = -K2[MPFp]
+kcak[MPF] -kpp[MPFp]
+Kcdc25[pMPFp] -Kweel[MPFp]

+kir[ CKI:MPFp] -ki[CKI][MPFp]
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Rate rule using SimBiology format for the differential rate equation 1. For a model using
this rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 5 on page B-36 MPFp = kcak*MPF - (kpp + Kweel + K2)*MPFp + Kcdc25*pMPFp

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38.

Reaction 19 on page B-50 MPFp -> MPF + AA v = K2*[MPFp]
(Reaction 6 on page B-44) MPF -> MPFp v = kcak*[MPF]
(Reaction 5 on page B-43) MPFp -> MPF v = kpp*[MPFp]
(Reaction 17 on page B-49) pMPFp -> MPFp v = Kcdc25*[pMPFp]
(Reaction 16 on page B-49) MPFp -> pMPFp v = Kweel*[MPFp]

Equation 11, Cell Division Control 25

Differential rate equation for activating and deactivating Cdc25 [Marlovits 1998 on page
B-55].

d[Cdc25p] _

 K25[MPFpI[Cdc25] _ k25r(Cdc25p]
a

Km25+[Cdc25] Km25r+[Cdc25p]

Rate rule in SimBiology format for the differential rate equation 1. For a model using this
rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32. Note that
since there isn't a rate rule for Cdc25, its amount is written as (TotalCdc25 -
Cdc25p).

Rule 11 on page B-37 Cdc25p = (k25*MPFp*(TotalCdc25 - Cdc25p))/(Km25 + (TotalCdc25 - Cq

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38.

Reaction 36 Cdc25 -> Cdc25p, v
Reaction 37 Cdc25p -> Cdc25, v

k25*[MPFp1*[Cdc25]/(Km25 + [Cdc25])
k25r*[Cdc25p]/ (Km25r + [Cdc25p])

Equation 12, Weel Activation/Deactivation
Differential rate equation for activating and deactivating Weel kinase [Marlovits 1998 on

page B-55]. The kinase (MPFp) phosphorylates active Weel (Weel) to its inactive form
(Weelp). The dephosphorylation of inactive Weel (Weelp) is by an unknown phosphatase.
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d[Weel] _ _ kw[MPFpl[Weell ,  kwr[WeelP]
dt - Kmw + [Weel] Kmwr + [WeelP]

Rate rule in SimBiology format for the differential rate equation 1. For a model using this
rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 12 Weelp = (kw*MPFp*(TotalWeel - Weelp))/(Kmw + (TotalWeel - Weelp))
- (kwr*Weelp)/(Kmwr + Weelp)

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38.

reaction 38 Weel -> Weelp, v
reaction 39 Weelp -> Weel, v

(kw*[MPFp]*[Weell])/(Kmw + [Weell])
(kwr*[Weelpl)/(Kmwr + [Weelp])

Equation 13, Intermediate Enzyme Activation/Deactivation

Differential rate equation for activating and deactivating the intermediate enzyme (IE)
[Marlovits 1998 on page B-55]. The active kinase (MPFp) phosphorylates the inactive
intermediate enzyme (IE) to its active form (IEp).

dlEp) _ . kie[MPFp]IE] _ kier[IEp]

dt Kmie + [IE] Kmier + [IEp]

Rate rule in SimBiology format for the differential rate equation 1. For a model using this
rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 13 IEp = (kie*MPFp*(TotallE - IEp))/(Kmie + (TotalIE - IEp))
- (kier*IEp)/(Kmier + IEp)

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38.

reaction 40 IE -> IEp, v
reaction 41 IEp -> IE, v

(kie*[MPFp]1*[IE])/(Kmie + [IE])
(kier*[IEp])/(Kmier + [IEp])

Equation 14, APC Activation/Deactivation

Differential rate equation for [Marlovits 1998 on page B-55].

d[APCa] _ + kaplIEP][APCi] _ kapr[APCa]
dt ' Kmap +[APCi] Kmapr +[APCd]




Model of M-Phase Control in Xenopus Oocyte Extracts

Rate rule in SimBiology format for the differential rate equation 1. For a model using this
rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Rule 14 APCa = (kap*IEp*(TotalAPC - APCa))/(Kmap + (TotalAPC - APCa))
- (kapr*APCa)/(Kmapr + APCa)

Reaction and reaction rate equations derived from the differential rate equation. For a
model using these reactions, see “SimBiology Model with Reactions and Algebraic Rules”
on page B-38.

Reaction 42 APCi -> APCa, v = (kap*[IEp]*[APCi])/(Kmap + [APCil])
Reaction 43 APCa -> APCi, v = (kapr*[APCa])/(Kmapr + [APCal)

Equation 17, Rate Parameter K2

Algebraic equation to define the rate parameter K2 [Marlovits 1998 on page B-55].
Inactive APC (APCi) is catalyzed by IE (intermediate enzyme) to active APC (APCa).

k2 = V2'[APC] + V2"[APC']

Algebraic rule in SimBiology format for the algebraic equation 17. For a model using this
rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Algebraic Rule 17 V2i*(TotalAPC - APCa) + V2a*APCa - K2

Algebraic rule when simulating with reactions. For a model using this rule with reactions,
see “SimBiology Model with Reactions and Algebraic Rules” on page B-38. V2' is
renamed to V21i and V2"is renamed to V2a. APCi (APC) is the inactive form of the enzyme
while APCa (APC') is the active form. K2 is the independent variable.

Algebraic Rule 1 (V2i*APCi) + (V2a*APCa) - K2
Equation 18, Rate Parameter Kcdc25

Algebraic equation to define the rate parameter Kcdc25 [Marlovits 1998 on page B-55].
Inactive Cdc25 (Cdc25) is phosphorylated by MPF to active Cdc25 (Cdc25p).

kedc25 = V25'[Cdc25] + V25"[Cdc25p]

Algebraic rule in SimBiology format for the algebraic equation 18. For a model using this
rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Algebraic Rule 18 V25i*(TotalCdc25 - Cdc25p) + V25a*Cdc25p - Kcdc25
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B-32

Algebraic rule when simulating with reactions. Kcdc25 is the independent variable. For a
model using this rule with reactions, see “SimBiology Model with Reactions and Algebraic
Rules” on page B-38.

Algebraic Rule 2 (V25i*Cdc25) + (V25a*Cdc25p) - Kcdc25
Equation 19, Rate Parameter Kweel

Algebraic equation to define the rate parameter [Marlovits 1998 on page B-55]. Active
Weel (Weel) is phosphorylated by MPF to inactive Weel (Weelp).

kweel = Vweel'[Weelp] + Vweel'"[Weel]

Algebraic rule in SimBiology format for rate parameter equation 19. For a model using
this rule, see “SimBiology Model with Rate and Algebraic Rules” on page B-32.

Algebraic Rule 19 Vweeli*Weelp + Vweela*(TotalWeel - Weelp) - Kweel

Algebraic rule when simulating with reactions. Kweel is the independent variable. For a
model using this rule with reactions, see “SimBiology Model with Reactions and Algebraic
Rules” on page B-38.

Algebraic Rule 3 (Vweeli*Weelp) + (Vweela*Weel) - Kweel

SimBiology Model with Rate and Algebraic Rules

* “Overview” on page B-33

* “Writing Differential Rate Equations as Rate Rules” on page B-33

* “Species” on page B-33

* “Parameters” on page B-34

+ “Rate Rule 1, Cyclin B (CycB)” on page B-35

* “Rate Rule 2, M-Phase Promoting Factor (MPF)” on page B-36

* “Rate Rule 3, Inhibited M-Phase Promoting Factor (pMPF)” on page B-36

» “Rate Rule 4, Activated but Inhibited M-Phase Promoting Factor (pMPFp)”
on page B-36

+ “Rate Rule 5, Activated M-Phase Promoting Factor (MPFp)” on page B-36
+ “Rate Rule 11, Activated Cdc25 (Cdc25p)” on page B-37
+ “Rate Rule 12, Inhibited Weel (Weelp)” on page B-37
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* “Rate Rule 13, Activated Intermediate Enzyme (IEp)” on page B-37
* “Rate Rule 14, Activated APC (APCa)” on page B-37

» “Algebraic Rule 17, Rate Parameter K2” on page B-37

* “Algebraic Rule 18, Rate Parameter Kcdc25” on page B-38

+ “Algebraic Rule 19, Rate Parameter Kweel” on page B-38

Overview

There is one rate rule for each equation defining a species and one algebraic rule for each
variable parameter in the M-phase control model [Marlovits 1998 on page B-55]. For a
list and description of the equations, see “M-Phase Control Equations” on page B-24.

A basic model includes rate rules 1 to 5 and 11 to 14 with algebraic rules 17, 18, and 19.
Writing Differential Rate Equations as Rate Rules

Writing differential rate equations in an unambiguous format that a software program can
understand is a simple process when you follow the syntax rules for programming
languages.

* Use an asterisk to indicate multiplication. For example, k[A] is written k*A or k*[A].
The brackets around the species A do not indicate concentration.

* SimBiology uses square brackets around species and parameter name to allow names
that are not valid MATLAB variable names. For example, you could have a species
named glucose-6-phosphate dehydrogenase but you need to add brackets
around the name in reaction rate and rule equations.

[glucose-6-phosphate dehydrogenase]

» Use parentheses to clarify the order of evaluation for mathematical operations. For
example, do not write Henri-Michaelis-Menten reaction rates as Vm*C/Kd + C,
because Vm*C is divided by Kd before adding C to the result. Instead, write this
reaction rate as (Vm*C)/(Kd + C).

Species
The following table lists species in the model with their initial amounts. There are three

variable parameters modeled as species (K2, Kcdc25, and KWeel). You could also model
the variable parameters as parameters with the property ConstantAmount cleared.
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Marne Initial&mount £ [Initial&mountlnits | Constant&mount
Cych 0.0 =1 -
MPF 0.0 =1 r
pMPF 0.0 =1 -
nMPFp 0.0 =1 I
MPFp 0.0 =1 -
Cde28p 0.0 =1 r
Yeelp 0.0 =1 -
IEp 0.0 =1 r
APCa 0.0 =1 -
Kcde25 0.0 =1 r
Kweel 0.0 =1 -
K2 0.0 =1 r
Yyee 0.0 =1 -
TotalCdc25 1.0 =1 W
Totalvee1 1.0 =1 W
TotalAPC 1.0 =1 W
TotallE 1.0 =1 -
PPase 1.0 =1 3
AntiAPC 1.0 =1 W
Cde2 100.0 =1 W
Parameters

The following table lists parameters in the model with their initial values. The property
ConstantValue is selected for all of the parameters.
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Marne “Walue © YYaluellnits Constantalue
“Vweea 1.0 =1 W
k1 1.0 =l W
Krrwr 1.0 =1 W
Kmapr 1.0 =l ¥
Km2ar 1.0 =1 W
kcak 0.64 =l ¥
W23 0.25 =1 W
V253 0.17 =l W
kier 0.15 =1 W
kapr 0.13 =l ¥
kap 0.13 =1 W
ke 0.1 =l ¥
k25r 0.1 =1 W
Ko 0.1 =l ¥
Km25 0.1 =1 W
kie 0.02 =l W
kv 0.02 =1 W
k25 0.02 =l W
W2A] 0.017 =1 W
iveel 0.01 =l ¥
Krmier 0.01 =1 W
Kmie 0.01 =l ¥
Krmap 0.01 =1 W
Y2 0.0080 =l W
k3 0.0050 =1 W
kpp 0.0040 =l W

Rate Rule 1, Cyclin B (CycB)

The rate rule is from “Equation 1, Cyclin B” on page B-26.

kl - K2*CycB - k3*Cdc2*CycB
0 nM

rate rule: CycB
species: CycB
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B-36

100 nM, [x]constant

parameters: k1l = 1 nM/minute
K2 = 0 1/minute, []constant
k3 = 0.005 1/(nM*minute)

K2 is a variable rate parameter whose value is defined by an algebraic rule. See
“Algebraic Rule 17, Rate Parameter K2” on page B-37. Its value varies from 0.005 to
0.25 1/minute.

Rate Rule 2, M-Phase Promoting Factor (MPF)

The rate rule is from “Equation 2, M-Phase Promoting Factor” on page B-26.

rate rule: MPF = kpp*MPFp - (Kweel + kcak + K2)*MPF + Kcdc25*pMPF
+ k3*Cdc2*CycB
species: MPF = 0 nM

MPFp = 0 nM
pMPF = 0 nM

parameters: kpp = 0.004 1/minute
kcak = 0.64 1/minute
k3 = 0.005 1/(nM*minute)
K2 = 0 1/minute
Kcdc25 = 0 1/minute
Kweel = 0 1/minute

K2, Kcdc25, and Kweel are variable rate parameters whose values are defined by
algebraic rules. See “Algebraic Rule 17, Rate Parameter K2” on page B-37, “Algebraic
Rule 18, Rate Parameter Kcdc25” on page B-38, and “Algebraic Rule 19, Rate Parameter
Kweel” on page B-38.

Rate Rule 3, Inhibited M-Phase Promoting Factor (pMPF)
The rate rule is from “Equation 3, Inhibited M-Phase Promoting Factor” on page B-27.
rate rule: pMPF = Kweel*MPF - (Kcdc25 + kcak + K2)*pMPF + kpp*pMPFp

Rate Rule 4, Activated but Inhibited M-Phase Promoting Factor (pMPFp)

The rate rule is from “Equation 4, Inhibited and Activated M-Phase Promoting Factor” on
page B-28.

rate rule: pMPFp = Kweel*MPFp - (kpp + Kcdc25 + K2)*pMPFp + kcak*pMPF

Rate Rule 5, Activated M-Phase Promoting Factor (MPFp)

The rate rule is from “Equation 5, Activated M-Phase Promoting Factor” on page B-28.
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rate rule: MPFp = kcak*MPF - (kpp + Kweel + K2)*MPFp + Kcdc25*pMPFp
Rate Rule 11, Activated Cdc25 (Cdc25p)

The rate rule is from “Equation 11, Cell Division Control 25” on page B-29.

rate rule: Cdc25p = (k25*MPFp*(TotalCdc25 - Cdc25p))/(Km25 + (TotalCdc25 - Cdc25p))
- (k25r*PPase*Cdc25p)/ (Km25r + Cdc25p)

Rate Rule 12, Inhibited Weel (Weelp)

The rate rule is from “Equation 12, Weel Activation/Deactivation” on page B-29.

rate rule: Weelp = (kw*MPFp*(TotalWeel - Weelp))/(Kmw + (TotalWeel - Weelp))
- (kwr*PPase*Weelp)/(Kmwr + Weelp)

Rate Rule 13, Activated Intermediate Enzyme (IEp)

The rate rule is from “Equation 13, Intermediate Enzyme Activation/Deactivation” on
page B-30.

rate rule: IEp = (kie*MPFp*(TotallE - IEp))/(Kmie + (TotalIE - IEp))
- (kier*PPase*IEp)/(Kmier + IEp)

Rate Rule 14, Activated APC (APCa)

The rate rule is from “Equation 14, APC Activation/Deactivation” on page B-30.

rate rule: APCa = (kap*IEp*(TotalAPC - APCa))/(Kmap + (TotalAPC - APCa))
- (kapr*AntiAPC*APCa)/(Kmapr + APCa)

Algebraic Rule 17, Rate Parameter K2

K2 is a variable rate parameter whose value is determined by the amount of active and
inactive APC. The algebraic rule is from “Equation 17, Rate Parameter K2” on page B-31.

algebraic rule: V2i*(TotalAPC - APCa) + V2a*APCa - K2
species: APCi = 1 nM
APCa = 0 nM
TotalAPC = 1 nM [x]constant
parameters: K2 0 or 0.25 1/minute, []constant
V2i 0.005 1/ (nM*minute)
V2a 0.25 1/(nM*minute)
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Algebraic Rule 18, Rate Parameter Kcdc25

Kcdc25 is a variable rate parameter whose value is determined by the amount of active
and inactive Cdc25. The algebraic rule is from “Algebraic Rule 18, Rate Parameter
Kcdc25” on page B-38.

algebraic rule: V25i*(TotalCdc25 - Cdc25p) + V25a*Cdc25p - Kcdc25
Algebraic Rule 19, Rate Parameter Kweel

Kweel is a variable rate parameter whose value is determined by the amount of active
and inactive Weel. The algebraic rule is from “Equation 19, Rate Parameter Kweel” on
page B-32.

algebraic rule: Vweei*Weelp + Vweea*(TotalWeel - Weelp) - Kweel

SimBiology Model with Reactions and Algebraic Rules

* “Overview” on page B-39

* “Reaction 1, Synthesis of Cyclin B” on page B-39

* “Reaction 2, Degradation of Cyclin B” on page B-40

* “Reaction 3, Dimerization of Cyclin B with Cdc2 Kinase” on page B-41

* “Reaction 4, Degradation of Cyclin B on MPF” on page B-42

* “Reaction 5, Deactivation of Active MPF” on page B-43

* “Reaction 6, Activation of MPF” on page B-44

* “Reaction 7, Remove Inhibiting Phosphate from Inhibited MPF” on page B-45

* “Reaction 8, Inhibition of MPF by Phosphorylation” on page B-46

* “Reaction 11, Degradation of Cyclin B on Inhibited MPF” on page B-48

* “Reaction 12, Deactivation of MPF to Inhibited MPF” on page B-48

* “Reaction 13, Activation of Inhibited MPF” on page B-48

* “Reaction 15, Degradation of Cyclin B on Active but Inhibited MPF” on page B-49
* “Reaction 16, Inhibit MPF by Phosphorylation” on page B-49

* “Reaction 17, Remove Inhibiting Phosphate from Activated MPF” on page B-49
* “Reaction 19, Degradation of Cyclin B on Activated MPF” on page B-50

* “Reaction 36, Activation of Cdc25 by Activated MPF” on page B-50
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* “Reaction 37, Deactivation of Cdc25” on page B-50

* “Reaction 38, Deactivation of Weel by Active MPF” on page B-51

* “Reaction 39, Activation of Weel” on page B-51

* “Reaction 40, Activation of Intermediate Enzyme by Active MPF” on page B-51
* “Reaction 41, Deactivation of IE” on page B-51

* “Reaction 42, APC Activation by IEp” on page B-52

* “Reaction 43, APC Deactivation” on page B-52

* “Block Diagram of the M-Phase Control Model with Reactions” on page B-52

Overview

There can be one or more reactions for an equation defining a species and one algebraic
rule for each variable parameter in the M-phase control model [Marlovits 1998 on page B-
55]. For a list and description of the equations, see “M-Phase Control Equations” on

page B-24.

A basic model includes reactions 1 t0 8, 11 to 13, 15to 17, 19, and 36 to 43 with
algebraic rules from equations 17, 18, and 19.

Reaction 1, Synthesis of Cyclin B

Cyclin B is synthesized at a constant rate.

reaction:
reaction rate:
parameter:
species:

AA -> CycB

kl nM/minute

kl = 1 nM/minute

CycB = 0 nM

AA = 100 nM [x]constant [x]boundary

Simulate reaction 1 with the sundials solver.
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Reaction 2, Degradation of Cyclin B

Cyclin B is degraded at the end of the M-phase.

reaction: CycB -> AA
reaction rate: K2*CycB nM/minute
parameters: K2 0 1/minute, []constant, variable by rule

V2i 0.005 1/nM*minute
V2a 0.25 1/nM*minute

species: CycB = 0 nM
APCi 1 nM
APCa 0 nM
AA = 100 nM [x]Jconstant [x]boundary

algebraic rule: (V2i*APCi) + (V2a*APCa) - K2

Initially, Cyclin B degradation is low. This implies the amount of active APC (APCa) = 0
and inactive APC (APCi) = APCtotal = 1 nM.

Test the algebraic rule by simulating reactions 1 and 2 with APCi = 0 and APCa = 1.
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Reaction 3, Dimerization of Cyclin B with Cdc2 Kinase

Cyclin B dimerizes with Cdc2 kinase to form M-phase promoting factor (MPF).

reaction: Cdc2 + CycB -> MPF
reaction rate: k3*Cdc2*CycB nM/minute

parameters: k3 = 0.005 1/(nM*minute)
species: Cdc2 = 100 nM
CycB= 0 nM
MPF = 0 nM

Test the model by simulating with K2 = 0.25.
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Reaction 4, Degradation of Cyclin B on MPF

Cyclin B is tagged with ubiquitin groups and degrades while bound to Cdc2.

reaction: MPF -> Cdc2 + AA
reaction rate: K2*[MPF]
parameters: K2 = 0 or 0.25 1/minute, variable by rule

v2i 0.005 1/ (nM*minute)
v2a 0.25 1/(nM*minute)

species: MPF = 0 nM
APCi = 1 nM
APCa = 0 nM
AA = 100 nM [x]constant [x]boundary

algebraic rule: (v2i*APCi) + (v2a*APCa) - K2

Test the simulation with APCa = 1 and APCi = 0. Because the amount of APCa
(active) is high, K2 increases and the degradation starts to balance the synthesis of MPF.
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Reaction 5, Deactivation of Active MPF

Active MPF (MPFp) is dephosphorylated on Thr-161 by an unknown phosphatase (PP) to
inactive MPF (MPF).

reaction:
reaction rate:
parameters:
species:

kcakr = 0.004 1/minute [Marlovits 1998, p. 175], but is renamed to kpp [Borisuk

1998].

Test simulation with APCa = 1 and APCi = 0. MPF increases without reaching steady

state.

MPFp -> MPF

kpp* [MPFp]

kpp = 0.004 1/minute
MPFp = @ nM

MPF = 0 nM
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Reaction 6, Activation of MPF

Inactive MPF (MPF) is phosphorylated on Thr-161 by an unknown cyclin activating kinase
(CAK).

reaction: MPF -> MPFp
reaction rate: kcak*[MPF]
parameters: kcak = 0.64 1/minute
species: MPF = 0 nM
MPFp = 0 nM

The kinase reaction that phosphorylates MPF to the active form is 160 times faster than
the phosphatase reaction that dephosphorylates active MPE.

Simulate the model with reactions 1 to 6. Notice that after adding reaction 6, most of the
product goes to active MPF (MPFp).
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Reaction 7, Remove Inhibiting Phosphate from Inhibited MPF

Cdc25 phosphatase removes the inhibiting phosphate groups at the threonine 14 and
tyrosine 15 residues on Cdc2 kinase.

reaction: pMPF -> MPF
reaction rate: Kcdc25*[pMPF]
parameters: Kcdc25 = 0.0 1/minute or 0.017 1/minute, variable by
algebraic rule

V25i = 0.017 1/(mM*minute)

V25a = 0.17 1/mM*minute
species: pMPF = 0 nM

MPF = 0 nM

Cdc25 = 1 nM (inactive)

Cdc25p = 0 nM (active)
algebraic rule: (V25i*Cdc25) + (V25a*Cdc25p) - Kcdc25
Initially, all of the Cdc25 phosphatase is in the inactive form (Cdc25).

Enter the initial value for Kcdc25 as 0.0 and let the first time step calculate the value
from the rule, or enter an initial value using the rule.
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B-46

Initially, set ConstantAmount for Cdc25 and Cdc25p to test reactions 1 through 7. Then
after you can add the reactions to regulate the Cdc25 phosphatase by clearing the
ConstantAmount property.

Reaction 8, Inhibition of MPF by Phosphorylation

Addition of inhibiting phosphate groups by Weel kinase to inhibit active M-phase
promoting factor (MPF). Myt1 kinase is also involved with the phosphorylation, but its
contribution is grouped with Weel.

reaction: MPF -> pMPF
reaction rate: Kweel*[MPF]
parameters: Kweel = 0.0 1/minute or 0.01 1/minute, variable by
algebraic rule

Vweeli = 0.01 1/(nM*minute)

Vweela = 1.0 1/(nM*minute)
species: MPF = 0 nM

pMPF = 0 nM

Weelp = 1 nM (inactive)
Weel = 0 nM (active)
algebraic rule: (Vweeli*Weelp) + (Vweela*Weel) - Kweel

The initial capitalization for the parameter Kweel is a convention to indicate that this
value changes during the simulation.

Test the simulation for reactions 1 through 8 with Weelp (inactive) = 1 and Weel
(active) = 0.
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Reaction 11, Degradation of Cyclin B on Inhibited MPF

Degradation of cyclin B (CycB) on inhibited MPF (pMPF). Cyclin B is tagged with ubiquitin
groups and degrades while bound to Cdc2.

reaction: pMPF -> Cdc2 + AA
reaction rate: K2*[pMPF] nM/minute
parameters: K2 = 0 or 0.25 1/minute, variable by rule
V2i 0.005 1/nM*minute
V2a 0.25 1/nM*minute
species: MPF = 0 nM
APCi 1 nM
APCa 0 nM
AA = 100 nM [x]constant [x]boundary
Cdc2 = 100 nm
algebraic rule: (V2i*APCi) + (V2a*APCa) - K2

Test the simulation with Weel active (Weel = 1) and APC active (APCi = 1).
Reaction 12, Deactivation of MPF to Inhibited MPF

Inhibited/active MPF (pMPFp) is dephosphorylated on Thr-161 by an unknown
phosphatase (PP) to inhibited MPF (pMPF). Compare reaction 12 with reaction 5 on page
B-43.

reaction: pMPFp -> pMPF
reaction rate: kpp*[pMPFp]
parameters: kpp = 0.004 1/minute
species: pMPFp 0 nM
pMPF 0 nM

Reaction 13, Activation of Inhibited MPF

Inhibited MPF (pMPF) is phosphorylated on Thr-161 by an unknown cyclin-activating
kinase (CAK). Compare reaction 13 with reaction 6 on page B-44.

reaction: pMPF -> pMPFp
reaction rate: kcak*[pMPF] nM/minute
parameters: kcak = 0.64 1/minute
species: pMPF = 0 nM
pMPFp = 0 nM

Test the simulation with Weelp = 1 (inactive)/ Weel = 0 and then test with Weelp = 0
(inactive)/ Weel = 1.
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Reaction 15, Degradation of Cyclin B on Active but Inhibited MPF

Degradation of cyclin B (CycB) on inhibited MPF (pMPF). Cyclin B is tagged with ubiquitin
groups and degrades while bound to cdc2 kinase.

reaction:
reaction rate:
parameters:

species:

algebraic rule:

pPMPFp -> Cdc2 + AA
K2*[pMPFp] nM/minute
K2 = 0 or 0.25 1/minute, variable by rule

v2i = 0.005 1/nM*minute
v2a = 0.25 1/nM*minute
MPF = 0 nM
APCi =1 nM
APCa = 0 nM

AA = 100 nM [x]Jconstant [x]boundary
Cdc2 = 100 nm
(V2i*APCi) + (V2a*APCa) - K2

Reaction 16, Inhibit MPF by Phosphorylation

Addition of inhibiting phosphate groups by Weel kinase to inhibit active M-phase
promoting factor (MPF). Myt1 kinase is also involved with the phosphorylation, but its
contribution is grouped with Weel.

reaction:
reaction rate:
parameters:

species:

algebraic rule:

MPFp -> pMPFp
Kweel*[MPFp] nM/minute
Kweel = 1/minute []constant, variable by rule

Vweei = 0.01 1/nM*minute
Vweea = 1 1/nM*minute
MPFp = 0 nM

pMPFp = 0 nM

Weelp = 1 nM (inactive)

Weel = 0 nM (active)
(Vweeli*Weelp) + (Vweela*Weel) - Kweel

Reaction 17, Remove Inhibiting Phosphate from Activated MPF

Remove the inhibiting phosphate group from pMPFp with cdc25 phosphatase.

reaction:
reaction rate:
parameters:

species:

pMPFp -> MPFp
Kcdc25* [ pMPFp]
Kcdc25 = 0 1/minue, []constant, variable by rule

V25i = 0.017 1/nM*minute
V25a = 0.17 1/nM*minute
pMPFp = 0 nM
MPFp = 0 nM
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algebraic rule: (V25i*Cdc25) + (V25a*Cdc25p) - Kcdc25

Reaction 19, Degradation of Cyclin B on Activated MPF

Degradation of cyclin B (CycB) on inhibited MPF (pMPF). Cyclin B is tagged with ubiquitin
groups and degrades while bound to cdc2 kinase.

reaction: MPFp -> MPF + AA
reaction rate: K2*[MPFp] nM/minute
parameters: K2 = 0 or 0.25 1/minute, variable by rule

V2i 0.005 1/nM*minute
V2a 0.25 1/nM*minute

species: MPF = 0 nM
MPFp 0 nM
APCi 1 nM
APCa 0 nM
AA = 100 nM [x]constant [x]boundary
Cdc2 = 100 nm

algebraic rule: (V2i*APCi) + (V2a*APCa) - K2

Reaction 36, Activation of Cdc25 by Activated MPF

Activation of cdc25 phosphatase by phosphorylation with active M-phase promoting factor
(MPFp).

reaction: Cdc25 + (MPFp) -> Cdc25p + (MPFp)
reaction rate: (k25*[MPFp]*[Cdc25])/(Km25 + [Cdc25])
parameters: k25 = 0.02 1/minute
Km25 = 0.1 nM
species: Cdc25 = 1 nM (inactive)
Cdc25p = 0 nM (active)

Initially MPF is inhibited (MPF* reacts to pMPF*).
Reaction 37, Deactivation of Cdc25

Deactivation of cdc25 phosphatase by dephosphorylation with an unknown phosphatase.

reaction: Cdc25p -> Cdc25
reaction rate: (k25r*[Cdc25p])/(Km25r + [Cdc25p])
parameters: k25r = 0.1 nM/minute
Km25r nM
species: (Cdc25 nM (inactive)
Cdc25p = 0 nM (active)

=1
=1
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Reaction 38, Deactivation of Weel by Active MPF

Deactivation of Weel kinase by phosphorylation with active M-phase promoting factor

(MPFp).

reaction: Weel + (MPFp) -> Weelp + (MPFp)
reaction rate: (kw*[MPFp]*[Weel])/(Kmw + [Weel]) nM/minute
parameters: kw = 0.02 1/minute
Kmw = 0.1 nM
species: Weelp = 1 nM (inactive)

Weel = 0 nM (active)

Initially MPF is inhibited (MPF* reacts to pMPF*).

Reaction 39, Activation of Weel

Activation of Weel kinase by dephosphorylation with an unknown kinase.

reaction: Weelp -> Weel
reaction rate: (kwr*[Weelp])/(Kmwr + [Weelp]) nM/minute
parameters: kwr = 0.1 nM/minute
Kmwr = 1 nM
species: Weelp = 1 nM (inactive)

Weel = 0 nM (active)

Reaction 40, Activation of Intermediate Enzyme by Active MPF

The inactive intermediate enzyme (IE) is activated by phosphorylation with active M-
phase promoting factor (MPFp).

reaction: IE + (MPFp) -> IEp + (MPFp)
reaction rate: (kie*[MPFp]*[IE])/(Kmie + [IE])
parameters: kie = 0.02 1/minute
Kmie = 0.01nM
species: IE = 1 nM (inactive)

IEp = 0 nM (active)

Reaction 41, Deactivation of IE

The active intermediate enzyme (IE) is deactivated by dephosphorylation.

reaction: IEp -> IE
reaction rate: (kier*[IEp])/(Kmier + [IEp])
parameters: kier = 0.15 nM/minute

Kmier = 0.01 nM
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species: IE = 1 nM (inactive)
IEp = 0 nM (active)

Reaction 42, APC Activation by IEp
Anaphase-promoting complex (APC) is activated by an active intermediate enzyme (IEp).
reaction: APCi + IEp -> APCa + IEp

reaction rate: (kap*[IEp]*[APCi])/(Kmap + [APCil])
parameters: kap = 0.13 1/minute

Kmap = 0.01 nM
species : APCi = 1 nM
APCa = 0 nM

Reaction 43, APC Deactivation

Anaphase-promoting complex (APC) is deactivated.

reaction: APCa -> APCi
reaction rate: (kapr*[APCa])/(Kmapr + [APCa])
parameters: kapr = 0.13 nM/minute

Kmapr = 1 nM
species : APCi =1 nM
APCa = 0 nM

Block Diagram of the M-Phase Control Model with Reactions
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